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What’s New in this Revision?

Note: Only the latest changes to this documentation are listed here. Changes made to earlier revisions
are listed in the "Changes to the User Documentation” document which can be downloaded from the
company extranet at https://extranet.confirmit.com.

The following changes have been made in revision 1 of the Forsta Plus Horizons v2022 Professional and
Standard Panels User Guide:

e The user guide is updated with new logo, company and product names. Note that images will be updated
at a later date, and URLSs, folder names etc. will be corrected as the changes become applicable.

Note: The general layout and language in this document is continually being corrected, adjusted and
improved to ensure the user has the best possible source of information. Only NEW information and
details of functionality that has changed since the previous issue are listed here - minor corrections to
the text and document layout are not listed.

Important

We need your feedback so we can improve this document and provide you with the information you
require. If you have any comments or constructive criticism concerning the content or layout of this
documentation, please send an email to documentation@forsta.com. Please include in your email the
section number and/or heading text of the section to which your comment applies.
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1. Introduction

Collecting feedback via the Internet gives tremendous possibilities. You can interview your employees and your
customers, and conduct surveys towards your markets, for example mapping the profiles of the people visiting
your web site. Within the Market Research industry, many agencies also use Panels to collect data and conduct
research.

A panel is a group of people, possibly several million, who have agreed to be available to answer surveys. When
a prospective panelist first registers in the panel, he/she will typically answer a registration survey that will log
personal and other information such as work-related and household details. This information will allow the
research company to pick out of the panel samples of panelists who are suitable to answer particular surveys. For
example, if you are conducting a marketing survey for a client company that manufactures dog food, you will
probably wish to include only dog-owners in your sample. You can import people directly into the panel if you
already have their information.

In Forsta Plus you can build a library of panelist interfaces, called Panel Portals, through which registered and
potential panelists can read about your panels and register themselves if necessary. Those who are already
registered (members) can log into the Panel Portal to answer new or previously started surveys, view their survey
list, update their profile, view their points etc. All these actions are conducted via the same interface.

A Panel can also be used by a company to hold information about its employees and/or customers. You can then
send specific people surveys based on the information in the Panel. For example, if you want to send a seminar
registration survey to all employees working in a particular city and a particular department, and who have not
already attended that seminar, then the panel will give you a sample containing the people matching these
criteria, and upload the list to the seminar registration survey.

Forsta Plus contains three "grades" of panel application; Basic panels, Standard Panels and Professional Panels.

e Basic Panels - this simple functionality is included as a part of the Professional Authoring application. The
Basic Panels functionality is described in the separate Professional Authoring User Guide.

e Standard Panels - this is a reduced set of the Professional Panels functionality. If you have a Standard
Panels license, use this user guide for information on Standard Panels functionality but be aware that
much of the information contained herein will not apply to you.

e Professional Panels - the full panels functionality.

This user guide explains the full Professional Panels functionality. Note that this guide should be read in
conjunction with the Professional Authoring User Guide, which explains how to create and set up the surveys. Be
aware that some functionality described herein, for example FTP import, may need additional licensing.

Note: The Professional Panel functionality is purchased as a separate add-on module within Forsta Plus.

Important

The browser manufacturers’ interpretations of web standards may vary, and this can result in slight
differences across the different browsers. Forsta therefore recommends that users test their surveys,
Panel Portal projects, and Reportal Viewer/Public Reports, on different browsers to ensure they look and
function as expected/required on the different browsers.

1.1. Recommended Limits

Note: The Professional Panels functionality includes no built-in limits. However, due to the time and
resources used when processing large databases, you are strongly recommended to keep within the
following maximum values:

¢ Number of panelists — is dependent on the type of license you have:
0 On Premise - up to 10 million.

0 On Demand - up to 5 million. Panels larger than this must be approved in advance by the Forsta On
Demand Operations team - contact support@confirmit.com, or an On Premise installation should be
considered.

e Survey history — up to 100 million records.
e Maximum number of variables in a panel - 500

e Maximum number of Columns in panel database - 4000
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Each single, numeric, date and open text question will occupy one column in the panel database. Multi
questions will occupy one column per answer alternative.

e Sampling (Memory on batch server, read from BitStream server and SQL server) — a maximum of 8
dimensions.

e Maximum number of cells in the sampling matrix — 100.000. This is calculated as the number of segments
in each dimension multiplied by the number of segments in the other dimensions. For example, if the
matrix has 8 dimensions, where the number of segments is nl in dimension 1, n2 in dimension 2 etc. the
total number of cells will be n1*n2*n3*n4*n5*n6*n7*n8. This value must be a maximum of 100.000.

e Be aware that large BitStream generations will use considerable server processing resources, and can
cause delays for other users. Large BitStream generations should therefore be performed during off-peak
hours.

e BitStream file set generation affects the BitStream server during generation and sampling, and will affect
the SQL server (reading) to a lesser degree. Therefore:

o Limit the number of open text fields included when sampling. BitStream files should only include the
fields to be used in filtering and sampling matrices, not the fields you need for the respondent file.

o Open text fields that are to be part of the BitStream files should be limited to 4 characters.
o Note that Open text fields are not supported as segments in the sampling matrix.

o To optimize the panel database: use Boolean data types and numeric codes whenever possible, and
numeric ranges between 0 and 255 should be specified.

e The “Panelist registration / update profile project” checkbox in the Project Overview page should only be
used for surveys used for panelists signing up for the panel and updating their profile. It must not be used
regular data collection (research projects/surveys). If this box is checked for a project, it will be registered
in the project log.

e “Sample Only” surveys (add-on) are intended only for access panel providers that sell sample to 3rd
parties, for surveys for which the access panel provider does not run the data collection. The surveys used
to redirect panelists to external survey links and update status upon survey completion can contain up to 5
additional questions (for example for rating the survey experience etc.), but are not to be used for regular
additional data collection.

Note: The actual limits will depend on the hardware configuration currently in use. Contact Forsta
Support for further information.
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2. General Information

2.1. How to Access Professional Panels
You have two ways of accessing the Professional Panels functionality:
¢ Go to the Home > Professional Panels menu command.

e Click the Professional Panels item in the Quick Access pane.

In both cases, the Professional Panel List page opens.

Professional Panel List
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Figure 1 Example of the Professional Panel List page

This page lists the panels currently available to you. These may be panels that you have created or imported, or
panels that others have created and given you permission to access. The panel details presented in this list are
as follows:

¢ Panel ID - the unique identification number for the panel. This is allocated automatically by Forsta Plus
when the panel is first created. This is the link used to access the panel.

¢ Panel Name - the identifying name of the panel, given by the person who created it.
e Company — the company registered as the “owner” of the panel.

e Created By - the name of the person who created the panel.

e Created - the date and time the panel was created.

e Keywords - you can register keywords for a panel to make it simpler to locate when the panel list is
extensive.

To open a panel, click on its blue Panel ID link. The Panel Overview page for the selected panel opens (see
Overview on page 28 for more information). Note that this page is also accessible via the Panel Utilities >
Overview menu command. To create a new panel, click the New Professional Panel button (see How to Create
a New Professional Panel on page 3 for more information). To import a panel and selected rules, matrices etc.
from a different site, click the Import Remote Panel button.

2.2. How to Create a New Professional Panel
To create a new Professional Panel:

1. Go to the Professional Panels List page by clicking the Home > Professional Panels menu command or
by clicking the Professional Panels item in the Quick Access pane.

2. Click the New Professional Panel button (located at the right end of the page's toolbar.)
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The New Professional Panel overlay opens.

al Panel List

New Professional Panel

Panel Name

[5ld

Create Panel Cancel

Figure 2 The Professional Panel Name overlay

Type the desired name of the panel into the field.
4. Click Create Panel.

The Professional Panel is created and added to the list in the Professional Panels List page. The Panel
Overview page opens (see Overview on page 28 for more information). Here you can add languages,
categories and keywords and edit the email address for error messages. To assist the user with creating
the panel, new panels will be created with a set of default Aggregated Variables. These variables are
editable by users after the panel is created.

2.3. How to Import a Panel from a Remote Site

This functionality enables you to import a Professional Panel from another site. The functionality includes
importing Portals, Rules, Rule Sets, Matrices and Linked Projects, and also re-maps to new projectlds and/or
rulelds.

You can perform a remote import on only Portals, Rules and Matrices, but in this case re-mapping of ids will not
be performed. No data will be transferred during a remote import.

Note: This functionality can also be used to duplicate a panel and all its related objects on the same
server.

To import a panel from a remote site:

1. Go to the Professional Panels list, and click the Import Remote Panel button located towards the right
end of the list toolbar.

The Import Remote Panel overlay opens.
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Figure 3 The Import Remote Panel overlay

2. Select the site you wish to import from.
Add the user name and password for that remote site.

4. Select or deselect the other items as necessary (see Properties on the Import Remote Panel Overlay on
page 5 for more information).

5. Click Import Panel.

The panel and any select associated functionality is imported and the panel is added to the Panel List.

Important

Once you have imported everything, complete the registration survey (if it exists) and run the BS rule (if it
exists). If you do not do this and the selected data source on the matrices and jobs does not exist, the
data source will be cleared when you open and save the matrices and jobs.

2.3.1. Properties on the Import Remote Panel Overlay

The properties and settings are as follows:

e Remote Site - type in the domain name of the remote Forsta site you want to import from (for example
author.euro.forsta.com).

e Use SSL - select whether the transfer should be conducted using an encrypted channel.

Note: The remote host you are connecting to must support HTTPS for this to work.

e Username - the username at the remote Forsta site you want to connect as.

Note: This user must have the SYSTEM_API_ACCESS permission at the remote site and read-access to
the schema you are trying to retrieve.

e Password - the corresponding password for your user at the remote Forsta site.

e Panelld - the id on the remote site of the panel you want to import.

Note: You must have read permission to the panel you want to import.
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e Launch panel after import - select whether you want the database to be generated automatically once
the panel has been imported.

e Import Panel Rules - select if you would like to import all panel rules for specified panel. A maximum of
50 Rules can be imported, sorted by LastExecuted.

e Import Panel Rule Sets - select if you would like to import all panel rule sets for specified panel. A
maximum of 50 RuleSets can be imported, sorted by LastExecuted.

e Import Matrices - select if you would like to import all matrices for specified panel. A maximum of 50
Matrices can be imported, sorted by LastUsed.

e Import Jobs - select if you would like to import all jobs for specified panel. A maximum of 50 jobs can be
imported, sorted by Modified.

e Import Portals - select if you would like to import all portals for specified panel.

e Import Linked Surveys - select if you would like to import all linked surveys for specified panel. A
maximum of 10 linked surveys can be imported.

e Reuse local database schemas - if enabled, this will attempt to find a local database schema which has
the same name as the schema associated with the remote survey. If such a schema is found, the local
schema will be used rather than importing the remote schema. When this checkbox is disabled, a schema
in a remote survey will always be imported, irrespective of how many times you import the survey.

e Reuse local survey layouts - if enabled, this will attempt to find a local survey layout with the same name
as the survey layout used by the remote survey(s). If such a survey layout is found, the local survey layout
will be used rather than importing the remote survey layout.

o Specify panel name - if you want to import the panel using a name different from that used on the remote
Forsta site, check this box and input your own name. If not, leave this unchecked.

2.4. Disabled Features

When a new Professional Panel is created, some features that are not used very often will be hidden by default.
These features can be activated in the Panel Settings page (see The Panel Settings Features Tab on page 120
for more information).

2.5. The Search Facility

In an established company the list of registered panels may run into thousands, and a search through the list for
the one panel that you wish to use could be time-consuming. Forsta Plus therefore provides you with a set of
filters so you can reduce a long list to a manageable size.

e Panel Category — Click the down arrow beside the field to open a drop-down list of the panel categories,
select the appropriate category from the list and click Search. The list is reduced to only those panels that
have the selected category.

Note: You do not need to type the entire name or number into the appropriate field —in most cases the
first few characters will tend to reduce the list considerably.

e Panel ID —type in part or all of the required panel’s ID number.

e Panel Name - type in the company name.

e Company — allows you to search for panels according to the company under which it is registered.
e Created By — allows you to search for panels created by specific users.

e Created— Select an operator and a date to search for, for example any panels created on or before a
certain date.

¢ Keywords - type a key word into the field to search for all panels with that word registered as a keyword.

2.6. Password Policy

As part of the continuous effort to ensure that Forsta Plus complies with the highest standards of security, the
following password policy applies, for end users (CAPI interviewers, report viewers, Analysts and Designers) and
Authoring users (Express, Professional and Translator).
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General:

System messages are provided (with translations to the usual common languages) for these settings. The
appropriate error messages will be displayed when users choose passwords that do not comply with the site
settings.

The Authoring (Express and Professional), Reportal and Panel Portal modules all have ‘Forgotten Password’
functionality. In the event a user or end user forgets his/her password, clicking the Forgot Password button
requests an email with a link that opens a page where they can reset the password. Note that the reset password
link is time-limited and only valid for one hour. If the user does not reset their password within that time then they
must re-click the button to be sent a new link. Refer to the Forsta Plus Professional Authoring User Guide for
further details.

All passwords are hashed and not transmitted in plain text, including those for panelists in Professional, Standard
and Basic Panel. Consequently, passwords will not be available in plain text for any system users. Instead, users
will be sent an activation link to open a page where they can choose their own password.

Panelists:

The changes to the password policy for panelists are optional, and users must actively enable the restrictions for
Basic and Professional Panels (see The Panel Settings on page 119 for more information). Users may then
define custom settings for a panel. Panelist passwords will be hashed, meaning that passwords will not be
available in plain text. When panelists use the “Forgot password” feature, they will be sent an activation link which
will open a page where they can reset their password.

Warning
The default Panelist password settings pre-set by Forsta provide minimum security. Remember to enable
suitable restrictions to ensure a satisfactory level of security for your panelists.

On-Demand users:

The passwords for all areas of Forsta Plus must satisfy the same minimum requirements for complexity.
Wherever passwords can be changed or set within the application, they will be validated against these rules
before the change is accepted.

e Password history - the new password must be different from the last 12 passwords.

e Minimum age - the user will have to wait 24 hours after changing the password before being allowed to
change it again.

¢ Maximum number of login attempts - after 5 invalid login attempts the account will be locked. The user
will not be allowed to login again until the account is reactivated by the system administrator in the single
panelist editor page (see Single Panelist Editor on page 100 for more information).

e Uppercase characters - the password must contain at least 1 uppercase letter.
¢ Non-alpha characters - the password must contain at least 1 character that is not a letter (a..z, A..Z).
e Password length - the password must contain at least 8 characters.

e Password expiry days - the password will expire after 60 days. (This will not apply for login to the CAPI
console.)

For Authoring users, it is possible to enforce even stricter requirements through certain company settings. Contact
Forsta support if you wish to implement a stricter policy.
On-Premise users:

The following configurable settings will be enforced for all On-Premise users. If the Company Administrator
selects to use the settings, users will have to comply with these settings when changing their password:

e Password history - the new password must be different from the last X passwords.

e Minimum age - the user will have to wait X hours after changing the password before being allowed to
change it again.

e Maximum number of login attempts - after X invalid login attempts the account will be locked. The user
will not be allowed to login again until the account is reactivated by the system administrator in the single
panelist editor page (see Single Panelist Editor on page 100 for more information).

e Non-alpha-numeric characters - a required minimum number of characters that are not numbers (0..9)
or letters (a..z, A..Z).
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e Uppercase characters - a required minimum number of uppercase letters.
¢ Non-alpha characters - a required minimum number of characters that are not letters (a..z, A..Z).
e Password length - a required minimum number of characters in the password.

e Password expiry days - the password will expire after a number of days. (This will not apply for login to
the CAPI console.)

e Password strength - in addition to a combination of the above settings, a regular expression may be
used to enforce an even stricter policy.

For Authoring users, it is possible to enforce even stricter requirements through certain company settings. The
server documentation that will be provided with the release will contain more detail.

2.7. CATI Support

Professional Panels supports CATI channel surveys, allowing sample uploads to appear in the CATI system for
interviewing.

Three scheduling options are available for respondent uploads for CATI-enabled surveys. When sample is loaded
from Professional Panel, the system will use the default value (No scheduling) and there is no option to change
this.
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3. The Menus

To open a panel, click on the blue Panel ID link in the Professional Panel List. The Panel Overview page for the
selected panel opens, and the Panel menus become available.

3.1. The Panel Setup Menu

The Panel Setup menu contains the menu commands required by the user while designing and editing the Panel
Portals database.

Note: The design and creation of a Panel Portal database is essentially the same as for a “normal”
guestionnaire database. This document therefore describes only the differences between a Panel Portal
database and a questionnaire database, and the additional procedures required. For further information
on designing and creating a database, refer to the separate Professional Authoring User Manual.

. Horme = |Panel Setup Y|I:'a|ma| Utilitiez = Panel Management = Sample Managernent =

Designer DaocZPanel uﬂ Database Generation =+ Professional Panel Definition Export Designer Log Active Languages

Figure 4 The Panel Setup menu commands

The menu commands are as follows:

¢ Designer — the database definition page (see Designer on page 12 for more information).

e Doc2Panel - is an authoring mode that allows panel designers to quickly and easily create panels from
documents. It enables you to copy a Word document into a scratch-pad-like browser. From here you can
then select the texts you wish to use for questions, answers etc. and convert them directly into a Forsta
Plus panel. For further information on this functionality, refer to the separate Professional Authoring User
Guide.

e Database Generation — generates and updates the database (see Database Generation on page 24 for
more information).

e Professional Panel Definition Export — export the database definition to another server (see
Professional Panel Definition Export on page 25 for more information).

e Designer Log — a “read-only” log of the main events occurring in the panel (see Designer Log on page 26
for more information).

e Active Languages - select the languages to be used (see Active Languages on page 26 for more
information).

e Legacy Jobs Import - allows company administrators to import legacy jobs into the Forsta Plus panel
from other systems (see Legacy Jobs Import on page 27 for more information).

3.2. The Panel Utilities Menu

The Panel Utilities functions allow you to create and manage your panels.

Once you have accessed the Professional Panels functionality (see How to Access Professional Panels on page
3 for more information) the Panel Utilities menu appears as shown below.

. Home ~ Panel Setup '|Pane| Litilities '|Pane| Management * Sample Management =

LT Ouerdiew aﬁpermissions Linked Surveys - Epanel Portals Panel Activity Log Database Cleanup Survey Synchronization Flex Extensions

Figure 5 The Panel Utilities menu commands

The menu commands are as follows:

e Overview — provides general information on the selected panel (see Overview on page 28 for more
information).

e Linked Projects - provides a Linked Projects list, which gives you an overview of all the projects that are
linked to the panel (see Linked Surveys on page 33 for more information).
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e Panel Portals — contains the commands you use to create and edit your Panel Portals (see Panel Portals
on page 35 for more information).

e Panel Activity Log — logs activity on the panel (see Panel Activity Log on page 69 for more information).

e Database Cleanup — removes deleted questions from the Panel database (see Database Cleanup on
page 71 for more information).

e Survey Synchronization — initiates a new task that checks all surveys associated with the current panel,
and updates the panel iffwhen there are changes. This is to keep the panel data up-to-date so samples
can be selected appropriately. This task can (should) be made recurring so it occurs automatically (see
Survey Synchronization on page 72 for more information).

e Flex Extensions - opens the "Extensions available..." list. Refer to the Authoring User Guide for further
information on Flex Extensions.

3.3. The Panel Management Menu

The Panel Management menu contains the commands used to create and edit the rules that define the panels
and specify the panelists.

o Horne ~ Panel Setup = Panel Utilities '|Pane| Managernent '|Samp|e Managernent *

Current Rule Current Rule Set Rule List Rule Set List Data = Caloulate wariables Aggregated Variable List Panelizt Credits = Panel Settings

Figure 6 The Panel Management menu commands

The menu commands are as follows:

e Single Panelist Editor — enables you to edit individual panelist's details (see Single Panelist Editor on
page 100 for more information).

e Multiple Panelist Editor — enables you to edit the details of several/many panelists simultaneously (see
Multiple Panelist Editor on page 106 for more information).

e Current Rule — shows the details of the rule currently selected in the Rule List (see Current Rule on page
73 for more information).

e Current Rule Set — provides details of the rule set currently selected in the Rule Set List (see Current
Rule Set on page 91 for more information).

e Rule List — displays a list of the available rules. Click on a rule to open it (see Rule List on page 94 for
more information).

e Rule Set List — displays a list of the available rule sets (see Rule Set List on page 97 for more
information).

e Aggregated Variable List — lists variables you have created to be used in aggregate queries to update
the Panelist table based on information in the Survey History table (see Aggregated Variable List on page
98 for more information).

e Panelist Credits - allows you to import and export panelist credits (see Panelist Credits on page Error!
Bookmark not defined. for more information).

e Panel Settings - allows you to define some custom settings for the panelists' password requirements (see
The Panel Settings on page 119 for more information).

3.4. The Sample Management Menu

A Sample is a group of panelists selected from the panel using sampling criteria. The sampling criteria are set
such that the sample is suitable to be respondents for a particular survey. For example, a sample selected to
reply to a survey produced on behalf of a car manufacturer might comprise of males between the ages of 20 and
30 who live in a particular part of the country and who drive a particular make of car.

The Sample Management functions allow you to create and manage samples.
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_:Home T Panel Setup T Panel Utilities = Panel Management '|Samp|e Managemeant v|

Current Job  CGurrent Matrix Job List Active Jab List Matrix List Scheduling Concurrent Sarmpling Multiple Sample Upload Tester Template List Sampling Settings

Figure 7 The Sample Management menu commands

The menu commands are as follows:

Current Job — opens the Current Job window. This window provides general information about the
selected job. Use this window to define and edit the criteria for the job (see Current Job on page 124 for
more information).

Current Matrix — this window shows the details of the matrix currently selected in the Matrix List (see
Current Matrix on page 173 for more information).

Job List - lists all the sampling jobs that you currently have “in progress” (see Job List on page 188 for
more information).

Active Job List — lists all the sampling jobs that are currently “in production” (see Active Job List on page
Error! Bookmark not defined. for more information).

Matrix List — lists all the matrices currently available in your Forsta Plus database (see Matrix List on
page 193 for more information).

Scheduling - lists the jobs that are awaiting execution and those that have been run (see Scheduling on
page 195 for more information).

Concurrent Sampling — enables you to run several sampling jobs simultaneously so scarce panelist
resources can be allocated fairly across the jobs (see Concurrent Sampling on page 198 for more
information).

Multiple Sample Upload — enables you to upload several jobs simultaneously (see Multiple Sample
Upload on page 200 for more information).

Tester Template List — templates that enable you to add rows to the respondent database that you can
then populate with “dummy” respondent information such that you can test the survey and the system
setup before you send it out to the actual respondents (see Tester Template List on page 201 for more
information).

Sampling Settings — allows you to set default values and rules for the panel (see Sampling Settings on
page 202 for more information).

The following chapters in this manual describe the menu commands’ functionality, and the processes and
procedures conducted via these menu commands. The menu commands are described in the order in which they
appear in the menus.
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4. The Panel Setup Menu

The Panel Setup menu contains the menu commands required by the user while designing and editing the Panel
Portals database.

Note: The design and creation of a Panel Portal database is essentially the same as for a “normal”
guestionnaire database. This chapter therefore describes only the differences between the functions,
procedures and properties available when creating a Panel Portal database and those available when
creating a questionnaire database. For further information on designing and creating a database, refer to
the separate Professional Authoring User Guide.

. Horme = |Panel Setup Y|I:'a|ma| Utilitiez = Panel Management = Sample Managernent =

Dezigner DocZPanel uﬂ Database Generation =+ Professional Panel Definition Export Designer Log Active Languages

Figure 8 The Panel Setup menu commands

4.1. Designer

Select this menu command to open the Designer page. Use this page to create and edit the panel database. The
page is divided into two main areas:

e The Toolbox column —the toolboxes that appear in the left column in the Designer page provide an
overview of the panel database and the objects available for use while creating or editing it. The toolboxes
are displayed and available throughout the process. The toolbox is divided into three sections:

o The Panel Variables toolbox — shows the layout of the current database. Edit the database here,
adding, deleting and/or moving objects as necessary. After any changes are made, the database must
be re-generated (see Database Generation on page 24 for more information). Note that each
“question” in the Panel Variables toolbox will become a column in the database.

0 The New Objects toolbox — lists the objects you can use in the database. Drag and drop objects from
here to the Panel Variables toolbox.

o0 The Secondary Project toolbox - you have the possibility to copy questions from other panels into
the current panel. This can be done in the Secondary Project toolbox. Projects in this toolbox will be
displayed in Read Only mode.

e The Question Details area — double-click on a question in the Panel Variables toolbox to show the details
of that question in the Question Details area. Use the tabs and data fields in this area to set up each
guestion in the database.
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Figure 9 Example of the Professional Designer page

For further information, refer to the separate Professional Authoring User Guide.

4.1.1. The Panel Variables Toolbox

This toolbox is where you create and edit the panel database.

You build your database in the toolbox by creating Objects (questions, i.e. the database columns). All objects
placed between the survey name and the “Reusable Scale/List” folder will be used in the database. The objects
available for you to use are listed in the New Objects toolbox. The database columns will be listed in the order in
which they are placed in this tree.

When you first create a new Professional Panel (see How to Create a New Professional Panel on page 3 for more
information), the "standard" folders are created along with some basic variables.
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Toolbox ~
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Figure 10 The Panel Variables toolbox as initially created

You can add folders and objects as required to the toolbox.

4.1.1.1. How to Add an Object to the Tree

There are five methods of creating objects:

Insert Inside — use to create the first question in a panel database, or to create an object inside another,
typically folders. Right-click on the panel/folder name and choose Insert Inside, then select from the
resulting list the object you wish to create.

Insert After — use to create objects in a project after an existing object. Right-click on the object after
which you wish to create the new object, choose Insert After, then select from the resulting list the object
you wish to create.

Drag and Drop - use standard Windows drag-and-drop techniques to copy objects from the New Object
toolbox into the Panel Variables toolbox.

Duplicate — copies an existing question. This would be useful if you have two or more questions that are
similar in layout and/or content. Create and set up the first question, then duplicate it and edit the copy as
required.

Dragging/Copying from the Secondary Projects toolbox - you can copy questions into the current
guestionnaire by dragging them from the secondary project toolbox and dropping them into the
questionnaire tree. Before copying, you can view the Secondary Project objects in Edit mode.

You can use any of the above methods to create any object in the database. For further information, refer to the
separate Professional Authoring User Manual.

4.1.1.2. How to Delete an Object from the Tree

To delete an object, select it and press the <DEL> key on your keyboard, or right-click on the object and select
Delete from the menu. This will remove the selected objects from the routing, and set the Deleted flag on the
objects to true.

4.1.1.3. How to Undelete an Object

If you delete a question from the tree and later wish to reinstate it, you can do this as long as the question has not
been removed completely by the Database Cleanup function (see Database Cleanup on page 71 for more
information).

1.

In the Panel Variables toolbox, right-click on the Panel name text and select Show Deleted from the
menu.

This shows any deleted questions.
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2. Right-click on the question and select Undelete.
Or
Right-click on the question and select Properties from the menu, then uncheck the Deleted box in the
guestions Properties page.
4.1.1.4. The System Variables

The System Variables are default fields that are added to the database Professional Panel is created. These are
as follows:

e Unsubscribed - indicates whether the panelist has opted out from the panel.

e UnsubscribedDate - a date field that indicates the date on which the panelist opted out from the panel.

Note: When set up correctly, the Unsubscribe variables will allow the panelist to opt-out of the panel in
the event he/she wishes to do so. However these variables must be set up "manually” by the user
creating the panel, and the setup will depend on the desired procedure for opting out, at what point in the
survey the panelist can unsubscribe, how the unsubscribe data is to be processed and used etc. Note
that the ForstaFlex Email Opt-Out extension has been specifically created to enable the user to include
opt-out links in the invitation emails and process the opt-out data (when the panelist wishes to
unsubscribe, for specific surveys or all surveys, for specific panels and/or for specific survey companies
etc.). Contact Forsta Support at support@confirmit.com for further details.

The Unsubscribe fields are only updated if the Opt-Out Flex Extension is used. Refer to the Flex
Extension User Guide for further details.

e EmailStatus - a single field that indicates the status of the panelist's email address. When you create a
sample, upload it to a survey and distribute the invitations to the respondents, the Email Delivery Report
will be created for these respondents in the survey. The delivery status from this survey will also be
flagged in the panel survey, i.e. the respondent table for the panelist will be updated in the panel survey
with this status. The EmailStatus variable can have 3 values:

o Valid - if the receiving server responds with a message with a SMTP code under 400, the email
address is Valid.

o Error (Permanent Error) — if the receiving server responds with a SMTP code between 500 and 599,
this means a “Permanent Error” has occurred.

0 TempError (Temporary Failure) — if the receiving server responds with a SMTP code between 400
and 499, this means a “Temporary Failure” has occurred.
4.1.1.5. The Survey History Core Fields

The "Core fields" are the default fields that are always included in the database. These are as follows:

e SurveylD - indicates the id of the survey.
e SurveyStatus —indicates the current status of the panelist in the survey. The options are:

0 Reserved —the panelist is selected for a job but the invitation email has not yet been sent (a short-
term status).

o Invited — an invitation to participate in the survey has been sent to the panelist but the panelist has not
yet accessed the survey.

0 In Progress — the panelist has started the survey but has not yet completed it.
o0 Completed — the panelist has completed the job.

0 Stopped By System — the panelist has been prevented from completing the survey by the system.
Possible reasons include "quota full", "screened" (the panelist may for example be outside the
requirements for the survey) or an error status from the survey.

¢ ReservedDate - the date the panelist was reserved for the job.

e InvitationDate — the date the panelists are given access to the survey.

e StartDate — the date the panelist first opens the survey.

e CompletedDate — the date the panelist completes the survey.

e SubSampleNumber — refers to the sub-sample number code the panelist was selected under.

e GroupNumber — refers to the group number code the panelist was selected under.
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o JoblsClosed — specifies whether or not the job is closed.

e RunNumber - the number of panel selection runs.

Note: The Survey Status options are stored in the database numerically. If the data is exported, the values
will be as follows: Reserved = 0. Invited = 1. In Progress = 2. Completed = 3. Stopped = 9.

4.1.1.6. The Credit Transaction History Core Fields

This loop folder contains a number of core fields relevant to credit transactions. These fields are created
automatically when the panel is created.

I+ |[]) LOre Feas
= @CreditTransacﬁanHisb:nry (Loop)
=l [ Core Fields

@Transacﬁunﬂuweyld (Open)
[125 TransactionCredit (Mumeric)
@Transacﬁnnﬁecﬁnnld (Cpen)
[1z5p TransactionSecondaryPanelistld (Mu
@TransacﬁunCDmment (Cpen)
ETransacﬁnnPending (Single)
ETransactianType (Single)
ETransacﬁDnIsHidden (Single)
ETransacﬁDnSnurceType (Single)
|4 TransactionCreated (Date)
|4 TransactionModified (Date)
@Transacﬁunh“ludiﬁedﬁy (Open)
[1z5p TransactionTaskId (Mumeric)

| o TR Lio o1 Mo

Figure 11 The Credit Transaction History core fields

The fields are as follows:

e TransactionSurveyld - the ID of the survey for which the credit transaction has been made.
e TransactionCredit - the "value" of the credit transaction.
e TransactionSectionld - id used if credits are assigned multiple times from one project.

e TransactionSecondaryPanelist - if points are received from another panelist (for example "referrals"),
this is the panelist id of the panelist who gave the points.

e TransactionComment - any comments that may have been attached to the transaction.

e TransactionPending - a transaction is "pending" in a survey until the respondent has been given a status
in that survey. Is the transaction pending? (true/false).

e TransactionType - why the transaction has been made; a normal update, a correction to the current
value, some credit has expired etc.

e TransactionlsHidden - is the transaction hidden; true or false.

e TransactionSourceType - the type of source where the transaction originated.

e TransactionCreated - the date the transaction was created.

e TransactionModified - the date the transaction was modified.

e TransactionModifiedBy - if the transaction has been modified, who it was modified by.

e TransactionTaskld - the ID of the server task performing the transaction.

4.1.1.7. Invitation and Reminder Emails

The Invitation and Reminder Email folder in the Panel Variables toolbox allows you to store directly in the panel
the email texts and setups that will be used when distributing the survey to the panelists. You can create as many
email objects as you need.
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To add an email to the container:

1. Drag-and-drop an Email object from the New Objects toolbox, or right-click on the container and select
Insert Email from the drop-down menu.

Toolbox w

= [Zd) Another Panel (p3315842)
| System Variables
| Reqular Variables
| Recoded Variables
|5 Database Space-consuming Variables
@ SurveyHistory (Loop)
@ CreditTransactionHistory (Loop)
EE Reusable scaleflist
@ Invitatign and reminder emails

Figure 12 Dragging an Email object from the New Objects toolbox

The email object is created and the Email Details page opens. To edit an existing email object, either
double-click on it or right-click on it and choose Edit from the menu.
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Figure 13 The Email Details page for a panel email

2. Make the selections and settings as required (see The Email Details Page Properties and Fields on page
19 for more information), and write the text of the email.

When you are using the WYSIWYG editor, you will be able to format the text by using the buttons in the
formatting toolbar.

3.  On completion, save the changes.

For further details on using emails in Forsta Plus, refer to the separate Professional Authoring User Guide.

-18 -



Forsta Confidential Forsta Plus 2022 Professional and Standard Panels User Guide

4.1.1.8. The Email Details Page Properties and Fields

Text Mode - indicates the current text editing mode. Click the toggle button in the toolbar to switch
between Wysiwyg and Html Source modes.

Id — displays the namettitle of the current email object. This is the Id of this email object, as displayed in
the Questionnaire Tree. The character string in this field is used to specify which email is to be used when
sending an email, or changing a recurring task. The default values are “e1”, “e2”, etc. Click in the field to
edit the text and enter a more descriptive title.

Deleted — will be chosen if the email object is soft-deleted. If you uncheck the Deleted option, the email
object will be undeleted.

Read only — choose this setting if you want the email object to be locked so that no changes are made to
it accidentally, either in questionnaire editing mode or when sending email in Respondents > Emailing.

Include link — check this box to have a link (URL) to the web interview included automatically at the
bottom of the e-mail (default).

Use HTTPS - the URLs will use https:// for secure links instead of http://.

Note: On-Premise Customers must configure the system to support HTTPS to enable this option. This
option will be activated after you have chosen the Include link option. For further details about the
security systems that are available, and those that are used in Forsta Plus, go to
http://extranet.confirmit.com/library/security.aspx.

Activate Logging -

Send as HTML — check to send the email as HTML code. Only mail clients that support HTML will be able
to read the email.

Send as plain text — check to send the email as plain text. Most mail clients will be able to read it.

The email object will have two text fields for each language: one for HTML body and one for Plain text
body. When sending email to respondents, you can choose to send the email either in one of those
formats or in both in one sending. When you choose to distribute the email in both formats, the mail
clients supporting HTML will use the HTML version, other mail clients will display the text version.

Send confirmation email — check this option if you want to receive confirmation email from the system,
stating that the emails have been sent. The default email address is that of the current user - yours; edit
as appropriate.

From - this shows the email address from which the email will be sent, default will be the address of the
currently logged on user - you. You can change this if required.

Display Name - The value entered in this field will be displayed in the 'From' field in the email. If nothing is
entered in this field, the recipient will see the email address/name entered in the From field. Specify a
valid email address in the Reply to field. When the receiver clicks his/her 'Reply to' button, the email will
go to this email address .

Reply to - specify a valid email address in this field. When the receiver clicks the 'Reply to' button, the
email will go to this email address.

Reply to Display Name - the name entered in this field will be displayed in the ‘To’ field when the receiver
clicks the Reply to button. If nothing is supplied, the name entered in ‘Display Name’ will be used. For
example, the ‘Reply to Display Name’ could be set to ‘DO NOT REPLY".

Default language - if respondents do not have a language specified in the ‘language’ column in the
respondent list, if their language is not activated with the Activate language setting, or if it does not exist
in the current email, they will receive the email in the default language selected here. This list contains all
the languages selected for the survey. If you set default language to 'None', respondents who do not
match any of the activated languages, will not receive any email.

Disable update of noOfEmailsSent - in the event you wish to prevent the email counter from registering
the email transmission (for example you may be sending reminders to respondents' managers etc. - see
Override Recipient Email above), check this box to disable the Number of Emails Sent column.

Additional survey link parameters - allows you to add custom parameters after the survey link. An
example could be:

http://survey.confirmit.com/wix/pXXXXXXXXX.aspx? sid =encryptedidé&co
de=1
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where code=1 is the additional parameter. This could previously be achieved by constructing the URL by
piping in *sid”and ~respid”, however this was not possible with encrypted system request parameters in
the URL. This field allows you to include additional URL parameters in the survey link in email when using
encrypted system request parameters. The field supports piping from the respondent list (with ~s). It works
both for piped links (with ~slink” or “secureslink”) and when the "include link" checkbox is selected.

e Custom headers - use this field to add custom headers to the email. The syntax is:
X-name:value
X-name2:value2
You can use piping to "personalize” the email. Here the syntax is:
X-name:pipedValue”
These headers will be added after the internal Forsta headers. Note that you cannot use the X-Forsta
prefix in custom headers.

e Custom survey link text - (located at the bottom of the page) allows you to insert clickable text instead of
the survey URL in HTML email. Note that this applies only to HTML email. This could previously be done
by constructing the URL by piping in ~sid™ and “respid”, but it was not possible with encrypted system
request parameters in the URLs. This field makes it much simpler to create a text such as "Click here to
take the survey", or even include an image tag. The correct < a href=---> tag will be created in the HTML.
This works both for piped links (with ~slink® or ~secureslink”) and when the "include link" checkbox is
selected.

4.1.2. The New Objects Toolbox

This toolbox contains the templates for the objects that can be used in the database. Note that the range of
options available here is much reduced from that available in the standard Professional Authoring toolbox.

_

2| Single

% Multi

i@ Open Text
1259 Mumeric
[ Felder

E Scale/List
[ Date

Figure 14 The objects available in the New Objects toolbox

4.1.3. The Secondary Project Toolbox

In Professional Designer you have the possibility to copy questions from other projects into the current project.
This can be done in the Secondary Project toolbox. Projects in this toolbox will be displayed in Read Only mode.

[ Praiect | (g B.P. 8| P Clear

Figure 15 The Secondary Project toolbox
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To find the panel you wish to add, open in this toolbox and click the Project, B.P. (Basic Panel) or P.P.
(Professional Panel) button as appropriate. To remove a questionnaire tree/project from the toolbox, click the
Clear button.

When you click the Project, B.P. or C.P. buttons, a Panel List overlay displaying all projects or panels is
displayed.

Panel List

psEamh|Q R&t| Panal Catagary A1l -

Panel ID Panel Name Company Creatad By Creatad +
= - |

@ p3702911 Test panel Confirmit Apple, Adam 2/23/2012 9:10:11 AM

T pl21731e Professional Panel Confirmit Apple, Adam 1/16/2012 1:35:53 PM

) pl1734935 Confirmit Professional Panel (Trainin... Confirmit Josefsson-Ruud, Peter 1/11/2012 10:20:18 AM  Training

All a b © d

Use this panel Cancel

Figure 16 Example of the Project List pop-up

In this pop-up window, search for and select the panel from which you want to reuse questions, and click OK. The
Panel Variables tree opens in the Secondary Project toolbox.

(%) Secondary Project (Read Only)

= [2d) Documentation Survey (pDE94912) -
@ One question per page
ilIntra (Info)
I:ﬁ Progressbar begin
q3 - Usage (Single)
W% IF f{g3).any(6)
E q2 - The Confirmit applications (Mult)
U IF f(q2).siz=( > 1
B IF f{q2).5ize0 > 1
combined - Profidency (Single)
q12 - Downloading (Single)
VR IF f(q12)=='1
Iﬂ_:| q5 - Problem-solving (Single) &

m

Figure 17 Example of the Secondary Project questionnaire tree

Now you can copy questions into the current panel by dragging them from the secondary project toolbox and
dropping them into the tree. Before copying, you can view the Secondary Project objects in Edit mode - double-
click on the object.
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4.1.4. The Question Details Page

The Question Details page is where you add text and answer options to the question. The functionality here is
identical to that in a standard Forsta Plus survey. Refer to the separate Professional Authoring User Guide for
further information.

4.1.4.1. Question Properties

The question objects in the Panel Variables toolbox have a range of properties and settings that you can
customized via the property sheets. The property sheet will always display the type and nameltitle of the active
object. To open the Properties pane for a question:

¢ In the Panel Variables toolbox, right-click on the question and select Properties.
Or

¢ Double-click on the question or right-click on it and select Edit to open the Question Details page, then
click the Show/Hide Properties button in the Details page toolbar.

_

Single Question - (g14)

General

Indexed ] =]
Variable type Marmal W

Data edit access required | Low b =
Boolean ]

Characteristic MNarmal b
Default value b

Question Category

Deleted I:l

Figure 18 The Properties pane for a Single question

Note: The Properties pane contains different properties depending on the type of question and the
property selections made. The list below describes all the properties that may appear.

The properties available are:

e Field Width - specifies the number of characters assigned to responses to this question in the database
and when exporting to fixed-width ASCI| files. The default Field Width for Single questions is 32
characters. If the Field Width is not defined for an Open text question, it will be unlimited. If defined, the
respondent will be prevented from entering more characters than the specified in Field width.

e Indexed — if selected, an index is created on this field in the database the next time you generate the
database. Indexes improve performance in areas such as 1) aggregated and verbatim reporting when
filtering on fields with indexes, 2) searching in individual reporting and in survey data editing (when search
fields are indexed), and 3) data imports where the key field is indexed. Note that indexes should be used
only when needed, as responses take longer to store the more indexes there are. This can lead to a
performance reduction during interviewing. Also, the database will be unavailable for other processes the
first time it is regenerated after the index property is set. Forsta Support therefore recommends against
setting new indexes and regenerating a survey while respondents are answering the survey.

e Variable Type - there may be a time when your panel variables include a question with many answer
alternatives, that you wish to simplify for the report. A question can therefore be:

o Normal - an ordinary question object.
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0 Recoded variable - turns this question into a recoded variable, which will not be displayed in the
interview. You can predefine complex recoding rules in SQL or JScript. Note that the values for
recoded variables must be updated "manually” (see Calculate Variables on page 113 for more
information). Refer to the Authoring User Guide for further information on recoding.

¢ Numeric — check to specify that the field shall only accept numerical characters.

e Total Digits — specify the total number of digits the field can contain.

e Decimal Places — specify the maximum number of decimal places allowed.

e Lower/Upper Limit — specify an upper and/or a lower limit for the number.

e Lower/Upper Limit Type — specify the limit type; either = or <=/>= as appropriate.

e Data Edit Access Required — this is the editing access permission level that users must have to be able
to edit the date for this question in the database column. Users with editing access permissions lower than
this level will not be able to edit the data for this question. Go to the Panel Utilities > Panel Overview
page > Permissions tab to allocate the appropriate permission levels to the users (see Access
Permission Levels on page 33 for more information). The options here are:

0 Low - all users with normal access permission can edit the data in this column.
0 Medium - only users with access levels Medium or High can edit the data in this column.
o High - only users with access level High can edit the data in this column.

e Boolean - applicable for Single questions. If selected, the question can have only two options, and the
codes must be 0 and 1. If you set an existing question to Boolean and that question had more than two
answer options, then all the options except the first two will be deleted.

e Characteristic — the group to which the data column is to be allocated (see Characteristic on page 24 for
more information). The options are:

o Normal - columns for which you expect the majority of operations will be reading of the data
contained.

0 Recoded - columns for which you expect the majority of operations will be writing of data.

0 Space Consuming — columns for which you expect the data contained will usually take a lot of space
in the database, for example free-text fields.

o Loop Support — defines a column as “Job-specific” information. Some information in the database is
related to the survey job rather than to the specific panelist. When a number of panelists are selected
for the same job, then that job information could be repeated for every panelist. To avoid expanding
the database with repeated information, job-specific information is held in a separate section of the
database. That section is then referred to for each panelist it applies to.

e Accept Leading Zeros — check this box if you want the field in the expression builder to accept leading
zeros.

e Unique — check if every field in the column is to be unique. Use this for passwords, login names etc.

o Default Value - type a value into this field to specify the value as default. The respondent will then be
given this answer unless they enter a different answer.

e Question Category - define a category for the question. A Reportal user can then filter on the question
categories when using hitlists in single view in Reportal. Refer to the Reportal User Guide for further
detalils.

¢ Deleted — will be checked if the question has been deleted from the Panel Variables toolbox (see How to
Delete an Object from the Tree on page 14 for more information). Uncheck to undelete the question (see
How to Undelete an Object on page 14 for more information). Note that you can view deleted questions by
right-clicking on the Panel Portal name in the tree and selecting Show Deleted. Deleted questions will
then be shown “pale” until Hide Deleted is selected.

Note: Some questions are required in a database by default, and these questions will be added
automatically when you create a new database. As the information contained in these questions is
required, some of the properties for these questions are not accessible and cannot be changed.
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4.1.4.2. Characteristic

To improve accessibility and reduce processing times, the database is divided into sections. The sections group
the columns together depending on the type of processing expected to be most usual in the columns. For
example, for some columns most of the processing will involve reading the data contained, while for other
columns most of the processing will involve writing data to the column. Other columns are expected to use a lot
more file space than others, as a “free text” character uses eight times more space than a Boolean character. Use
the Characteristic property to specify which group the column will be allocated to.

When the database needs to process information, it will go first to the group containing the columns with the
appropriate characteristic. For example, if a database process is to write some data to a column, then the system
will look for that column first in the Recode group. If the system finds the column in that group then it will perform
the process. If it does not find the column there, then it will look in the other groups. This procedure will save
considerable processing time, as otherwise the system must look through the entire database each time it needs
to conduct a process.

4.2. Database Generation

This menu command activates the database generation function. The Panel database is used to administrate the
panelists. If changes are made to the database, then it must be re-generated for those changes to be
incorporated.

This menu command only generates the database or regenerates it after changes have been made. To create or
edit the database, go to Panel Setup > Designer (see Designer on page 12 for more information).

1. Go tothe Panel Setup > Database Generation menu command.

The page shown below is displayed.

Cpltions

Active Database Production

Generate database Update existing databasze [rebuild] *

E'i_l llj_d tim Ij.at.dtl.d ............... —
|Create new database

Generate Database |

Figure 19 The Generate database Options tab

2. Select whether you wish to generate a new database or update the existing database (if the database has
not been generated previously then the “Update existing database” option will not be available).

Note: If you select Update Existing Database, the database and the new data are checked before the
update commences. In the event an error is found, then the process is stopped before any changes are
made. If no errors are found then the new data will be added to the existing database — no existing data
will be deleted.

Note: If a database already exists for the project and you select Create New Database, the old database
will be overwritten and any data in the old database will be deleted.

3. Click Generate Database.

The database is created/updated. A Task pane opens, containing a progress bar and a task status list.
When the database has been generated, the text Task Completed will be displayed at the bottom of the
task status list.

In the event you have deleted questions from the database during editing, see also section
DatabaseCleanup.htm.

Note: Only the database is created; there is no web interview. Note also that in Professional Panels there
is no Test database available.
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4.3. Professional Panel Definition Export

You can export Professional Panel definitions (the project coding) using XML. This enables you to transfer panel
definitions from one Forsta server to another. When you export a panel definition, the definition file is attached to
an email, which is sent to the address specified in the Email Recipient field in the dialog box.

When a panel definition is exported, included with the definition are the sampling settings under the Sample
Management > Sampling Settings menu (see Sampling Settings on page 202 for more information) and the
panel settings under the Panel Management > Panel Settings menu (see The Panel Settings on page 119 for
more information).

4.3.1. How to Export a Panel Definition

1. Gotothe Panel Setup > Professional Panel Definition Export menu command.

The ...Export overlay opens.

Professional Panel Definition Export

Email recipient documentation@confirmit.com

Comment

I Export survey definition I Cancel

Figure 20 The Panel Definition Export overlay

2. Check that the Email recipient is correct, type any comments into the Comment field as appropriate, then
click OK.

The Task page is displayed, showing a progress bar, the task ID and the status. On completion, the
progress bar is at 100% and an OK button appears.

3. Click the OK button to close the task page and return to the Professional Panel List page.

An email is sent to the specified recipient containing the project definition XML file. This file can now be
imported into another server.

4.3.2. How to Import a Panel Definition
To import a panel definition that has been exported from another server:

1. Inthe Professional Authoring Home page, go to the Home > Import Survey Definition menu command.

The Survey Definition Import dialog opens.

Survey Definiion Import

File to upload | |[ Browse... |

Figure 21 The Survey Definition Import dialog
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2. Browse to the XML file you wish to import, then click OK

A Task pane opens containing a progress bar and a task status list. When the project definition file has
been imported, the text Task Completed will be displayed at the bottom of the task status list.

3. Click OK to close the Task pane.

The panel will now be listed on the Professional Panel List, accessed by going to the Home >
Professional Panels menu command. Once the panel is imported, you can import and attach a portal to
it.

4.4. Designer Log

The system records actions executed on a project basis. The Designer Log provides an overview of all changes
that have been made on the project since it was first created. The system records the exact time when changes
are made, the user who makes the changes, and specifies details of the change.

This page is for information only - no changes can be made to the information.

Confirmit.

everywhere:

—
e
O

. Home + |Panel Setup ~|Panel Utilities * Panel Management = Sample Management ~ ~ |User: Apple, Adam Log Off

]

Designer Doc2Panel [[5 Database Generation 4 Professional Panel Definition Export Designer Log Active Languages

Date User Description e
1/16/2012 1:35:53 PM Apple, Adam Project created. -
3/21/2012 9:30:00 AM  Apple, Adam ProfessionalAuthoring: 1D of node "" changed: "'->"q28"

3/21/2012 9:30:00 AM Apple, Adam ProfessionalAuthoring: Property "ShowDownloadLlink” of node "g28" changed: ""-="true"

3/21/201Z2 9:30:00 AM  Apple, Adam ProfessionalAuthoring: Property "FallbackStrategy” of node "q28" changed: ""->"RenderNormalQuestion”
3/21/2012 9:30:00 AM  Apple, Adam Professionalfuthoring: Property "UsePradefinedScript” of node "q28" changed: "'->"falsa"

3/21/2012 9:30:00 AM Apple, Adam ProfessionalAuthoring: Property "autocheckother” of node "g28" changed: ""->="true"

3/21/2012 9:30:00 AM  Apple, Ad=m ProfessionalAuthoring: Property "answerbuttonsmode” of node "g28" changed: ""->"Inherit"

3/21/2012 9:20:00 AM Apple, Adam ProfessionalAuthoring: Property "dataWriteAccessLevel" of node "g28" changed: ""-="0"

3/21/201Z2 9:30:00 AM  Apple, Adam ProfessionalAuthoring: Property "characteristic” of node "q28" changed: ""-="0"

3/21/2012 9:30:20 AM Apple, Adam ProfessionalAuthoring: ID of node "g28" changed: "g28"->"Language"

3/21/201Z2 9130120 AM Apple, Adam ProfessionalAuthoring: English Title of node "Langusge"” changed: ""-="Language"

ProfessionalAuthoring: English Text of node "Language" changed: ""-="In which language would you like

3/21/2012 9:33:24 AM Apple, Adam to view the portal?”

Figure 22 Example of the Designer Log page

4.5. Active Languages

This menu command opens the Active Languages page. This page lists the languages selected for the Portal on
the General tab (see The General Tab on page 28 for more information).

In the General tab you can select as many languages as required for the Portal, but while you are working in
Professional Panels, to keep the pages to a manageable size, a maximum of five languages can be displayed at
one time. This limit applies anywhere where the languages are listed, such as in the database question details
pages. Note that the maximum of five languages only refers to what you see whilst working in Forsta Plus; the
panelists will see their selected language.

In the Active Languages page, check the boxes for the (up to five) languages you wish to show then click Save.
To hide a language, click again in the box to remove the tick, and save.
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n Save

Maximurm nurnber of active languages

[] Active Languages
Arabic

¥ chinese

[l panish

Dutch

[#]English

D French

[ aerrnan
izpanese

D Spanish

Figure 23 Example of the Active Languages pane

4.6. Legacy Jobs Import

If you are the Panel Administrator (you created the panel or have been given Administrator permission for it) and
in addition have the SYSTEM_COMPANY_ADMINISTRATOR permission, then the Panel Setup menu will also
include the Legacy Jobs Import item. This functionality is intended for new Professional Panel clients who have
previously used a different panel-management product, and allows you to import legacy jobs into the panel from
the other system. The imported legacy jobs can then be used for exclusion purposes.

Note: The legacy jobs imported must be in XML format, and the job number must match the survey
history data existing in the panel.

Contact Forsta Support for further details.
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5. The Panel Utilities Menu

The Panel Utilities menu contains additional utilities that will be useful to the designer while creating and/or editing
the Panel Portals database.

5

. Home * Panel Setup '|Pane| Utilitiez '|Pane| Managernent * Sample Managerment ~

L0 Cverview &Permissions Linked Surveys = @Panel Portals Panel Activity Log Database Cleanup Survey Synchronization Flex Extensions

Figure 24 The Panel Utilities menu

5.1. Overview

When you access a panel via its link in the Professional Panels list, you come first to the Panel Overview page.
This page provides general information about the panel, presented on three tabs.

e The General tab.
e The Permissions tab.

e The Active Languages tab.

Note: In the event your company has licensed one or more extensions, then an additional tab will be
available. For more information concerning extensions, refer to the Authoring User Guide.

5.1.1. The General Tab

This tab displays general information about the panel.

m Save Duplicate }( Delete |

General I MaobilePortal |

Panel 1D p1217318 (@ Panel fitles |
- Englis
Panel Name Professional Panel
Company Confirmit Norwegian
Description
\d istrato ;
DB sarver name co-osl-tst265
Size of DB data 2.204 MB
Size of DB log 1.024 MB
Panel Schema last modified 1/16/2012 1:25:532 PM
La ;
nguages Available Selected DB last generated 1/16/2012 1:36:32 PM
Afrikaans English Panel info last updated 2/24/2012 11:19:30 AM
Albanian Norwegian
Arabic Data growth last day =
Arabic (Algeria) Log growth last day =
Arabic (Bahrain] il
Data growth last week =
Log growth last week =
iate'g*’:lm and Available Categories Selected Data growth last month -
eywords _
Templats Log growth last month
Benchmark I Refre=h I
Library
heck Growtl
New Keyword Add Date
Creator Apple, Adam (from) ﬁ (to) m
Created 1/16/2012 1:35:33 PM Data size
Last Modified 3/21/2012 10:06:06 AM Log size
Status production # Complate
# Incomplete
Calculate
Enable database D
encryption
[ Panel tasks ]

Figure 25 Example of the Panel Overview General tab for a panel
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The information presented on this tab is as follows:

e Panel ID - the unique identification number for the panel. This is allocated automatically by Forsta Plus
when the panel is first created and cannot be changed.

e Panel Name - the identifying name of the panel, given by the person who created it. You can change the
name here.

e Company — the company registered as the “owner” of the panel. This can be changed here if you have
the necessary permission. Click the down-arrow beside the field and select the required company name
from the list.

e Description — a description of the panel, for future reference. Type in text here.

e Languages - the language(s) selected for the panel. To add a language, select it in the Available column
and click the >> button to move it to the Selected column. The selected languages are then listed in the
Active Languages page (see Active Languages on page 26 for more information).

e Categories and Keywords — the keywords registered for the project as listed in the Keywords column on
the Professional Panels List page (see How to Access Professional Panels on page 3 for more
information). To add a keyword, select it in the Available column and click the >> button to move it to the
Selected column.

o New Keyword - use this field to add keywords to the Available list. Type the required word into the field
and click Add.

e Creator — the name of the user who created the project. This cannot be changed.
e Created - the date and time when the project was created. This cannot be changed.

e Last Modified - the date and time when the project was last modified. This is updated automatically by
Forsta Plus and cannot be changed manually.

e Status —the current status of the project. This is updated automatically as the project progresses.
e Deployment — the type of deployment selected.
e Panel Portal URL - the URL to the portal currently selected for this panel.

o Enforce HTTPS... — check this option to enforce HTTPS use in Advanced Reporting, accessing reports
via the Enduser interface, for this project.

e Email address... - type in the email address to which you want error message emails to be sent in the
event scripting errors are found in the interview. The default will be the email address of the current user

(you).

e Enable database encryption - if your company has the required add-on, you can select this option to
encrypt the production database. Refer to the Authoring User Guide for further details. Note that test
databases are not encrypted, and it is not possible to change the encryption state of a previously launched
database; once a database is launched, if you wish to change the encryption state you must create a new
database.

e Project Tasks button — opens the Tasks management page (see The Project Tasks Page on page 29 for
more information).

e Recurring Tasks button - if this panel has recurring rules that are active, then this button will appear.
Click the button to open the Tasks Management page. In this page you can disable the recurring tasks or
edit them as required (see How to Set Up Recurring Tasks on page 154 for more information).

5.1.1.1. The Project Tasks Page

The Tasks page allows you to check the status of any tasks requested for this panel.

Note: You can view all tasks by deleting the Project ID from the search criteria field and clicking Search.

To access this page: From the Panel Overview page > General tab, click the Project tasks button at the bottom
of the page. The Tasks page opens at the Search tab. Forsta Plus users who have Administrator permission to a
project will be able to see and search for all batch tasks that have been set up for this panel.

You can also access this page by going to the Quick Access pane > Tasks menu command. This will route list
all tasks, but you can view only the tasks for one particular project by typing the project ID into the appropriate
search field (see How to Change the Execution Settings on page 159 for more information).

The page comprises six tabs:
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Scheduled tab- lists all the tasks that are scheduled to run.

Executing tab - lists the tasks that are currently executing.

Completed tab - lists all the tasks that have already run and are completed.

Aborted tab - lists all the tasks that have already run but which have aborted for some reason.
Recurring tab - lists any tasks that are recurring.

Search tab - lists all the tasks, enabling you to conduct searches more easily.

Scheduled || Executing | Completed | Aborted | Recurring | Search

- search 4 Reset| Task Type | Recurring | Period |Last 20 days ¥ | Repart Humber |

Task Id

32116
32115

nls

User 1d Broject Id Task Type Scheduls Status Company Server Comment
ps§703251 v

nigelb pET03251 Launch Survey 05/03/2010 11:23:43 Aborted by System Confirmit VM245 Launch Survey
nigelb pE703251 Launch Survey 05/02/2010 11:21:05 Complete Confirmit VM245 Launch Survey

Figure 26 Example of the Task page

The In the event the task list is extensive, you can search through the list using a number of criteria:

Task Type - if you know the type of task, select from the drop-down list.

Company - if you know which company created the task, select it from the drop-down list.

Server - the server the task is/was run on. Select from the drop-down list.

Recurring - If you know whether or not the task is recurring, select as appropriate here.

Period - if you know when the task was run, select the period from the drop-down list.

Report Number - if you know the number of the report the task was associated with, type it in here.
Task ID - the ID number given to the batch job by the system. Click on the header to sort the list.
User ID — the login ID for the user initiating the task. Click on the header to sort the list.

Project ID - the system-generated project number. Click on the header to sort the list.

Task type — the type of task to be performed. Click on the header to sort the list.

Schedule - the schedule date (the date the task was initiated). Click on the header to sort the list.

Status — select a status from the drop-down list. Click on the header to sort the list. For Completed and
Aborted tasks, only the tasks run during the past 7 days will be shown. Completed and Aborted tasks that
are older than 7 days are deleted.

Company - the registered company of the user who initiated the task.

Server - the server on which the task is/was run.

Click on the Task ID number to go to the task details window. Here is displayed information about the particular

task, and you can disable the task, set up or change the recurrence pattern (see How to Set Up Recurring Tasks
on page 154 for more information), check the details etc. The details presented differ for the different task types.
The figure below shows an example of the dialog for a sampling task.
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Launch Survey X
Definition | Recurrence | Parameters [ Instances |
Task Type Launch Survey
ID 25636
-
Company Confirmit
Project Id p6703251
Comment Launch Survey
Command Line
Save || Run task

Close Window

Figure 27 Example of a Task Details window

e Click Close Window to return to the Tasks page.

Note: To avoid unnecessary strain on the server if there is an error in the file, Forsta Plus sets a limit on
the time a task can run before it is aborted. However, this may also result in heavy tasks (for example
based on long questionnaires) being stopped before they are completed. In the event this becomes a
problem, ask your Forsta administrator to adjust the time limitation.

ASP only - Contact Forsta Professional Services for assistance: support@confirmit.com

5.2. Permissions

The user who creates the panel is the panel administrator and owner, and a panel is initially invisible to all other
Forsta Plus users. You can give access permission to other users via this page. All Forsta Plus users in your
organization will be listed in the page, and you as the panel administrator may set up other Forsta Plus accounts
with permissions to view the new panel.

ASP only: Personnel at Forsta may be granted access for support purposes.

Initially, only users and groups within your organization are listed on the page. To add other users, provide Forsta
with those users’ correct user keys.

To open the Permissions page, go to the Panel Utilities > Permissions menu item.
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(4] Permission changes for other users will take effect at next login or within 5 minutes.

| Save | Search / Reset Add other user Rernous other user Grant all -- please salect -- ~ Reuvoks all| -- please salact -- - ‘

Display Users and groups v  regardless of access rights

User ID

Usars

L eaiideiliel Alexande Melnilcoy None -

Eratn Admin System None -

a b c d e f a h i i k | m n o P q r =3 t u v w ® ¥ z

First Hame Last Name Permission type Administrate project | Datz edit access me... Data edit access high z
- - -

"

None - E

None -
Tyichay Nona -

- None -

Lulyznav None -

e None -

Page 1 =)

Figure 28 Example of the Permissions tab

The columns and buttons are as follows:

Search - add search criteria to the column header fields and click Search to display only those users who
satisfy the criteria.

Reset - removes all search criteria and re-displays the complete list.
Add other user — click to open a dialog that allows you to add users to the list.

Remove other user - click to open a dialog that allows you to remove users that have previously been
added.

Display - you can select from the drop-downs to display just users, groups or other users, and/or user
with permissions set.

Grant all - select a permission from the drop-down beside this button and click the button to give that
permission to all the currently listed users. Note that if you do not wish to give the selected permission to
all users in your company then you must first conduct a search such that only the appropriate users are
listed on the page.

Revoke all - select a permission from the drop-down beside this button and click the button to remove that
permission from all the currently listed users. Note that if you do not wish to remove the selected
permission from all users in your company then you must first conduct a search such that only the
appropriate users are listed on the page.

User ID - the user id of the user (if entered in User Settings) is listed in this column.

Last Name / First Name - the registered name of the user. This can be changed by the user in the Home
> User > Settings page.

Permission type - click the down-arrow beside a user's field to open a drop-down list of the permissions,
then select the appropriate permission for that user. The options are:

o None - the user does not have access to the project.

0 Read - the user has only Read permission, i.e. he/she can view the questionnaire and associated
reports but is not allowed to add new or delete existing elements in them.

0 Write - the user has Write permission, i.e. he/she is allowed to add questions to the questionnaire and
reports.

o Delete - the user has Delete permission, i.e. he/she is allowed to work on the questionnaire and
reports, and is allowed to delete objects in them.

Administrate project - The user is the administrator and owner of the project. He/she may alter the
guestionnaire, set the project live, check response status, etc., as well as delete the entire project This is
usually the person who initiates the project.

On completion, click Save to save any changes.
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The Permissions page lists a maximum of 50 users on the current page; click the next/previous Page buttons in
the lower-right corner of the page to move between pages. Click a letter-button (along the lower edge of the page)
to list only those users who's User ID starts with that letter. The list can be sorted on the User ID, First name and
Last name columns; click the appropriate column header to toggle the sort order up or down on that column.

5.2.1. How to Add Users to the Permissions List

Typically, an external user will send you his or her user key by email. Paste this key into Forsta Plus as follows:

1. Click the Add other users button above the list.

The Add other users overlay opens.

2. Paste the new user’s key into the overlay and click Add.

Note: Ensure there is no space after the last character in the user key.

The overlay closes and you are returned to the Permissions list. The new user is added to the list under Other
Users.

You must now allocate the appropriate Permission levels to the new user.

5.2.2. How to Remove Users from the Permissions List
To remove a user from the Other Users list:

1. Click the Remove other user button above the list.

The Remove Other Users overlay opens, listing the users in the Other Users list.

2. Select the user or users you wish to remove from the list and click Delete.

Note: You can only remove users from the Other Users list. Users in the “Users in own company” list can
only be added and removed by the company system administrator.

5.2.3. Access Permission Levels

The panelist data is held in columns in the database; one column for each “question” (see Designer on page 12
for more information). The data in the various columns can be viewed by any user, but can only be changed by a
user if that user has the appropriate permission level for that column. Each individual column can have one of
three access levels; Low, Medium or High, the level for the column being defined by the database designer in the
Question Properties pane (see Question Properties on page 22 for more information). Each user is given access
permission to one of these same levels here in the Permissions tab.

o Low —the default access level. None of the Data Edit Access check-boxes are selected. The user can
read all the data columns, and change data in columns that have Low write access. The user cannot
change data in columns having Data Edit Access Medium or High.

e Medium - the Data Edit Access Medium check-box is selected. The user can read all the data columns,
and change data in columns that have Low or Medium Data Edit Access but cannot change data in
columns having the Data Edit Access High setting.

e High - the Data Edit Access Medium and High check-boxes are selected. The user can read or change all
the data columns.

5.3. Linked Surveys

Click this menu item to open a drop-down list as shown below.

Linked Surveys -

Mew Registration Survey

Mew Update Profile Survey
Linked Surveys List

Figure 29 The Linked Projects drop-down list

The options are:
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o New Registration Survey - click to create a new survey for panelists' initial registration to the
Professional Panel. This functionality is also available via a button on the Linked Projects list. Refer to the
Authoring User Guide for more information on creating surveys.

e New Update Profile Survey - click to create a new survey to allow existing panelists to update their
profile. This functionality is also available via a button on the Linked Projects list. Refer to the Authoring
User Guide for more information on creating surveys.

e Linked Surveys List - opens a list of those surveys that have been linked to the panel. The list shows
registration surveys, profile update surveys, polls and surveys that have been sampled to. Note that
keywords are available for registration and update surveys, and can be used for filtering.This list can be
filtered on the different categories: Sample surveys (regular surveys that you have uploaded sample to
from the Professional Panel), Registration surveys and Profile Update surveys (the categories mentioned
above) and Polls. Click on the survey name to open the survey in Authoring.

Note: Old registration and update surveys must be given these keywords to appear in the filtering (but
they will appear in the list under sample surveys).

|.¢.\' Search 2 Reset All - Mew Registration Survey Mew Update Profile Suruel,l|
D Name Created By Created &
- - =
p2941361 Car Project for Documnentation Apple, Adam 2/17/2012 11:21:20 AM =

Figure 30 Example of the Linked Projects list

Two buttons corresponding to the New ... Survey menu items are available in the upper-right corner of the list, to
enable you to create new registration and update surveys. This greatly simplifies setting up these types of surveys
from the panel, since the functionality will automatically set the correct category and link the survey to the panel.
For the Registration survey, it will also automatically add the email and password questions that you need to
create the panelist.

When working with a survey that is linked to a Professional Panel, the Professional Panel will automatically open
in the Secondary Project toolbox. From here you can drag-and-drop variables from the Professional Panel into the
survey. The variables dragged in will automatically be set as Visible panel variables. Also, if you have the
Professional Panel add-on, two new Categories are introduced on the Project Overview page, allowing you to
categorize surveys that are Registration Projects and Update Profile Projects. Refer to the Authoring User Guide
for further information.

Surveys linked to a panel will have a link on the Survey Overview page, enabling you to go directly to that panel
from the survey. In addition, the Hide Survey from Panelist check box is available. Normally, all surveys a panelist
is sampled to (matching the status filter ) are listed in the survey list in a panel portal. Check this box to prevent
the survey being listed

Panelist
registration- 7
Jupdate profile
Survey
Allow current survey to access Find Panel... Clear |Go to panel
Panel

Hide survey from panelist

Figure 31 Example of the Professional Panel buttons and link on a linked survey's Overview page

5.3.1. Using Visible and Hidden Panel Variables

In Authoring, two Panel-related variable types are available in the question property sheets:

e Panel variable (hidden).

e Panel variable (visible).
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Both can be used in surveys to which you have uploaded sample from a Basic Panel, and in surveys that are
linked to a Professional Panel (through the “Professional Panel” setting on the Project Overview page).

Panel variable (hidden) can only be used to pull values from the corresponding field (with the same variable
name/type) in the panel database - you cannot use this to push data back to the panel. This is done automatically
at the point in the survey where the variable is placed. Hidden panel variables will not push any data back to the
panel, so in the event you need to set different values for these hidden fields, you must write a script to submit
those values to the panel database.

Panel variable (visible) will pull the value that is stored in the panel database (if there is a value there), and the
question will then be displayed to the respondent with this value. The respondent can modify the value and submit
a different response as required. For surveys linked to a Professional Panel, if the panelist exists in the panel
database (profile update or regular surveys) then the new value will automatically be submitted to the panel
database when the respondent moves to the next page. For Panelist Registration surveys, this means that the
panelist must be added to the panel (using the CreatePanelist function call), before the visible panel variables will
be able to push data to the panel. For Basic Panels, no data will be submitted back to the panel database.

When working with a project that is linked to a Professional panel, the Panel will automatically open in the
Secondary Project toolbox and you can drag-and-drop variables from the Panel to the survey. The variables
dragged into the survey will automatically be set as Visible panel variables.

5.4. Panel Portals

In Forsta Plus you can build your own library of panelist interfaces (Panel Portals), through which your panelists
(and potential panelists) can read about your panels and register as new panelists. Those who have already
become panelists (members) can log into the Panel Portal to answer new or previously-started surveys, view their
survey list, update their profile, view their points, etc. All these actions are conducted via the Panel Portals menu.

A panel functions in the same way as a normal survey. Typically, a panel consists of mapping and profile
questions such as demographic questions, work-related and household questions. The panelists register
themselves in your Panel, or you can import people directly into your Panel if you already have their information.
Based on their information inside the Panel, you can then recruit relevant respondents to specific surveys. A
Panel Portal is the interface (homepage) through which your panelists log in to participate in surveys, check their
point status, change their profile, etc.

Panel Portals can only be used together with Forsta Plus Panels.

5.4.1. Accessing Panel Portals

1. On the Professional Panel List page, click on the appropriate Panel ID to open the Panel you wish to work
with.

2. Go to the Panel Utilities > Panel Portals menu command.

The Panel Portal List page opens. This page lists all the portals that you have access to. The current
portal (if any) is shown in bold.

3. To open a Panel Portal in the Designer page, click on the Portal Name, or move the mouse pointer onto
the Portal name to display a down-arrow button beside the name, click the button to display a drop-down
menu and select Designer.

|>( Delete Import Cornmunity Portal Mew Somrunity Portal
D Portal Name Company Created By Created Published z
O |D0c Portal | T | User Guide Company Apple, Adam 09/03/2010 13:43:57 09/03/2010 13:46:41

Designer
Wiew
Duplicate

Export

Figure 32 Accessing a Panel Portal for editing
The menu options are:

e Designer — opens the Panel Portal Designer page. This menu command has the same effect as clicking
directly on the Portal name.
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View - opens the panel in viewing mode, as the panelist will see it, in a new window. Note that the panel
must be published before View becomes available (see How to Publish a Panel Portal on page 64 for
more information).

Duplicate — makes a copy of the selected Portal. You can then re-name and edit the copy to make
variations of the original.

Export — allows you to export a Panel Portal to another Forsta server.

5.4.2. How to Add a Portal to your Panel

A Panel Portal can only be activated on a Forsta Plus Panel. You can do this in two ways:

Create a new Panel Portal (see How to Create a New Portal for a Panel on page 36 for more information).

Import an existing Panel Portal template to your panel (this is the most common approach)(see How to
Import a Panel Portal on page 37 for more information).

Note that the direct panelist link will be displayed under Panel Management together with the link to the panel
registration survey.

5.4.2.1. How to Create a New Portal for a Panel

1.

Go to the Panel Utilities > Panel Portals menu command.

The Panel Portal List page opens.

Click the New Panel Portal button located towards the upper-right corner of the page.

The New Template wizard opens at the Properties overlay.

B MNew Template - Step 1 of 2
fal

Mame | |

Display Mode @) neoinn () Mobile

Canced Maxt = Firigh

Figure 33 The New Template wizard Properties overlay

Type a name for the new portal into the Name field.
Select whether you wish the portal to be for desktop or mobile device rendering.

Click Next. Note that if you choose Finish here then an empty Portal Designer page opens and you must
then create the portal "manually".

On Next, the wizard moves to step 2 in the process and the template selection page opens. This lists the
templates available to you for the selected type of rendering.
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Figure 34 The New Template wizard step 2 - selecting the template to use

6. Select the template you wish to use from the list and click Finish.

The Portal Designer page opens with the new portal as defined by the selected template. Use this page
and the toolbox provided to design and edit the portal as required.

5.4.2.2. How to Import a Panel Portal

You can also import Panel Portals created on other Forsta installations (see How to Export a Panel Portal on
page 66 for more information).

Note: You must first have a Panel into which the Portal can be imported.

1. Go to the Panel Utilities > Panel Portals menu command.

The Panel Portal List page opens.

2. Click the Import Panel Portal button located towards the upper-right corner of the page.
The File to Upload selection dialog box opens.

File to upload | |[ Browse... |

Figure 35 The File to Upload selection dialog box

3. Click Browse to open a standard Windows file selection dialog.
4. Browse to and select the portal file you wish to import, then click Open.
The portal is imported to this Panel.
5.4.2.3. How to Set a Portal as Default
In the event you have more than one portal available, you can set one of them to be default. To do this:

1. Go to the Panel Utilities > Panel Portals menu command, and from the Panel Portal List select the portal
you wish to make default.
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2. In the PanelPortal toolbox, right-click on the portal and select Set as Default Portal.

Toolbox w7
= Emmmmnﬂ
E [jPag  Edit
BRI | publish
= The
o Set as Default Purtalhj
(@
E Cuplicate
=l 3 Pag Export
b
% Save as Template
oL |
@[ Expand All
@f Collapse All
[+ M
* 2 El Rename
0
@ :ﬂ Properties
[ER4 Login (LOGIM)

Figure 36 Setting a portal as Default

The text (DEFAULT) is displayed after the portal name in the toolbox, and the portal name is displayed in

bold text in the Panel Portal List.

5.4.2.4. How to make the Portal Dynamic

You can control which portal is displayed when a panelist logs in such that for example the portal layout depend
on the country of origin specified in the user's details. The variable that is used to specify which portal is to be

displayed is set in the default portal. To do this:

1. Decide which variable in the panel is to control the portal used, or create the variable as necessary.

This variable must include all the possible options for which you wish to provide different portals for. This
example uses the Country variable, so will display a portal depending on the country selected by the

panelist. The panel question should ask for example "In which country do you live?"

2. Goto the Panel Utilities > Panel Portals menu command to open the Panel Portal List window, and

select the default portal.

3. Inthe Panel Portal toolbox, right-click on the portal name (the top item in the toolbox) and select
Properties from the menu or double-click on the portal name, to open the Properties page for the portal.

4. Set the Portal Code Variable property to the variable you wish to use as the controller (in this case

country).
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Figure 37 Setting the Portal Code Variable property

5. Set the Portal Code property to the code for the "default" country and save the changes.

6. Go to the Properties pages for the other portals that are to be made available, and set the Portal Code
property to the code of the appropriate answer. l.e. If a particular portal is to be presented when the
panelist's country is France, then set the code for the France answer into the Portal Code field for that
portal. Note that for the "secondary" portals, the Portal Code Variable will already be set to that selected
above for the default portal.

7. Save the changes.

Once the panelist has completed the panel questionnaire and provided an answer to the Country
question, when the panelist later logs in, he/she will automatically be presented with the portal specified by
the variable.

Note: Once the Portal Code has been set for a portal, then it can be displayed by adding the querystring
parameter "pc" to the portal url. for example, add ...&pc=1 to the url to use the portal with the code 1.

5.4.2.5. How to Add Meta Tags to a Portal

You can add meta tags to the HTML code of the Panel Portal pages, enabling you to add information such as
Author, Description, Keywords etc. to the page. Note that this information will not be visible on the survey page.
To add meta tags:

1. In Forsta Plus, open the portal you wish to work with.
2. Double-click the top-most node (with the name of the portal) or right-click it and select Edit.

The Meta Tags list page opens.
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| Save ‘ﬁ

Meta Tags

| [Td Add Meta Tag X Delste |

Name Http-Equiv Content

There are no Meta Tags specified for this Community Portal, click "Add Meta Tag' to add one.

Figure 38 The Meta Tags list

3. Click the Add Meta Tag button.

Data fields appear.

|Sal.le ‘ﬁ |

Meta Tags

| L& Add Meta Tag }( Delete |

I:‘ Name Http-Equiv Content

] ~ v s

Figure 39 Adding a Meta Tag to the list

4. Click the down-arrow beside the Name field to open a list of standard tags and select a tag from the list, or
type another tag name into the field.

5. Add the content of the tag into the Content field.

e Http-Equiv - provides an HTTP header for the information in the Content attribute. The Http-Equiv
attribute can be used to simulate an HTTP response header, and its value depends on the value of the
Content attribute. If the Name attribute is set, the Http-Equiv attribute should not be set.

6. Click Save to save the changes.
7. Repeat the procedure as necessary to add more meta tags.

8. On completion, publish the portal and verify that the meta tags are added correctly to the page.

5.4.3. Panel Portal Languages

The Panel Portal pages and texts can be made available to the respondents in any language and any number of
languages. You can also make the portal language dynamic, so the portal will automatically adopt the language
specified in the user details.

5.4.3.1. How to Add a Language to the Portal

1. Inthe Panel Portal toolbox, right-click on the Portal name (the top item in the toolbox) and select
Properties from the menu or double-click on the Portal name.

The Properties page for the portal opens.
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Properties

E Sa'.'e| E Save and Close | & RESEt|
Community Portal - Documentation Portal 1
Name |Du—cumentatiun Portal 1 |
Default Language | English V|
Portal Languages {Languages) III
Theme Code Variable | V|
] Title
English | |
French | |
German | |

Figure 40 Example of the Properties page for a Portal
2. Click the ... button beside the Portal Languages property.

The Portal Languages window opens with the currently selected languages listed in the Selected Items
column.
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Figure 41 The Portal Languages window

3. Inthe Available Items column, scroll to the language you wish to add to the portal, and click on it to select
it. You can select as many languages as you require.

4. Click the >> button to move the selected language(s) to the Selected Items column.
Select a language in the Selected Items column and click the << button to remove that language.
6. On completion, click OK.

The window closes and the selected languages are added to the Portal.

Note: A search facility is available in the upper part of the window. If this is not visible, click the chevron
button beside Find to open it.

Text fields for the selected languages will now be available in the Portal and page Properties pages. You
must now fill in the text fields for the Portal and the various pages for the languages you have selected
(see Page Properties on page 53 for more information).

5.4.3.2. How to make the Portal Language Dynamic

You can make the portal language dynamic such that the portal will use the language specified in the user's
details. To do this:

1. Inthe panel, create a language variable using the language codes (refer to Appendix B of the Authoring
User Guide for details) as the codes for the options.

This variable will need to include as answer options all the possible languages that you wish to provide to
the panelists. It should ask for example, "In which language would you like to view the portal?"
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Figure 42 Example of the language variable

-

2. Goto the Panel Utilities > Panel Portals menu command to open the Panel Portal List window, and
select the portal you wish to work with.

3. Inthe Panel Portal toolbox, right-click on the Portal name (the top item in the toolbox) and select
Properties from the menu or double-click on the Portal name, to open the Properties page for the portal.

4. Set the portal's Language Code Variable property to the variable you created in point 1 of this procedure,
as shown below.

Tookbox I save Properties
(%) Panel Portal Mata Tags Community Portal - DocPortall
ElNEEocrortal =T ITRY;
El [ Page Masters Add Mets T Name DocPortall
= b Default Master Name Default Language English -
EMES
@Green g Portal Languages (Languages] III
@Drange Portal Code
= h Pages There are no Me
@Home (DEFALLT) Portal Code Variable hd
@ Join Community Theme Code Variable -
@ Lost Password? Language Code Variable - )
T3 FAGs g
[ Members Only == .
@Comﬁd Us English English
@About Norweagian Morwagian
23 Login (LOGIN)
FESET N o

Figure 43 Setting the Language Code Variable property

5. Save the changes.

Once the panelist has completed the panel questionnaire and provided an answer to the language
variable, when the panelist later logs in, he/she will automatically be presented with the language specified

in the variable.

Note: The dynamic portal language functionality will not work if the Language Selector component is
included in the panel. If the Language Selector component has been used then you will need to go
through the panel and remove all instances of the component from the page master and all pages.
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5.4.4. The Panel Portal Designer

The Panel Portal Designer is where you create and make changes to your portal pages. The toolbox contains the
Page Masters (see The Page Masters Folder on page 45 for more information), Themes (see The Themes Folder
on page 46 for more information), and Pages (see The Pages Folder on page 51 for more information). The
Visual Components toolbox contains the elements that you can use on a page (see Visual Components on page
55 for more information).

In the figure below, the Panel Portal toolbox contains a Page Master, Themes and a number of Pages. In addition
there are more pages inside the Members Only folder (see Folders and Structure on page 54 for more
information).

[l [ Page Masters
@ Default Master
El [ Themes
(5l Green (DEFALLT)
E Orange
=l =) Pages
[ER4 Home (DEFALLT)
|ER4 Join Community
|EL4 Lost Password?
54 FAGS
|- Members Only
[EE4 Contact Us

[EE4 About

[EE4 Login (LOGIN)

Visual Components

L3

__ﬂ_ 1 Page area

Iﬁ; Loagin

.1-\_:1 Login name

I'ai?,, Login status

ﬁ Password recovery
IEZ Change password
@ Mavigator

4 Mavigator path

m

@ Language selectaor
|_‘b/ Theme selector

Surveys list

[ rradit halanea

Figure 44 The Portal Designer toolboxes

The portal has a right-click menu. The options in this menu allow you to publish the portal (see How to Publish a
Panel Portal on page 64 for more information), set the portal as default (see How to Set a Portal as Default on
page 37 for more information), export the portal etc.
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5.4.4.1. The Page Masters Folder

A Page Master is a template that provides an overall look-and-feel to the pages in the Panel Portal. You can
create as many Page Masters as you need for a Portal. The first Page Master in the list will be used as the
default, and will be applied to all pages in the Portal unless other Page Masters are specified for particular pages.
A portal page will always adopt the look-and-feel of the Page Master specified.

5.4.4.1.1. How to Create a Page Master

To create a new Page Master, right-click on the Page Masters folder name text beside the folder icon to open the
drop-down menu, and choose Insert Page Master (Inside). A blank Page Master is added to the portal. If you
want to base a new Page Master on an existing one, then right-click on the Page Master you wish to copy, and
choose Duplicate.

5.4.4.1.2. The Page Master Properties

The Page Master has a Properties page where you can edit the page master name, set the document type etc.
To open the Properties page:

1. Inthe Panel Portal toolbox, expand the Page Masters folder, right-click on the page master and select
Properties from the drop-down menu.

The Properties page opens.

Page Master - Default Master

MName Default Master

Document Type ¥HTML 1.1 Strict -
External Javascript Url =]
Body Style Name body hd

Use newest available version of IE rendering [ =]

Figure 45 The Properties page for a Page Master

The properties are as follows:

¢ Name - the name of the page master. Here you can edit it as required.
¢ Document type - choose a standard for the document type.

e External Javascript Url - you can refer to an external Javascript file in the page master. Enter the URL of
the .js file you wish to use. You can add multiple URLSs to the field; use a comma (,) as the separator.

e Body Style Name — the style to be set for the BODY-tag in the document.

e Use newest available version of IE rendering - Internet Explorer versions later than 7 render pages
very differently from Internet 6 and 7. Therefore Forsta Plus normally runs all surveys in a compatibility
mode which makes newer versions of Internet Explorer behave like Internet Explorer 7. This then avoids
the extra complexity related to creating html and css that behave the same in all versions of Internet
Explorer. Select this option to turn the compatibility mode off, thereby allowing Internet Explorer always to
run in the best available mode, based on Doctype and Internet Explorer version. Use this property in
combination with the HTML5 doctype option to run Internet Explorer 8 and 9 (and later) in the most
modern rendering mode available in these browsers.

The article by Microsoft at the following URL explains the subject in more detail:
http://msdn.microsoft.com/en-us/library/cc288325(v=vs.85).aspx

2. Set the properties as required, then save the changes by clicking the Save button above the Page Master
Designer area.
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5.4.4.1.3. How to Edit a Page Master

To open a Page Master for editing, double-click the name of the Page Master In the toolbox, or right-click on it
and choose Edit. The page designer opens at the Layout tab.
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Figure 46 Example of a Page Master

On the Layout tab, you specify which Visual Components (page elements) are to be included on the page, and
where they are to be located.

To define the look-and-feel for each of the Visual Components, double-click the component or right-click on it and
choose Properties (see Visual Components on page 55 for more information).

Go to the Preview tab to preview the current version of the Page Master. Remember to save any changes you
may have done before previewing the Page Master.

For more information on using HTML tables, free-from text, and images on your portal pages, see Editing your
Page Masters and Portal Pages.
5.4.4.2. The Themes Folder

A theme is a collection of different Styles, each holding a specific layout definition. Inside a Panel Portal you can
have as many different themes as you wish, but only one can be active at a time. You can specify one theme to
be the default, and this theme will then be used whenever no other theme is specified. You can however select
other themes to be used for specific pages and components.

To set a theme as default, right-click on the desired theme and select Set as Default. Forsta Plus will display the
text (DEFAULT) next to the default theme in the Panel Portal toolbox.
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Figure 47 The default theme

You can allow the panelists to select a theme so they can "personalize" their portals. To give the panelists this
possibility, place a Theme Selector component into the master page for the portal (see Visual Components on
page 55 for more information). If a panelist chooses not to select a different theme, then the portal will be
presented using the default theme.

You can also have Forsta Plus select the theme to be used depending on a panelist's answer to a question in the
panelist questionnaire. For example you could have Forsta Plus use different themes for males and females
under and over the age of 20. In this case you use the Theme Code property to set up the specifications (see The
Theme Code Property on page 47 for more information).

Once you have set up the Theme Code functionality, you can define in the email link that the panelist uses to
open the portal the theme to be used (see Adding a Theme Code to the Email Link on page 49 for more
information).

5.4.4.2.1. The Theme Code Property

You can program Forsta Plus to select a theme automatically for a panelist depending on answers given in the
guestionnaire. This involves using the Theme Code property, which causes the default theme to be overwritten.

Note: If a Theme Selector component is included on the Master page for the portal, then the theme
specified in the Theme Selector will over-write the theme specified by the Theme Code. You are therefore
recommended to remove the Theme Selector component (if one exists) from the page master before
starting this procedure.

1. Ensure that the Themes folder in the Panel Portal toolbox contains the themes you wish to be available
for the panelists.

2. Inthe panel questionnaire (Panel Setup menu), include a single question and give it a logical name, for
example "ThemeCode".

3. Add the theme options as the answers to this question, and set the codes for the answers to be something
specific.
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For example, if the themes available are to be "Green" and "Orange", then it would be logical to set the
question's answers to "Green" and "Orange", and the codes to "g" and "0" respectively as in the figure
below.
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Figure 48 Example of a Single question in the panelist questionnaire to set the theme for a panelist

As the theme selection is to be automatic, the question would normally be "hidden".

4. Generate the database for the panelist questionnaire.
In the Panel Utilities > Panel Portals page, select the portal you wish to work with.
6. Inthe Panel Portal toolbox, double-click on the Portal node or right-click on it and select Properties.

The Properties page for the portal opens.

7. Click the down-arrow beside the Theme Code Variable field and select the variable (question) that you
have created earlier.

8. Save the changes.

9. In the Panel Portals toolbox, the Themes folder contains the available themes. Double-click on a Theme
or right-click on it and select Properties.

The Properties page for the theme opens as shown below.

E Save E Save and Close El Resat

PanelThemeSheet - Green

Name |Green |
External Stylesheet Url | | (=]
Theme Code |g |

Figure 49 The Properties page for the Green theme

10. Inthe Theme Code field, type the code for the theme as specified earlier in the procedure.

In the example above, the code for the Green theme was set to g.

11. Save the changes.

You can now go into the Panel Management > Single Panelist Editor page and set the ThemeCode variable to
the desired theme for specific panelists, and you can also of course use a panel rule to set the theme for sets of
panelists simultaneously.
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5.4.4.2.2. Adding a Theme Code to the Email Link

Once you have set up the Theme Code functionality (see The Theme Code Property on page 47 for more
information) you can add a Theme Code to the email link that is sent to the panelists. To do this, type:

tc=<precode>
onto the end of the link that is to be sent to the panelist.

This can also be done automatically using scripting and piping, but this is only for advanced users and the details
are beyond the scope of this manual.

Note: Adding a Theme Code to the email link will automatically over-ride all other theme selections.

5.4.4.3. Styles

Click the plus sign in front of each Theme to see all the styles for that Theme. The figure below shows the styles
available in the Green theme. When the Green theme is in use, the Visual Components (and free-form text) can
be assign any of these look-and-feel definitions.

To set a Style for a Visual Component:

1. Double-click the component on the page, or right-click and choose Properties.

The component Properties pane opens.

2. One of the properties listed is the Style Name. Click the down-arrow button beside the property to open a
drop-down list of the available styles, and select the required style from the list.

Click Apply or Apply and Close to apply the change.

4. On completion, save the changes.

| Tookbox H save| 24 & R —— X
Apply Apply and Close Reset
Page Master - Default Master I SR &

rtal1 (DEFALLT)

Login - Login
[=] |-y Page Masters ‘

@Defau\t Master

E ) Themes

=) (5 Green (DEFALLT)
E navigatarbg L
D profile
E tablegrid
B pagetitle
=1 topbutton

al Components

Login Button Type Button -

Login Button Image Url

Logout Image Url

|b Theme selector Orizntation Horizontal -

Text Layout TextOnLeft -

m

Display Remember Me ]

Show Login Status When Logged In

Password Recovery Page
i3 Page area

2. Login

2 Login name

-
Destination Page -

iced Password Page
Style Name o

Title Text Style Name

}2 Login status

ﬁ Password recovery

m

[ Change password
@ Mavigator
A Navigator path

Language selectar L
\j// Theme selector

@@ Navigator path

Lg Credit balance

. ] »

Instruction Tesxt Style Name
Logged In Status Text Style Name
Error Message Style Name

Login Button Style Name

Check Box Style Name

Hyper Link Style Name

I =hal Ghds Wama

toplogintitie
toptaxtbox
toplabel
footerlabel

navigatortopitem

Figure 50 Applying a style for a Visual Component

Each style has its own set of properties as appropriate for the style’s requirements. Below is the properties pane

for the pagetitle style. As this style is a “Text” component, it requires a number of font properties.
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E Save E Save and Close & Preview Reset

Mative HTML Style - pagetide

w Background ‘ Text | Position | Layout | Edges | Lists | Other
Calor HARTAGE o
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Italic | Mot Set v |
Small caps | Mot Set lv_.,|
Bold | Mot Set v |
Size \z0 |
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Cverline D
Preview

Previewas
Html Style Preview

rmargin-right: 10px;
font-zize: 20px;
color: #4A83A6E;

v font-tarmilyiverdana:

Figure 51 Style properties

When you change a setting, Forsta Plus provides an instant preview of the style so that you can see how the
change affects the style. Also, when making changes to a style, each alteration (setting) is listed below the
preview so that you can see which settings have been set for that style (see Visual Components on page 55 for
more information).

5.4.4.4. View Stylesheet Contents
You can view all the styles for a theme on one sheet.

¢ Right-click on a Theme and choose View Stylesheet Contents.

Forsta Plus will then list all the styles for that Theme. This can be useful if you want to quickly find the definitions
of all styles, typically for use outside this theme.

-50 -



Forsta Confidential Forsta Plus 2022 Professional and Standard Panels User Guide

Toolbox o '
| .navigatorbg{

background-color: #4A8AGE;
H

= @ DocPortal1 (DEFAULT)

B [ Page Masters -profilef
— height:400pax;
324 Default Master vidth: 745px;
Bl 3 Themes H
=

.tablegrid{
font-size:11px;

= profile color: 24ABAGE;

[~ tablegrid ;

ﬁ pagetitle .pagetitlef

= margin-right: 10pax;
% b]pbu?b]n font-size: 20px;

|- toplogin color: #4ABAGE;

ﬁ toplogintitle font-family:verdana;
ﬁ toptextbox :

ﬁ toplabel topbuttony

margin-left: 2psx;
font-size: 10px;
color: #4A8ARE;

j'- Page area - font-family:verdana;
= — }
.% Login ]
toploging
I’;-l-'l Login name ) margin-top:-3px;

|l5 .
'g Login status toplogintitled

ﬁ Password recovery EII-:::ELZEEE:EFF‘E}S-

le= Change password }
) toptextboxd
@ Mawvigator font-size:11p:sx;

font-family:arial;
width:65px;

m

A Mavigator path
El | ammniane eslartar ! H

Figure 52 Viewing the Stylesheet Contents

5.4.4.5. The Pages Folder
The third main folder inside the Panel Portal toolbox is the “Pages” folder. This is where you set up the portal
pages.
5.4.45.1. How to Create a New Page
To create a new page in the Portal:
1. Inthe Panel Portal toolbox, right-click on the Pages folder text to open a drop-down menu.
2. Select Insert Page (Inside).

Or: Right-click on an existing page and choose Duplicate.

5.4.4.5.2. How to Edit a Page

Double-click on a page in the Panel Portal > Pages folder to open the page for editing. The Panel Portal
Designer page opens for the selected page. This is where you select the Visual Components that are to be used
on the page, and position them on the page.

A new page has been created in the Pages folder, called in this case Example Page (see How to Create a New
Page on page 51 for more information). This page will now be used to provide worked examples of the various
procedures used when editing a page.

On this page it has been decided to show some text (the text element), an external link, a link to the page called
“Home”, and an image will be inserted across the bottom of the page.
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1. The first step is to set the Page Master (see The Page Masters Folder on page 45 for more information):

Right-click on the page and select Properties from the drop-down menu. The Properties pane opens. The
first property in the list is Page Master.

Right-click on the down-arrow beside the Page Master field to open a drop-down list of the page masters
available, and select the desired page master from the list.

If several languages have been defined for the Portal, then on this Properties page you can also type in
translations of the title and description for the non-default languages.

Save the changes.

The “Page Area” element determines where the page (portal page) is located on the overall page (Page
Master) (see How to Create a Page Master on page 45 for more information).

In other words, overall browser views are set up as Page Masters. The individual portal pages are set up
under “Pages”, and you assign a Page Master for each page (if you do not, the default Page Master will
be used). The portal pages will always appear on the screen where the Visual Component “Page Area” is
located.

2. Setthe Page as Default / Login

In the same way as one Theme is set to be default, one page is also set as the default page. This will then
be the first page that the respondent sees when he/she goes to the Panel Portal. In most cases this will be
the starting page (home page).

Right-click the page and choosing Set as Default. Forsta Plus will show the default page each time a new
visitor enters the portals.

The page you wish to use as the login page must also be specified. To do this, right-click the page and
selecting Set as Login. Forsta Plus will display the text “LOGIN” next to the login page in the Panel Portal
toolbox.
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Figure 53 Setting the Login page

5.4.4.5.3. Page Properties

To open the Properties pane for a portal page, right-click on the page in the Panel Portal toolbox and choose
Properties from the menu, or when the page is open for editing click the Show/hide Properties button in the
Editing pane toolbar. The properties pane opens alongside the page.
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properies

Page - Example Page

Page Maszter | Default Mastar V|
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E Title
English | |
French | |
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[E] Description
English | |

French | |

German | |

Figure 54 Example of a Page Properties page

The page properties are as follows:

Page Master — defines the layout for that page (see The Page Masters Folder on page 45 for more
information).

Name — the name of the page. You can edit this at any time.

Protected — check this box if you want this page to be accessible only to people who are logged in. If a
page is not protected all visitors can see the page.

Navigator Item — defines when the page is to be visible in the menu bar (see Folders and Structure on
page 54 for more information).

Visible — leave this box checked if you wish the page to be visible in the menu bar all the time. If the box
is unchecked, then the page will not show.

Visible when not logged in- leave this box checked if you want the page to be visible to all visitors to the
site. Uncheck the box to hide the page from those who are not logged in.

Title — the portal can be made available in any number of languages. These languages are selected when
the portal is first created, or can be added later (see Panel Portal Languages on page 40 for more
information). The respondents can select the language (from the list available) in which the Portal is
presented. The Title property provides one field for each language selected. Type into the fields the page
titles in the various languages.

Description — here you specify for each language the text you wish to appear when a respondent points
to the page on their screens (mouse-over).

5.4.45.4. Folders and Structure

Folders are used inside the “Pages” section to create a menu structure for the portal pages. Each folder will be
presented as a clickable sub-menu for the panelists.

To insert a new folder:

1.

Right-click on an existing folder and select either Insert Folder (Inside) or Insert Folder (After) as
appropriate.
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2. Once you have created the folder, create pages inside the folder or place them there using drag-and-drop.
Note that you can have folders within folders.

In the figure below, note how the pages Example Page, Home, Join Community, FAQs, Contact Us, and About
are displayed as separate pages on the menu bar. The folder “Members Only” creates a drop-down menu which
leads to the pages inside the folder. The Lost Password page does not appear here because the Visible property
in the page's Properties page has been unchecked. The login page is only displayed when someone attempts to
enter a restricted page.

| Toolbox ~ [ save = & ‘
L :
= DocPortal1 (DEFALLT) -
=l [ Page Masters Layout | Preview
3 P =
Bl (5 Themes English = Theme: Green = User Name: Password: =
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EE Qrange
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4 Home (DEFALLT) [ Insert Your Logo]
|_n“g Join Community
|_n“g Lost Password?
oLl FAQs
=1 [ Members Only
|_E‘;;ﬁ,‘ Mew Surveys
|_E‘;;ﬁ,‘ Surveys in Progress
|_E‘;;ﬁ,‘ Completed Surveys
|_E‘;;ﬁ,‘ View Your Points
|_E‘;'__§,‘Updahe Your Profile
|_E‘;;ﬁ,‘ Change Your Password|

|_n“g About
oz Login (LoGIN)

Contaut Us

Join Community | Lost Password? Members Only

New Surveys
Surveys in Progress t%

Completed Surveys

View Your Points
Update Your Profile

m

Change Your Password

Visual Components

3 Dana aras

Figure 55 Using a folder to create a menu layout

5.4.4.6. Visual Components

The Visual Components are “prefabricated” elements you can use on the portal pages. Page Masters and
“normal” pages have different sets of Visual Components available, reflecting the pages’ different functions.

The procedure for inserting Visual Components is the same for Page Masters and Pages. Note that the Visual
Components you insert into a Page will all be located within the Page Area component that is positioned on the
Page Master.

5.4.4.6.1. How to Add an HTML Table to the Page

When you first create a page, it will be empty. To simplify the positioning of components on a page, it is
recommended that the first thing you create on the page is a table. You can then place the various components
within the table cells, and use the cell properties to define the positions of the components. An existing page will
normally already have a table.

1. Double-click on the appropriate page in the Panel Portal toolbox Pages folder, or create a new page (see
How to Create a Page Master on page 45 for more information).

The Page Editor for the page opens.

-B5 -



Forsta Plus 2022 Professional and Standard Panels User Guide Forsta Confidential

Save %:
Layout I Praview
# 33 B 7 U

-- Style -- Vl - : r @

(i
Il
il
T
111
T
111
(Tha}
m
(]
m

Figure 56 The blank page editor

2. To create the table, click the Table button E (A in the figure below) in the page editor toolbar to open
the table selector, move the pointer to the right and down until the required number of rows and cells are
selected, then click in the lower-right selected square.

Save %.3
Layaout I Preview
b 2B B LU

-- Style -- b

A

Figure 57 Creating a 3x3 HTML Table

While working in the Portal Designer, a dotted grid is displayed as a visual guide so you can see the table
and cell boundaries while editing. The table will not be visible on the portal page. If you wish to see the
page without this grid, either select preview, or click the Show/hide grid button (B in the figure above).

3. Right-click in the table and select Table Properties from the drop-down menu to open the Properties
page for the table.

4. Right-click in a cell and select Cell Properties from the drop-down menu to open the Properties page for
the selected cell.

5. In the right-click menu you can also add and delete rows and columns for the table.

6. On completion, click Save to save the changes.
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Figure 58 The resulting 3x3 table

5.4.4.6.2. How to Add a Visual Component to the Page

A page can include any number of visual components. From the Visual Components toolbox, which contains all
the various page elements, we will now drag a component and drop it in the upper left cell.

1. Gotothe Visual Components toolbox, click on the component you wish to insert, and drag it up to the
appropriate field in the table.

Or:

Right-click in the appropriate cell, choose Insert Component, then select the desired component from the

drop-down list.

Toolbox

=l & DocPortal1 (DEFALLT)
[=l [C5) Page Masters
E:)
Bl |5 Themes
[& Green (DEFAULT)
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[l [ Pages
(23 Home (DEFAULLT)
E@ Join Community

Ea Lost Password?
IRP\ FA e

L1

m

Q¥ Navigator path

Language selector

&5 Theme selector
3 credit halance

Figure 59 Dragging a Visual Component into the table

In the example, a Language Selector component is being dragged into the upper-left cell of the table. You
can now open the component’s, the cell's and/or the table’s Properties pages and set up the component

as required.
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2. On completion, click Save to save the changes.

5.4.4.7. The Visual Components Toolbox

Page Masters and “normal” pages have different sets of Visual Components in the toolbox, reflecting the pages’
different functions. The following sections describe all the components available.

Each Visual Component has a Properties page that contains properties particular to that type of component. The
Properties page enables you to select the characteristics for the specific component, and in many cases what
information the component displays and how it is displayed to the panelist. To open the Properties page for a
component, double-click on the component or right-click and select Properties. Refer to the separate Professional
Authoring User Manual for further information on the properties.

5.4.4.7.1. Page Area

The Page Area component determines where the page (portal page) is located on the overall page. This
component is only available for a Page Master.

Layout | preview

& & BB B

-- Style --

Page area

Page link - Contact Us

Page link - Password

T S

1
'
'
[
'
1
1
Page link - About H
'
1
H
'
'
'
2

Figure 60 A Page Master with the Page Area element

5.4.4.7.2. Login

The Login element displays the username and password text-fields and the associated Login button to the
panelists.
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Figure 61 Example of the Login component in use

Note: For Professional and Standard Panels, the User Name will be the user's email address. The user will
therefore log in using his/her email address and password.

5.4.4.7.3. Login Name

The Login Name element displays the panelist’s username (normally the email address) after he or she logs in. In
the figure below, the Login Name element is being set up. Here, a custom text (Format String) is defined so when
for example Peter Jones logs in with his username “peterj@firm.com”, the text displayed in the page becomes
“Welcome peterj@firm.com!”

The “username” is the only element that can be piped into the Login Name component.

Apply | Apply and Close @. =i Reset
-EE @ Login Name - Login name
A R R R RS —“-'T Et',rle MName | Ingintexl: W
a I|:I
- Login name Ll /3 = mat String
N X | Delete X
¥EssEsssssszsassssssssas; - - nglish Welcome ~usernamenl
: Login | Properties
i_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_ mEmmmEE= -_-_-_-_‘I:: i P‘"‘\:‘ -= p aness
:E Norwegian

Figure 62 Setting up the Login name component

5.4.4.7.4. Login Status

The Login Status component allows you to place a hyperlink to a login page anywhere in your portal. This
element is often used in combination with the property “Show Login Status When Logged In” on the Login
component. If this property is checked on the Login component, and the Login component is always displayed on
screen (normally part of the Page Master), then the Login Status component may not be used.

5.4.4.7.5. Password Recovery

This component allows the panelist to ask that his or her password be sent to their email address. This requires
that the panelist has previously registered.

5.4.4.7.6. Change Password

This component provides the panelist with a link to a page on which they can change their password. The panelist
can click the link at any time.
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5.4.4.7.7. Navigator and Navigator Path

The Navigator component determines where on the page the menu is displayed. The Navigator path component
shows the panelists the history of pages visited.

5.4.4.7.8. Language Selector

If the portal is created in more than one language, then the panelists and other visitors to the site must be able to
choose which language the portal is presented in. In this case the selector is located in the upper left corner of the
page.

> —_

Englizh | W

\Englizh J
French %.

Herman

Language:

Confirmit.

Example Page | Home | Join Community 15 | Members Only Contact Us

Login

Figure 63 Example of the Language Selector in use

5.4.4.7.9. Theme Selector

If more than one theme is available to the portal, then you can provide the Theme Selector component to allow
the panelists and other visitors to choose which of the themes is used for their portal. In the example shown
below, the selector is located in the upper left corner of the page (ringed) and the “Green” theme is selected (see
The Themes Folder on page 46 for more information).
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Figure 64 Example of the Theme Selector in use

5.4.4.7.10. Surveys List

This component presents a list of the surveys the panelist is involved with, and can present additional information
on each survey in the list. Each Surveys List component on a page can display one type of list, for example “All
completed surveys” or “All surveys that are not yet started”. If you wish to present several types of list to the
panelist, then you must add one Surveys List component to the page for each type of list you wish to present.

5.4.4.7.11. Credit Balance

Forsta Plus keeps track of points earned for panelist participation. Use the Credit Balance component to display
the current number of points earned by the panelist. In the example below, when panelists go to the View Your
Points page, they will see the sentence “You have N points in your account.” The variable N displays the credit
balance, starting at zero.
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@ Join Commurity

@ Lost Password?

EEiFAQs

[l [ Members Only
@ Mew Surveys
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=
@ Update Your Profile |E
@ Change Your Passwo
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24 Login (LOGIN)

e
0
:
:

eIV = = I'points in your account.

{H Password recovery

Figure 65 Example of the Credit Balance component in use
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Note: You can import and export panelist credits (see Panelist Credits on page Error! Bookmark not
defined. for more information).

5.4.4.7.12. Edit Profile

Your panelists should have the opportunity to update their profiles. This component places a link on the portal
page that, when clicked, takes the panelist to the survey they answered when signing up as a panelist. Here they
can update their details so that when you next sample the panel for respondents for a particular survey, the group
of respondents found for that survey is optimized.

Note: You can use different surveys to update different parts of the panelist database. The link must then
refer to the appropriate survey, so you must type the survey’s ID number into the Profile Survey ID field.

The survey will appear where the Edit Profile component is placed on the page.

Note that you can have the Edit Profile survey open as an "In-line" frame. This allows you to embed the survey
into any web page without having to use iFrames. To do this:

1. Double-click on the Edit Profile visual component to open the Designer page for that component.
2. Right-click on the Edit Profile component on the page and select Properties from the drop-down menu.

The Properties page opens.

Apply | Apply and Close E}‘ Resat

PanelEditProfile - Edit profile

Profile Survey Id |p01354225

Use Inline Frame [ ]

Query String coreprofile=yes
Return Page Members Area
Style Name aeditprofile

Figure 66 The Edit Profile component Properties page

Check the Use Inline Frame box.

4. Click Apply or Apply and Close to save the changes.

5.4.4.7.13. Edit Profile Link

This is basically the same as the Edit Profile component, but takes the panelist away from the portal page and
opens the registration survey in the window. Once the panelist has worked through the survey, it is closed and
he/she is returned to the portal.

Note: You can use different surveys to update different parts of the panelist database. The link must then
refer to the appropriate survey, so you must type the survey’s ID number into the Profile Survey ID field.

5.4.4.7.14. External link

You can insert hyperlinks on your portal pages. To do this, drag the Visual Component “External link” onto a
page, then double-click the element (or right-click and choose Properties) to set the properties for the element.
One property that must be set is the URL for the link.

5.4.4.7.15. Link Target

Use this component to embed an external link on a portal page. If/when the panelist clicks this link, the external
site will open in the portal page.
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5.4.4.7.16. Text

Use the Text component to display text on a portal page. Note that you can enter text directly onto a page (see
Free Text on page 68 for more information), however If you do the text will be the same for all panelists,
regardless of language. If you use the Text element, you can to specify text for each language selected for the
portal, and Forsta Plus will display the text in the language chosen by the panelist via Language Selector (see
Language Selector on page 60 for more information).

5.4.4.7.17. Poll
You can link Polls to a Panel and embed the panel in the Panel Portal.

If you have created a Poll going through the “New Poll” wizard (refer to the Authoring User Guide for further
information), you can return to the Project Overview page before launching the poll and set up a link to the Panel.
This will automatically add “panelistid” to the project.

In Panel Portal, you can insert the Poll component on any page:

1. Right-click on the component and select Properties to open the Properties page.
2. Inthe Poll Survey ID field, type the project number of the poll.

3. Decide whether it should only be available for panelists who are logged in, those who are not logged in, or
both.

Note: For a logged in panelist, the system will automatically capture the panelistid and store it in the Poll
database. This makes it possible to merge the poll results with panelist profile data, for reporting, or for
adding the poll answers to the panelist database.

4. Apply the changes and Save.

HSaue g %; s
Page - Contact Us Apply Apply and Close IEL Reset
Layout I Preview Poll - poll
d
£ B B 7 U S = =iz iz EE
— * -2 lﬁ - : i i Oy Poll Survey Id | |
- style -- )
visible
Hide When Logged In I:‘

Visible When Mot Logged In

Style Name | b

Figure 67 Setting the properties for a Poll visual component

5.4.5. Properties on a Panel Portal

To set properties on the portal level, right-click on the portal name, and choose Properties or double-click on the
portal name. The Properties page opens.
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Figure 68 Setting the properties on the portal level

e The portal name is displayed at the top of the property sheet. You can change the name by typing a new
name into the field.

e Default Language - specify which of the Portal Languages is to be the default. This language will be used
as the first-entry language and whenever another language has not been chosen.

e Portal Languages - select the languages you wish the panelists to be able to select between. In the
example above, English, French and German are selected.

e Theme Code Variable - specify the question to be used as the deciding element when Theme Codes are
to control the theme used by the portal (see The Theme Code Property on page 47 for more information).

e Titles - specify the title that is to be used for each language. These will be displayed to the panelists and
other visitors.
5.4.5.1. Managing your Panel Portals

You can create as many Panel Portals as you require. However, only one portal can be publicly active at a time
on each panel. You would normally build your portals inside the panels so that you have full control of how the
portals will look.

5.4.5.1.1. How to Publish a Panel Portal

Several Portals can be published for a panel at one time. The name of the default portal is presented in bold text.
The default portal is the portal that will be used if no other is specified.

}( Delete Irnport Community Porkal Mew Cormrnunity Portal
D Portal Name Company Created By Created Fublished 2
I:‘ UsA Confirmit ASA Andresen, Ole 16/10/2008 10:29:55 05/01/2009 12:27:26

D Canada Confirmit ASA Andresen, Ole 20/11/2008 16:15:28 14/01/2009 13:38:17

D USA backup Confirmit ASA Apple, Adam 14/01/2009 12:52:49

Figure 69 Example of the Panel Portal List, the default portal in bold

When a portal is published, the Panel Portal URL becomes available from the Project Management page >
Overview tab and any changes you make to the Portal become public. The date and time a portal was last
published are displayed in the published column.

To publish a portal:
1. Inthe Panel Portal toolbox, right-click on the portal name to open the drop-down menu.

2. Choose Publish from the menu.
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If you wish to remove a portal from public view then you can "Unpublish" it. Once the portal has been published
then the Unpublish option becomes available in the right-click menu. If a portal has been specified for as
particular set of panelists, and that portal is later unpublished, the those panelists will be presented with the
default portal.

5.4.5.1.2. Testing your Panel Portal

While working with the portals, you may need to test how different portals function together with your panel.
Forsta recommends that you have all relevant portals added to the panel. You can then try the different
alternatives in Preview.

If you wish to make changes to a portal to for example try a different look or setup, you would probably save
considerable time by duplicating an existing portal instead of creating a new one and starting from the beginning.
5.4.5.1.3. Managing your Portal within your Panel

To list all portals that are added to the active panel, go to the Panel Utilities > Panel Portal List menu command
in Professional Authoring.

The list shows when each portal was created and by whom. The currently published portal for this panel is listed
in bold, and the time when the portal was last published is also shown.

5.4.5.1.4. Managing your Portal Templates

The same Portal can be used on many different panels simultaneously. Whenever you save a portal as a
template (see How to Save a Portal as a Template on page 65 for more information) the portal is stored as a
general (global) portal template, which can later be added to other panels.

A list of all such global Panel Portal templates is found under the Home > Templates > Panel Portal menu
command.

Panel Portal Template List Confirmit. ™
everywhere .""
1 ; Home =~ |Panel Setup =~ Panel Utilities * Panel Management ™ Sample Management = * |User: Apple, Adam Log Off

@ Hew = @F{ecent > @SUNEYS l]ﬂ Basic Panels @ Standard Panels @ Professional Panels Survey Routers ‘L:\:? Favorites Archivin =

}( Delate p Search __2 Reseat Import Panel Portal MNew Panel Durta||
D Name Company Created By Created z
- - =
[ DocPortalz Confirmit Apple, Adam 3/21/2012 9:45:44 AM T
Default template Confirmit Admin, System 10/5/2011 2:15:34 PM
[[] AnctherDocPortal Confirmit Apple, Adam 3/21/2012 9:49:20 AM

Figure 70 Example of a Panel Portal template list

When you enter a template, you can right-click on the template name and select Permissions from the menu. A
list of all Forsta Plus users in your company is then displayed, so you can decide who in your company should
have access to use this particular template.

Note: Users with the Company Administrate permission have by default access to all the company's
Portal templates.

5.4.5.1.5. How to Save a Portal as a Template

To save a portal as a template for later use:

1. Whilst in the panel that has the portal that you wish to save as a template, go to the Panel Portals menu
item.

2. Open the portal.

3. Inthe Panel Portal toolbox, right-click on the portal name (the top node in the toolbox) and choose Save
as Template.
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An identical copy of the current portal is saved as a template, and is opened in the Panel Portal Designer
page. Here you can rename the template, and make changes to the copy or the original without the other
being affected.

5.4.5.1.6. How to Export a Panel Portal

If you wish to make a Panel Portal available to another server, you can export it as an XML file. The file is then
sent by email to a specified email address, whereupon the recipient can import it into the other server.

1. Inthe Panel Portal toolbox, right-click on the portal name and select Export from the menu.

The Properties dialog opens.

Email recipient | adar. apple@firrm. corn

Figure 71 The Properties dialog when exporting a portal

2. Type the recipient’s email address into the field, then click OK.

The Task page is displayed, showing a progress bar, the task ID and the status. On completion, the
progress bar is at 100% and an OK button appears. An email is sent to the specified recipient, with the
compressed XML file attached. The recipient can then save and de-compress the file, then import it into
the server (see How to Import a Panel Portal on page 37 for more information).

5.4.5.2. Editing your Page Masters and Portal Pages

Note: Forsta Plus is not installed on your computer locally like an application such as MS PowerPoint
normally is. In addition, no plug-ins or ActiveX components need to be downloaded for you to gain full
functionality. Working in Forsta Plus means working 100% in a browser window. All formatting is done
using HTML and style sheets. You use HTML table or style properties to position elements on the page
instead of moving them to a precise point as in for example PowerPoint.

The normal method of setting up a portal page (positioning the Visual Components) is to use HTML tables (see

How to Add an HTML Table to the Page on page 55 for more information). A page can consist of one table or a

combination of tables within tables. Place the various Visual Components (page elements) and images you wish
to use, inside the appropriate table cell.

Alternatively, you can specify each Visual Component’s position and layout by using style settings (CSS) (see
Styles on page 49 for more information).

5.4.5.2.1. Adding Rows and Columns to the Table

You can add as many rows and columns as required to an HTML table. To add rows and/or columns, right-click
the cell within which you wish to add a row or column, and select Insert Row/Column from the drop-down menu.

5.4.5.2.2. Deleting Table Cells, Rows and Columns

To delete unwanted cells, rows and/or columns, right-click in the cell you wish to delete (or a cell in the row or
column), and choose Delete Cell/Row/Column as appropriate.

5.4.5.2.3. Table Properties

To set the properties for the table, right-click anywhere within the table and select Table Properties from the
drop-down menu.
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Apply | Apply and Close E{ Resat

HitmliTable Control

BackgroundColar |

width |100%

Height |

CellPadding

|
CellSpacing |
|

Barder

Figure 72 The Table Properties page

The Table Properties page contains properties that are applied to the entire table. Note that similar properties are
also available for the individual cells in the table, and if you set cell properties, then these will take precedence
over the table properties.

To set the background color of your table, type in the color code in the BackgroundColor text field, or double-
click in the box to the right of the BackgroundColor property. A color picker chart then opens, from which you can
choose a color. To activate your settings choose Apply or Apply and Close.

=8 Click on the color you wish ko use == Y¥e

HtmliTable Control

BackgroundColar I#FFDCIFF
width |1oow
Height |
CellPadding II:I
CellSpacing II:I
Baorder II:I

|http:,|',|'Fi-I:uugFixE| (oF Local intranet

Figure 73 Editing the background color

You can also specify the width and height of your table. The dimensions can be input as either pixels or
percentage of the full screen. If you wish to use screen percentage, then you must type in the % character after
the value. Otherwise the setting will default to pixels.

In the table properties above, Cell padding, Cell spacing and Borders are set in pixels.

Cell Spacing specifies how far apart you want the cells to be within the table, while Cell Padding is how far from
the cell walls you want the text (or other contents) inside the cell to appear.

5.4.5.2.4. Cell Properties

To edit the properties of a table cell, right-click in the cell and choose Cell Properties from the menu. The
property list shown below will appear.
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HtmilTabla CellControl
BackgroundColar I I:l
width |
Height |
Colspan |1
RDWSEEH |1
Haorizantalalignrment INn:nt Set ;I
werticalalignment IN-:ut Set ;I

Figure 74 Cell properties

Here you can change the background color, width and height(see Table Properties on page 66 for more
information). Be aware that changing these settings might influence the formatting or appearance of the other
cells in the same row or column.

If you wish to stretch a cell across more than one row or column, input values in the Colspan and/or Rowspan
properties to specify the number of rows/columns you want the cell to span.

The Horizontal and Vertical alignment properties define where in the cell any elements you add to that cell will
be placed.
5.4.5.2.5. HTML Mode

When building your portal pages, you would normally work in WYSIWYG mode (what-you-see-is-what-you-get).
Users who are familiar with HTML coding can switch to HTML mode at any time. To toggle between the modes,
click the Toggle Editor button at the left end of the toolbar.

The figure below shows the table in HTML mode. You can at any time toggle back to WYSIWYG mode by clicking
the same button.

Save %3

Layout | Praview

& & BB @

<table style="width: 100%"><thody>=<tr=<td=</td=<td></td></tr=<tr=<td
colspan="2"/></tr><ftbody></table>

Figure 75 Example of the HTML editing mode

Important
When working in HTML mode, do not alter or remove the code that refers to Visual Components (page
elements).

5.45.2.6. Free Text

You can type free text into a portal page by adding it to a table cell or directly to the page itself. You can also
copy-and-paste text into the table cells. To further edit (format) your text, use the buttons in the toolbar. These are
standard text-editing functions.
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Note: Common keyboard shortcuts can also be used, for example CTRL-B for bold, CTRL-U for underline,
CTRL-I for italic etc. Enter inserts a paragraph break (<p></p>) and Shift-Enter inserts a line break (<br>).

If you paste pre-formatted text into a page from other web pages or from a text editor application such as
MS Word, the text will keep the formatting.

5.4.5.2.7. Images
You can insert images/pictures directly into a portal page.

If you are in HTML mode (see HTML Mode on page 68 for more information) enter the HTML code img tag at the
location where you want to insert the image.

If you are in WYSIWYG mode you can copy-and-paste an image onto the page. You can also drag an image from
a website or browser and drop it into the required position on a page. Be aware that if the image you wish to use
is a hyperlink, then you must copy and paste it into the report, not drag-and-drop it, because dragging-and-
dropping an image that is a link will result in the browser trying to open the page the link points to instead of
pasting in the picture. In this case the image will not be moved to the Forsta Plus site, there will just be an image
tag referring to the original location of the image.

You can also right-click in a table cell and select Insert Image. This will open the property frame towards the right
side of the screen, where you can specify source (the URL to the image), width, height, border, alt (alternative
text, for use when image is not displayed), image alignment, and horizontal and vertical spacing.

5.5. Panel Activity Log

This menu command provides access to a page that logs activity in the panel. This will be primarily activity with
Panel Rules and Sampling. The page has two tabs:

e Overview - provides a general overview of the numbers and types of the various activities that have
occurred.

e Activity Logs - provides details of the activities.

5.5.1. The Overview Tab

This tab provides an overview of the various activities that have occurred in the panel during a specified period.

|,'-\- Search | Fram|01/12/2007 | o) To[14/12/2007 [0 |

Overview | Activity Logs

oK Error Abort In Queue Running
Job Execution/Posting 11 1 0 0 ]
Job Unposting 0 0 0 0 0
Sample Upload 2 0 0 0 0
Survey Synchronization Q n] Q 1] u]
Rule Set o u] o [} o
Rule 2 u] o [} o

Figure 76 Example of the Panel Activity Log Overview tab

The time and date when each activity occurred is logged. Use the From and To date fields to specify the time
period for which you wish to view the activity (either type the dates into the fields or click the icons to open date
selection calendars). Note that the From and To fields operate on both the Overview and Activity Log tabs
simultaneously - any activities listed in the Overview are also listed in the Activity Log.

During the time period specified in the example shown in the figure above there have been a total of 17 activities.
These include 12 job executions, 11 of which were successful and one of which resulted in an error, 2 sample
uploads and 3 rule changes all of which were successful.

Click on the appropriate activity result link (for example in the figure above the red 1 in the Error column) to go to
the Activity Log tab and view the details for that activity.

Go to the Activity Log tab to see the detalil list of all the activities.

5.5.2. The Activity Logs Tab

The Activity Logs tab lists the activities that have occurred in the panel during the specified period.
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|‘,;'\- Search From|01/12/2007 | O) To|14/12/2007 | 0

Overview | Activity Logs

Status All hg |
Log ID Date Time Duration Username Rule Set Recurring Activity Type z
= ™ Al % All v

@ 1257 06/12/2007 10:35:52 1 min jehanz_admin No Job Execution/Posting

Q 1258 06/12/2007 10:34:56 < 1 min johanz_admin No Job Execution/Posting

@ 1255 06/12/2007 10:27:20 < 1 min johanz_admin No Job Execution/Posting

@ 1254 06/12/2007 10:26:17 < 1 min johanz_admin No Job Execution/Posting

@ 1253 06/12/2007 10:24:23 < 1 min jehanz_admin No Job Execution/Posting

@ 1252 05/12/2007 12:08:57 < 1 min erikb No Sample Upload

@ 1251 05/12/2007 13:07:58 1 min erikb No Job Execution/Posting

@ 1250 04/12/2007 15:28:21 < 1min erikb No Job Execution/Posting

@ 1249 04/12/2007 15:25:43 < 1 min arikb No Job Execution/Posting

@ 1248 04/12/2007 15:21:50 1 min erikb No Sample Upload

@ 1247 04/12/2007 15:04:44 < 1 min erikb No Job Execution/Posting

@ 1248 04/12/2007 14:45:07 < 1min erikb No Job Execution/Posting

@ 1245 04/12/2007 14:43:27 < 1 min arikb No Job Execution/Posting

@ 1244 04/12/2007 14:41:52 < 1 min erikb No Job Execution/Posting

@ 1243 04/12/2007 14:22:37 1 min erikb No Rule

@ 1242 04/12/2007 14:20:43 1 min erikb No Fule

@ 1241 04/12/2007 14:16:24 2 mins arikb No Rule

Figure 77 Example of the Activity Log tab

The time and date when each activity occurred is logged. Use the From and To date fields to specify the time
period for which you wish to view the activity (either type the dates into the fields or click the icons to open date
selection calendars). Note that the From and To fields operate on both the Overview and Activity Log tabs
simultaneously - any activities listed in the Overview are also listed in the Activity Log.

In the event the list is extensive, you can search it using a number of criteria to reduce it to manageable
proportions. The search criteria are as follows:

e Status - the status of the activity. This can be:
o All — shows all activities.
0o OK - shows all activities that were concluded correctly.
o Abort — shows only those activities that were aborted before completion.
o Error — shows only those activities that were stopped due to an error.

¢ Log ID - select an operator and type in a number to, for example, show all activities after a specified Log
ID number. To reset, clear the field and click Search.

e Username - type in the first characters of a username to show only those activities that were initiated
while that user was logged on. To reset, clear the field and click Search.

e Rule Set —type in the first characters of a rule set to show only those activities that included that rule set.

e Recurring — select Yes or No to show only those activities that are recurring tasks or only those that are
not recurring, respectively. Select All to reset.

e Activity Type — select the type of activity that you are interested in.

You can sort the list by the various columns - click on the appropriate column header, and click again to reverse
the order.

Click on a blue Log ID link to open the Logging Details page for that activity.

5.5.3. The Logging Details Page

Click on a Log ID link on the Activity Logs tab to open the Logging Details page for that activity. This page gives
you detailed information on the activity, as shown in the example below.
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ﬁ Cloze
Log ID 1256
Date Time 06/12/2007 10:24:56
Duration < 1 min
Username johana_admin
Rule Set
Recurring No
Activity Type Job Execution/Posting
Status Error
Description
Initiating task: Sampling - Execute Job L

Error: Validation error {Job2): Validation error in job:
Mailing date can not be in the past.

Error: Execute Jobs failed:
Firmglobal.Confirmit.TaskManagement. TaskAbortExc
eption: Error in the application.

Server stack trace:
at
Firmglebal.Confirmit.Core.BusinessManagers.Enterpri

sePanel.SamplingManager.StartConcurrentSampling
(Int22 panelld, Int3...

Figure 78 Example of the Logging Details page

Click on the Close button in the upper-left corner of the page to close the page and return to the Activity Logs tab.

5.6. Database Cleanup

When working with the database, if you delete a question (a column) and regenerate the database, the question
and its data will no longer be visible or available in the database. However the data that was held in the column
will not be removed from the database file in the first instance, it will merely be hidden. This is for two reasons:

e With a large database the operation to delete the data will take a considerable amount of time and
resources and will have a significant impact on the server performance during the time the deletion is in
progress. It is therefore more practical to “save up” a number of deletion operations and run them
simultaneously, thereby only causing one disturbance in the server instead of several.

e If you should later wish to “undelete” the column, you can do this relatively easily while the data remains in
the database (see How to Undelete an Object on page 14 for more information).

Note: Once you have performed a Database Cleanup, the questions and associated data will be removed
permanently from the database. You cannot then “undelete”.

The Database Cleanup function completely removes deleted questions/columns, and the associated data, from
the database. Once the data is deleted by the Cleanup function, if you later need that data then you must re-
import it.

1. Goto the Panel Utilities > Database Cleanup menu command.

The Database Cleanup page opens. This page contains a list of the questions that have been deleted
from the database.

2. Check the boxes beside those guestions you wish to delete permanently from the database.

3. Click Delete Columns.

A confirmation box with the selected questions listed appears.

4. Click Delete to remove the questions and data permanently from the database.
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5.7. Survey Synchronization

The Survey Synchronization function checks all surveys associated with the current panel, and updates the panel
iffwhen there are changes. This function keeps the panel data up-to-date so samples can be selected
appropriately.

For example: If a panelist is sent a survey and responds immediately, then the panel database can be updated
such that the panelist is made available to be sent another survey. If on the other hand the panelist does not
respond, then that person will not be available for further surveys until a predefined time after the current survey
closes.

Note: The survey rule used to synchronize the database must have Survey Database (Synchronization) as
the source and Panel Database as the target (see Source Type > Survey Database (Synchronization) on
page 77 for more information).

Important

Surveys using batch statusing must include three “background” variables, named 'JobNumber*
‘RunNumber' and 'Panelistld’. They must be added as background variables in the survey tree, and they
must be included in the fields uploaded in the sample/job. JobNumber should be an open question node
with a suitable field width set, while RunNumber and Panelistld must be numerical open questions with a
suitable number of digits.

You can set the time interval for the synchronization function as required. Note that several rules depend on this
Survey Synchronization task to be run (see How to Create a New Survey Rule Template on page 210 for more
information).

1. Goto the Panel Utilities > Survey Sync menu command.

The dialog shown in the figure below opens.

Comment

Start Time ASAR w

(],

Figure 79 The Launch Survey Synchronization Task dialog

2. Type in a comment as appropriate, and select whether you wish to run the task as soon as possible or to
schedule it for later execution (if you schedule for execution later, you can set up a recurring task).

3. Click OK.

If you have selected to run the task as soon as possible, then the task is added to the queue. If you have
selected to run the task later, then the Recurrence Pattern dialog opens (see The Sampling Jobs List on
page 195 for more information).

5.7.1. Closing Surveys

If a job arrives at its specified closing date and the survey to which the job is associated can be closed, Survey
Sync will close the survey automatically.

If an open survey is closed manually, Survey Sync will update the job such that it is no longer in production.
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6. The Panel Management Menu

This menu contains the functionality enabling you to edit panelist details and create and edit the rules employed
to select samples from the panel.

o Hermmz = Panel Setup ~ Panel Utilities Y|F‘ane| Managemeant Y|Sarn|:v|e Management T

Current Rule Current Rule Set Rule List Rule Set List Data = Calculate Wariables Aggregated Wariable List Panelist Credits = Panel Settings

Figure 80 The Panel Management menu

6.1. Current Rule

Rules are used to change data and move/copy it from one place to another. For example you can use rules to
update the database or export panelist credits.

The Current Rule page shows the details of the rule selected in the Rule List (see Rule List on page 94 for more
information). When you select a rule in the Rule List, the Current Rule page opens at the General tab — see the
next section.

Note: Until you have selected a rule from the Rule List during the current session, the Current Rule menu
command will take you to the Rule List.

The following buttons are common for all the tabs in the page:

e Back — takes you back to Rule list
e Save - saves any changes made.

e Duplicate — makes a duplicate copy of the rule. Use this if you need to make a rule that will be similar to
an existing rule. You can then edit the copy.

e Execute — once you have set up the rule and are sure it is correct, click this button to run the rule.
e Validate Action Script — checks the script created in the Action tab to ensure there are no errors.

e Export Rule — exports the rule so it can be imported into a different Panel server.

6.1.1. The General Tab

The Rule Details > General tab shows the details of the currently selected rule. Here you can change the rule’s
Name, write in a Comment, select the source and target type and set the Status. The remaining information
cannot be edited.
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@ Back Save Duplicate Execute WValidate Action Script Export Rule

General | gource || Action Target

Rule ID 1254582

Rule Name MewRulel

Comment

Source Type Panel Database -
Target Type Panel Database -
Status @ Enabled ) Disabled

Created Date 7/3/2012 12:48:352 PM

Created By usermanual

Figure 81 Example of the Rule Details > General tab

The properties and fields are as follows:

e Source Type - select the type of source the rule is to use. The screen layout for the Source tab depends
on the type selected.

e Target Type - select the type of target the rule is to use. The screen layout for the Target tab depends on
the type selected.

e Status - select the required status for the rule. The options are:
0 Enabled - select to allow the rule to be run “as required”. This is the default setting.

o Disabled - select this option if you wish to prevent the rule from being run. This could be useful if you
have a recurring task, and wish to stop using this rule in that task for a period but do not wish to
change the task permanently.

e Created Date - the date the rule was created.

e Created By - the user name of the person who created the rule.

6.1.2. The Source Tab

Use this tab to specify the data source on which the rule is to operate. The data to be moved or changed can
come from a number of sources — select the Source Type. The subsequent screen layout depends on the Source
Type selected.

Note: A survey rule that is to be used to synchronize the panel database with a survey must have
"Survey" as its source.

6.1.2.1. Source Type > Delimited Text File

Select this option if the data source is a text file. The Source tab layout is then as shown in the figure below.
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General | Source | Action

Source Type

Formatting
Locale

Code Page

Truncate Open Ends

Uploaded File

Pick up from FTP Location

File Handling

Target

Delimited Text File

Tab Separated W

English {United Kingdom) i I:lUnil:nde
1232 - Western European (I50) w

200 DND Truncation

(Full Length) &l
@ No source file has been uploaded. Upload file...

o g

Map Fields

Figure 82 The Source tab with File selected as the Source Type

e Formatting — data is copied out as a text file. Select comma-separated or tab-separated as required.

e Locale - specify the area or country in which the data in the file is to be used. This will allow the system to
format fields such as date fields according to local standards.

e Unicode - check this box if the file is saved as Unicode. The Code Page property is then disabled.

e Code Page - select the code used in the file.

e Truncate Open Ends - when exporting data to File, system performance is heavily affected by the
number of “unlimited width” text fields in the exports (i.e. Open Text fields with no field width settings).
Open Text fields can be truncated by using this setting (default is 200 characters). Forsta strongly
recommends truncating Open Text field widths with this setting rather than choosing “Full length”, as this
will lead to significant improvements in processing time.

e Uploaded File - import files can either be uploaded directly in the browser, or placed on an FTP server
and retrieved from there (see below). Select the required option.

e Pick up from FTP Location - if your company has licensed the FTP add-on and it has been enabled, this
option will be active. You can then fetch the file to be uploaded from Forsta's FTP location. Forsta's FTP
address is specified as part of the enabling procedure and cannot be changed, so you must add only the
file name to this field. If you select this option, then you can also decide what to do with the original file on
the FTP site; leave it there or delete it (see below). Note that fetching from FTP can allow automation of
data flows, since you can set up the system to pick up files automatically

e File Handling - if you have selected to use the FTP option (see above), then you can decide what to do
with the file on the FTP site after it is uploaded; leave it there or delete it.

e Encrypted File - if your company has licensed the Encryption add-on and it has been enabled, the data
transfer encryption functionality makes it possible to perform secure data transfers in Forsta Plus. If the

source file has been encrypted by the sender using your PGP public key, you will need to decrypt the files
using your private key. Note that an administrator setting makes it possible to force every Forsta Plus user
within a company to use encryption and FTP server during data transfer.

Map Fields - Use this to map fields/columns with different names in source and target, from the source to
the Survey Database (go to Mapping Fields for more information).

Make the required settings and save them.

In the event you wish to upload a file click Upload File, if you wish to pick up the file from the FTP site
type the file name into the field.

For uploaded files, a File Upload dialog opens.

Browse to and select the file to be uploaded, then click OK to load the file.
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Field names in the uploaded file that are not the same as field names in the database must be mapped
manually to the appropriate fields in the database. Any field names in the uploaded file that are identical to
field names in the database will be mapped automatically. If any columns in the file need to be mapped
manually, a message will be presented below the Map Fields button. If this is the case and you wish to
map the fields, click Map Fields (see Mapping Fields on page 90 for more information).

4. Click Save to save the changes.

Note: If you have more than one BitStream data source in a panel and use rules to update them (see
Target Type > BitStream Files on page 85 for more information), then when you need to update one
BitStream set it is very important that you update all of them. If this is not done, then the “not-updated”
BitStream files may be inconsistent and will then produce incorrect results.

An example to illustrate the situation:

Assume that you have two separate BitStream sets, A and B, and you have a number of sampling jobs working
on each. When you run a sampling job on a BitStream set, this will cause the selected panelists to be noted in a
table of “dirty” panelists — these are essentially panelists who have been selected for one or more jobs without the
BitStream data source being informed (the BitStream data sources cannot know that a panelist has been selected
for a job until the files are updated). When a sampling job is run, dirty panelists are detected by looking in the dirty
table, so any panelists currently in the table will be checked and excluded/included as appropriate. If you now
update BitStream set A, the panelists involved here will no longer be dirty, so will be removed from the dirty table.
However BitStream set B has not been updated yet so still does not know about the dirty panelists. As these have
now been removed from the dirty table they will not be noted, and there is a very real chance that when running
another job on BitStream set B, panelists who should be excluded will be selected.

6.1.2.2. Source Type > Database

Select this option if the data source is a database. The Source tab layout is then as shown in the figure below.
Note that the option is only available for an On-Premise (server) installation, and is then set up in the System
Configuration.

General | Source | Action || Target

Source Type Database

Connection String

Table Name {:)

Query String O

Figure 83 The Source tab with Database selected as the Source Type

e Connection String — the connection string used to connect to the database.

e Table Name - to select entire table, write in the table name. Otherwise, define a Query String if you only
want part of the table. Here you must use SQL syntax.

6.1.2.3. Source Type > Panel Database

When you select Panel Database as the source type, the Source tab layout may be as shown below. Note that
the fields available can also depend on the target type selected.
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General | Source | Action | Target

Source Type Panel Database

Panel Variables s, 5jlable Selectad

email

EmailStatus

PanelistCreatedDats
PanelistModifiedDate
Unsubscribed

UnsubscribedDate
Aggregated.CTHVariable
Aggregated.SurveyHistoryVariable

==

<

Variable P rti
anable Froperties Date Mumeric/Teaxt Boolean Mulki

Survey History Variables

Select variables...

Credit Transaction History
Variables

Select variables...
Expression

Edit...

Figure 84 The Source tab with Panel Database selected as the Source Type

e Panel Variables - Search for and select the variables you wish to use.

e Variable Properties - Only available when the target is set to Delimited Text File. Select a variable in the
Panel Variables > Selected field; the properties appropriate to the variable then appear in the Variable
Properties field. Make the desired settings.

e Survey History Variables — click Select variables... to open a selection overlay, then select the Survey
History variables you wish to use. On completion, click OK to close the overlay and add the variables to
the field.

e Credit Transaction History Variables — click Select variables... to open a selection overlay, then select
the Credit Transaction History variables you wish to use . On completion, click OK to close the overlay
and add the variables to the field.

Note: When the Source Type is Panel Database and the Target is a File, you can format the values to be
copied, for example the date format, field widths etc.

6.1.2.4. Source Type > Survey Database (Synchronization)

Important

This source type can only be used if the source survey has JobNumber, RunNumber and Panelistld as
background fields in the survey. JobNumber should be an open question node with a suitable field width
set, while RunNumber and Panelistld must be numerical open questions with a suitable number of digits.
If you attempt to use this source type and one or more of these required fields are missing, the rule will
fail. Check the survey or use ‘Select columns’ from within the Source tab to ensure the fields are present.

Select this option if the data source is a survey database that is to be synchronized with the panel database. The
Source tab layout is then as shown in the figure below.

Note: When "Survey Synchronization" is enabled in Panel Management > Panel Settings > Features >
Enable Survey Synchronization, the "Survey Database (Synchronization)" option will be available in the
Source Type drop-down in the General tab (see The General Tab on page 73 for more information).
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General | Source | Action | Target
Source Type Survey Database (Synchronization)
Survey Status Complete e

Additional Survey Variables

Community Panel Variables Available Selectad

Search

email
PanelistCreatedDate
PanelistMadifiedDate
Unsubscribed
UnsubscribedDate ==

=

Survey History Variables Available Selectad

Search

CompletedDate e
GroupNumber .
InvitaticnDate

JablsClosed S
ResarvedDats
StartDate
SubSampleMumber

Figure 85 The Source tab with Survey selected as the Source Type

Note: A synchronization rule does not have an Execute button; the rule must be run from Panel Utilities >
Survey Synchronization (see Survey Synchronization on page 72 for more information).

When you select Source Type to be Survey Database (Synchronization), on the Target tab the Target Type
parameter must be set to Panel Database and the Target Mode parameter must be set to Update Data (see
Target Type > Panel Database on page 86 for more information).

The survey synchronization task will run for surveys that are connected to a data synchronization rule and have
the status Production. If a data synchronization rule is to be run for all surveys that are used in the sampling, go to
Sample Management > Sampling Settings > Survey Rule Templates (see The Survey Rule Templates Tab on
page 210 for more information) and set up a new template rule (see How to Create a New Survey Rule Template
on page 210 for more information), and choose the data synchronization rule for Update Completes, Update Non
Responder, or Survey Closing, then save your changes. Thereafter go to General and here select this rule to be
the Default Survey Rule Template. Note that this will only function for sampling jobs that are executed after this
setup has been created and saved.

To link a survey in to a Data Synchronization task that has already executed, go to Sample Management >
Active Jobs List and select the rule for Update Completes, Update Non Responder, or Survey Closing as
appropriate. Remember to check that the Sampling job is set to Production.

The fields and options on the tab are:

e Survey Status — select the required option. Additional fields will be activated depending on the selection.
All options and fields are described below.

o Complete - selects only data from surveys with the status Complete.

o0 Incomplete — selects only data from surveys with the status Incomplete.

o Non-starters — selects only data from surveys that have not been started (respondent data).
o All Responses - selects all the response data.

e Additional Survey Variables — type in the names of the questions you wish to retrieve from the survey,
separated by comma. These fields can be used in the action script. To access the field in the script, the
variables must be prefixed with ‘Survey.’. l.e. If you have selected interview_start as an Additional Survey
Variable, you must write Survey.interview_start in the script to get the value for the current panelist.
Click the Validate Action Script button to check the script.
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o Professional Panel Variables — fields selected here are retrieved and can then be updated. Any
variables selected here will be listed in the Available Fields column on the Action tab (see The Action Tab
on page 81 for more information).

e Survey History Variables — the fields in the Survey History table.

6.1.2.5. Source Type > BitStream Files

Select this option if the data source is to be a BitStream file. The Source tab layout is then as shown below.

General | Source | Action | Target

Source Type BitStream Files

Data Source All W

Expression

Edit...
BitStream wvariables Available Selectad
Search AccessFromCyberCafe
AccessFromLibrary
AccessFromHome s AccessFromWork
AccessFromOther AgePresOfkids
AccessFromOtherSpecified BusinessOwner
AccessFromSchool
ActivateDate
Active
ActiveDaysOnPanel
AddedDate =
ACLBrowser =
ACLUser

archiveflag

archiveflagdate

CanadianProvince

CensusRegion
ClosedCustomCounter
ClosedlobsCounter
ClosedTrackerCounter
CHRCounter b

Survey History Variables Specify Survey History Variables

Figure 86 The Source tab with Bitstream Files selected as the Source Type

e Datasource - this field contains a list of the available BitStream files. Select the required file to populate
the Available list.

e Expression / Edit — click to open an expression editor window so you can create an expression to select
the data you wish to be manipulated. The functionality in this window is the same as that for the Multiple
Panelist Editor. For further details (see Multiple Panelist Editor on page 106 for more information).

e BitStream variables - select the required variables.

e Survey History Variables — check this box only if exporting data if the result is to be files, or if you wish to
generate BitStream files.

6.1.2.6. Source Type > Survey Database

When you select Survey Database as the source type, the Source tab layout is as shown below.
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General | Source | Action || Target

Source Type Survey Database
Project IDs O Select projects
Keyword Filter {:} =
Use Test Database ]
Data Filter

Interview status filter D Complete Responses

|:| Incomplete Responses

D Screened
|:| Quota Full
D Error
Expression
Edit...
Date Filter |:| :ﬁ :ﬁ
All Data b

Data to be included _
{Only applies to recurring tasks)

Columns {‘:*} &ll Columns (no filter)
{:} Select... (no filter column selected)

O Survey Data Template

Figure 87 The Source tab with Survey Database selected as the Source Type

e Project ID — you can select a project either by its Project ID or by keywords. To use Project IDs, click the
radio button, click Projects, and select the required project(s) from the list (note that you can select more
than one).

o Keyword Filter - click the radio button and type in the required keyword. The filter will then match any
survey that is assigned the particular category or keyword in the Project Overview page. Refer to the
Authoring User Guide for further details.

e Use Test Database - check if you wish to test the rule using data from the Test database.
e Complete responses — selects only data from surveys with the status Complete.

e Incomplete responses — selects only data from surveys with the status Incomplete.

e Screened - selects only data from surveys with the status Screened.

e Quota full - selects only data from surveys with the status Quota Full.

e Error - selects only data from surveys with the status Error.

e Expression - here you can create an expression to filter the data that is to be manipulated by the rule.
Click Edit to open the Expression Editor window. Refer to the Authoring User Guide for further details.

e Date Filter - if you wish to include only data from between particular dates, check the box and select the
dates here.
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e Datato beincluded - select All Data, which updates all data, or Data Changed Since Last Run, which
updates only the data that has been changed since the previous update. Note that this setting only applies
to recurring tasks. Refer to the Authoring User Guide for further details.

e Columns - you can select the columns you wish to include; all columns, selected, or as used in the
selected template.

Go to the Target tab and click Map Fields to link source fields to target fields (see Mapping Fields on page 90 for
more information). Key fields can also be specified. If no key fields are specified, all source fields must match the
target fields by name, and the responseid and projectid on the source are used as the keys.

6.1.2.7. Source Type > Credit Transaction History

When you select Credit Transaction History as the source type, the Source tab layout is as shown.

@ Back Save Duplicate Execute Walidate Action Scripk Export Rule

General | Source | Action || Target

Source Type Cradit Transaction History

Selected Variables

Select variables...

Data Filter
Expression
Edit...
Date Filter :ﬁ :E
Relative Date Filter =]
Data to be included 4| pats -

(Only applies to recurring tasks)

Figure 88 The Source tab when Credit Transaction History is selected as the Source Type

e Selected variables - Lists the variables that are selected for the rule. Click Select Variables to open an
overlay where you can select the variables that are to be included.The available variables are those listed
in the Core Fields folder in the Panel Variables toolbox.

e Expression - if you wish to include only a sub-set of the data in the rule, click Edit and create the required
filter expression.

o Date filter - if you wish to include only data that was created within specific dates, check the box and
select the desired start and end dates. Note that if the box is checked, both date fields must be filled.

e Relative date filter - the Relative date filter allows you to export data from time intervals specified relative
to the scheduled export time. This functionality will be useful when you data exports are running as
recurring tasks.

e Datato beincluded - in the event you are running a recurring task, you may wish to include only data
that is new or changed since the previous time the task was run as this could reduce considerably the
volume of data to be transferred. Select as appropriate.

6.1.3. The Action Tab

Use the Action tab to specify actions that are to be performed on the data. The Action tab has four sub-tabs:

e Script - write into this tab the actions that are to be run on the selected source records. The actions are
run once for each record.
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e Global Variables - here you must define the script properties that will be available to all the records.
e Global Script - any actions written in this tab are run once at the beginning of the process.

e Post Script - any actions written in this tab are performed once after all the other actions have been
performed.

Note: You are not required to enter information into this tab. However, any scripting entered on this tab
must be in JSCRIPT.NET format. Refer to MSDN.COM for further details.

Fields selected in the Source tab (see The Source Tab on page 74 for more information) are listed in the
Available Fields column. These fields are available as Strongly Typed Properties in the script code.

If you wish to change data, write the required action into the Action field.

6.1.3.1. The Script Tab

Into this tab you must type in the actions that are to be run for the selected source records. Each action will be run
once for each selected record.

General | Source | Action | Target

Script | Global Variables || Global Script | Post Script

Write in here the actions that are to be run on the selected source records, The actions are run once for Available Variables
each record.

Want to improve your scripting experience? activated fad
active

age

age_groups
Aggregated.ComplatedSurveyStatusLastWeask
Aggregated.DatelastCompleted
Aggregated.DatelastInvited
Aggregated.NrOfCompletedSurveys
Aggregated.StoppedSurveyStatusLastWesk
Aggregated. TotalNrOfSurvaysInvitedTo
answer_rate

zppliances

booked

carowner

children

country

credits

dateofbirth

dateafmarriage

degree

dogowmner

empstatus

su

gender

householdsize

housing

income_usdollar

inrannectinn

//Updats the panelists
if{Language == 3)

recordsUpdated ++;

Figure 89 Example of the Script tab

Note that any variables selected in the Source tab are listed in the Available Variables column.

6.1.3.2. The Global Variables Tab

In this tab you must define any script properties that are to be available to the database records.
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General | Socurce | Action | Target

Script | Global Variables

Global Script | Post Script

You can define script properties that will be available to all records. They must then be defined here.
Want to improwve your scripting experience?

var fromMail : String = "mailer@confirmit.com”;
var toMail : String = "test@mycompany.com”;
var recordsUpdate

int = 0

Figure 90 Example of the Global Variables tab

6.1.3.3. The Global Script Tab

Any actions written here are performed once at the beginning of the process. Here you could, for example, tell the
system to send you an email to inform you that the scripting procedure is about to start.

General || Source | Action

Target

Script || Global variables | Global Script

Post Script

Actions written here are run once at the beginning of the process.
Want to improwve your scripting experience?

//E.g. send email when the rule starts
var subject : String = "Rule started";

var body : String = "Started: " + DateTime.Now.ToString():
SendMail{ fremMail, toMail, subject, body):;

Figure 91 Example of the Global Script tab

6.1.3.4. The Post Script Tab

Write into this tab any actions that you wish to be performed once, only on completion of the other Script actions.
An example here could be to tell the system to send you an email once the scripting process is complete.
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General | Source | Action | Target

Script || Global variables | Global Script | Post Script

Actions written here are performed once, after all other actions have been performed. -~
Want to improwve your scripting experience?

//E.g. send email when the rule has finished

var subject : String = "Rule finished";

var body : String = "Finished: " + DateTime.Now.ToString([):
body == "Records updated: " + recordsUpdated:

SendMail( fremMail, toMail, subject. body);

Figure 92 Example of the Post Script tab

6.1.4. The Target Tab

Use the Target tab to select the target for the data defined in the Source tab (see The Source Tab on page 74 for

more information). The fields available on the Target tab depend on the Target Type that you select.

Note: A survey rule that is to be used to synchronize the panel database with a survey must have "Panel

DB" as its target.

6.1.4.1. Target Type > Delimited Text File

The fields available when Delimited Text File is selected as the Target Type.

General | Source | Action | Target

Target Type Delimited Text File

File Name Test_file

Formatting Tab Separated + || Set Export Field Name...
Locale English (United Kingdom) W

Truncate Open Ends 200 DND Truncation (Full Length) &

Open End Handling Include Open Ends b

File Transfer =]

Encrypt File =)

Email Address documentation@confirmit.com

Figure 93 The tab when File is selected

e File Name — type in the name of the file the data is to be copied to.

e Formatting — the data is copied out as a text file. Select Comma Separated, Tab Separated or Custom as

required.

e Custom Delimiter - if you have selected Custom, select the delimiter you wish to use.

e Locale - specify the area or country in which the data in the file is to be used. This will allow the system to

format fields such as date fields according to local standards.

e Truncate Open Ends - when exporting data to File, system performance is heavily affected by the
number of “unlimited width” text fields in the exports (i.e. Open Text fields with no field width settings).
Open Text fields can be truncated by using this setting (default is 200 characters). Forsta strongly

recommends truncating Open Text field widths with this setting rather than choosing “Full length”, as this

will lead to significant improvements in processing time.

e Open Ends Handling - defines how open ended questions are handled. The options are:
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o Include Open Ends - all open end questions are included in the export.
o0 Exclude Open Ends - no open end questions are included in the export.

o0 Open Ends Only (one row per respondent) - only open end questions are included in the export file,
with one row in the file for each respondent (all the answers for each respondent are in the same row).

0 Open Ends Only (one row per answer) - only open end questions are included in the export file, with
one row in the file for each answer given.

e File transfer - export files can either be sent by email or placed on an FTP server. FTP may be a good
option for large volumes of data, since emails with large attachments may be blocked. FTP can allow
automation of data flows, since files can then be picked up automatically by another system/process. Note
that FTP transfer can be enforced as a company setting, in which case the email option will not be
selectable. Refer to the Administrator manual for further details.

e Encrypt file - if your company has licensed the Encryption add-on and it has been enabled, the data
transfer encryption functionality makes it possible to perform secure data transfers in Forsta Plus. If the
source file has been encrypted by the sender using your PGP public key, you will need to decrypt the files
using your private key. Note that an administrator setting makes it possible to force every Forsta Plus user
within a company to use encryption and FTP server during data transfer. Check the box to use file

encryption.

e Email Address —the email address to which the file is to be sent.

Note: When the Source Type is Panel Database and the Target is a File, you can format the values to be
copied, for example the date format, field widths etc.

6.1.4.2. Target Type > Database

The fields available when Database is selected as the Target Type.

General | Source | Action | Target

Target Type Catabase

Connection String

Table Name

Figure 94 The tab when Database is selected

e Connection String — type in here the connection string used to connect to the database.
e Table Name - type in here the name of the table into which the data is to be copied.

e Mapping Setting — you can map fields from the source to the fields in the database table.

6.1.4.3. Target Type > BitStream Files

The fields available when BitStream Files is selected as the Target Type.

General || Source | Action | Target

Target Type EitStream Files

File Name

BitStream Name

Figure 95 The tab when BitStream Files is selected

¢ File Name — type in here the name of the BitStream file into which the data is to be copied.

e BitStream Name — type in here the name that is to be displayed for the BitStream files
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6.1.4.4. Target Type > Panel Database

The Panel Database target type is used to update the database.

General || Source | Action | Target

Target Type PanelDatabase

Target Mode Update Data b

Figure 96 The tab when Panel Database is selected

Note: A survey rule that is to be used to synchronize the panel database with a survey must have "Panel
Database" as its target.

e Target Mode - this property has different options available depending on the Source and Target
selections.

When both Source and Target are Panel Database:

0 Update Data - records from the source will update any matching records in the target database. The
selected key field will be used to match records from the source to records in the target database. Any
records in the source database that do not match the selected key fields in the target will be ignored.

o Delete Data - when the Action tab contains an action script that includes the DeleteCurrentPanelist()
function, selecting Delete Data will delete from the panelist database any unsubscribed panelists that
are selected by the filter currently applied in the Source tab. Note that if you continue with this action,
the selected panelists will be permanently removed from the database and cannot later be retrieved.

Note: Only panelists that are registered as Unsubscribed will be deleted from the database.

When a source other than Panel Database is selected, you can choose between the four modes listed
below. In all the modes the user will be asked to provide a key (see Key field below). The keys available
are respid, responseid, and any field in the panel database that has an index. To create an index on a field
in a panel database, go to the question properties of the field and set the "Indexed" property (available on
single and open text questions with a field width set), and then re-launch the survey. By employing this
setting, you can then use for example email address, membership number etc. as a key. The rule
executer reads the value of the selected key field in the incoming data file and checks to see if a row with
the same key already exists in the target.

0 Update data - use if the source is a Panel database, or if the Source is a file, and the file includes a
Response ID column. Any records in the source that already exist in the target panel database will be
updated with values from the source. Any records in the source that do not already exist in the target
panel database will be ignored.

o Append data - use if the Source is a file, and the file does not include a Response ID column. Any
records in the source that do not exist in the target database will be added to the target database. Any
records in the source that already exist in the target database will be ignored.

o Append with key - use if the Source is a file and the file includes a Response ID column.

0 Merge data - all the data from the source will be added to the target panel database. Any records in
the source that already exist in the target database will be updated, and any records in the source that
do not currently exist in the target database will be added to the target database.

When you select Source Type to be Survey (see Source Type > Survey Database (Synchronization) on page 77
for more information), on the Target tab the Target Type must be set to Panel Database and the Target Mode
must be set to Update.

When you set the Source Type to be Survey Database (see Source Type > Survey Database on page 79 for
more information), the target tab includes the Map Fields button (see Mapping Fields on page 90 for more
information).

6.1.4.5. Target Type > None

This type of "target" needs an Action script (see The Action Tab on page 81 for more information) but produces
no data output. Use this option if you for example wish to test a rule, send emails, log rules etc.
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6.1.4.6. Target Type > Credit Transaction History

The fields available when Credit Transaction History is selected as the Target Type.

General || Source | Action | Target

Target Type Credit Transaction History

Target Mode | Update Datz 2

Figure 97 The tab when Credit Transaction History is selected

e Target Mode — specify how the source data is to be added to the database.

You can choose between two modes for importing the data, listed below.

0 Update Data - use if the Source is Credit Transaction History, or if the Source is a file and the file
includes a CreditTransactionHistory column. CreditTransactionHistory is the key when file is the
Source. Any records in the source that already exist in the target Credit Transaction History will be
updated with values from the source. Any records in the source that do not already exist in the target
Credit Transaction History will be ignored.

0 Append Data - use if the Source is a file. The key can be selected to be either responseid or email.
Any record in the Source with a panel record matching the key value will be added to the target Credit
Transaction History. Any records in the Source that do not have a panel record matching the key value
will be ignored.
6.1.4.7. Target Type > Excel File

This enables you to export the data as an Excel file. The fields available when Excel File is selected as the Target
Type are as follows.

General | Source || Action | Target

Target Type Excel File

Excel Version | Microsoft Excel 2007 (.xlsx)
Locale English (United States) -
Truncate Open Ends 200 Mo Truncation (Full Length) =
Encrypt File

Email Address documentation@confirmit.com
File Transfer Email -
Override Email Options

Override Filename

Figure 98 The tab when Excel File is selected

e Excel version - select the version of the Excel file to which the data is to be transferred. Microsoft Excel
97-2003 and Microsoft Excel 2007 are supported.

e Locale — specify the area or country in which the data in the file is to be used. This will allow the system to
format fields such as date fields according to local standards.

e Truncate Open Ends - when exporting data to Excel, system performance is heavily affected by the
number of “unlimited width” text fields in the exports (i.e. Open Text fields with no field width settings). For
Open Text questions with no field width specified, you are recommended to truncate texts to improve
performance. If a number of characters is specified for the Open Ends Width, any texts longer than this
limit will automatically be truncated. If No Truncation (Full Length) is selected, the whole text will be
imported/exported, but the task will take significantly longer to execute.
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e Encrypt file - data transfer encryption functionality makes it possible to perform secure data exports from
Forsta Plus. The encrypted files can then be either ordered by email or sent to the FTP server for
downloading. The users will have to decrypt the files using their private PGP encryption keys. Note that
your company must license the Data Transfer Encryption add-on for this option to be available.

e Email Address —if Email is selected in File Transfer, add to this field the email address to which the file is
to be sent. Default is the user's (your) registered email address.

e File transfer - export files can either be sent by email or placed on an FTP server. FTP is the
recommended option for large volumes of data, since emails with large attachments may be blocked. FTP
can allow automation of data flows, since files can then be picked up automatically by another
system/process. Note that your company must license the FTP add-on for this option to be available (refer
to the Authoring User Guide for more information).

e Override Email Options - when selected, allows you to override the standard export email options and
customize both the subject and the email that will be sent to the export recipient. Checking this box
displays a number of additional options.

e Override Filename - allows you to override the system-generated name. Tick this check-box to open the
file name text-box. Here you can edit the system-generated name. Note that when exporting Survey Data
to the FTP server in Survey Data &gt; Exports or Data Processing rules, the Override Filename option
accepts relative paths, as for example “.\..\myftpfile_in_another_folder.txt". In this case the file will not be
stored in the default folder (“ProjectsData\p123123” or “RulesData\RuleN”), but rather directly under the
(Company) Download folder.

6.1.5. How to Duplicate a Rule

To save time while creating a new rule, if you have an existing rule that is similar to the one you require then you
can duplicate it.

1. Inthe Current Panel Rule page, click Duplicate.

The Duplicate Panel Rule dialog opens.

Rule Name

Cancel Finish

Figure 99 The Duplicate Panel Rule dialog

2. Type in a name for the new rule, then click Finish.

The rule is duplicated, and will appear in the Panel Rules list. The Panel Rule Details page opens showing
the new duplicate rule. You can now edit the new rule as required.

Note: To prevent two rules sharing the same BitStream set, when arule is duplicated, the BitStream set is
also duplicated and the new BitStream set is given a new name. The new name is "<original file name> -
Copy".

6.1.6. How to Execute a Rule
Run the rule to perform the actions that are specified.

1. Inthe Current Rule page, click Execute.

The rule is checked to ensure the required information is present. If it is acceptable, the Rule Execution
Properties dialog opens.
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6.

Rule Execution Properbes

Rule Cermo Rule 1 [387)
Comment | |
Start Time | ASAP v |

Figure 100 The Rule Execution Properties dialog

Type any comments into the Comment field.
In the Start Time field, select when you want the task to be run.

Select ASAP to run the job as soon as it gets to the front of the task queue in the server. Select Schedule
for Later Execution if you want the job to be run at a specific time in the future or if you want the job to be
repeated at regular intervals.

Click OK.

If you have specified that the task is to run as soon as possible (ASAP) then a Task page opens showing
a progress bar, the Task ID and the sequences being run and completed.

If you have specified that the task is to be scheduled for later execution, then a Recurrence Pattern dialog
opens (see The Sampling Jobs List on page 195 for more information).

On completion, the text Task Completed is displayed at the bottom of the sequence list.

Click OK to close the Task page and return to the Panel Rule Details page.

6.1.7. Validating an Action Script

Click to check the script for compilation errors. If errors are found, they will be listed in a separate window. You
must then correct the errors and validate again.

6.1.8. How to Export a Rule

You can export rules to other servers and/or panels. Proceed as follows:

1.
2.

Save the rule to ensure all changes/updates are included.
Click Export Rule.
The Export Rule dialog opens.

(Rule Export

Email recipient |adam.app|e@confirmit.cn:rn |

Comment | |

Figure 101 The Rule Export dialog
Edit the email address to which the rule is to be sent, and add a comment, as necessatry.

Click OK.

An email is sent to the specified address with the rule attached. This rule must now be imported into the
destination server (see How to Import a Rule on page 96 for more information).
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6.1.9. Mapping Fields

When uploading a .txt file from the FTP site (refer to the Authoring User Guide for further details on FTP), or when
creating rules with Source Type set to Survey Database and Target Type set to Panel Database, the Map Fields
button becomes available. This functionality allows you to map fields that have different names in the source and
target.

Note: When creating rules to upload .txt files from the FTP site, if the file exists on the FTP site when the
rule is created then the Map Fields button will be available. If the file does not yet exist on the FTP site
then the button will not be available.

| General " Source " Action I Target

Target Type PanelDatabase
Target Mode | Merge Data w
| Map Fialds...

Figure 102 The Target tab with the Map Fields button

1. Click Map Fields to open the Field Mapping page.

General | Source AmonITarget

|® Back Map Fields Autornap Fields Remove Mapping Remove All Mappings Toggle Key Field ‘

Key Fields (source/target) <Source Project 1d>, <Source Responseld> (&)

Field Name Type & Field Name Key Field | Mapped To Type Length 2
[ Il |1 ] [ I =~ ]

O age tinyint A O email nvarchar 128

) ageNum tinyint O Password nvarchar 40

(O carsTestad_1 bit (O Respenseld int 4

() carsTestad_2 bit (& Unsubscribed bit 1

() carsTestad_3 bit (O UnsubscribedDate smalldatetime 16

(0 carsTestad_4 bit

() carsTested_5 bit U

() carsTested_se bit

() carsTested_98_other nvarchar

() carsTested_99 bit

) dest tinvint

Figure 103 Example of a field mapping page

The Source Fields column lists all the fields available in the source project, and those available in the
target.

2. Select the two fields (one field in each list) that you wish to map, then click Map Fields.

The two fields are mapped, and the field names from the source are added to the Mapped To column in
the Target Fields list. You can map as many pairs of fields as you wish, performing one mapping at a time.
The figure below shows two mappings; email - name and Responseld to responseid.
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Target Fields (Panel p1619668)

Field Mame = Key Field Mapped To Type Length e
| | | | e -
{:} email name nvarchar 128
) Password nvarchar 40
O Responseld responseid int 4
) Unsubscribed bit 1
) UnsubscribedDate smalldatetime 16

Figure 104 Two fields from the source are mapped to fields in the target

o Key Fields - the key field is used as a unique identifier to indicate which records are to be updated and
which are to be appended. The default key fields are the source Project Id and the original Responseld
from the source. These will be stored as system fields in the target database and will be used the next
time you run the same source/target combination. You can change the key fields if required. To do this,
select a field in the Target Fields list and click Toggle Key Fields. A small key icon is displayed in the Key
Field column alongside the selected field name, and the field name is also displayed in the Key Fields row
towards the top of the page . Note that only fields that are indexed can be used as key fields. Refer to the
Authoring User Guide for further information on indexing fields.

|@ Back ap fields Automap Fields Rermowe Mapping Rernove All Mappings Toggle Key Fisld

Key Fields (source/target) nams/ema=il

Source Fields (Survey p0039555) Target Fields (Panel p1619668)

Field Name «~ Type = ield Name Key Field Mapped Tc
O age tinyint : O email H %‘ name
O ageNum tinyint O Password
) carsTested 1 bit 1 Respbonseld resoonseid

Figure 105 Toggling the key fields

e Automap Fields - You can perform an automatic mapping sequence. This maps all pairs of fields that
have matching names in the source and the target. To run this, click the Automap Fields button. Note
that the type of the fields is ignored during Automapping.

6.2. Current Rule Set

A Rule set is a collection of rules that are to be run as one. The rules are run in the order in which they are listed
in the set. Go to the Panel Management > Current Rule Set menu command to open the latest rule set selected
from the Rule Set List. If no rule set has been selected during the current session, then the Rule Set List will be
displayed (see Rule Set List on page 97 for more information).

6.2.1. The General Tab

The Rule Set Details page opens at the General tab.
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@ Back Save Execute

General | Rule Management | Report

Rule Set ID 41

Rule Set Name Docl

Type Recurring
Comment

No comment

Status (® Enabled ) Disabled

Disable Sampling |:|
When Executing

Date Created Z5/08/2008 09:32:57
Created By usermanual
Date Updated 26/08/2008 09:323:16
Updated By usermanual

Figure 106 Example of the Rule Set Details page > General tab

¢ Rule Set ID - the identification number for the rule set. This number is generated automatically by Forsta
Plus and cannot be changed.

¢ Rule Set Name - the name given to the rule set when it was created/last edited. You can change this
name as required.

e Type —the type of rule set. The options are:

0 Ad Hoc - arule set that is created for a specific use/event.

o0 Recurring — a rule set created to perform a long-term job, that will normally recur at regular intervals.
e Comment — a description of the rule set, to simplify identification.
e Status - the status for the rule set.

0 Enabled —allows the rule to be run “as required”. This is the default setting.

o Disabled - select this option if you wish to prevent the rule from being run. This could be useful if you
have a recurring task, and wish to stop using this rule set in that task for a period but do not wish to
change the task permanently.

e Disable Sampling When Executing — check the box to prevent sampling being performed on the
database while the rule set is being run.

¢ Date information — for information only.

6.2.2. The Rule Management Tab

Use this tab to add rules to the Rule Set, and to specify what is to occur in the event Forsta Plus discovers an
error whilst the rule set is running.

6.2.2.1. How to Add a Rule to the Rule Set

1. Go tothe Panel Management > Current Rule Set menu command.
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2. In the Rule Management tab, click the down-arrow beside the Rule field to open a drop-down list of the
rules available.

General | Rule Managerment Report

Save Rule Populate Panel Fields

= % Doct

E Tesk R )
Duplicate rule 2
E Derno R ompormrerrors

Pasting Rule

Figure 107 Selecting a rule to add to the rule set

3. Select the required rule from the list and click Add.

The rule is added to the rule set. Once a rule is added to the set, it is removed from the list.

General | Rule Managerment Report

Save Ru|e| V| o add

= % Doct
D Test Rule 1 (Skop an erraor)
E Demo Fule 1 (Skop on errar)
E Populate Panel Fields (Stop on erraor)

Figure 108 The rule added to the rule set

4. Double-click on the rule to open its Details pane, then make the appropriate settings.
5.  On completion, click Save to save the changes.

You can add as many rules as required to a rule set, and you can add a rule to as many different rule sets are you
wish. The rule sets to which a rule has been added will be listed in the Rule Set Name column in the Rule List
(see Rule List on page 94 for more information).

6.2.2.2. Error Handling in a Rule Set List

To set up the properties for a rule in the set, double-click on the rule in the left column to open the Details page.

General | Rule Management | Report

| Save Rule | v & add
On error : Rule Name Cutput Rule
O continue Comment
@ stop Source Panal Database
O jump to Target File
Variables
Exprassion
Script

Created Date  22/08/2008 09:57:25
Created By
Updated Date  26/08/2008 09:36:15

Updated By usermanual

Figure 109 Example of the Rule Management tab
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e On error — select the function you wish to occur in the event Forsta Plus discovers an error whilst the rule
set is running. The options are:

o Continue — select this option if you wish the rule set to continue running.
0 Stop — select this option if you wish the rule set to be stopped.

o Jump to — select this option if you wish the current rule to be stopped and the rule set to jump to

another rule. If you select this option, you must then select the rule to which the set is to jump, from
the list below the “on error” options.

6.2.3. The Report Tab

This tab provides an overview of the contents of the various rules selected in the Rule Management tab.

General || Rule Management | Report

=4 Printer Friendly Version

Rule Sat Name: Docl

Type: Recurring

Status: Enabled

Date Created: 26/08/2008 09:32:37 by usermanual
Date Updated: 2&/08/2008 09:26:22 by usermanual

L Rule Name: Output Rule - Created: 22/08/2008 09:57:25 by
Source: PanelDatabase

Target: File

Condition:

Action

On Error:
Stop

Rule Name: Docl - Created: 22/08/2008 12:25:02 by usermanual

Source: Survey
Target: PanelDatabase

Action

On Error:
Stop

Figure 110 Example of the Report tab

Click Printer Friendly Version to open the report in a new window, formatted to be printed out or saved.

6.3. Rule List

Go to the Panel Management > Rule List menu command to display a list of all the rules in this panel. From this
tab you can create new rules, and import rules from other panels.

‘)( Delete [ Search [/ Reset Status Enabled = Mew Rule | Import Rule

[F| 10 Rule Name Source Targst Rule Set Name Created By Last Exscutad Last Exscuted By @

— All - Al - - - =

[ 1294687 DocPanelz Pansl Database Pansl Database Apple Admin, Adam

7] 1294684 DocPanell Pansl Database Pansl Database Apple Admin, Adam

Figure 111 The Panel Rule List
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Click on a Rule Name link to open the Current Rule page for that rule (see Current Rule on page 73 for more
information).

In the event the Rule List is extensive, you can search for the required rule using the search criteria fields. Select
or set the appropriate criteria and click the Search button towards the right end of the search bar. The fields are
as follows:

ID - the automatically-generated identification number of the rule. Select the appropriate operator and type
a number into the field.

Rule Name - the name of the rule, defined by the creator on the Current Rule > General tab.
Source - the source to be used by the rule - defined by the creator on the Current Rule > Source tab.
Target - the target to be used by the rule - defined by the creator on the Current Rule > Target tab.

Rule Set Name - if the rule has been included in one or more Rule Sets, then the sets will be indicated
here as a comma-separated list.

Created By - the user name of the person who created the rule.

Last Executed - the date and time of when the rule was last executed. Select the appropriate operator,
then click on the Calendar icon to open a calendar and select the desired date.

Last Executed By - the user name of the person who last executed the rule.

6.3.1. How to Create a New Rule

1.

Click the New Rule Button towards the right end of the Panel Rule List toolbar.

The Add New Panel Rule form opens at the General tab. Note that until you have named and saved the
new rule, the other tabs in the form are inactive.

@ Back Save

General

Rule Name

Comment

Source Type Panel Database -
Target Type Panel Database -
Status @ Enabled ) Disabled

Created Date 7/3/2012 12:40:44 PM

Created By usermanual

Figure 112 The Add New Rule page
2. In the Rule Name field, type in a name for your new rule.
3. Type a comment/description into the Comment field so others can see what this rule is intended for.
4. Select the type of source the rule is to use (see The Source Tab on page 74 for more information).
5. Select the type of target the rule is to use (see The Target Tab on page 84 for more information).
6. Select the status for the new rule. The options are:

o Enabled - select to allow the rule to be run “as required”. This is the default setting.

-05 -



Forsta Plus 2022 Professional and Standard Panels User Guide Forsta Confidential

o Disabled - select this option if you wish to prevent the rule from being run. This could be useful if you
have a recurring task, and wish to stop using this rule in that task for a period but do not wish to
change the task permanently.

5.  On completion, click Save.

The new rule is saved and will now appear in the Panel Rules list. The system allocates a Rule ID to the
new rule, and this ID is displayed towards the top of the form. The form changes to the Rule Details form
(see Current Rule on page 73 for more information), and the Source, Action and Target tabs become
active. Go to these tabs and make the appropriate settings.

@ Back Save Duplicate Ewecute WValidate Action Script Export Rule

Genaral | gource || Action Target

Rule ID 1254582

Rule Name NewRulel

Comment

Source Type Panal Database -
Target Type Panel Database -
Status @ Enabled () Disabled

Created Date 7/3/2012 12:48:352 PM

Created By usermanual

Figure 113 Example of the Panel Rule Details form

Note: A rule that creates BitStream files from the panel database must be created before sub samples can
be created (see How to Create a New Sub Sample on page 144 for more information). For this rule, the
Source must be Panel Database, the Target must be BitStream, and SurveyStatus must be selected in the
Survey History Variables field.

6.3.2. How to Import a Rule

You can copy rules to other servers or panels by using the Rule Export / Import functionality (see How to Export a
Rule on page 89 for more information). Proceed as follows to import a rule into the current Panel or server.

Note: The rule must be available as an .XML file (zipped or open) in a folder accessible from the current
panel. The file will have been sent, attached to an email, from the originating server/panel.

1. Go to the Panel Management > Rule List menu command to open the Rule List window.
2. Click the Import Rule button towards the right end of the toolbar.

The Rule Import dialog opens.
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Rule Import

File to upload | |[ Browse... |

Rule Hame | |

Figure 114 The Rule Import dialog

Browse to and select the file.

4. Type a name for the rule into the Rule Name field.
Click OK.
The rule is imported and added to the Rule List.

Note: To prevent two rules sharing the same BitStream set, when arule is imported, its BitStream set is
also imported and the new BitStream set is renamed as "<original file name> - Copy".

6. Click on the blue Rule Name link to open the rule in the Current Rule window (see Current Rule on page
73 for more information).

6.4. Rule Set List

Go to the Panel Management > Rule Set List menu command to display a list of the rule sets available.

Rule Set List

¥ pelete| O search status Al v New Rule Set

O Fule Set Mame Type Last Executed Last Executed By 2
B | [an ~| = - = ]

0 =z Croc2 Recurring

D 7z Lol Recurring

Figure 115 Example of the Rule Set List

Click on the blue Rule Set Name link for the desired rule set to select that rule set and open the Current Rule Set
window (see Current Rule Set on page 91 for more information). In the event the list is extensive, use the search
functionality to reduce the list to a manageable size.

6.4.1. How to Create a New Rule Set

1. Inthe Rule Set List window, click the New Rule Set button towards the right end of the toolbar.

The New Rule Set dialog opens.

Mewr Rule Set

Rule Set Name | |

I o] 4 IlCance||

Figure 116 The New Rule Set dialog

2. Type the name of the new rule set into the field, then click OK.

The rule set is added to the list.

3. Click on the blue Rule Set Name link for the rule set to select it and open the Current Rule Set window
(see Current Rule Set on page 91 for more information). Here you set up the rule set properties and add
rules.

-97 -




Forsta Plus 2022 Professional and Standard Panels User Guide Forsta Confidential

6.5. Aggregated Variable List

When a new Professional Panel is created, a set of default Aggregated Variables will be added automatically to
the Aggregated Variables list. You can also specify additional Aggregated Variables. These variables are used in
aggregate queries to update the Panelist table based on information in the Survey History table. The Aggregated
Variable List lists all the aggregated variables available for this user.

|X Delete| [ search| 2 Resat New Aggregated Variab|e|

]| Name Loop Lavel Created Date Created By Updated Date Updated By 2

[0 creditBalance
[0 creditsReceived

[[] creditsUsed

CreditTransactionHistory
CreditTransactionHistory

CreditTransactionHistory

8/30/2012 11:55:56 AM g

8/30/2012 11:55:56 AM

8/30/2012 11:55:56 AM

[F] DateGfLastComplete SurveyHistory 8/30/2012 11:55:56 AM

[[] DateofLastParticipation SurveyHistory 8/30/2012 11:55:56 AM

[[] pateofLastSurveyInvitation SurveyHistory 8/30/2012 11:55:56 AM

[F] mumberofSurveysCompleted SurveyHistory 8/30/2012 11155156 AM

[£] mumberofSurveysCompletedLastMonth SurveyHistory 8/30/2012 11155156 AM

[F] MumberOfSurveysInProgress SurveyHistory 8/20/2012 11155156 AM

[F] mumberofSurveysinvitdTo SurveyHistory 8/30/2012 11:55:56 AM

[F] numberofSurveysSampledTo SurveyHistory 8/30/2012 11:55:56 AM

0 of 11 selected. Page 1
All a b c d e f g h i k | m n o p q r s t u v w x ¥ z

Figure 117 Example of the Aggregated Variable List

To open an Aggregated Variable, click on the blue Name link for that variable in the list. If the event the list is
extensive, use the search functionality to reduce the list to a manageable size.

6.5.1. How to Create a New Aggregated Variable

1. Go tothe Panel Management > Aggregated Variable List menu command.

The Aggregated Variables window opens.

2. Click on the New Aggregated Variable button towards the right end of the toolbar.
The New Aggregated Variable dialog opens.

e —

Name

Loop Level SurveyHistory -

Cancal || || || Finish

Figure 118 The New Aggregated Variable dialog

3. Type a name for the variable into the Name field.
4. Select whether you wish to use Survey History or Credit Transaction History, then click Finish.

The variable is created and added to the Aggregated Variable List, and the variable opens for editing.
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|@ Back Save CDuplicate

Name CTHVariable

Aggregate Operator Count

Panel Field Name

Condition
Edit
Expression COUNT(*)
Comment
Loop Lewvel CreditTransactionHistory
Created Date 2/28/2012 1:05:09 PM
Created By nigelb
Updated Date
Updated By

Figure 119 Example of the editing page for an Aggregated Variable

e Name - the name of the selected virtual variable. You can edit this as required.

e Aggregate Operator — select the type of operator you wish to use. Options are:
o Count - counts the number of rows in the table that satisfy the condition, and outputs the result.
0 Avg - totals the values in the table fields that satisfy the condition, and outputs the average value.

0 Min — examines the values in the table fields that satisfy the condition, and outputs the minimum
value.

0 Max — examines the values in the table fields that satisfy the condition, and outputs the maximum
value.

0 Sum - totals the values in the table fields that satisfy the condition, and outputs the result.

e Panel Field Name - specify the field in the Credit Transaction or Survey History table that the condition is
to be run on. Note that the fields available will depend on the Aggregate Operator selected.

e Condition — click Edit to open a condition editor window, then create the required condition (see Multiple
Panelist Editor on page 106 for more information). On completion, click Save to copy the condition to the
Expression field.

e Expression - the expression that will be used for the aggregated variable. This is arrived at by combining
the selected Aggregate Operator and Output Field Name, and the Condition.

e Comment — type in a comment or description for the variable.
e Loop Level - indicates the loop used - for information only.
¢ Date information — for information only.

Once you have created and saved the Aggregated Variable, it will be available for use in the Professional Panel
Variables field in the Current Rule > Source tab (see Source Type > Panel Database on page 76 for more
information).

6.6. Data

The Panel Management > Data sub-menu contains the items enabling you to edit panelist data, export, import
and create templates.
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Crata =

Single Panelist Editor

Multiple Panelist Editor
Exports
Imports

Templates

Figure 120 The Panel Management > Data menu

6.6.1. Single Panelist Editor
Go to the Panel Management > Data > Single Panelist Editor menu command.

This page lists the panelists registered in the database. In the upper pane, each panelist is initially presented as
his/her response ID in numerical order. In this pane you can specify the data columns that are to be displayed
(see Select Columns on page 101 for more information), and filter the list to focus on particular panelists. Click on
the column headers to sort the list by the selected header. Enter criteria into the search fields at the top of the
columns to display only those records that comply with the criteria.

—
Confimit .2

@ Single Panelist Editor

Leg Off 2

- |User: Apple, Adam

; Home * Panel Setup = Panel Utilities = [Panel Management = | Sample Management -

Current Rule Rule List Data = Calculate Variables Panelist Credits = Panel Settings

Filter: No advanced filter.

,,O Search Q Reset Select a View ------------- + Select Columns... Advanced Filter.., Clear Advanced Filter
responseid & email EmailStatus PanelistCreatedDate PanelistMaodifiedDate z
= =~ =~ e = - &

la@test.com 3/7/2012 12:56:00 PM 3/7/2012 12:56:00 PM

2a@test.com
Za@test.com
4a@test.com
Sa@test.com
Ga@test.com

LR SR S

7a@test.com

3/7/2012 12:56:00 PM
3/7/2012 12:56:00 PM
3/7/2012 12:56:00 PM
3/7/2012 12:56:00 FM
3/7/2012 12:56:00 PM
3/7/2012 12:56:00 PM

3/7/2012 12:56:00 PM =1

3/7/2012 12:56:00 PM
3/7/2012 12:56:00 FM
3/7/2012 12:56:00 FM
3/7/2012 12:56:00 PM
3/7/2012 12:56:00 PM

[ 1-50of 100000 ] i 2 3 < 3 (-] 7 =} 3 10 .

Details I All Surveys ” Completed Surveys || Surveys Started, Not Completed " Surveys Mot Started |

Click on an answer to update ONE panelist. Response ID: 1

|>< Delete Panelist Manage Credits... Select a Wiew ------------- + Select Rows...
Field Text Answer Code Answer Text =
email Email address la@test.com -

Mot Answered/Skipped
3/7/2012 12:56:00 PM
3/7/2012 12:56:00 PM
[VALUE HIDDEN FOR SECURITY RE...
Mot Answered/Skipped =

EmailStatus
PanelistCreatedDate
PanelistModifiedDate
Password

Unsubscribed

m

Page 1

Figure 121 Example of a panelist list in the Edit window

To select a panelist for editing, click the panelist’'s blue Response ID link. The selected panelist’s details are then
displayed in the Details pane in the lower part of the page (see The Panelist Editor Tabs on page 102 for more
information).

Note that if a panelist is locked out of the system because they have exceeded the permitted number of log-in
attempts (they have entered the wrong password too many times), then an Unlock panelist button appears in the
panelist's Details pane toolbar. Click this to unlock the panelist.

6.6.1.1. Search

The Search facility enables you to conduct a simple search through the list for the required panelist, though you
must know the panelist's Response ID.
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To conduct a search for a panelist, select an operator, type the characters of the required panelist's Response ID
into the data field, then click Search.

6.6.1.2. Select Columns

Click Select Columns to open a window that allows you to specify which database columns are to be displayed
in the Panelist Editor window.

/= Select Columns - Windows Internet Explorern

E, https: [ fauthor, testlab, firmglobal . netfconfirmf authoring  EnterprisePanel/EPResponseColumnSelector, as

Select Columns Confirmit. /™

Select from the available items below everywhere =

Select action on views
| Update Default V|

Find what || || Find |

[ ] Match case
[ ] Match whole words only

Available itams Selectad items
D Form Name ﬁ |:| Form Mame
[] =ctivated = [] email
active language
=
D address_city
|:| address_post
] =c=
|:| age_groups
|:| answer_rate
— ¥
| O | | Cancel
Done €0 Internst H100% v

Figure 122 Example of the Select Columns window

To select columns:

1. Inthe Available items column, click on the data column(s) you wish to be displayed in the list, to highlight
them.

Note: In the event the database contains a large number of columns, use the built-in search facility in the
upper pare of the window to reduce the list to a manageable size.

2. Click the >> button to move the highlighted items over to the Selected Items column.
3. Click OK.

The Panelist Editor window is updated automatically when you click OK.
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6.6.1.3. Advanced Filter

Use this function to mount an advanced search for panelists, using logical expressions based on selecting a
combination of specific answers provided by the panelists in the database columns.

1. Click Advanced Filter.

The filter window opens. The left column will contain a list of all the database columns.

-- Web Page Dialog,

Expression:
Search: Operators Add here WValidate
| | OAnd
vatefRirth - Date Of Birty H Oop
Gender - Gender of the panealist |:| @ Hene

LivesInCity - Panelist lives in the

Password 0

RecodedFieldl - This field can be Hot
Responseld
UserLagen Functions

@ Equal

In

O Between

O =

0=

O =

O <=
Contains
Left
Right

OIsNuII

|http 1/jauthar testlab. firmalobal . net fconfirmf authoring/EnterprisePanel{Sampling/ExpressionPopUpEditorContainer . aspx?ProjectId: | Internet

Figure 123 Example of the Advanced Filter window

2. Click on an item in the left column to select it.

In the event the list is extensive, type characters into the Search field to reduce the list to a manageable
size to enable you to find the question you are looking for. Once you have selected a question in the first
column, the second column shows the possible answers for that question.

The number/text/date field and the available operators change to suit the selected item.

Select or type in data as appropriate into the field.

Click Add Here to add the selected data to the expression.

Select the required operator, and again click Add Here to add it to the expression.
Repeat the steps until the desired expression is built.

On completion, click OK to apply the expression to the panel.

Click Search.

© N o o &~ w

The list of panelists is reduced to show only those who answer to the expression.

You can now more easily find the panelists you need to edit the details for.

6.6.1.4. Clear Advanced Filter

Click this button to clear the expression from the advanced filter and reset the list of panelists.

6.6.1.5. The Panelist Editor Tabs

These tabs display the information relevant to the selected panelist.
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6.6.1.5.1. The Details Tab

This tab shows the details of the selected panelist.

Details I All Surveys ” Completed Surveys ” Surveys Started, Not Completed " Surveys Not Started |
Click on an answer to update ONE panelist. Responseld: 1
¥ Delete Panelist select a View | -- ---- & | select Rows..,
Field Text Answer Precode Answer Text e
CreatedDate 22/07/2010 16:42:00
dob 02/06/2010 00:00:00
email ahth@confirmit.com
ModifiedDate 22/07/2010 16:42:00
Password [VALUE HIDDEN FOR SECURITY REASONS]
Unsubscribed False
UnsubscribedDate Mot Answered/Skipped
Page 1

Figure 124 Example of the Details tab for a selected panelist

Click the Select Rows button located towards the right end of the lower pane's toolbar if you wish to display only
a selection of the rows listed in the lower pane (see Select Rows on page 105 for more information).

The Created Date and Modified Date rows cannot be edited. These are set automatically by the system when the
panelist record is initially created and when/if the record is later edited, respectively. Both these fields can be used
when sampling, searching, in rules etc.

To edit the remaining details, click on the appropriate link in the Answer Text column. A separate Editing window
opens. Here you can type in the new details. On completion, click OK to save the changes and close the window.
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IS Lpdate country - Windows Internet Explorer,

£ | https:ffauthor, testlab, firmglobal net foonfirm) authoring/EnterprisePanelfEPQuestionUpdate, aspx?ProjectId=p011 %
Update country A Confirmit. ™
Select a new answer - Click "0K' to update the response(s) everywhere e-'

ﬁ Close
p Search
Answer Precode Answer Text 3
| | |

O 1 us A

) 31 Metherlands

) 32 Belgium

{::} 33 France

) za Spain

) a4 United Kingdem 1

() =253 Ireland

() 354 Iceland

() =38 Finland

) 270 Lithuania

M =71 Latvia b/

Page 1

Mot answered D | Ok || Cancel
Dane € Internet *100% -

Figure 125 Example of a panelist details editing window

6.6.1.5.2. The All Surveys Tab

This tab lists all the surveys the selected panelist has been involved with. This list is basically a combination of the
lists in the remaining tabs in this area of the window. Note that this list also includes closed and/or deleted
surveys, and surveys where the panelist has the status "Reserved".

6.6.1.5.3. The Completed Surveys Tab

This tab lists all the surveys the selected panelist has completed. Note that this list also includes closed and/or
deleted surveys, and surveys with the status "quota full" or "screened".

6.6.1.5.4. The Surveys Started Not Completed Tab

This tab lists all the surveys the selected panelist has started but not yet completed. Surveys with the status
"quota full" or "screened" are not included here; these are included in the Completed Surveys list.

Note that this list also includes closed and/or deleted surveys.

Links to the surveys are provided. Click the link to open a new window with the URL to the survey, as shown in
the example below. If you wish to view the survey, copy the URL into your browser.
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{= Survey Link - Windows Internet Explorer

& | http:jisampling2. firmglobal. netfconfirm/authoring/EnterprisePanel fSurvey LinkPopup, aspx?PanelistId=301809408SurveyId=p0431 3668Project +

Survey Link

ﬁ Cloze

Survey Link (Url) http://sampling2.firmglobal.net/wix/p0421266.aspx?r=18s=PHKRFMCD

|© 2007 Confirmit

I & Internet F 00 -

Figure 126 Example of the Survey Link window

6.6.1.5.5. The Surveys Not Started Tab

This tab lists all the surveys the selected panelist has been sent but has not yet started. A link to the survey is
provided. Note that this list also includes closed and/or deleted surveys.

6.6.1.6. Manage Credits

Click the Manage Credits button, located towards the right end of the details tab in the lower pane's toolbar, to
open an overlay that allows you to edit the credit transactions for the selected panelist.

Manage Credit Transactions

Response ID: 1

‘p Search Q Reset Add Credit.. Select a View  ------------- w Select Colurmns... ‘
TransactionCredit TransactionSurveyld TransactionSectionId TransactionComment e
= -

25 procooool - Survey completed -
25 procoooo? Sectionl Secticn 1 completed

25 procoooo? Section2 Secticn 2 completad

25 procoooos - Survey completed

&0 [aeterereterere) - Survey completed

3 P 3 - Survey scresnesd

23 [abeterereterera ] - Survey completed

-70 DT Sectionl Redeemed credits

Figure 127 Example of the Manage Credit Transactions overlay

Click on a blue link to open a further overlay where the individual items can be edited.

A version of this page is also available via the Panel Management > Panelist Credits > Transaction Editor
menu command. The Transaction Editor page however lists all the transactions that have been made for all the
panelists in the panel (see Transaction Editor on page 115 for more information).

6.6.1.7. Select Rows

Under default conditions the Single Panelist Editor window will display all the available rows. If you wish to display
only a reduced selection of the available rows, click the Select Rows button (located towards the right end of the

lower pane's toolbar) to open a window that allows you to specify which database rows are to be displayed. Once

one or more rows are selected, only those selected rows will be displayed.
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Select Rows Confirmit. ™

Select from the available items below everywhere

Select action on views
Update Default -

Find what

[] Match case
[] Match whole words only

Available items Selected items

Form Mame it [] Form Mame

age (Age)

m

agegroup [(Age group (calculated fr

answerrate (Answer rate)

children (Number of children)

carocwner [(Carownear)

city (City)
country (Country)

(5 T

A

1 | 3

| Ok || Cancel

Figure 128 Example of the Select Rows dialog

To select rows:

1. Inthe Available items column, click on the data rows you wish to be displayed in the list to check the
boxes and highlight the rows.

Note: In the event the database contains a large number of rows, use the built-in search facility in the
upper pare of the window to reduce the list to a manageable size.

2. Click the >> button to move the highlighted items over to the Selected items column.
3. Click OK.
The Panelist Editor window is updated automatically when you click OK.

Once you have the rows you required in the window, you can save your layout as the default view, or you can
save it as a new view. To do this, go to the Select Action on Views field in the upper part of the Select Rows
dialog and make the appropriate selection. Once you have saved a new view, the view will be available in the
Select a View field.

6.6.2. Multiple Panelist Editor

| Note: The Multiple Panelist Editor functionality is not available for Standard Panels.

Use this function to edit the details of several/many panelists simultaneously. Note that the same changes will be
made to the details of all panelists selected using this method. When you go to the Multiple Panelist Editor, the
page shown in the figure below opens.
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| & save Executa Salect Copy of Existing Ruls

Expression

Variables s zjlable

Search

AccessFromCyberCafe A~
AccessFromHome =
AccessFromLibrary
AccessFromOther
AccessFromOtherSpecified
AccessFromSchool
AccessFromWorke

Selected

Script

Want to improve your scripting experience?

Active

AllY

ActivateDate ‘
ActiveDaysOnPanel ‘

AllY

AddedDate

AgePresOfKids

ACLBrovwser

ACLUser

archiveflag

archiveflagdate

BusinessOwner
CanadiznProvince
CensusRegion
ClosedCustomCounter ]

Walidate

Figure 129 Example of the Multiple Panelist Editor page

Note: If arule already exists that will find the panelists you wish to edit (and only those panelists!), then
you can click Select Rule and select that rule from the resulting list (see Current Rule on page 73 for more

information).

To create a condition:

1. Click Edit.

The Expression Editor window opens as shown below.

3 -- Web Page Dialog

kb

Ernail addressz

Ernail

LivesInCity - Panelist lives in the
Password

ql3

ReacodedFieldl - This fizld can be
Responseld

Uszerlogon

Dperators

O and
Oor

irth
Gender - Gender of the panelist l:l @ Hone

et

Functions

@ Equal
In

O Between

O=

O =

O =

O ==
Contains
Laft
Right

O 1zhull

|http:,l’,l’author.testlab.firmglobal.net,l’confirm,l’authoring,l’EnterprisePaneI,l’Sampling,l'ExpressionPopUpEditorContainer.aspx?SchemaMode: ® Internet

Expression:

¥ Add here

Walidate

Figure 130 Example of the Expression Editor window

0 The left column lists all the questions/columns in the panelist database.

0 The second column lists the possible answers for the question/column selected in the first column.

0 The third column lists the operators and functions available for the question/column selected in the first

column.

0 The Expression area displays the expression as you build it, both as the entered code and as
“explanatory text” below the Expression field.
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Note: If you have the necessary knowledge and information you can type the expression directly into the
Expression field. However by doing this you risk creating errors that will prevent the expression from
functioning correctly. In most cases, the most efficient method of creating the expression is by using the
procedure described below.

2. Inthe left column, find the question/column you wish to add to the expression and click on it to select it.

In the event the list is extensive, type characters into the Search field to reduce the list to a manageable
size to enable you to find the question you are looking for. Once you have selected a question in the first
column, the second column shows the possible answers for that question.

In the second column, select or type in the answer you require.
In the third column, select the required operator and function.

In the expression area, click Add Here to copy the selected question and answer(s) into the expression.

o g &> Ww

Repeat the procedure as required to build the desired expression.

2} - Web Page Dialog

Expression:
Search: Operators ¥ Add here Validate
| | @And DATEBRETWEEN(D ate OfBirth, TODATE("L/1/1950"), TODATE
["1/10/1980"])
- t : O or
1/1/1980
Gender - Gender of the panelist _ O Hone
LivesInCity - Panelist lives in the| End Date:
Pazsvard
q:;swor 1/10/1980 D het
RecodedFieldl - This field can be
Responseld Functions
Uzerlogon N
O Equal D ATEBETWEEN(D ate OfBirth, TODATE( 1/1/1980 ), TODATE( 1/10/1980 J)
In
@ Between
O =
O =
O =
O =
Contains
Left
Right
O 1=ull
Ihttp:,l',l’author.testlab.ﬁrmglobal.net,l'conFirm,l’authoring,l'EnterprisePaneI,l'Sampling,l'ExpressionPopUpEditorContainer.aspx?SchemaMode= @ Internet

Figure 131 Example of an expression under construction

7. Click Validate to check the expression does not contain errors.

Note: Errors will not be possible if you use the method described here, but can arise if you type the
expression directly into the Expression field.

8. On completion, click OK.

The Expression Editor window closes and the expression is copied into the Condition field in the Panelist
Editor window.

9. Click Save to save the changes.
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Save Execute Selact Rule ‘
Condition @EBETWEEN[DateOFBMh, TODATE( 1/1/1980 ), TODATE( 1/10/1980 ])) Action
Variables 4, jlable Selected
Search
DateOfirth - Date OF Birth
Email - Ermail address
@ender - Gender of the panelist
LivesInCity - Panelist lives in the city
Password
q15
RecodedFieldl - This field can be used for anyth
UserLagan
anel: UserManual Community Panel (p0733266) Current Rule: (none) |Languag=\£ng|ish + | Database | Production V”Conﬁnnt 11 test site | @ 2007 FIRM

Figure 132 The Panelist Editor with the condition

You now have the condition (ringed above) that will find the panelists that you wish to edit. You must now define
which answer you wish to change for these panelists, and what you wish to change the answer to.

10. In the Available column, find and select the answer column you wish to edit.
11. Click the >> button to transfer the selection to the Selected column.

12. In the Action field, type in the change you wish to make.

Note: the syntax required here is the same as used in the Rule Editor functionality (see Current Rule on
page 73 for more information).

13. Click Save to save the changes.

14. When you are sure the condition will find the required panelists, and the change you have specified is
correct, click Execute to run the condition.

The system now checks through the panel looking for any panelists answering to the condition. Note that
in a large panel this may take some time. On completion, a dialog box opens indicating how many
panelists have been found answering to the condition.

0 qualified records have been found.

0 out of these qualified records will be updatad.

Do you want to update those records?

Update | | Cancel

Figure 133 Example of a search result

15. If you wish to update the panelist records, click Update. Otherwise, click Cancel.

6.6.3. Exporting Data
You can export data as a delimited text file.

1. Go tothe Panel Management > Data > Export menu command.

The Data Export page opens.
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Project ID pls19668
Active Database Production
Format [Dslimited Text File

Filter

Expression

Cancel || = Back || MNext = || Finish

Figure 134 The Data Export page

2. If you wish to create a filter expression, click Edit.

An expression editor window opens. Here you can assemble the filter expression you require. Refer to the
separate Professional Authoring User Guide for further details on creating expressions.

Otherwise, click Next.

The Export Properties page opens.

Export Properties

Delimiter | Tab W | @

Custom Delimiter | |

Locale | English (United Kingdom) V| @
Truncate Open Ends |2':|':| | D No Truncation {Full Length]) @
Open End Handling | Include COpen Ends V|

Variables to Include (Survey
data template) D @

i
+
0

| || Select templ

Panel Variables

I Select variables... I

Surwvey History Variables

| Select variables... |

Owverride Filename F

Cancel || < Back || MNext = || Finish

Figure 135 The Export Properties page 1

The various properties and settings are:

e Delimiter - a delimiter is a sequence of one or more characters used to specify the boundary between
separate, independent regions in plain text or other data stream. An example of a delimiter is the comma
character in a sequence of comma-separated values. Select the delimiter that you wish to be used in the
data file to be exported. The options are:

0 Comma - a Comma (,) -separated ASCII text file is generated. All answers will be inside quotes ().
The variable names will be in the first row.
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0 Tab - a Tab-separated ASCII text file is generated. No quotes (") are used. The variable names will
be in the first row.

o Custom - the Custom Delimiter field is activated. Here you can select any single keyboard character,
which will then be used as the delimiter in the exported ASCII text file.

Locale - determines the formatting of elements such as numbers (decimal point) and dates/times. Select
the locale appropriate to the format used in the file.

Truncate Open Ends - For Open Ends (Open Text questions with no field width specified), it is
recommended to truncate texts to improve performance. If a number of characters is specified for the
Open Ends Width, texts longer than this limit, if any, will automatically be truncated. If No Truncation (Full
Length) is selected, the whole text will be imported/exported, but the task may take significantly longer to

execute.

Note: There is no filter for Open End type, so all Open Text questions with no field width specified will be
included in the export (those with type Normal, Hidden or Background), while those with field width set

will not be included.

Open End Handling - defines how open ended questions are handled. The options are:
0 Include Open Ends - all open end questions are included in the export.
0 Exclude Open Ends - no open end questions are included in the export.

0 Open Ends Only (one row per respondent) - only open end questions are included in the export file,
with one row in the file for each respondent (all the answers for each respondent are in the same row).

o Open Ends Only (one row per answer) - only open end questions are included in the export file, with
one row in the file for each answer given.

Variables to Include... - you can build templates to choose a subset of data fields for your exports. If you
have a template you wish to use, check this box and then select the template. See the Authoring User

Guide for further information.

Panel Variables - if you do not have a template to use, click Select Variables to open a selection window
enabling you to select the panel variables you wish to include in the export. Note that you must select one
or more variables or the export will return nothing.

Survey History Variables - if you do not have a template to use, click Select Variables to open a
selection window, enabling you to select the survey history variables you wish to include in the export.

Override Filename - all export tasks will generate files with unique names in the format:
<projectid>_<userid>_<taskid>.<extension>. The "Override filename" functionality allows you to override
this system-generated name. Tick this check-box to open a text-box where you can specify a new name.

Note: The'_"PROJECTID”_' part of the name will be replaced by the real project id during the export.
Default is "PROJECTID"_"USERID"_"TASKID". "PROJECTID" is only "required" when executing a rule;

it is not "required” when running an export using the Export GUI.

3. Make the appropriate settings and click Next.
The Export Properties page changes to:
File Transfer Email |
Encrypt File |:| =]
Email Address documentation@confirmit.com
Start Time ASAP v
Cancel < Back Finish

Figure 136 The Export Properties page 2

Here, the properties and setting are:
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e File transfer - export files can either be sent by email or placed on an FTP server. FTP is the
recommended option for large volumes of data, since emails with large attachments may be blocked. FTP
can allow automation of data flows, since files can then be picked up automatically by another
system/process. Note that your company must license the FTP add-on for this option to be available.
Refer to the Authoring User Guide for further details on the FTP functionality.

e Encrypt file - data transfer encryption functionality makes it possible to perform secure data exports from
Forsta Plus. The encrypted files can then be either ordered by email or sent to the FTP server for
downloading. The users will have to decrypt the files using their private PGP encryption keys. Refer to the
separate Professional Authoring User Guide for further information on PGP encryption.

e Email Address - if Emalil is selected in File Transfer above, this is the email address to which the email
will be sent. Check that the recipient's email address is correct.

e Start Time - the time when the export task is to commence. You can select ASAP (as soon as possible)
or schedule it for a later time. If you schedule the task for later, then when you click Finish, a Recurrence
setup page opens. Refer to the Authoring User Guide for further details.

4. Make the appropriate settings and click Finish.
The Rule Executor page opens, detailing the task's progress. When the task has run, the data is exported
as a delimited text file. The file will be attached to an email and send to the specified address or sent to
the FTP site as selected. On completion, go to another menu item as appropriate to continue with your
work.
6.6.4. Importing Data
Respondent data can be imported into a Professional Panel.
1. Go tothe Panel Management > Data > Import menu item.

The Data Import page opens.

Project Id pls19668

Active Database Production

Format Excel File W
Upload File {E}
o 2
Sort Data [ &

File Handling

Figure 137 The Data Import page

e Project ID - the ID of the current project - the project into which the data will be imported.
e Active Database - the database into which the file will be imported.
e Format - select the format of the file you wish to import.

Import files can either be uploaded directly in the browser, or placed on an FTP server and retrieved from there
(see below). Select the required option.

e Upload File - if the import file is to be uploaded directly from the browser, select this option and click
Browse (see Uploading a File on page 113 for more information).
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e Pick up from FTP Location - if your company has licensed the FTP add-on and it has been enabled, this
option will be active. You can then fetch the file to be uploaded from Forsta's FTP location. Forsta's FTP
address is specified as part of the enabling procedure and cannot be changed, so you must add only the
file name to this field. Refer to the separate Professional Authoring User Guide for further details on the
FTP functionality.

e Sort Data - [Excel only] when importing Excel files, data in all sheets must be sorted by key columns. If
the data in your import file is not sorted, check this check box to instruct the task execution to sort data in
all the Excel sheets automatically. Please note that sorting may take some time for large data.

e File Handling - if you select "Pick up from FTP Location", these options become active. You can then also
decide what to do with the original files on the FTP site; leave them there or delete them. Note that
fetching from FTP can allow automation of data flows, since you can set up the system to pick up files
automatically.

The properties and settings available in the following steps in the procedure will depend on the format you have
selected here.

6.6.4.1. Uploading a File
To upload a file:
1. Go tothe Panel Management > Data > Import menu item.
The Data Import page opens.
2. Select the required file format, then click Browse.
A standard file browser window opens.
3. Find and select the file you wish to upload, then click Open.
The file path is added to the Upload File field.
4. Click Next.

The Import Properties page opens.The fields available on the page will depend on the type of file you are
importing.

5. Make the appropriate settings and click Next or Finish.

If you click Finish, the import task will be added to the queue. If you click Next, you are given the
opportunity to set up a recurring task such that the file will be imported at regular intervals.

Refer to the separate Professional Authoring User Guide for further details on uploading files.

6.6.5. Data Templates

You can create data templates for Professional Panel projects that can be edited in the Template Editor in the
same way as with normal projects. These templates can be used when exporting and importing data. Refer to the
separate Professional Authoring User Guide for further information on templates.

6.7. Calculate Variables

The values in recoded variables are not updated automatically as response data is added to the questionnaire;
the values must be calculated and updated as a specific operation. You can perform this task manually as
required when respondents complete the survey, or you can set the variable calculation to run automatically as a
recurring task.

1. Go to the Panel Management > Calculate Variables menu command.

The page shown below opens.
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Active Database Production

Respondents | All A

1] Variables are calculated for all respondents. This is
the slowest calculation, but should be used when
variable expressions are changed or interviewing is
running and respondents are allowsd to change
their answers.

Status | Complete W |
All variables
Start time | ASAP v |

Figure 138 Calculating the Variables

The fields and options are as follows:

Active Database - the currently selected database. Use the selection box in the lower right corner of the
Forsta Plus window to change this as necessary.

Respondents - choose whether you want to calculate variables for All respondents, Uncalculated
respondents, or only New respondents.

Status - choose whether you want to calculate variables for all respondents, or only those with the status
Complete or Incomplete.

All Variables - if you do not wish to update all the variables, uncheck this box to open a text field where
you can input the variables that are to be updated.

Start time - select the start time for the batch job: ASAP or Schedule for later execution.

Make the appropriate settings and click OK. If you have selected Schedule for later execution, then when you
click OK the Task Recurrence page opens. In this case, make the settings as required and click Save.

For further information on recoding variables, refer to the Authoring User Guide.

6.8.

Panelist Credits

Panelist Credits are stored in the Credit Transaction History loop level, which is added to new panels
automatically on creation and is located in the Panel Variables toolbox (see The Panel Variables Toolbox on page
Error! Bookmark not defined. for more information).
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I+ |[]) LOre Heas
=l lﬁCrEditTransacﬁDnHisb:ury (Loop)
=l [ Core Fields

@Transacﬁunﬂuweyld (Open)
125 TransactionCredit (Mumeric)
@TransacﬁnnSecﬁDnId (Open)
[z5p TransactionSecondaryPanelistld (Mu
@Transacﬁunmmment (Cpen)
ETransacﬁnnF‘ending (Single)
ETransacﬁnnType (Single)
ETransactianIsHidden (Single)
ETransacﬁDnSnurceType (Single)
|5 TransactionCreated (Date)
|4 TransactionModified (Date)
@Transacﬁunh“ludiﬁedﬁy (Open)
[1z5p TransactionTaskId (Mumeric)
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=

Figure 139 The Credit Transaction History folder in the Panel Variables toolbox

The Panel Management > Panelist Credits menu command enables you to import and export panelist credits.
The menu contains four options:

Panel Management =~

Current Rule

Current Rule Set

Rule List

Rule Set List

Data L
Calculate Variables
Aggregated Variable List

Panelist Cradits [: b Transaction Editor

Panel Settings Export

Import
Legacy L

Figure 140 The Panelist Credits menu

See the following sub-sections for further details. The Legacy sub menu enables import to and export from only
the old legacy Panelist Credit system.

6.8.1. Transaction Editor

Go to the Panel Management > Panelist Credits > Transaction Editor menu command to open the Transaction
Editor page. Here you can edit each of the credit transactions that has been performed in the current panel.
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Transaction Editor Confirmit
everywhere
_;‘ Hore ™ Panel Setup ™ Panel Utilities = Sarmple Management = - |User: Apple, Adarm
|Current Rule |Ru|e List| Data ™ |Ca|cu|ate Variables Panelizt Credits = |Pane| Settings

Filter: No advanced filter.

‘p Search| (2 Reset Add Credit.,. Select a View ------------- » Select Colurmnz... Advanced Filter.,. Clear Advanced Filter
responseaid - TransactionCredit TransactionSurveyld TransactionSectionId TransactionComment z
= - = -

i 25 procoococd - Survey completed s
1 25 P 2 Section1 Section 1 completad

1 25 PR 2 Section2 Section 2 completed

1 25 PO D - Survey completed

i &0 procooooed - Survey completed

i 5 Do 3 - Survey scresned

1 25 [aEte et teerd - Survey completed

1 -70 [ te el Sectionl Redeemed credits

2 25 pacsex 1 - Survey completed

2 25 PIOCOOOKS - Survey completed

2 5 prooooo s - Survey scresned

2 -40 PR T Section1 Redeemed credits

2 -20 PO T Section2 Redeemed credits

k] 25 ProCOoooe2 Sectionl Section 1 completad

k] 25 ProCOOooe? SectionZ Saction 2 completad

3 25 P 3 - Survey completed A

[1-60of5s] Page 1 =

Figure 141 Example of the Transaction Editor page

Click on a blue link to open an overlay where the individual items can be edited.

Click on the column headers to sort the list by the selected header. Enter criteria into the search fields at the top
of the columns to display only those records that comply with the specified criteria.

A version of this page is also available by clicking the Manage Credits button on the Single Panelist Editor page
accessible via the Panel Management > Data > Single Panelist Editor menu command. The Manage Credit
Transaction page however lists only the transactions that have been made for the selected panelist (see Manage
Credits on page 105 for more information).

6.8.2. How to Export Panelist Credits

If you do not add a filter expression, this procedure exports the panelist credits for all the panelists in the selected
panel.

1. Goto Panel Management > Panelist Credits > Export.

The Export Panelist Credits page opens.

Panel ID pl217318

Format Delimited Text File -
Filter
Expression
Cancel || = Back || Next = || Finish

Figure 142 The Export Panelist Credits dialog - 1
2. Select the desired output format, and if you only wish to export a sub-set of the panelist credits then add a

filter expression to remove those that you do not wish to export.

3. Click Next - the dialog changes.
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Formatting Tab Separated - @

Custom Delimiter | |

Text Qualifier | With Quotes - |
Locale English (United States) ~ @
File Encoding UTF-8 -
Panelist Credits Variables

Select variables...

Override Filanama [ |

Cancel || <Back || MNext> || Finish

Figure 143 The Export Panelist Credits dialog - 2

4. Click Select Variables, select the Panelist Credit Variables you wish to export, make the appropriate
selections for the remaining properties, then click Next.

The dialog changes again.

Email Address documentation@confirmit.com

File Transfer Email - @
Owverride Email Options D

Encrypt File D @

Start Time ASAP -

Comment

Cancel || < Back || Next = || Finish

Figure 144 The Export Panelist Credits dialog - 3

5. Select the type of transfer you wish to perform; Email or via FTP.

Note: The FTP transfer option is a chargeable add-on. This option will only be available if your company
has the appropriate license. If so, the FTP site details will be specified automatically by Forsta Plus.

6. If Email is selected, check the recipient email address is correct and edit as necessary.
7. Specify the start time for the transfer.

If you select Schedule for Later Execution, you can set the export to be a recurring task, that is, it will be
performed automatically at specified time intervals.

8. Click Finish.

At the specified time, the credits are added to a file in the format you have selected, and this file is zipped,
attached to an email, and sent to the stated address.
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6.8.3. How to Import Panelist Credits

The panelist credits for a panel can be exported as a zipped .txt file, via email, or if you have the appropriate
license, via FTP (see How to Export Panelist Credits on page 116 for more information). Note that there are a
number of information columns that must be included in the .txt file to be imported. These are "required fields" and
must have the column headers as shown:

Field/column name Description Required/Optional

responseid The unique responseid ID of the panelist. Maximum Required for Append
number of characters is 50. (or use email)

email The email address of the panelist. Will not be imported to Required for Append

the panel credit table, but is used to find the matching
responseid.

(or use responseid)

CreditTransactionHistory

The Id of the particular credit entry.

Required for Update

TransactionSurveyld The project Id of the project for which the credit is being Optional
granted.

TransactionCredit The credit amount. Optional

TransactionCreated The date for the credit entry. Format yyyy-MM-dd Optional
hh:mm:ss.

TransactionComment A text string, up to 256 characters. Optional
TransactionSectionld A string used if credits are to be assigned multiple times for |Optional
one project. Up to 40 characters.

TransactionSecondaryPanelistld | If points are received from another panelist (e.g. refferals), [Optional

this is the panelist id of the panelist who gave the points.
TransactionPending Is the transaction pending (true/false)? A transaction is Optional
pending in a survey until the respondent has been given a
status in the survey.
TransactionType Why the transaction has been made; a normal update, a Optional
correction to the current value, some credit has expired etc.
TransactionlsHidden Is the transaction hidden; true or false. Optional

If the file has been exported via email, save the file attachment to an appropriate folder in your network.

1. Open the Panel to which you wish to import the panelist credit file.

2. Goto the Panel Management > Panelist Credit menu command and select Import.

The Import Panelist Credits dialog opens.
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Panel ID p1173455

Format Delimited Text File -
Uploaded File ®
Pick up from FTP Location | =
Cancel || “ Mext = ||

Figure 145 The Import Panelist Credits dialog

3. If the file has been exported via email, select the Transfer Type to be Upload then browse to the file that
is to be uploaded and select it. If the file has been exported to FTP, type the file name into the File Name
field.

Note: FTP export requires your company to license an add-on. The FTP site details will then be specified
automatically by Forsta.

4. Select the Key Field that is to be used to identify the panelists to which each credit value is to be credited.

This list is populated automatically from the fields available in the panel.

5. Set the start time for the import task.

Note: If the file is to be exported at regular intervals (using a recurring task) then you can also set the
import to occur at corresponding intervals, thereby updating the credits automatically. In this case,
ensure you allow a delay between the times set for the exports and the imports to allow for possible
qgueues in the task server.

6. Click OK.

The import will be performed at the specified time(s).

6.9. The Panel Settings

You can define some custom settings for the panelists' password requirements, and you can show or hide a
number of the sampling setting features. These are defined separately for each panel, so different panels can
have different password requirements and sampling settings.

Note: You must actively go to the Panel Settings page and make the settings for each panel.

1. When in the Professional Panel, go to the Panel Management > Panel Settings menu command.
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Panel Management -

Current Rule

Current Rule St

Rule List

Rule Sat List

Cata *
Calculate Variables
Aggregated Variable List
Panelist Credits .

Panel Settings P
L

Figure 146 The Panel Management > Panel Settings menu command

The Panel Settings page opens at the Features tab. The Features tab enables you to show or hide
features as required for specific projects (see The Panel Settings Features Tab on page 120 for more
information). The Security tab allows you to adjust the password and HTTPS settings (see The Panel
Settings Security Tab on page 121 for more information). Forsta has a defined policy regarding password
complexity etc. (see Password Policy on page 6 for more information).

6.9.1. The Panel Settings Features Tab

The Features tab enables you to show or hide features as required for specific projects. This allows
"unnecessary" features to be hidden such that they do not distract the user or fill the screen with unwanted menus
etc. The items are described in other sections in this documentation. For each item, the options are Enabled and
Disabled.
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H Save
Features I Security |

| (L] This page allows to Enable/Disable features for current Community Panel.
3]

Panel Setup

Legacy Jobs Import Disabled

(%) Panel Utilities

Panel Activity Log Disabled -

Database Cleanup Disabled

(%) Panel Ma nagement

‘

Multiple Panelist Editor Enabled
Rules Enabled w
Rule Set Enabled -
Aggregated Variables m

(%) 5a mple Management

‘

Scheduling Disabled
Concurrent Sampling m
Multiple Sample Upload m
Testar Template List m
Survey Synchronization m
Job Approval ‘Disabled
E;iﬁ:':::si“ Future Date m
External Fields m
Manual Panelist Exclusion m
Sampling - Output Rule m
Sampling - Posting Rule m
g:tl::iil“n;:d Sampling Algorithm ‘Dicabled -
Expected Return Variable m
Individual Rest Days m

6.9.2. The Panel Settings Security Tab
The Security tab allows you to adjust the password and HTTPS settings.

Note: You must actively go to the Panel Settings page and make the settings for each panel. No changes
will be made to the panel's password settings unless you do so.
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Save

Features | Security

L] Specify password validation settings for current panel,
Thesea settings will apply for all places where it is possible to change
password.
E.g. Portals, registration and maintenance survays.

Password expiry days |D | &
Password history |D | &
Minimum age |D | &
Minimum required length |D | &
Minimum required non alpha characters |D | &
Minimum required non alphanumeric characters |D | =)l
Minimum required uppercase characters |D | 2]
Password similar to username ] &

Enforce https access to portals |:|

Panelist Unigue Variable ﬂ]

Allow the portals to be embedded within frames ||

Exclude fields | |

Session timeout in portals (in minutes) |D |

Figure 147 The Panel Settings Security tab

The options are as follows:

e Password expiry days - specify how many days the password is to be valid after it has been changed.
Use 0 to disable this functionality such that the password does not expire.

e Password history - specify that the new password must be different from the last X passwords used. This
prevents the panelist merely using the same password over and over again. Use 0 to disable this
functionality such that the same passwords can be reused.

e Minimum age - specify the number of minutes the user must wait after changing the password before
they are allowed to change it again. Use 0 to disable this functionality.

e Minimum required length - specify the minimum number of characters (of all types) that a password
must have. Use 0 to disable this functionality such that a password can be of any length.

¢ Minimum required non alpha characters - specify the minimum number of non alpha characters a
password must have. This will force the panelist to use numerical and/or other characters in the password,
thereby making it more difficult to guess. Use 0 to disable this functionality such that the panelist can use
only alpha characters if so desired.

e Minimum required non alphanumeric characters - specify the minimum number of non alpha-numeric
characters (for example #a%& etc) that must be included in the password. Use 0 to disable this
functionality.

e Minimum required uppercase characters - specify the minimum number of upper-case characters that
must be included in the password. Use 0 to disable this functionality.

e Password similar to username - check the box if the password is to be validated against the username
to ensure that the password and username are not identical. Leave the box unchecked to disable this
functionality, thereby allowing the panelist to use their username also as their password.
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e Enforce HTTPS access to portals - check the box to force the user to use HTTPS when accessing the
portal.

e Panelist Unique Variable - specifies the variable that is to be used to uniquely identify a panelist, for
example email or Customerld. This will be the variable used as the username when the user logs in to the
portal. The variable must be defined with the property Unique set to true.

e Allow the portals to be embedded within frames - check the box if you want to allow the portal to be
embedded within another web site in an iframe. If this option is not checked, the portal can not be
embedded in an iframe.

e Exclude fields - for improved protection of panelists it is possible to exclude specified data fields, for
example Personally Identifiable Information (PII) from viewing and exports. You may wish for example to
exclude email addresses from exports so that users cannot retrieve panelists' email addresses from any
kind of data export from the panel or surveys linked to the panel. Write the field names into this field, using
comma or semicolon to separate the field names if more than one field is to be excluded, and save the
changes, to exclude the specified fields from all exports. Note that excluded fields are listed in the task log
and in notification emails.

e Session timeout... - add a time in minutes to specify how long a session will be kept active before the
panelist will need to log in again. If empty, the system defaults for session timeout will be used.

Note: A special Normal role is available for users that prevents access to the Panel Settings, thereby
preventing normal users from making changes to this option. If a user has this special Normal role then
he/she will not be able to unlink a panel from the survey. Any changes to this field are registered in a
special activity log - refer to the Admin manual for further information.

When you have made any changes, click Save to save them.
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7. The Sample Management Menu

A Sample is a group of people who have been selected from a Panel to participate in a particular survey. The
members of the sample will have specific characteristics that make them suitable for that survey.

When a person agrees to be a panelist, they complete a questionnaire to provide their personal details and other
information that the survey company (your company) may require. There could be hundreds of questions. These
could include such details as where the panelist lives, whether they drive and/or own a car and if so what type,
whether they have any children and if so how many, their ages, sexes, what types of schools they attend, whether
they have any pets and if so what types etc. The panelist's answers to these questions are entered into a
database and later used to determine the panelist’s suitability to participate in a particular survey. For example, if
a company that manufactures dog-food has asked for a survey to be conducted to analyze dogs’ preferences in a
particular town, there is not much point in including a panelist who does not own a dog or who lives in a different
town.

Additional criteria, such as whether the prospective panelist has recently participated in a survey of a particular
category, or participated in a survey of any category, within a specified period, can also be included in the sample
selection process. These “exclusion” criteria will help to prevent panelists becoming overworked and perhaps
bored with answering surveys. You can also use similar functionality to re-include potential panelists who were
previously excluded automatically for other reasons.

Forsta’s Sample Management function uses the panelists’ details in the database, and the additional criteria, to
assemble a group of panelists who are suitable for a particular survey. The required number of panelists are then
selected randomly from that group.

Note: Forsta Plus does not support sampling from both Basic Panel and Professional Panel into the same
survey.

It is not possible to sample to closed surveys from Standard or Professional Panels. If you attempt to do
so, an error message will be displayed.

The panelists that are selected for a survey are “booked” in the system for a defined period from the moment that
the job for which they have been selected is executed. The selected panelists are flagged in the database, and
will be available to be included in jobs that are executed later according to the mailing dates and exclusion rules
for those jobs.

The sections in this chapter describe the functionality available through the Sample Management menu, and the
procedures required to make use of that functionality.

_:Home T Panel Setup T Panel Utilities = Panel Management '|Samp|e Managemeant v|

Current Job  Current Matrix Job List Active Jab List Matrix List Scheduling Concurrent Sampling Multiple Sample Upload Tester Template List Sampling Settings

Figure 148 The Sample Management menu

Click on Sample Management to access the sub-menu commands. The Job List is automatically displayed below
the menu. Click on a job in the list to select it and go to the Current Job window.

7.1. Current Job

A sampling job is a group of sampling definitions with common properties that is to be scheduled and executed as
one job. This produces a sample file as output, and some reports on the outcome of the sampling job. The
sampling job will operate on a subset of the panel defined by a “global criteria” (a global filter, for example only
panelists from a particular state).

The Current Job window provides general information about the selected job and enables you to define and edit
the criteria for the job. To open this window, go to the Sample Management > Current Job menu command. The
window contains seven tabs:

¢ Job Information — define the basic details for the job.

e Exclusions — define any date-related automatic and manual exclusions, and manually relax exclusions
that have been applied automatically.

e Universal Criteria — create the background panelist-selection expression.

e Sub Samples — a survey may need groups of respondents with different characteristics. The Sub
Samples function allows you to create such groups.
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e Additional Items — specify which columns of information about the selected panelists are to be included
in the resulting text file.

e Execution - confirm the panel selection and book the panelists for the job.

e Reporting — view, and print as necessary, reports on the outcomes of the sampling jobs..

7.1.1. The Job Information Tab

This tab provides basic information about the current job.

Job Infarmation | Exclusions | Filker | Sample Definition | Sample File Fields | Execution | Reporting

| Save Duplicate Export Job Walidate Job

Job Numbear ]

Description Omnibus

Mailing Date ig/10/2008 D =)

Status Work In Progress (g

Properties =]

Project_Manager Ole Andresen '
CustemlobStatus Open '

Data Source v

External Fields Mo external file has been uploaded Upload file &)

External Survey Links Mo links have been uploaded Upload links g

Category Available Categories Selected Categories 2
search Damao
= Fanel Categories
AnotherSample
Demo

SampleType

==

<<

Figure 149 Example of the Job Information tab

7.1.1.1. The Tool bar

e Save — click to save the changes you have made to the job. The button flashes while Forsta Plus has
unsaved changes.

e Duplicate — makes a copy of the current job so you can create a new job to the same specifications. You
will be required to give the new job a different job number, and the Job Status will be reset to Work In
Progress, but all other details will be identical to the original job. Once the job has been duplicated and
given a new number, you can then edit the job as required.

e Export Job — exports the job definition (not matrices) to a text file and sends the file to the stated email
address. This function can be used by customers with their own servers to copy jobs from one server to
another.

e Validate Job — tests the job to ensure there are no logical inconsistencies that would cause the procedure
to fail when the panelists are actually being selected.
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7.1.1.2. The Data Fields and Areas

Job Number — a unique identification number for the job. The number is generated when the job is first
created, though it can be changed if necessary.

Description — a free-text description of the job to simplify identification later. You can edit the description
at any time.

Mailing Date - a calendar that enables you to set and change the mailing date (see How to Set the
Mailing Date on page 132 for more information).

Status — the current status for the job. The job status is changed automatically by the system when for
example the job is uploaded, when it is emailed etc.

Properties — you can define properties for the jobs (for example “Complexity”), and specify options for the
property (for example “Low”, “Medium” and “High”) (see The Property Definitions Tab on page Error!
Bookmark not defined. for more information). You can then specify the property and option for each job,
and these can be used when excluding panelists from jobs (see The Auto Job Exclusion Tab on page 129
for more information).

Data Source - a list of the available BitStream files used as a base for sampling.

External Fields — allows you to upload additional information on an individual panelist or for a group of
panelists. This information will be in the form of text files that must be created outside of Forsta Plus and
uploaded. The files must be tab-delimited with Panelistld as the key column, followed by the external fields
as shown in the image below. (see How to Upload a File on page 127 for more information).

External Survey Links - allows you to upload a repository of unique links to an external survey. The links
will be added to the Sample file and can be uploaded to a Forsta Plus project that handles the statusing
and redirecting for the Sample Only job.

Category — A panel's category is specific to that panel. Use this area to define the category or categories
to which the job is to apply. The Panel Categories list is a logical hierarchy of all the registered categories
(see The Categorization Tree Tab on page Error! Bookmark not defined. for more information).

FPaneli=ztId Country Region HouseholdZizel
1 hAustria LDE 3
4 MNorway O3L 2.1
& Belgiwm BRU .|
7 T3k NYC S

Figure 150 Example of a text file with a list of panelist information

7.1.1.3. Procedures in the Job Information Tab

7.1.1.3.1. How to Duplicate a Job

1.

Click the Duplicate button in the blue Job Information tab toolbar.

The Duplicate Job dialog opens.

Job Number

K Cancel

Figure 151 The Job Import dialog box

Type a unique job number for the duplicate job into the data field.
Click OK.

The new job opens in the Forsta Plus window, is listed in the Sample Management > Job List window
under its job number, and can be selected and edited as required.
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7.1.1.3.2. How to Export a Job

1. Click the Export Job button in the blue Job Information tab toolbar.

The Job Export dialog opens. The default email address (that of the current user) is included as default in
the Email Recipient field.

Job Export

Email recipient | docurnentationi@confirmit, corn |

Comnvent | |

Figure 152 The Job Export dialog box

2. If necessary, change the email address to that of the intended recipient.
Type a comment if required.
4. Click OK.
The new job opens in the Forsta Plus window, is listed in the Sample Management > Job List window
under its job number, and can be selected and edited as required.
7.1.1.3.3. How to Upload a File

You can upload text files of additional information on panelists or external survey links. The upload procedure is
the same for both types of file.

Note: The text file must be of .txt format and must be named matchfile.txt. The link file must be of .txt
format with 'Link' as the only column header and all the links below

1. Inthe External Fields area, click the Upload File link.

The Upload Settings dialog box opens.

Upload a text file containing external fields. l?'

Upload Settings

File to upload | |[ Browss.. |

|DK || Cancel |

Figure 153 The Upload Settings dialog box

2. Inthe dialog box click Browse.

A standard File Selection window opens.

3. Browse to and select the required file, then click Open.

The file path and name is added to the File to Upload data field.

4. Click OK to complete the upload, or Cancel to return to the Job Information tab.

7.1.1.3.4. How to Check the Job

You can check the current job at any time during the construction process, to ensure it will function correctly and
to view a list of any errors or problems.

1. Click the Validate Job button in the Job Information tab toolbar.

An information dialog opens with a list of any errors or problems that the job may contain.
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(

x|

Mailing date can naot be in the past.
! E Mo samplingmatrix is specified Far subsample 1
Samplingmatrix specified for subsample 1 does nok exist
Tokal barget is not specified For subsample 1. When marked For balancing, total target is mandatorsy,
Mo weight is specified for subsample 1
Targek for group with code '0° in groupset 1 For subsample 1 must be larger than 0,
Mo samplingmatrix is specified for subsample 2
Samplingmatrix specified for subsample 2 does nok exist
Tokal target is not specified For subsample 2, Wwhen marked for balancing, total target is mandatorsy,
Mo weight is specified for subsample 2
Targek for group with code '0° in groupset 2 For subsample 2 must be larger than 0,

Figure 154 Example of a verification message list

You must now work through the list and correct the problems.

Click OK to close the list dialog.

Once all the errors have been corrected, when you click the Validate Job button the “Sampling Job is
Valid” message box is displayed as shown below.

Microsoft Internet Explorer, E|
L "_-. Samplingjob is walid
L

Figure 155 The Job is Valid message box

7.1.1.3.5. How to Select a Category

If the Available Categories list is extensive or contains many similarly-named categories located in different
branches of the hierarchy, you may wish to perform a search to locate the category you are looking for. To find
panel categories:

1.

Type an appropriate combination of characters into the data field at the top of the Available Categories
column. Wildcards are not necessary.

Click Search.

Forsta Plus will find and display all the instances of that combination of characters that are to be found in
the Panel Categories hierarchy.

For example if you type Product into the field and click Search, Forsta Plus will find all categories with the
word Product anywhere in the category name. Note that you do not need to type in complete words. For
example, type Il into the field and click Search to find all categories with Il anywhere in the name, such as
any category with the word small in its name, or grill, or rolls....

If after typing in the first search criteria the list is still long, you can perform a search through the first set of
results by repeating the procedure using other search criteria.

To reset the search filter and restore the entire hierarchy to perform a new search, click Clear.

Once you have found the required category, click on it to select it, then click the >> button located
between the columns.

The selected category is moved from the Available Categories column to the Selected Categories column.
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Note: You can select as many categories as you wish.

To remove a category from the Selected Categories list, click on it to select it and then click the << button
located between the columns. The category is returned to the Available Categories list.

4. On completion, click Save to save the changes.

| Note: The Save button flashes while the system contains changes that have not yet been saved.

7.1.2. The Exclusions Tab

You may wish to exclude potential panelists from a job for various reasons. For example you may wish to avoid
using panelists who have recently been asked to reply to a survey of a particular category, or those who have
recently been asked to reply to a survey of any category. The Exclusions tab enables you to set time-frames
around the job’s planned mailing date, within which such panelists will be excluded.

The Exclusions tab contains three sub-tabs:
e Auto Job Exclusion — panelists are excluded automatically if they conform to the general rules set here.
e Manual Job Exclusion — you can set additional exclusion rules and/or relax some rules.

e Manual Panelist Exclusion - you can upload a file with a list of panelists, and these panelists will be
excluded.

7.1.2.1. The Auto Job Exclusion Tab

In the Auto Job Exclusion tab you can select the type of exclusion you wish to use; Project, Category, Date
and/or,Property, and set the dates within which you wish the exclusion rules to apply.

You can also exclude all panelists so you can then go to one of the other tabs and relax the exclusion for specific
jobs and/or panelists.

Job ]rllufrruliunl Exchusions | Fiter | Sample Definition | Sample File Fields | Execution | Reporting |

Ao Job Exclusion I Manual Job Exclusion " Manual Panelist Exclusion |

|ﬂsave

O Exclude ANl Panelists S

~ @ Specify Auto Exclusion &

~ O project Exclusion r [ category Exdusion® ———————————  — [2] pate Exclusion &
Ewcludde Baserd an Mailing Date = Use Individual Rest Days O
Days Before Mailing Date I:l'.ld\-: Diays Before Maling Date ﬂvg. Days Before Mailing Date ;!dvb
Days After Mailing Date [afpess Days Afler Mailing Date [zajtays Days Afier Mailing Date [ Flaays
WE man tir ons tor fre  ler Sen Wk manm tir ons tor fre ler son Wk man btir ons bor fre  ler sen
week 30 31 1 2 3 t 5 e week 300 31 1 2 3 2 5
wesk & 7 B 9 10 2 week week & 7 B 9 10
week 13 14 15 16 17 18 1% ik week 13 14 15 16 17 B
wesk 20 21 22 23 24 35 36 week week 20 21
wesk 27 2B 3 31 1 2 f— E — E
week 3 4 5 & 7 B 9 week ek & 7 B 9

Survey Status{ Al Survey Status] Al =]

DPmperL\' Exclusion: (CustomlobStatus) o

Survey Status Al

Figure 156 The Auto Exclusion tab

Select either:
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Exclude all panelists - select this to exclude all panelists from all jobs. You can then go to the Manual Exclusion
tabs and relax the exclusion for specific jobs. Use this function if you want to send for example a follow-up survey
to the same panelists as for an earlier survey.

Or:

Specify Auto Exclusion - select this to exclude panelists using Project, Category, Date and/or Property
Exclusion, then set up the exclusions as required.

e Project Exclusion - select to exclude panelists based on the project which the sample is uploaded to. So
if you enable project exclusion on a job, it must be connected to a survey. Then when running the sample,
you can either:

o Exclude all panelists who have previously been uploaded to that survey. There is then no risk of a
panelist being uploaded to the same survey twice.

0 Exclude all panelists who have been uploaded to that survey and has mailing date in a particular
period before and after the current job’s mailing date. There is then no risk of a panelist being
uploaded to the same survey twice in that period.

e Category exclusion — excludes potential panelists if they have the selected status and have been used in
a sample for a survey of the same category within the specified dates.

e Date exclusion — excludes potential panelists if they have the selected status and have been used in a
sample for any survey within the specified dates. The panelist may have been invited to participate in a
survey, they may or may not have responded to that invitation, or they may have already been included in
a different sample for a survey that is still being planned.

In both cases the exclusion dates are applied around the Mailing Date — the date on which you plan to
email the survey invitations to those panelists who are finally selected. The darker shaded date is the
selected Mailing Date (set at the top of the tab (see How to Set the Mailing Date on page 132 for more
information), while the lighter shaded area covers the days selected in the Days Before and Days After
fields for the appropriate calendar.

e Property exclusion — a Property Definition (see The Property Definitions Tab on page Error! Bookmark
not defined. for more information) can be activated so it can be used in the exclusion. This excludes
potential panelists if they have the selected property and Survey Status. Click Add to add a property
definition (see How to Set the Property Exclusion Function on page 135 for more information).

7.1.2.2. The Manual Job Exclusion Tab

You may wish to include some potential panelists in your survey who have been excluded by the Auto Exclusion
function, or you may wish to exclude panelists who have previously been involved with particular jobs, in addition
to any exclusion generated by the Auto Exclusion function. The Manual Exclusion tab provides you with these
possibilities.

The tab is divided horizontally into two lists:

e Available Jobs - the jobs currently registered in your database, which are available to be excluded or
relaxed.

e Manually Excluded and Included Jobs — jobs selected manually from the Available Jobs list to be
excluded or relaxed.

To simplify management, the lists are automatically divided into “pages” with 30 jobs on a page. Scroll through the
current page using the scroll bar at the right side of the list, and move through the pages by clicking on the Page
arrow buttons at the lower-right corner of the list.
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Job Information I Exclusions I Filter " Sample Definition " Sample File Fields " Execution " Reporting |

Auto Job Exclusion I Manual Job Exclusion I Manual Panelist Exclusion |

|p Search / Reset (] Exclude [;] Include \.fiew| Date Excluded Jobs V| Mailing Datel |V| |
Job Number Description Outgo Mziling Date ProjectId Category e
[ I | [- & ] L1

No items available

0 of 0 selected. [D-00of0]

|u save X Remove view Excuded and Incduded Jobs

L]

Job Number Description Outgo Mailing Date ProjectId Filter

No items available

0 of 0 selected. [D-00of0D]

Figure 157 Example of the Manual Exclusion tab

7.1.2.2.1. The Job Filters

In an established company the list of registered jobs may run into thousands, and a search through the list for the
one job that you wish to select for exclusion or relaxation could be time-consuming. Forsta Plus therefore
provides you with a set of filters so you can reduce a long list to a manageable size.

|p Search -/ Reset () Excluds [;J Include View| Date Excluded Jobs V| Mailing Date| |V|
Job Mumber Description Outgo Mailing Date ProjectId Category z
| | | [= & | | | [an ]

Figure 158 The joblist filter fields

The filters are as follows:

e Job Number — type in the number of the job you are looking for, then click Search. You can use the *
character as a wildcard, and type in part of the number. For example, type in 123 to find all jobs where the
job number starts with 123, such as job number 123456. Typing in *123 will find all jobs with the number
123 somewhere in the job number, such as job number 45123678.

e Description — type in the description of the job you are looking for, then click Search. You do not need to
type in the entire description, and you can also use the * wildcard. For example, if the job you are looking
for has the text “Forsta Customer Survey 1” in the description field, typing in confirm, *sur, or even just *1
will find the job. However bear in mind that the simpler the search criteria is, the more jobs the search is
likely to find.

e Outgo — allows you to search for jobs according to the number of respondents who were invited to
participate in the survey. Click the drop-down arrow beside the operator field and select the required
operator, then type the appropriate number into the field to the right of the drop-down arrow. When you
are ready, click Search. For example, select the <= operator and type in 1000 to list all the jobs that were
mailed to 1000 people or fewer.

e Mailing Date — allows you to search for jobs according to the date on which they were mailed. Click the
drop-down arrow beside the operator field and select the required operator, then click on the calendar icon
beside the field and select the date. When you are ready, click Search. For example, select the <=
operator and a date to list all the jobs that were mailed on or before the selected date.

e Project ID - allows you to search for jobs according to the project ID of the project to which they are
connected. Note that if you hover the mouse pointer over a project ID, the name of that project is
displayed in a tool-tip.
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e Category — this field lists the categories selected in the Job Information tab. Click the drop-down arrow to
open the list and select the required category, then click Search.

Once you have found the job or jobs that you wish to use, you can exclude them or include them as required by
clicking the appropriate button in the toolbar above the list. Click Reset to remove all filter criteria and reset the

list.

7.1.2.3. The Manual Panelist Exclusion Tab

Use this tab to upload a list of panelists to be excluded.

Job Information I Exclusions I Filter ” Sample Definition " Sample File Fields " Execution " Reporting

Auto Job Exclusion " Manual Job Exclusicn I Manual Panelist Exclusion |

(1] Upload a text file containing panelist ids. =)

Upload ettings

File to upload | |[ Browse... |

| OK || Cancel |

No external file has been uploaded &)

Figure 159 The Manual Panelist Exclusion tab

Click Browse to open a file selection window, find the file and select it, then click OK. Once you have uploaded a
file, the name of the file you have uploaded and the number of panelists listed in the file is displayed on the tab. If
required you can then click Remove File and confirm to delete it.

7.1.2.4. Procedures in the Exclusions Tab

7.1.2.4.1. How to Set the Mailing Date

The panelists that are selected for a survey are 'booked' in the system for a defined period from the moment that
the job for which they have been selected is executed. The selected panelists are flagged in the database, and
will be available to be included in jobs that are executed later according to the mailing dates and exclusion rules

for those jobs. To set the mailing date for a job:
1. Go tothe Sample Management > Current Job menu command.
2. Click the Job Information tab.
3. Click on the calendar icon to the right of the Mailing Date field.

The calendar opens.

x

£ | September 2012 | >

S5u Mo Tu We Th Fr S5a

1
23 4 5 6 7 8
9 10/11/12|13| 14|15
1617|1813 20 21 =22
23| 24|25 26| 27| 28|29
30

Figure 160 The calendar
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4. Using the arrow buttons, browse to the appropriate year and month, then click on the desired date to
select it.

Note that today’s date is outlined, and the selected date (if a date is already selected) is shaded. To close
the calendar without selecting a date, click outside the calendar.

When you click on a date, the calendar closes and the date is entered into the Mailing Date field. The time
intervals you set in the Exclusions tab are then applied around the selected Mailing Date.

5. Click Save to save the changes.

7.1.2.4.2. Exclude All Jobs

This check box is on the Auto Exclusion tab. Check this box to exclude all panelists for all jobs. You can then go
to the Manual Exclusion tab and relax the exclusion for specific jobs. Use this function if you want to send for
example a follow-up survey to the same panelists as for an earlier survey.

7.1.2.4.3. How to Set the Category Exclusion Function

| Note: Go to the Job Information tab to select the category(ies) with which this job is to be associated.

If you wish to exclude potential panelists if they have been invited to participate in a survey with the same
category(ies) as this survey, within a specified time period, proceed as follows:

1. Go tothe Sample Management > Current Job menu command.
2. Click the Exclusions tab.

The Exclusions window opens at the Auto Exclusion tab.

3. Check the Category Exclusion box.

The Category Exclusion function is activated.

Category Exclusion =]

Days Before Mailing Date EI days
Days After Mailing Date El days

| August 2008 [
Wk Mon Tue Wed Thu Fri Sat Sun
week 28 23 30 31 1 z 3
week 4 5 & 7 2 g 10
week 11 12 13 14 15 16 17
week 18 19 20 21 22 23

s

weaek 4 5 = 7

Survey Status
All b

Figure 161 The Category Exclusion function

4. Inthe Days Before... and Days After... data fields, specify the number of days which, if a panelist has
been included in another panel of the same category during this period, they are to be excluded from this
survey.

5. Click the drop-down arrow beside the Survey Status field to open a list of the statuses and select the
desired option.

The options are:
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6.

Reserved — excludes all potential panelists who are already reserved for other projects in the
specified categories and date range.

Invited — excludes potential panelists if an invitation has been sent to them to participate in a survey in
one of the specified categories.

In Progress — excludes potential panelists if they are in progress with a survey of the specified
categories.

Completed — excludes all potential panelists who have completed a survey in the specified categories
within the specified date range.

Stopped by System — excludes potential panelists who have been invited to participate in a survey in
the specified categories during the specified time period, if those panelists have been prevented from
completing those surveys by Forsta Plus.

All — excludes all potential panelists who have been invited to participate in any survey of the specified

categories during the specified period.

Click Save to the save the changes.

7.1.2.4.4. How to Set the Date Exclusion Function

If you wish to exclude potential panelists if they have been invited to participate in any survey within a specified
time period around the mailing date for this survey, proceed as follows:

1.
2.

Go to the Sample Management > Current Job menu command.
Click the Exclusions tab.

The Exclusions window opens at the Auto Exclusion tab.

Check the Date Exclusion box.

The Date Exclusion function is activated.

Date Exclusion :ﬂ]

Days Before Mailing Date EI days
Days After Mailing Date EI days

-« Auvgust 2008 »
Wk Mon Tue Wed Thu Fri Sat Sun
week 22 29 20 31 1 2 3
week 4 5 6 7 g 3 10
week 11 12 13 14 15 16 17
wvieek 18 19 20 21 22 23

s

vieek 4 5 8 7

Survey Status
All W

Figure 162 The Date Exclusion function

In the Days Before... and Days After... fields, specify the period during which, if a potential panelist has
been included in any other panel, they are to be excluded from this panel.

Click the drop-down arrow beside the Survey Status field to open a list of the statuses.
Select the desired option.

The options are:
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0 Reserved — excludes all potential panelists who are already reserved for other projects in the
specified date range.

o Invited — excludes potential panelists if an invitation has been sent to them to participate in a survey
within the specified date range.

o In Progress — excludes potential panelists if they are in progress with a survey within the specified
date range.

o Completed — excludes all potential panelists who have completed a survey within the specified date
range.

0 Stopped by System — excludes potential panelists who have been invited to participate in a survey
during the specified time period, if those panelists have been stopped from completing those surveys
by Forsta Plus.

o All — excludes all potential panelists who have been invited to participate in any survey during the
specified period.

7. Click Save to the save the changes.

7.1.2.4.5. How to Set the Property Exclusion Function

If you wish to exclude potential panelists who are or have been involved with jobs with particular properties,
proceed as follows:

Note: This requires that the appropriate properties have been defined (see The Property Definitions Tab
on page Error! Bookmark not defined. for more information).

1. Go to the Sample Management > Sampling Settings menu command.
The Sampling Settings window opens.

2. Goto the Property Definitions tab.

A list of the available Property Definitions is displayed, as shown in the example below.

| General || Categorization Tree | Property Definitions | output Field Templates || Survey Rule Templates

|>< Delete Mew Property Definition
| name 1d Required  Showin Joblist | Use Output Template Survey Rule Template | Has Survey History Support
D Complexity Complexity - - v v v
D Duration Test v

Figure 163 Example of the Property Definitions list

3. Click on the Name of the Property Definition you wish to use, to open the Property Definition page for that
property.
The page shown in the example below opens.

General " Categorization Tree I Property Definitions I Output Field Templates " Survey Rule Templates

|@ Back | Save and Close | [ save

Property Name |C0mp|e>cit',r |

Property ID |C0mp|e>cit',r |

1= required [ Show in Joblist [#]use output Template [¥] Use Survey Rule Template [¥]Has Survey History Support @ [#] Use in Exclusion

> Remove o add

[ zd Name Defau... Auto... Output Template Survey Rule Template &
Ol | [eom | o | v | ¥
Oz | [medium | c O | v | ¥
Ols | [pign | o O] ¥ | ]

Figure 164 Example of the Definition page for a property
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4. Check the Use In Exclusion box, and other boxes as required.

Note: Only one Property Definition can be used for exclusion in a job. Once the Use In Exclusion box is

checked for a Property Definition, the box cannot be accessed for another definition.

5. Click Save and close.
6. Go to the Sample Management > Current Job menu command, then go to the Exclusions tab.
7. On the Auto Exclusion tab, check the Property Exclusion box.

Note that the Property Definition you selected in step 3 above is now named beside the Property
Exclusion box (arrowed in the figure below).

8. Click Add.

A row is added to the exclusion list as shown in the example below.

Property Exclusion: [Complexity) &

:qt::q-le % | Days Bafore Mailing o 5| Days After Mailing Date ]
Add
Medium
Survey High bl

Figure 165 Example of the Property Exclusion list

9. Select the required item (in the figure above the Complexity property is selected, so the Item Name field

lists the items registered for the Complexity property. In this case the Low item is being chosen).

10. Type values into the Days Before... and Days After... fields to set the date range for which the exclusion

property is to be applied (the date range is applied about the Mailing Date).

11. If panelists conforming to the property exclusion should also have a specific status, then select the
required status.

Note: You can add as many rows as required to the list, and set them up such that all the required
combinations of items, dates and survey statuses are covered.

12. Save the changes.

7.1.2.4.6. How to Manually Exclude a Job

If you wish to exclude potential panelists who have previously been involved in a particular job, proceed as
follows:

1. Go to the Sample Management > Current Job menu command.
2. Click the Exclusions tab.

The Exclusions window opens at the Auto Exclusion tab.

Go to the Manual Exclusion tab.

Using the filters as necessary, find the appropriate job in the list.

Click in the job’s checkbox at the left side of the job list to flag it.

o 0~ w

Click the Exclude button in the Available Jobs toolbar.

The job is moved down to the Selected Job list, and is colored pink for easy identification.

Note: You can exclude only those panelists in the job who have a specified Survey Status (you can
specify more than one status).

7. Click the ... button beside the Filter field to open the Filter dialog as shown below.
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a - Webpage Dialog

Search:

AccessFromHome
AccessFromLibrary
AccessFromOther
AccessFromOtherSpecified
AccessFromSchool
AccessFromWork
ActivateDate

Active
ActiveDaysOnPanel
AddedDate
AgePresOfKids
AOLBrowser

AOLUser

archiveflag
archiveflagdate
BusinessOwner
CanadianProvince
CensusRegion
ClosedCustomCounter
ClosedlobsCounter
ClosedTrackerCounter
CHNR.Counter
ComputerType
ConnectionType

AccessFromCyberCafe A

Yes (True)
Ne (False)

Operators

O and

Oor

@ None
DNot

Functions

Equal

Contains

Left

Right

Expression:

Add here  Validate

X

Survey Status:
Reserved

In Progress

Invited

Completed

Stopped By System None

@ 1=null

<

http:ff172.16,12.106/confirm/authoring/EnterprisePanelfSampling; JobEliminationFilkerExpressionPopupContainer, aspx?Schematode=Ei ,r;& Trusted sites

Figure 166 The Filters Web Page dialog

8. Create an expression as necessary (see The Filter Tab on page Error! Bookmark not defined. for more
information).

9. Check the boxes for the statuses you wish to exclude (if None is selected, the other boxes are grayed
out), and click OK.

10. The dialog closes and you return to the Manual Exclusion tab.
11. Click Save to save the changes.

Any potential panelists who satisfies the criteria in the selected job are now excluded from your current job. You
can exclude several jobs at one time, and as many jobs as required.

7.1.2.4.7. How to Include an Automatic Exclusion

If you wish to include in your current job potential panelists who have been involved with a particular job that has
been excluded by the general criteria set in the Auto Exclusion function, proceed as follows:

1. Go tothe Sample Management > Current Job menu command.
2. Click the Exclusions tab.

The Exclusions window opens at the Auto Exclusion tab.

Go to the Manual Exclusion tab.

Using the filters as necessary, find the appropriate job in the list.

Click in the job’s checkbox at the left side of the job list to flag it.

o o M W

Click the Include button in the Available Job toolbar.
The job is moved down to the Selected Job list, and is colored green for easy identification.
7. Click Save to save the changes.

Any potential panelists who satisfied the criteria in the selected job are now included in your current job. You can
relax the exclusion notice for several jobs at one time, and for as many jobs as required.

7.1.2.4.8. How to Deselect a Job
You may wish to deselect a job that you have previously selected for exclusion or relaxation. Proceed as follows:

1. Go tothe Sample Management > Current Job menu command.

2. Click the Exclusions tab.
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The Exclusions window opens at the Auto Exclusion tab.

Go to the Manual Exclusion tab.

Find the appropriate job in the Selected Jobs list.

Click in the job’s checkbox at the left side of the job list to flag it.

o 0~ w

Click the Remove button in the Selected Jobs toolbar.
The job is removed from the Selected Jobs list, and is returned to the Available Jobs list.

7. Click Save to save the changes.

7.1.3. The Filter Tab

This tab is where you create the selection criteria expression that is the overall filter for the panelists. You can
select criteria from the list and assemble them using the operators and functions, or if you have the required
knowledge you can write the expression directly into the data field.

Job Information | Exclusions | Filter | Sample Definition | Sample File Fields | Execution | Reporting
|Saue |

(Ll Create the background panelist-selection expression |

Universal Criteria:

Search: Dperators Add here

Ohnd
OOr
@ None

ot

Functions

m
m
m
m

Figure 167 Example of the Universal Criteria tab

7.1.3.1. The Data Fields

e Search —type a character or string of characters into the Search field. As you type, Forsta Plus reduces
the criteria list to show only those criteria that include that character or series somewhere in the criteria
name.

e The Operators:

0 And — a conjunction operator to be used when more than one criteria must be satisfied. For example,
the panelist must be male and must be married.

o Or — a conjunction operator to be used when one or more criteria must be satisfied. For example, the
panelist must have network access from home or from work.

o None - this is not a conjunction operator. Use when adding the first criteria in the expression.

o0 Not — the negative operator. Use for example when you want panelists who are not in banking though
any other profession is acceptable.

e The Functions (these will be active depending on the criteria selected):
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o Equal — use when you want the selected criteria to be equal to a specific value, for example when you
want panelists of a specific age or you want the criteria to be Yes or No.

In — use when the criteria value is to be one of a range or set of values.

Between — use when you want the criteria to be between two values, for example between two dates.

o O o

> (Greater than) - use when the criteria is to be greater than a specified value.

o

>= (Greater than or equal to) - use when the criteria is to be greater than or equal to a specified value.
0 < (Less than) — use when the criteria is to be less than a specified value.
0 <= (Less than or equal to) — use when the criteria is to be less than or equal to a specified value.

o Contains — you can write an expression that looks, for example, for a certain combination of four
characters anywhere in a line of text.

o0 Left —you can write an expression that looks, for example, for the first three characters in a line of
text. In this case select Left as the desired string is to be on the left end of the line.

o Right — you can write an expression that looks, for example, for the last three characters in a line of
text. In this case select Right as the desired string is to be on the right end of the line.

o0 IsNull - you can write an expression that looks for any null-codes in multi questions; i.e. answer
options that have not been selected.

o0 Any - you can write an expression that looks for instances where any of a specified set of codes are
present.

o All - you can write an expression that looks for any instances where all of a specified set of codes are
present.

e Other data fields

0 Text area — type text as required into this field. The field is only accessible for certain pre-defined
criteria.

o Paste area — here you can paste in, for example, a list of values copied from a document.

o Number — here you can type in numerical characters only. Use in conjunction with a Function (see
above) when, for example, you want a criteria to have a specific numerical value. The field is only
accessible for certain pre-defined criteria.

o End Number — when the Number field is open, if you also select the Between function, a second
numerical data field appears. This enables you to input a second number such that you can specify
the criteria must have a value between the two given numbers.

7.1.3.2. Procedures in the Filter Tab

7.1.3.2.1. How to Create an Expression

Note: The procedures for creating expressions in the Filter tab and in the Sample Definition > Group Set
tab > Expression Editor window are virtually identical. The only difference is that the Expression Editor
window has Validate and OK buttons while the Filter tab has a Save button. The Filter tab is displayed in
the main Forsta Plus window, so clicking Save checks the expression and saves the changes; it does not
close the window. However as the Expression Editor function opens in a separate window, clicking OK
checks the expression, saves the changes and automatically closes the window. If you then wished to
make further changes to the expression, you would need to reopen the window before continuing. The
Validate button is therefore included to allow you to check that the expression you have entered is valid
before you click OK to save it and close the window. Therefore, if you are creating an expression in the
Expression Editor window, click Validate to check the expression before you click OK to close the
window.

1. Inthe left column, search for or browse to the criteria you wish to start your expression with, and click on it
to select it.

Any options that may apply to the criteria will be listed in the second column.

2. Select the radio button for the None operator (you cannot start an expression with the operators And or
Or).

Select the appropriate function and type any text or values into the Text or Number fields as required.

4. Click Add Here (see the following figure) to add the criteria to the field.
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Univerzial Criteria:

Add here

AccessFromHorme = Yes

Figure 168 Adding criteria to the data field

Note that the coding is displayed in the white data field while the logical expression is “written” below the
field.

5. Select and add criteria until you have the required expression.

Universial Criteria:
Add here

Active = "0" AND IN

(CensusRegion, "1", "2", "3", "4", "5t Mgh, NP Mgu navy AND BETWEEN
[PMActualige, 12, 991 AMD PMHOH = "1" AMD Language = "2" AND
MOT IM(StateCode, "AK", "HI"] AND DMA <> "622"

Active = Ackive AND IN[CensuszRegion, Mew England, Middle Atlantic, East N
Central, West M Central, South Atlantic, East South Central, West South
Central, Mountain, Pacific) AND BETWEEN({FMActualige, 18 , 99 ) AND
PMHOH = res AND Language = English AND HOT IN(StateCode, Alaska,
Hawaii) AMD DMA <= HNew Orleans, LASMS

Figure 169 Example of a complete expression

6. Click Save to save the changes.

7.1.4. The Sample Definition Tab

Particular surveys may need groups of respondents with different characteristics. For example, you might want to
create one group to reflect the people in one city with that city’s male/female ratio and income levels, and another
group for a different city with that city’s male/female ratio and income levels. The Sample Definition function
allows you to create such groups.

To access this function, go to the Sample Management > Current Job menu command, then click the Sample
Definition tab.

This tab is divided into two areas:

e The hierarchy column — displays the various sub-samples and group sets in a hierarchy.

e The editor page —displays the details of the item selected in the hierarchy column and enables you to edit
those details.

In the hierarchy column, either right-click on an item then select Edit from the drop-down menu (see The Right-
Click Menu on page 141 for more information), or double-click on the item, to open its editor page.

The following sections describe the editor pages for the various items in the hierarchy.
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7.1.4.1. The Right-Click Menu

Place the cursor over an item in the hierarchy then click the right mouse button to open the right-click menu for
that item. The menu commands available will depend on the type of item selected in the hierarchy. The full set of
possibilities is listed below:

Edit — opens the editor page for the selected item. You can also open the editor page for an item by
double-clicking on the item.

Add Group Set (Below) — creates a new Group Set below (within) the currently selected Sub Sample.
Add Group Set (After) — creates a new Group Set after the currently selected Group Set.

Add Sub Sample (Below) — creates a new Sub Sample below (within) the Sub Sample hierarchy.
Add Sub Sample (After) — creates a new Sub Sample after the current Sub Sample.

Refresh — refreshes the window to ensure all changes are displayed.

Expand All — expands the entire hierarchy.

Collapse All — collapses the entire hierarchy.

Duplicate — duplicates the selected Sub Sample and its underlying Group Sets and places the new Sub
Sample at the bottom of the hierarchy.

Delete — deletes the selected item. You are asked to confirm the deletion.

7.1.4.2. The Sub Samples Folder Editor Page

In the hierarchy column, either right-click on the Sub Samples item then select Edit from the drop-down menu, or
double-click on the item, to open its editor page.

Job Information " Exclusions " Filter I Sample Definition I Sample File Fields " Execution " Reporting

]
E |5 SubSample1 (SubSample 1)
Group set 11
Group set 1/2
E |5 SubSample2 (SubSample 2)

H Save

Disregard Sampling Matrix in sampling D

Group set 2/1 Matrix List Add Matrix ]l Delete Matrix ]]
Group set 2/1 ] name
[ matrix1
Custom Code Add Row ]l Delete Row ]]
I:‘ Name

D |Cu5t0mC0del |

D |Cu5t0mC0de2 |

I:‘ Name
[ |slebalt

value

|[z2e8 |

Figure 170 Example of the editing page for the Sub Samples folder

The "main" Sub Samples folder has the following data fields in its editing page:

Disregard Sampling Matrix... - you can set up universal criteria with matrices etc. (see The Filter Tab on
page Error! Bookmark not defined. for more information). Check this box to switch off the requirement to
use matrices and only use the filters. Set the filters for each group, sub-sample etc. individually. This
method of sampling is called Basic Sampling.

Matrix List - this is the list of matrices that are available in the Matrix drop-down on the Sub Sample editor
page (see The Sub Sample Editor Page on page 142 for more information). This allows you to create a
small set of matrices from the complete list (which may run into hundreds), thereby simplifying the
selection process and reducing the chance of errors. Click Add, then select the required matrices from the
list.
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Custom Code - use this field to add custom codes to the job so you can use the codes later in the sub
samples (see The Sub Sample Editor Page on page 142 for more information).

Global Custom Code - use this field to add custom codes to the job that all in the sample will be given
(this is similar to the default codes in the sub sample).

7.1.4.3. The Sub Sample Editor Page

In the hierarchy column, either right-click on a sub-sample folder then select Edit from the drop-down menu, or
double-click on the folder, to open the folder's editor page.

Job Information | Exclusions || Filter | Sample Definition | Sample File Fields || Execution | Reporting

B [ Sub Samples Save
=@ }ubsample (SubSample 1
Sub Sample Name
Group set 11 SubSample1
Group set 1/2 Selected Matrix Matriscl * | Manzge available matrices
Bl I SubSample2 (SubSample 2)
Group set 2/1 Cellweight Heavy weight ~| @
Group set 2/1 Original Cellweight v i@
Discard default group =
from final sample D g
Filter E] a
Total Target 1000 a
Default Code 3559 a
Custom Codes Manage custom codes
CustamCodel
CustomCodeZ

Figure 171 Example of the editing page for a sub sample folder

In the figure above, note the two "CustomCode" fields in the lower part of the page. These are created in the Sub
Samples editing page (see The Sub Samples Folder Editor Page on page 141 for more information).

The Sub-folders have the following data fields in their editing pages:

Sub Sample Name — the name for the sub sample.

Selected Matrix — the matrix to be used to build up the group. Note that the matrix must be created first.
The drop-down list will contain those matrices added to the Matrix List in the Sub Samples editing page
(see The Sub Samples Folder Editor Page on page 141 for more information)

Manage Available matrices - click this link to go to the Sub Samples Folder Editor Page to manage the
matrices.

Use Dynamic Targets - check this box if you wish to set the segment targets according to the
composition of the underlying sampling population (BitStream set).

Apply Filters when Calculating Dynamic Targets - check this box if you wish to include the sampling
job's universal criteria and the sub-sample filter in the query to calculate the dynamic segment targets.

Cellweight — select the cell weight to be used by the Sub Sample. See also Original Cellweight below.

Original Cellweight — the customer might have specified a particular cell weight. However if not enough
respondents can be found who satisfy the selection criteria, the cell weight might be changed to enable
the job to be completed. In that case the cell weight actually used is given in the Cellweight field while the
cell weight specified by the customer is given here.

Expression — the filter used to select the respondents. Click the ... button to open the Expression Editor
window (see How to Create an Expression on page 139 for more information).

Total target — this is the total number of panelists you wish to have in the sub sample Each group set in
the sub sample is allocated its own target, and this total target is the total of the group set targets. Forsta
Plus will attempt to fill this requirement while adhering to the selection criteria set in this and the other
tabs.
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Note: Forsta Plus performs two series of checks while creating a sample. The first check is performed
using the criteria defined in the sampling job (using the Universal Criteria expression and exclusions),
then a second check is performed to ensure any required percentages, weightings etc. are met. If Forsta
Plus finds more than the required number of panelists that comply with the criteria then the program will
randomly select the total required from those found. If not enough panelists complying with the criteria in
the first check can be found, then an error message is displayed and the job will stop. If you wish to
continue with the job you will then have to change some of the criteria. If the first check finds enough
panelists but the second check cannot meet the required percentages, weightings etc. then Forsta Plus
will try to complete the job by making adjustments to the weightings and percentages. Any changes will
be notified in the job report.

o Default Code — you can define a code number for each group. If a respondent is found who satisfies the
general criteria but who does not fit into a specific group, they will be allocated this default code.

e <custom code> - if a custom code is defined in the sub-sample (see Adding a Custom Code on page 144
for more information), then it will appear here. Add a value as required.

e Weight Parameter — this property is only used during concurrent sampling (see Concurrent Sampling on
page 198 for more information), and is only visible on the Sub Sample Editor page if the Expected Return
Variable box is set to a value other than None (see The General Tab on page 203 for more information).
The property enables you to specify the accuracy of the sampling by using the probability that panelists
are likely to reply to the survey. Enter a value between -1 and +1. A value of -1 will allow the sample to
include panelists who have a low probability of replying. This will thereby result in a larger sample to
ensure the required number of responses are returned. A value of +1 will restrict the sample to only those
panelists who have a high probability of replying to the survey. This will thereby result in a sample closer
in number to the required size.

e Disable Balancing — a particular matrix can be used for many jobs. Check this box if you do not want to
use the cell weights applicable to the matrix.

o Discard Default Group... — check this box if you do not wish to use potential respondents who have been
allocated the default code number (see above).

7.1.4.4. The Group Set Editor Page

In the hierarchy column, either right-click on a Group Set item then select Edit from the drop-down menu, or
double-click on the item, to open its editor page.

| Save

Group Set Name |Group set 1/1

Filter E]

Custom Codes Manage custom codes
CustomCodel

CustomCode2

‘}( Celete ﬁ‘ Move Up G Mowve Down Add Group Add Groups..

L]

|:| Percent Target Code CustomCodel CustomCode2

| z0 a0 &7 58

Figure 172 Example of the Group Set editing page

e Group Set Name - the name of the group set as it appears in the hierarch column. You can edit this name
as required.

o Filter - if you wish to use a filter expression instead of matrices, click the ... button and create the
expression here (see How to Create an Expression on page 139 for more information).

e Custom code field(s) - these are created in the Custom Code field in the Sub Samples editing page (see
The Sub Samples Folder Editor Page on page 141 for more information).

e Group List - the list of groups in the Group Set. Click Add Group to create new groups (see How to
Create a New Group Set on page 145 for more information).
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7.1.4.5. Procedures in the Sample Definition Tab

Note: Double-click on an item in the hierarchy or right-click on it and select Edit, to open the item’s editor
page.

7.1.4.5.1. Adding a Matrix List

A panel can have a large number of matrices available for use. When you are setting up a group of sub-samples
you may only need a small selection of the available matrices. Use the Matrix List functionality to build a “short
list” of the matrices that are to be available for the sub-samples. These matrices will then appear in the drop-down
list beside the Matrix field on the sub-sample editor page.

To add a matrix to the drop-down list, click the Add Matrix button and select the required matrix from the full list.

7.1.45.2. Adding a Custom Code

You can define one or more variables for which you can specify values in the Sub-Sample and Group levels.
When you add a custom code, it appears in the sub-sample / group window with the name you have given it. If
you add values to both the Sub-Sample and Group levels, then the Group level takes precedence.

To add a Custom Code:

1. Inthe Sub Samples Editor page (see The Sub Samples Folder Editor Page on page 141 for more
information), click the Add Row button for the Custom Code field.

A new row is added to the Custom Code list.
2. Type a name for the code into the Name field.
Note that the name must include only alpha-numeric characters - no special characters or space.

3. Click Save.

The new Custom Code will now appear in the Sub Sample Editor page (see The Sub Sample Editor Page
on page 142 for more information)

7.1.4.5.3. Adding a Global Custom Code
You can define a variable and a value that will be given to all panelists who are selected for the sample file.

Type in the name for the global code and give it a value. If you wish to add more codes, click the Add Row
button.

7.1.4.5.4. How to Create a New Sub Sample

Note: A rule that creates BitStream files from the panel database must be created before sub samples can
be created (see How to Create a New Rule on page 95 for more information). For this rule, the Source
must be Panel Database, the Target must be BitStream, and SurveyStatus must be selected in the Survey
History Variables field.

1. Click onthe Sub Sample icon after which you wish to create the new sub sample.
2. Click the right mouse button.

The right-click menu opens.
3. Click Add Sub Sample (After).

A new sub sample is created after the current sub sample, and its details window opens as shown in the
figure below.

4. Type the name for the sub sample into the Name field, and fill in the remaining details as appropriate (the
Total Target must be specified).

5. Click Save to save the new sub sample.

Note: You can also select Duplicate from the right-click menu to make a copy of the currently selected
Sub Sample and its underlying Group Sets.
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E Save

Sub Sample Name |(new5u|:l sample) |

Selected Matrix | V| Manage available matrices
Cellweight | Mo Matriz selected V| ﬂ

Original Cellweight | Ma Matrixz selactad V| ﬂ

poiag 0@

Filter E] ,ﬂ

Total Target | | Q

Default Code |5IE.IEIEI |@

Custom Codes Manage custom codes

Figure 173 Example of a sub sample editor page

7.1.4.5.5. How to Create a New Group Set

The Group Set function allows you to create a number of groups with similar characteristics. Each Sub Sample in
the hierarchy can contain any number of Group Sets, and each Group Set can contain any number of groups.
Once a group set is created you can edit the characteristics for each group individually.

1. Inthe hierarchy column, right-click the Sub Sample into which you wish to add a new Group Set, then
from the right-click menu select Add Group Set (Below).

The Group Set Editor page opens.

E Save }( Rermowve Group Generate Group

Group S5et
Hame

Expression E]
'@' Mave Up @' Maove Down

|I:new graup set) |

D Percent Target Code z
| ] ] o
0 of 1 selacted, Page 1

Figure 174 The Group Set Editor page

1. Type the desired name for the new group set into the Group Set Name field.

2. Click Save to save the changes and apply the name.

Note: The new Group Set already contains one undefined group. If you only require one group in the
Group Set then you need only to fill in the details for this group. In this case, click in the data fields under
Target and Code and type in the appropriate details — see below for the field descriptions.
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3. If you wish to create more groups, click Generate Group.

The Generate Groups window opens.

Generate

Generate Group

Generate ﬁ Claze

Number of Groups |5
Group Start Code 10
Group Increment =1
Percent |:|

Target 200
Figure 175 Example of the Generate Groups window

4. Fillin the details. The fields are as follows:

o Number of Groups — the number of groups you wish to create in this operation.

0 Group Start Code — each group should have a code humber. The number series will be created
automatically but the system needs to know where to start. Type in here the first code number to be
used.

o Group Increment — The code numbers can be set to increase in increments, for example in steps of
10 (10, 20, 30 etc.). Type the required increment in here.

o Percent — if you want to use a percentage of the total number of suitable people found by the filter
instead of a set number, check this box. See also Target below.

0 Target — the total number of people you want to have in the group, or the percentage of the total
number of people found by the filter. For example, if the filter finds 500 suitable respondents for the
group and you type in 50 here, the system will randomly pick out 50 people. If you type in 50 here and
also check the Percent box then the system will randomly pick out 50% of 500 = 250 people.

5. Click Generate to create the new groups.
The new groups are added to the Group Set list.
6. Click Save to save the changes.

The figure below shows the Group Set editor page with the new groups created according to the
parameters set in the Generate Groups window in the previous figure.
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Save )'( Fernove Group Generate Group

Group Set Name Group Set 271

Expression E]

ﬁ Maove Up {} Maove Down

[] percent Target Code
O O 200 10
O O 200 15
O O 200 20
O O 200 25
O O 200 20

Figure 176 Example of the new groups

You can edit the group details as required. Click in the data field and make the necessary changes. On
completion, save the changes.

7.1.5. The Sample File Fields Tab

When a person first agrees to make themselves available as a potential panelist, a lot of details about that person
are registered into a database. The database is constructed as a table of rows and columns where each row
contains the details of one person and each column contains the answers provided for one particular question.

The end product of the panel selection process is a text file containing a sample of the database table rows
(panelists’ details) as defined by the exclusion and selection criteria.

Some information, such as the panelist’s ID number is always included by default. However you can use the
Sample File Fields tab to specify which other columns of information about the selected panelists are to be
included in the text file. The columns included here will define the contents of the results tables that will be
available after the survey is completed. To add columns:

1. Inthe Available Fields list, select the columns you wish to add by clicking in the boxes beside the name.
2. Click Add.
The selected columns are moved to the Selected Fields area.

Click Add All to add all of the columns without having to select them individually. In the Selected Fields
area, select a column and click Remove to return it to the Available Fields list.
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Job Information || Exclusions | Filter | Sample Definition | S3mple File Fields | Execution || Reporting

| (1) Specify which columns of panelist-infarmation to include in the sample file. |
|p Search #k Add Add All View Panel Fields ¥ ‘ |P Search 3 Remave Remove All wisw | Al Fields v ‘
! Field Hame 2 | O Field name Field Type <
| \ | | | |
[ activated & age Template A
O active broveer Template
address_city browserversion Template
[0 =ddress_post carbrand Template
age carowner Template
[ =ge_groups children Template
[] answer_rate 1 country Template
appliances credits Template
booked degres Template ||
[ browser dogowner Template
[ browserversion email Template
[ carbrand empstatus Template
[ carovmer firstname Template
[ children gender Template
[ country GroupNumber Systemn
O credits householdsize Template
[0 datecfbirth v housing Template v
4 of 50 seleded, Page 1 | 0 of 32 selected. Page 1 N
Figure 177 The Sample File Fields window
7.1.5.1. The Sample File Fields Tab Toolbar
The toolbar for the Sample File Fields tab is as shown below.
|p search| dk Add Add All| view | Panel Fields v | |p Search X Remoue Remove All| view [4ll Fislds v |
[ Fisld name 2 | O Field name Field Type =

Figure 178 The Sample File Fields toolbar

Search — starts the search function.

Add — moves selected fields from the Available Fields list to the Selected Fields list.

Add All — moves all the available fields from the Available Fields list to the Selected Fields list.
Field Type — select the field type you wish to use. The options are:

Panel fields — the fields pre-defined by the panel.

External fields — additional fields made available by uploading a matchfile.txt file (see How to Upload a
File on page 127 for more information).

Check box — click in a check box to select the associated field. The uppermost check box selects all the
fields.

Field name — the header for the list of fields in the column.
Remove — removes selected fields from the Selected Fields list.
Remove All — removes all fields from the Selected Fields list.

View - select from the drop-down list the field type you wish to view.

7.1.5.2. Procedures in the Sample File Fields Tab

7.1.5.2.1. How to Add Fields to the Selected Fields Column

In the Available Fields column click in the check boxes to select the desired fields.

Selected fields are shaded blue for easy identification.
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4.

If for example the majority of fields are required, click in the check-box immediately below the Search
button to select all the fields, then use standard Windows techniques and deselect those that are not
required.

Click Add.

The fields are moved to the Selected Fields column.

Click Add All to move all the fields to the Selected Fields column.

7.1.5.2.2. How to Remove Fields from the Selected Fields Column

1.

3.

In the Selected Fields column, click in the check box to select the field you wish to remove.

Selected fields are shaded blue for easy identification.

Click Remove.

The fields are moved to the Selected Fields column.

Click Remove All to return all the fields to the Available Fields column.

7.1.5.2.3. Searching for Field Names

If the Available Fields list is extensive, you may wish to perform a search to locate the field name or names you
are looking for. Proceed as follows:

1.

Type an appropriate combination of characters into the Field Name data field. Wildcards are not
necessary.

Click Search or press the Return key on your keyboard.

Forsta Plus will find and display all the instances of that combination of characters that are to be found in
the Available Fields column.

For example if you type Zip into the field and click Search, Forsta Plus will find all fields with the word Zip
anywhere in the field name. Note that you do not need to type in complete words. For example, type Il into
the field and click Search to find all fields with Il anywhere in the name.

If after typing in the first search criteria the list is still long, you can perform a search through the first set of
results by repeating the procedure.

Once you have found the required field, click in its check box on it to select it, then click Add.

The selected field is moved from the Available Fields column to the Selected Fields column.

Note: You can select as many fields as you wish.

4.

To remove a field from the Selected Fields list, click in its check box to select it and then click the Remove
button. The field is returned to the Available Fields list.

On completion, click Save to save the changes.

| Note: The Save button flashes while the system contains changes that have not yet been saved.

7.1.6. The Execution Tab

Once you have set up all the selection criteria for the job, the job must be executed. This is done via the
Execution tab.

To access the Execution tab, go to the Sample Management > Current Job menu command.

- 149 -



Forsta Plus 2022 Professional and Standard Panels User Guide Forsta Confidential

Job Information || Exclusions || Filter | Sample Definition | Sample File Fields | Ex=cution | Reporting

| Save Execute Job Rermove Job Fram Panel

Job Status Approved

Mailing Date 01 September 2010
Preapproved

Disregard in Future Date Exclusions

Incidence Rate (%) 100 =)
Completion Rate (%) 100 =l

Braview Target(s)

Rebuild Sample File Remove Run From Panel Upload Change Mailing Date | Sample File Preview Add Test Panelists| Export Sample File Generats Sample Fill-In

Run Created Created By Mailing date  Panel Updated Uploaded Status Outgo/Exp. Return | Actual Return  Augment Of z
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Figure 179 The Execution tab

The Execution tab contains two main areas:

o The Job Execution area - run the job you have set up in the other tabs.
e The Job Runs area - manage the runs that have been performed.

The procedures available on this tab include the following:

e You can test the job settings by performing a dummy run (the database is not updated and the panelists
are not reserved).

e You can perform a “real” sample selection procedure with or without final reports.

¢ You can define when you want the execution job to be performed, and whether or not you want the job to
be repeated at specified intervals.

Once the job has been executed, you can also:

e Upload the sample file into a project (see How to Upload the Sample File on page 162 for more
information).

e "Undo" the sampling operation and return to sample to the panel (see How to Remove a Run from the
Panel on page 160 for more information).

e Change the mailing date (see How to Change the Panel Mailing Date on page 163 for more information).

¢ View a snapshot of the panelists in the sample (see After the Job has been Executed on page 160 for
more information).

e Add test recipients (Tester Templates) (see Tester Template List on page 201 for more information).
e Export the sample file (see How to Export the Sample File on page 164 for more information).

e Generate "Sample Fill-In". If a run does not find the required number of panelists using the specified
weight set, this executes a new run for which weights are recalculated to generate the required sample
(see How to Generate Sample Fill-in on page 160 for more information).

7.1.6.1. The Job Execution Area
This area shows general information about the job.
The toolbar contains a number of buttons and the area contains two check boxes.
e Save - saves changes to the tab. The button flashes while the tab has unsaved changes.

e Execute Job — starts the job execution process. Once the job is executed for the first time, additional
buttons become available (see After the Job has been Executed on page 160 for more information).

Note: Once you have clicked the Execute Job button, it is deactivated while the job is running. This is to
prevent “multiple-clicking” and the job being executed several times by mistake.
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Remove Job From Panel - click here if you have performed a number of sampling tasks and updated the
panel, but then wish to "undo" ALL the panel updates (see How to Remove a Job from the Panel on page
161 for more information). This will free-up the panelists selected for the samples so they are available for
other projects/samples. Note that this action removes ALL the runs from the panel. To remove one
specific run use Remove Run From Panel in the Job Runs area of the tab (see How to Remove a Run
from the Panel on page 160 for more information).

Preapproved — Forsta Plus can be set up by the system administrator such that an executed job must be
approved by the user’'s manager before it can be mailed. Check this box if you wish to avoid that
procedure, for example for testing purposes.

Disregard in Future Date Exclusions — check this box if you do not want the panelists selected by this
job to be excluded from future samples by the time limits set in the Exclusions tab. Use this for example if
you want to send an information email to a group of panelists without affecting their validity to be selected
for future questionnaires.

Incidence Rate % - here you can set the percentage of the panelists who receive the invitation to
participate in the survey, who you expect will not be screened for some reason. l.e. the percentage who
start to reply to the survey. For example, an Incidence Rate of 80% means that you expect 20% of the
panelists to be screened. The value will be taken into account when the number of panelists selected for
the sample is calculated.

Completion Rate % - here you can set the percentage of the panelists who start to reply to the survey,
who you expect will actually complete the survey. For example, an Completion Rate of 80% means that
you expect 80% of the panelists who start answering the survey to actually complete it. This value will be
taken into account when the number of panelists selected for the sample is calculated.

7.1.6.2. The Job Runs Area

The Job Runs area for the Execution tab displays the details of the sampling jobs that have been run.

The jobs are listed in the order they were performed with the most recent jobs at the top of the list. In the event
the list is extensive, it will be divided into pages with 30 jobs on a page.

The area has the following buttons:

Rebuild Sample File - regenerates the sample file to include new columns, but without selecting new
panelists. A task pane opens to provide information while the recreation task progresses. On completion,
click OK to return to the Execution tab. The Rebuild Sample File button is only available once the job has
been executed. This could be used for example if you have created an sample file but need to add or
change variables.

Remove Run From Panel - click this button in the event you have performed a sampling task and
updated your panel but then wish to "undo” the sample selection (see How to Remove a Run from the
Panel on page 160 for more information).

Upload - click to upload the sample file to a project (see How to Upload the Sample File on page 162 for
more information).

Change Mailing Date - change the mailing date for the project (see How to Change the Panel Mailing
Date on page 163 for more information).

Sample File Preview - provides an overview of the first 10 panelists in the sample file so you can check
that the file is correct.

Add Test Panelists - add test respondents to the database (see How to Add Test Panelists to the
Database on page 164 for more information).

Export Sample File - once you have created the sample file you can export it to another server or project
(see How to Export the Sample File on page 164 for more information).

7.1.6.3. Procedures in the Execution Tab

7.1.6.3.1. How to Execute a Job

When executing a job you have several options available to you:

You can test the settings by performing a dummy run (the database is not updated and the panelists are
not reserved).

You can perform a “real” sample selection procedure with or without final reports.
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e If you create a sample file you can specify whether it is to be uploaded automatically into a project, and if
so, which project.

e You can define when you want the execution job to be performed, and whether or not you want the job to
be repeated at specified intervals.

Proceed as follows (note that the process is divided into sections depending on the selections you make):
1. Inthe Current Job > Execution tab, check the details presented on the tab and make the appropriate
settings.
2. Inthe Job Execution (upper) section, click Execute Job.

The Execute Job Properties dialog box opens as shown below. Use the options in this dialog to select the
desired type of resullt.

Update Panel V]
Generate Sample File 7]
Comment

: Upload Sample

Existing Project

New Project

Start Time ASAP -

Cancel Finish

Figure 180 The Execute Job Properties dialog box

e Update Panel — ensure this box is checked if you wish to create a sample and update the database. This
action will reserve the selected panelists for the job, ensuring they cannot be used for other jobs during
the exclusion periods.

Click in the box to deselect it if you wish to perform a “dummy-run” of the sample selection process. Forsta
Plus will then apply all the expressions and exclusions, will check the system setup, and will present a
report with all the appropriate information, but no changes will be made in the database and the panelists
will not be reserved. Use this to test the job setup to ensure you get the required panel. You can perform
as many dry-runs as you wish.

Note: If you execute the job with the Update Panel option selected, you can remove the panelist
reservations from the database afterwards. To do this, click the Remove Job from Panel button that

appears in the tab’s toolbar.

e Generate Sample File — ensure this box is checked if you require the sample file (the list of panelists
reserved for the job) to be created. Note that you cannot Upload the sample if the sample file is not

created.

Note: If you select to generate the sample file but not to update the panel database, then Forsta Plus will
have no record that the selected panelists have been involved with this job. These same panelists may
then be included in later jobs, and will not be excluded automatically by date and/or category.
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Note: When the sample file is generated, each panelist is assigned a random mailcode value from 0 to 9.
This code is used to determine which batch the panelist is to be included in for email invitations and
reminders. When the number of batches is selected, the panelists are divided amongst the batches
according to their mailcode value. If only one batch is to be used, the mailcode value is ignored and all
panelists in the sample file are included. If for example the number of batches is set to 2, then panelists
with mailcode values 0, 1, 2, 3 and 4 will be allocated to the first batch and those with values 5, 6, 7, 8 and
9 to the second batch. If the number of batches is set to 10, all panelists with mailcode 0 will be in the first
batch to be sent, all panelists with mailcode 1 will be in the second batch to be sent etc.

e Comments — type any comments into the free-text data field.

e Upload Sample - check this box if you wish to upload the resulting sample file directly into a project.
When checked, the two options below are activated. Note that if you select this option you must click Next
and then make further selections (see The Upload Sample Properties Page on page 156 for more
information).

o Existing Project - select this option if you wish to upload the sample file to an existing project.
o New Project - select this option if you wish to upload the sample file to a new project.

e Start Time — specify the time when the task is to commence. Click the down arrow to open a drop-down
list of the options available:

0 ASAP - start the job as soon as possible. The job will be queued behind any other jobs awaiting
processing in the database, and will be run as soon as the processor is available.

0 Schedule for later execution — select this option if you want to run the job execution procedure at a
later time. If this option is selected, when you click OK, a dialog opens in which you can set the
required time and date for the procedure to be run, and whether you want the job to be repeated. See
the next section for details.

3. Select the required options and click Next or Finish as appropriate.

If you have selected to upload the sample, when you click Next the Upload Sample Properties page
opens (see The Upload Sample Properties Page on page 156 for more information). If you have not
selected to upload the sample, when you click Finish the sample selection task begins as defined by the
specified Start Time. While the task is running a Progress and Information window is displayed to keep
you informed of progress, as shown in the example below.

| @ Back

Task 1d Name Status Sampling - Execute Job

4083551 Sampling - Execute Jobs Error L |
0% 23% S50% 75% 100%
Task Id: 40859551
Status: Aborted by system
Assigned server: S8813-UKBATCH1
Schedule: 28/08/2008 05:14:07
Start Time: 28/08/2008 09:14:09
End Time: 28/08/2008 09:14:11

Elapsed Time: 00:00:02

(10:14:03) Initiating task: Sampling - Executs Job
(10:14:10) Starts building aggregated Sampling Matrix...
(10:14:10) Starts BitStream generation...

(10:14:10) Deploying BitStream files...

(10:14:10) Deploying BitStream files...

(10:14:11) Using Bitstream datasource: 'all’

(10:14:11) Starts concurrent balancing of samples...

Figure 181 Example of the Execute Job task information page

The task may take some time depending on the size of the panelist database and the exclusion criteria
set. When the Execute function is completed, the text "Task Complete" appears at the bottom of the task
list.

3.  When the task has completed, click the Back button (see the figure above) to return to the Execution tab.

Once the task is complete, if the sample file has been created, you can upload the file into a Forsta Plus project.
In this case, an Upload button appears in the Job Runs (lower) section on the Execution tab (see How to Upload
the Sample File on page 162 for more information).
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Note: Unless the Preapproved box on the Execution tab has been checked, the sample list you have
created will now need to be checked and approved by a manager. The manager’s Forsta Plus access will
have been set up by the system administrator, and when the manager logs on and opens the job, the
Execution tab will have two additional buttons; Approve and Decline. The manager will check the sample
list and then click the appropriate button.

7.1.6.3.2. How to Set the Execution Time/Date for a Job

You may want a job to be executed at some time in the future. Forsta Plus allows you to input a time and date for
the job to be executed, and define whether or not the job is to be repeated at intervals. Here you can also stop a
job that has already been input, or reset it to start as soon as possible. Proceed as follows:

1. Inthe Execute Job Properties dialog box, go to the Start Time drop-down menu and select Schedule for
later execution.

2. Click OK.

The Execute Job page opens at the Recurrence tab.

Cefinition Recurrence Parameters Instances

New Start Time O Dizsable task (clear queus)

O asap
@ [12:00 |[os/0z/2008 [2)

Recurring Task No | W

Save Cancel

Figure 182 The Recurrence tab

The options are as follows:

o Disable task — select this radio button and click Save to disable the selected task. The task will not
then run. The task is not deleted; you can access it later and restart it.

0 ASAP - select this radio button and click Save to run the task as soon as possible.
o Time and date fields — set a time and date for when the task is to run, then click Save.

o Recurring task — click the down-arrow and select Yes if the task is to recur. Additional options then
become available in the dialog box. See the next section for further details.

When you save the settings, the Recurrence tab changes to show the selected settings.

Definition Recurrence Parameters Instances

Current Settings Initial Start Time: 06/02/2008 12:00:00

Change

Figure 183 Example of the Recurrence tab when settings are saved

7.1.6.3.3. How to Set Up Recurring Tasks

You may want a job to be repeated one or more times during a defined period. If so, proceed as follows:

1. Inthe Recurrence dialog (see How to Set the Execution Time/Date for a Job on page 154 for more
information), click the down-arrow beside the Recurring Task field and select Yes.
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The dialog expands to display additional parameters — see the figure below.

Definition Recurrence Parameters Instances

New Start Time O Disable task (clear queus)

O asap

® [12:00 |[os/0z/2008 [2)

Recurring Task Yes W
End By 21/12/2008 |:_-
Recurrence pattern type Monthly |+

Monthly schedule Day |0 | of every |0 | monthis)

Save Cancel

Figure 184 The dialog with the Recurrence function activated

2. Inthe New Start Time fields, set the time you want the first job execution to be performed.

3. Inthe Recurrence Pattern Type field, click the down-arrow and select the basic recurrence rate (hourly,
daily etc.).

The “Schedule” area below changes depending on the selection made here. In this area:

(o]

For hourly recurrences, type in the rate. For example, if you want the job to be executed every 4
hours, type 4 into the box. The job will be first executed at the date and time set in the New Start Time
fields, then will be repeated every four hours.

For daily recurrences, type in the rate. For example, if you want the job to be executed every 3rd day,
type 3 into the box. The job will be first executed at the date and time selected in the New Start Time
fields, and will be repeated every third day.

For weekly recurrences, type in the rate and select the days of the week on which you want the job to
be executed. For example, if you type 2 into the first box and click in the Monday and Friday boxes to
select them, the job will be executed every second week; the first time on the Monday, the next time
on the Friday, the next time on the Monday and so on.

For monthly recurrences, type in the day of the month and the rate. For example, if you want the job to
be executed on the 10" day of every second month, type 10 into the Day box and 2 into the Month
box.

4. In the Range of Recurrence fields, set the end-date and time for the recurrences. No recurrences will be
performed after this date and time.

5. Click Save to save the settings.

The Recurrence tab changes to display the settings.
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Recurrence I Parameters || Instances |
Recurrence parameters saved

Current Settings Initial Start Time: 05/02/2008 12:00:00
Pattern: Maonthly
Interval: Every 1 month(s)
Range: 31/12/2008

Mext scheduled ocurrences 06/02/2008 12:00:00

01/03/2008 12:00:00
01/04/2008 12:00:00
01/05/2008 12:00:00
01/06/2008 12:00:00

Figure 185 The Recurrence tab showing an example of recurring settings

| Note: If you go out of the dialog before saving the settings, the settings will revert to their default values.

Once you have saved the settings, you can go back at any time to change them or halt the task. To do this, click
Change(see How to Change the Execution Settings on page 159 for more information).

7.1.6.3.4. The Upload Sample Properties Page

The Upload Sample Properties page is where you select the project to which the sample is to be attached. When
executing a job (see How to Execute a Job on page 151 for more information), if you select the Upload option
and click Next in the resulting dialog, the Upload Sample Properties page opens as shown below.

Note: If the sample contains text variables that are longer than 255 characters, those variables will be
truncated automatically to 255 characters when they are uploaded to the survey.

(£] Mote! Text variables longer than 255 characters will be automatically truncated upon upload to the survey.

Upload Sample Properties

Project Id [ || select project |
Comment | |
Test Database [F]
Email Sample Email Reminder
Email Email Reminder

Mailing Date 31/10/2008 et Tt ]

Mailing Time

Override for Sub Samples

Cancel || < Back || Next = || Finish |

Figure 186 The Upload Sample Properties page

1. Click Select Project.
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The Project List window opens.

Select the required project from the list and click OK.

The window closes and the selected project Id is added to the field. Note that in the event the list is
extensive, you can search for the required project using the various search criteria available.

Type a comment into the Comment field as required.

Click in the Test Database box to select it if you wish to attach the resulting panel to the project's Test
database.

If the selected project contains an email, when you select the Email Sample box the email properties
become active.

Project Id p0991725 Select project
Comment Test run 1
Test Database
Email Sample Email Reminder
Email al ¥ Email Reminder al W
Mail Date 19/01,/2008 Days to Reminder
Mailing Time 00:00
Number of Batches 1

Hours Between Batches |0

Override for Sub Samples

Sub Sample Name Email Reminder Email
(new sub sample) Dafault Default %
Cancel < Back MNext = Finizh

Figure 187 The Upload Sample Properties page with the email section active

Email - if the project includes more than one email, click the down-arrow and select from the list the email
that is to be used. Note that any email nodes used in the panel will also be available here.

Mail Date - the date on which the email is to be sent (see How to Set the Mailing Date on page 132 for
more information).

Mailing Time - the time at which the email is to be sent. If a large number of emails are to be sent and the
transmission is divided into batches, this is the time the first batch is sent.

Number of Batches - if a large number of emails are to be sent and you wish to divide the transmission
into batches, type the number of batches here.

Hours Between Batches - specify the number of hours between each batch of emails that is to be sent.

Email Reminder - if you wish to send a reminder email to those panelists who do not respond to the
guestionnaire, check the box. The two options then become active.

Email Reminder - if the project includes more than one email, click the down-arrow and select from the
list the email that is to be used.

Days to Reminder - type in the number of days after which the reminder email is to be sent.

Make the settings as required.
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6. If you have several sub-samples and you wish to send different emails to different sub-samples, check this
box. The Sub Sample list below becomes active. Here you can select the primary and reminder emails for
each sub sample.

7. On completion, click Next.

The Augment Sample Properties page opens (see The Augment Sample Properties Page on page 158 for
more information).

7.1.6.3.5. The Augment Sample Properties Page

When you click Next on the Upload Sample Properties page (see The Upload Sample Properties Page on page
156 for more information), the Augment Sample Properties page opens as shown below.

Use the Augment Sample functionality to ensure you receive the required number of completes to your
questionnaire. If for example you need 1000 completes, you will probably start by creating a sample of 1000
panelists. However there is a good chance that not all of the panelists will reply, leaving you with perhaps only
600 completes. You can therefore set up the Augment functionality such that after a specified period, additional
samples are created so that you will receive the desired total of 1000 completes.

The Augment functionality will wait a specified period (Days to First Augment) after the initial mailing date, and
then count the number of completes that have been returned by the original sample. It will then check whether
that number is within the Augmenting limits (Lower and Upper Limits), and if so will select a new sample
calculated to provide the required "top-up" of completes. If the Number of Augments is set to anything other than
1, the system will then wait a further specified number of days (Days Between Augments), before repeating the
process. The process will be repeated until either the required number of completes is received or the specified
number of augments is performed.

Schedule Augments

Days Between Augments Number of Augments i
New Target Factor (%) =] Lower Limit to Run Augment (9] 0 (=]
Days to First Augment Upper Limit to Run Augment (%) (100 =]
Sub Sample Name Total Target Target for Calculating Diff
{new sub sample) 50 (=]
Cancel < Back

Figure 188 The Augment Sample Properties page

o Days Between Augments - the number of days that are to elapse between each augmenting task.
e Number of Augments - the number of augmenting tasks that are to be run, if required.

o New Target factor - the factor in percent by which the difference between the original total target and the
actual return is multiplied. The calculation will be run for each sub sample, and the new total target will be
distributed to the groups according to the original ratio. The calculation is: New Total Target = (Total
Target - Actual Return) * New Target Factor

e Lower Limit to Run Augment - the percent difference between the original target and the actual return
must be higher than this limit for the augment to run. The limit is per sub sample.

e Days to First Augment - the number of days after the mailing date when the first augment task is to run.

e Upper Limit to Run Augment - the percent difference between the original target and the actual return
must be lower than this limit for the augment to run. The limit is per sub sample.
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e Target for Calculating Diff. - the target used for calculating the difference between the target and the
actual return instead of the original total target. The calculation is:

New Total Target = (Target for Calculation Diff - Actual Return) * New Target Factor.

7.1.6.3.6. How to Change the Execution Settings

Once a job execution task is set up and activated, the job will be listed in the Tasks list. If you wish to make
changes to the task, execution time or recurrence sequence, proceed as follows:

1. Inthe Quick Access pane, go to the Tasks menu command.

The Tasks window opens listing all the tasks that are scheduled to run, with the task to be performed first
at the top.

Note: The list will include tasks for all projects to which you have access. To restrict the list to the tasks
for one project, type the project ID into the appropriate search field and click Search (see The Project
Tasks Page on page 29 for more information).

Scheduled | Executing || Completed || Aborted || Recurring || Search |

P search| X Dissble|totiy| TaskTunl  Plcempans]  lrecwmng]  ¥lreporchumba] |
| Task 1d User Id Project Id Task Type Schedule = Delzy Company Comment o
[ I J [ \

D 109157 nigelb p2704337 Sampling - Execute Job 06/02/2008 11:00:00 Confirmit ASA

[ 109181 nigelb p2704397 Sampling - Exscuts Job 06/02/2008 12:00:00 Confirmit ASA

D 109155 nigelb p0914692 Rule Executor 01/03/2008 10:54:14 Confirmit ASA

D 52101 rodrigov p0357042 Datz Import 05/04/2008 12:36:36 Confirmit ASA

|—| 56532 lukaszw p2170443 Batch Emailing - Fixed Domain 22/11/2010 15:00:00 Confirmit ASA

Figure 189 Example of a Task List

2. Click the blue Task ID link for the task you wish to change.

The Execute Job window opens for that job, showing the instances for the job.

3. Go to the Recurrence tab, and click Change.

The tab changes to show the current details of the job.

Sampling - Execute Job

Fecurrence I Parameters ” Instances |

New Start Time

O Disable task (clear queuea)

® asap
O |o0:00 ||os/oz/2008 |2

Recurring Task

End By 31/12/2008 | o)
Recurrence pattern type Manthly %

Monthly schedule Cay of every maonthi(s])

| Save || Cancel

Figure 190 The Execute Job > Recurrence tab ready for changing

Here you can make the required changes to the job (see How to Change the Job Schedule Settings on
page 197 for more information).
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4. On completion, click Save to save the settings, then click Close Window to return to the Task list.

7.1.6.3.7. How to Generate Sample Fill-in

If a run does not find the required sample using the specified weight set, you can execute a "topping-up" run for
which weights are recalculated automatically to generate the required total sample. The new weights are
calculated based on the difference between the specified target and the outcome of the previous run.

1. On the Execution tab > Job Runs list, select the run you wish to top-up.
2. Click Generate Sample Fill-in.

A confirmation window opens.

£ x|

P Generate Sample Fill-Inn will do the Following For the Sub Samples used by this run:

_\_\___‘

- Caloulate a new target,
- Create a new weight set, where weights are calculated based on the difference bebween the target and outcome per segment of the selected run.

- Apply new weights to Sub Sample

Do you wank ko conkinue?

oK ] [ Cancel

Figure 191 The confirmation window

3. Click OK to continue.

The sub-sample target is changed to what is missing from the original sample, the sub sample weights are
changed to ensure the required sample is achieved, the matrix used by the sub-sample is given new
weights and the weight targets are updated. The job is then run and the sample will be completed.

7.1.6.3.8. How to Delete a Job from the Execute List

Once a job is scheduled for execution it will be listed in the Scheduling window. Go to this window to delete a job
before it is executed (see How to Abort Execution of a Sampling Job on page 197 for more information)

7.1.6.4. After the Job has been Executed

Once a sampling job has been executed, the basic details of the job are presented in the Job Runs list in the
lower part of the Execution tab (see The Job Runs Area on page 151 for more information). A number of
procedures and operations can be performed from the Job Runs area. These are described in the following
sections.

The reports generated for the various jobs that have been run are accessible through the Reporting tab (see The
Reporting Tab on page Error! Bookmark not defined. for more information).

7.1.6.4.1. How to Remove a Run from the Panel

In the event you have performed a sampling task and updated your panel, but then wish to "undo” the sample
selection, proceed as follows:

Note: This procedure will remove a selected run from the panel. To remove all existing runs from the
panel, use Remove Job From Panel in the Job Execution area of the tab (see How to Remove a Job from
the Panel on page 161 for more information).

1. Inthe Job Runs area in the lower part of the Execution tab, click on the Run Number for the sampling run
you wish to cancel.

2. Click the Remove Run From Panel button (located in the Job Runs area).

The Remove Sample dialog opens.
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Repost Sample |:|

Comment | |

Start Time | ASAP v|

Figure 192 The Remove Sample dialog

Repost Sample - you may wish to update the existing sample. Check this box to delete the existing
sample and then automatically re-run the task. If you check this box, you can then select the time when
the repost is to occur.

Comment - type a comment into the field as required.

Start Time — specify the time when the task is to commence. Click the down-arrow to open a drop-down
list of the options available:

0 ASAP - start the job as soon as possible. The job will be queued behind any other jobs awaiting
processing in the database, and will be run as soon as the processor is available.

0 Schedule for later execution — select this option if you want to run the task at a later time. If this
option is selected, when you click OK, a dialog opens in which you can set the required time and date
for the procedure to be run, and whether you want the job to be repeated.

Make the required selections and click OK.
The task is run as specified.
On completion, click the OK button to return to the Execution tab.

If you selected Repost Sample, once the Repost operation is completed then the Panel Updated column
will show No for the selected run.

7.1.6.4.2. How to Remove a Job from the Panel

In the event you have performed a number of sampling tasks and updated your panel, but then wish to "undo"
ALL the sample selections, proceed as follows:

Important
This procedure will remove all the runs from the panel. To remove one specific run, use Remove Run
From Panel in the Job Runs area of the tab (see How to Remove a Run from the Panel on page 160 for

more information).

1.

In the Job Execution area in the upper part of the Execution tab, click the Remove Job From Panel
button.

The Remove Sample dialog opens.

Remowve Sample

Repost Sample |:|
Comment | |
Start Time | ASAP v |

Figure 193 The Remove Sample dialog
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e Repost Sample - you may wish to update the existing samples. Check this box to delete the existing
samples and then automatically re-run the tasks. If you check this box, you can then select the time when
the repost is to occur.

e Comment - type a comment into the field as required.

e Start Time — specify the time when the task is to commence. Click the down-arrow to open a drop-down
list of the options available:

0 ASAP - start the removal task as soon as possible. The task will be queued behind any other tasks
awaiting processing in the database, and will be run as soon as the processor is available.

o Schedule for later execution — select this option if you want to run the task at a later time. If this
option is selected, when you click OK, a dialog opens in which you can set the required time and date
for the procedure to be run, and whether you want the job to be repeated.

3. Make the required selections and click OK.
The task is run as specified.
4. On completion, click the OK button to return to the Execution tab.
If you selected Repost Sample, once the Repost operation is completed then the Panel Updated column
will show No for the selected run.
7.1.6.4.3. How to Upload the Sample File

Once you have created the required sample file, if it is not uploaded to the project automatically when it is created
(see The Upload Sample Properties Page on page 156 for more information) then it must be uploaded
"manually”. To do so, proceed as follows:

1. Inthe Execution tab's Job Runs area, select the run you wish to upload to your project.
2. Click Upload.
The Upload Sample Properties dialog box opens.

@ Existing Project

D New Project

Start Time ASAD o

Figure 194 The Upload Sample Properties dialog - 1

e Existing Project - select to upload the sample file to an existing project.
e New Project - select to create a new project and upload the sample file to it.

3. Select the start time for the job and click Next (see How to Set the Execution Time/Date for a Job on page
154 for more information).

The dialog changes to that shown below. Note that if you have selected to upload to a new project, the
field layout will be slightly different.
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Project Id Select project

Comment

Test Database [F

Email Sample

Cancel < Back

Figure 195 The Upload Sample Properties dialog - 2

e Project ID —the ID number of the project into which you wish to load the sample file.
e Comment — free text field for general comments.

e Test Database — check to load the data file into a test database such that you can test the survey.

2. Inthe Project ID field, write the ID number of the project into which you wish to load the sample file, and
make the other settings as required.

3. Click OK.

The file containing the details of the selected panelists is loaded into the selected survey. While this is
happening, a task list and progress bar is displayed on the screen. On completion, an OK button will
appear at the bottom of the task list.

4. Click OK to return to the Job Information page.

The Sampling job is now complete. Refer to the separate Professional Authoring User Guide for further
information on survey creation.

Note: When the sample file is generated, each panelist is assigned a random mailcode value from 0 to 9.
This code is used to determine which batch the panelist is to be included in for email invitations and
reminders. When the number of batches is selected, the panelists are divided amongst the batches
according to their mailcode value. If only one batch is to be used, the mailcode value is ignored and all
panelists in the sample file are included. If for example the number of batches is set to 2, then panelists
with mailcode values 0, 1, 2, 3 and 4 will be allocated to the first batch and those with values 5, 6, 7, 8 and
9 to the second batch. If the number of batches is set to 10, all panelists with mailcode O will be in the first
batch to be sent, all panelists with mailcode 1 will be in the second batch to be sent etc.

7.1.6.4.4. How to Change the Panel Mailing Date

If you need to change the mailing date (the date the project is to be emailed to the panel), then you can do so as
follows:

1. Inthe Execution tab's Job Runs area, select the run you wish to change the mailing date for.
2. Click the Change Mail Date button.
The Change Date dialog opens.
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Current Mail Date 22/02/2007

Mewr Mail Date 2g/0z/z007

Figure 196 Example of the Change Date dialog

3. Setthe date as required.
4. Click OK.

7.1.6.4.5. How to Add Test Panelists to the Database

Once a job has been executed for the first time, the Add Test Panelists button appears in the tab’s toolbar. To
add a tester template to the database:

1. Click the Add Test Panelists button.

The Tester Template List window opens. This window lists all the tester templates available for this panel
(see Tester Template List on page 201 for more information).

2. Select in the list the template you wish to add to the database.
3. Click Apply and Close.

The template is added to the database.
7.1.6.4.6. How to Export the Sample File
Once you have created the sample file you can export it to another server or project. Proceed as follows:

1. On the Execution tab, in the Job Runs area select the job run for which you wish to export the sample file.
2. Click Export Sample File.
The Sample File Export dialog opens.

Email recipient |dn:umentatinn@:nnfirmit.mm |

Comment | |

Figure 197 The Sample File Export dialog

3. The Email Recipient field contains the email address registered for the current user. Change this as
required.

4. Type a comment into the Comment field if required and click OK.
The sample file created by the selected job is zipped, attached to an email and sent to the specified
address.
7.1.6.5. The Task Definition Properties Dialog

Use this dialog to set up recurring jobs, and to view the details of jobs that are already set up to run at some point
in the future. The tabs in the dialog are:

e Properties— provides general information on the selected job, and allows you to enter comments on the
job.
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Task definition properties

Properties Recurr

netances | Paremeters | Ownerstip |

Task type

Sampling - Execute Job
ID 1030
Owner nigelb

Company ID

Project ID pl220548

Comment

Command line

Save

Figure 198 Example of the Properties tab

Recurr — once the settings have been saved, this tab displays the initial settings for the current job and
the dates and times of any recurrences.

Instances — One job scheduled for execution can have several instances (recurrences). The Instances
tab lists those recurrences that have been completed, and the next recurrence scheduled to be performed.
Click on the link in the Schedule column to check the details for each recurrence.

Schedule

2007-10-24 14:00:00

Status

@ In queue

Figure 199 Example of the Instances tab

Parameters — is for information only.

Task definition parameters

Jobids
Pulltoexpectedreturns
Tasktype

Runasap

Projectid

243326,243324

False
Firmglobal.Confirmit.Tasks.Sampling.Executelobs
False

p0220548

Figure 200 Example of the Parameters tab
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e Ownership — All tasks have a specified “owner”; in most cases the user who originally created the task.
However, a user’s access permission can expire or be deleted, and if a task previously created by a now-
expired/deleted user attempts to run then the task will abort. In this case, the administrator has the option
of changing the task’s owner. To change the task owner, go to the Ownership tab, type in the new owner’s
user-name, and save the change.

Note: To change a task owner, the administrator must have task_admin, system_admin,
system_project_admin or project_admin permission. Users with other permissions will not see the
Ownership tab.

Note: If the owner of a sampling task is changed, the ownership of any associated sample upload task will
also be changed such that it remains associated.

7.1.7. The Reporting Tab

This tab lists the jobs that have been executed, and provides access to the reports for those jobs.

Job Information | Exclusions || Filker | Sample Definition | Sample File Fields || Execution | Reporting |

Job Reporting
Job Definition Repart

Job Status Work In Progress

Crosstab Report

Run Created Created By Mailing date | Status Augment Of | Outge/Exp. Return | Actual Return | Definition Report | Outgo Report o

Figure 201 Example of the Reporting tab

The tab contains two main areas:

e The Job Reporting area - provides access to the current Job Definition Report and status (see The Job
Reporting Area on page 166 for more information)

e The Job Runs area - provides access to the Job Definition Reports and other information for each run, as
the job was defined when that run was executed (see The Job Runs Area on page Error! Bookmark not
defined. for more information).

7.1.7.1. The Job Reporting Area
The Job Reporting area is in the upper part of the Reporting tab.

Job Reporting
Job Cefinition Report

Job Status Waork In Progress

Figure 202 The Job Reporting area on the Reporting tab

The area displays the current status for the job. Note that the job status is changed automatically by Forsta Plus
as it passes through the various development stages. The area has one button:

e Job Definition Report — click this button to display a report of the current job definition, as shown in the
example below. Note that the Definition Report links in the Job Runs area provide access to the Job
Definition Reports as they were when the runs were performed.
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‘@ Back Printer Friendly Version |

Job Number: Jobben

Job Description:

Data Source Kajakk

Mail Date 19/01/2008

Date Created: 04/12/2007

Created By: arikb

Date Modified: 14/01/2008

Modified By: nigelb

Field Data

Job Categories Carbonated Soft Drinks

Brealfast Items (Cereals, Waffles, Syrup)

Active = Active AND IN{CensusRegion, New England, Middle Atlantic, Esst N Central, West N Central, South Atlantic, East South Central, West South
Total Available Sample Central) AND BETWEEN(PMActuzlAge, 18 , 99 ) AND PMHOH = Yes AND Language = English AND [NOT IN(StateCode, Alaska, Hawaii)) AND DMA =
Abilene-Swestvater, TX

Date Elimination 14/01/2008 - 03/02/2008
Category Elimination 05/01/2008 - 03/02/2008
Additional Items AccessFromHome

AccessFromWork
AddedDate
BusinessOvmer

email

Language
Excluded and Relaxed Job Job Number Survey status Filter Description
SubSampleNum Field Expression Default Group Matrix Original Cell Weight Cellweight Total Target
1 ss1 My matrix Male 50
Group Set 1/1
Group O siza=0
Group Set 1/2
Group O size = 0
2 552 My matrix Female 50

Group Set 2/1
Group O size = 0
Group Set 2/2

Group 0 size = 0

Figure 203 Example of a Job Definition Report

The Job Definition Report report contains three sections:

e Job Details — the job number, status etc (see The Job Details Area on page 167 for more information).

e General Information — the job categories, the expression and exclusions used, and the additional items
selected (see The General Information Area on page 167 for more information).

e Sub Sample Information — details of the sub samples defined (see The SubSamples Information Area on
page 168 for more information).

7.1.7.1.1. The Job Details Area

This area provides general details of the job, such as the number, a description, the data source etc..

Job Number: 12345

Job Description: Trial

Data Source all

Mailing Date 29,/08/2008
Date Created: 22/08/2008
Created By: usermanual
Date Modified: 28/08/2008
Maodified By: usermanual

Figure 204 Example of the Job Details area

Click the green Back button to close the window and return to the Reporting tab.

7.1.7.1.2. The General Information Area

This area shows general information about the job, such as which categories are selected, the filter scripting,
exclusions etc..
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Click the up or down arrow button in the area's header row to show or hide the information, and click the
green Back button to close the window and return to the Reporting tab.

[ GereraTramaton

Field Data
Job Categories Carbonated Soft Drinks

Breakfast Items (Cereals, Waffles, Syrup)

Active = Active AND IN(CensusRegion, New England, Middle Atlantic, East N Central, West N Central, South Atlantic, East South Central,
Total Available Sample West South Central) AND BETWEEN(PMActuzlAge, 18 , 99 ) AND PMHOH = Yes AND Language = English AND (HOT IN(StateCode,
Alaska, Hawaii)) AND DMA = Abilene-Sweetwater, TX
Date Elimination 14/01/2008 - 03/02/2008
Category Elimination 05/01/2008 - 03/02/2008
Additional Items AccessFromHeme
AccessFromwark
AddedDate
BusinessOvmer
email
Language
Excluded and Relaxed Job Job Number Survey status Filter Description

Figure 205 Example of the General Information area

Note that exclusions are sorted by job number.

7.1.7.1.3. The SubSamples Information Area
This area displays details of the various sub-samples in the sample.

Click the up or down arrow button in the area's header row to show or hide the information, and click the
green Back button to close the window and return to the Reporting tab.

(%) SubSamples Infomation

SubSampleNum  Field Expression Default Group Matrix Original Cell Weight CellWeight Total Target
1 ss1 My matrix Male 50
Group Set 1/1

Group 0 size = 0

Group Set 1/2

Group 0 size = 0

2 ss2 My matrix Female 50
Group Set 2/1

Group 0 size = 0

Group Set 2/2

Group 0 size = 0

Figure 206 Example of the SubSamples Information area

7.1.7.2. The Job Runs Area

The Reporting tab's Job Runs area is located in the lower part of the tab.

Crosstab Report| Crosstab Report Excel

Run Created Crezted By Mailing date | Status Augment Of | Outgo/Exp. Return | Actual Return | Definition Report | Outgo Report o
O 2 29/08/2008 nigelb_pros 05/09/2008 Work In Progress [u] [View] [HTML] [Excel]
Q1 15/05/2008 johana_admin 15/05/2008 Production 31 [Wiew] [HTML] [Excal]

Figure 207 Example of the Reporting tab's Job Runs area

This area lists the job runs that have been performed, and provides links to the various reports that are created for
each run. These are:

e Crosstab Report - you can build simple tables to analyze the generated samples using the same data as
the Outgo Reports. Click this button to use the "current" sample settings (see The Crosstab Report on
page 169 for more information).

o Definition Report - specifies the job definition at the moment the run was executed (see The Definition
Report on page 170 for more information).
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e Outgo Report - provides the outgo report in HTML (see The Outgo Report HTML on page 171 for more
information) and Excel format (see The Outgo Report Excel on page 172 for more information).

Click on the button above the run list or the appropriate blue link to open the required report.

7.1.7.2.1. The Crosstab Report

This tab allows you to select various fields and segments from the database, and create reports using the
selected items. You can add the desired fields and segments to the table rows and columns, nest or stack them
as required, then view the results.

|@ Back <Create Report

Report Settings

Decimals:
Distribution: Count w
Remowve Empty Headers on Rows D

Remowve Empty Headers on Columns I:‘

Available Fields:

Rows Columns
AccessFromHome Language GroupMumber Add
AccessFromWark
Language ® stacked ® stacked Clear
BusinessOwvner Fields
GroupMumber O Nested O Nested

SubSampleNumber
Selected Tables:
Rows Columns

SubSampleNumber;Busi... Stacked ¥ AccessFromHome Stacked ¥ Remove
Add to Rows

Available Segments: Add to Columns

Figure 208 Example of a Crosstab Report under construction

e Back - click to return to the Reporting tab.

o Create Report - once you have selected the required fields and/or segments, click to view the resulting
report.

¢ Decimals - you can specify the number of decimals to be used in the results. Type a positive integer into
the field. Note that you can increase the number of decimal places displayed to reduce the effects of
rounding and thereby increase the accuracy of the displayed data.

e Distribution - select the value on which the chart is to be based. Note that the selected option must be
available in the table for it to be presented in the chart.

o Count — shows the actual number of responses per series.

0 Horizontal Percent — the results calculated as a percentage, where the columns add up to 100%
“horizontally” in the table.

o Vertical Percent —the results calculated as a percentage, where the columns add up to 100%
“vertically” in the table.

o Combinations of the above.
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e Remove Empty Headers on Rows/Columns - check the boxes to automatically hide (mask) all rows
and/or columns that contain no data. As soon as data is received for the row or column, it will be
displayed.

To add a field or segment to the report, select it in the Available list and click Add to Rows/Columns as
appropriate. The selected item is then copied into the Rows or Columns field. Select the Stacked or Nested radio
buttons as required, then click Add to move the selected items to the Selected Tables field. When you have set
up the report as required, click Create Report to view the results.

|@ Back
(SubSampleNumber --- AccessFromHome)
Yes Mo Total
Sub Sample Number
1 3 o0 3
2 z 0o 2
Total 5 0 5
Back to top

E (Language --- GroupNumber)

Group Mumhber

] Total
English 0 5
French o 0
German 0 0
Italian o 0
Spanish o 0
Total 0 5

Back to top

Figure 209 The resulting Crosstab Report

7.1.7.2.2. The Definition Report

This report specifies the job definition at the moment the run was executed. When the Job Runs list contains a
number of runs, the Definition reports for the runs may well differ. Note that the Job Definition Report button in the
Job Reporting area opens a report of the "current” settings (see The Job Reporting Area on page 166 for more
information).
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|@ Back |
Run Number s
Job Number: Jobban
Job Description:
Data Source Kajakk
Mail Date 15/01/2008
Date Created: 10/01/2008
Created By: nigalb
Date Modified: 10/01/2008
Modified By: nigelb
Field Data
Job Categories Carbonatad Soft Drinks
Breskfsst Itams (Carsals, Waffles, Syrup)
Active = Active AND IN{CensusRegion, New Englznd, Middle Atlantic, East N Centrsl, West N Centrsl, South Atlantic, Esst South
Total Available Sample Cantral, West South Cantral) AND BETWEEN(PMActuslAgs, 18 , 89 ) AND PMHOK = Y=s AND Langusgs = English AND (NOT IN
(Stat=Cods, Alzska, Hawail)) AND DMA = Asbilane-Swestvater, TX
Data Elimination 14/01/2008 - 03/02/2008
Category Elimination 05/01/2008 - 03/02/2008
Additional Items AccessFromHome
AccessFromWork
AddadDats
BusinessOunar
email
Languags
Excluded and Relaxed Job Job Number Survey status Filter Description
SubSampleNum  Field Exprassion Default Group  Matrix Original Call Weight callweight Total Targat
1 551 My matrix Male 50
Group Set 1/1
Group 0 size =0
Group Set 1/2
Group 0 size =0
2 ss2 My matrix Female 50
Group Set 2/1
Group 0 size =0
Group Set 2/2
Group 0 size =0

Figure 210 Example of a Definition Report

The Definition Report report comprises three areas:

e Job Details — the job number, status etc (see The Job Details Area on page 167 for more information).

e General Information — the job categories, the expression and exclusions used, and the additional items
selected (see The General Information Area on page 167 for more information).

e Sub Sample Information — details of the sub samples defined (see The SubSamples Information Area on
page 168 for more information).

7.1.7.2.3. The Outgo Report HTML

This option allows you to create Outgo reports in HTML format, as shown in the example below.
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| (€) Back = Printer Friendly Versian Sub sample| All v |

Job Number Jobben
SubSampleNum 1

SubSample Name ss1

Created Date 10/01/2008 11:15:02
Created By nigelb

Total Outgo Posted 5

(@ summary Report

Demo Set Row Available Requested Target  Adjusted Target Final Target Actual H/L (+/-)

Total Total 5 50 50 32 -47

1) Gender
1) Male 1 20.0 % 50 100.0 % 50 100.0 %% 100.0 % 1 32.3% -49 -98.0 %
2) Female 4 80.0 % [1] 0.0 % 1] 0.0 % 0.0 % 2 667 % 2 0.0 %%

(R trosstab Report

Demo Set Row Total Group 0 Group 0 Group 9999 Total Group 0 Group 0 39";;"
Total Total 3 o o 2 100.0% 100.0% 100.0% 100.0%
1) Gender 1) Male 1 0 0 1 33,2 % 0.0 % 0.0 % 33.3 %
2) Female 2 0 0 2 66.7 % 0.0 % 0.0 % 66.7 %

Job Number Jobben

SubSampleNum z

SubSample Name 552

Created Date 10/01/2008 11:15:02

Created By nigelb

Total Dutgo Posted 5

@;. Summary Report

Demo Sat Row Available Requested Target  Adjusted Target Final Target Actual H/L (+/-)

Total Total 5 50 50 2 -a3

1) Gender
1) Male 1 200% 0 0.0 % 0 0.0 % 0.0 % 0 0.0% 0 0.0 %
2) Female 4 80.0% 50 100.0 % 50 100.0 % 100.0 % 2 LUD# -48  -96.0 %

(%) trosstab Report

Demo Set Row Total Group®  Group0 | Group 9999 Total Group®  Group 0 39";;"

Total Total 2 L] o 2 100.0%  100.0%  100.0%  100.0%

1) Gender 1) Male 0 o o 0 0.0 % 0.0 % 0.0 % 0.0 %
2) Female 2 0 0 2 100.0 % 0.0 % 0.0%  100.0 %

Figure 211 Example of an Outgo Report HTML

e Click Back to return to the Reporting tab.

e Printer Friendly version — opens a new window containing a version of the report that is set up for
printing.

e Sub Sample- the information is presented separately for each sub-sample. Use this field to filter the sub
sample details that you want to be displayed. Select between the various sub samples that are included in
the job, or All.

7.1.7.2.4. The Outgo Report Excel

This option allows you to create Outgo reports in Excel format, as shown in the example below.
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A [ s | c | o [ e [ F [ & [ & [ v | 4 [ k [ L [ ™ [ »n

1 |2ob Number l10bben

2 |Subsample 1
TSubsample Name ss1
| 4 [created Date 10.01.2008
| 5 |created By nigelb
| 6 |Total Dutgo Posted "5

7
i Demo Set Row Availahle Requested Target Adjusted Target Final Tar Outgo Selected HAL {+/-)

10 |Total Total 5 50 50 3
Z 1) Gender

12 1) Male 1 20,0 % 50 100,0 % 50 100,0 % 100,0 % 1 33,3 % =49 -98,0 %
ﬁ 2) Female 4 80,0 % 1) 0,0 % o 0,0 % 0,0 % 2 66,7 % 2 0,0 %
14|

16 [Demo Set Row Total Group0 Group0 Group99<Total Groupd Groupd Group9999
|17 |Total Total 3 ] 0 3 100.0%" 100%" 100%" 100%
W 1) Gender 1) Male 1 o] a 1 33,3 % 0,0 % 0,0 % 33,3 %
W 2) Female 2 o o 2 66,7 % 0,0 % 0,0 % 66,7 %

Figure 212 Example of an Outgo Report in Excel format

7.2. Current Matrix

This window shows the details of the matrix currently selected in the Matrix List. The window contains four tabs:
e General — displays the general details for the matrix and allows you to select the data source to be used.
e Dimensions - lists the existing dimensions for the matrix and allows you to create more as required.
e Weights — lists the existing weights for the matrix and allows you to create more as required.
e Report — displays a report of the current settings.

The window opens at the General tab.

Note: In the event no matrix has been selected so far in the current Forsta Plus session, when you click
on Current Matrix you will be taken to the Matrix List. Select a matrix to go to the Current Matrix page.

7.2.1. The General Tab

This tab provides general information about the selected matrix.

General I Dimensions ” Waights " Report

H Save Duplicate Export Matrix | Walidate Matrix

Matrix Name |AgeGender

Data Source | W | g]

Created By nigelb

Created Date 23/08/2010 05:24:05
Modified By nigelb

Modified Date 22/08/2010 09:24:05
Last Accessed

Last Job Used

Last Used

Figure 213 The Current Matrix > General tab

The tab’s toolbar contains four buttons:

e Save - saves changes. The button flashes while Forsta Plus detects unsaved changes.
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e Duplicate — creates a copy of the current matrix.

e Export Matrix — exports a matrix to another server.

e Validate Matrix — checks the matrix to ensure it contains no errors.
Other fields are:

e Matrix Name - the name of the matrix. You can edit the name here.

e Data Source - this drop-down lists the available BitStream files that can be used as a base for the matrix.
If you select the blank option, the data source used will be the latest-launched version of the panel.

7.2.2. The Dimensions Tab

A Dimension is a set of segments (answer options). For example, “Gender” could be a dimension in a matrix, and
within that dimension could be the segments “Male” and “Female”.

Go to the Sample Management > Current Matrix window, and open the Dimensions tab. This tab lists the
dimensions registered for the currently selected matrix.

General | Dimensions | weaights | Report

|>< Delete ﬁ Move Up {} Maove Down Combine Dimensions Mew Dirnension
D Dimension Name z

D Gender/Carbrands/Degres

- Gender
- Carbrands
- Degree

Figure 214 Example of the Dimensions tab list

In the example, the dimension is named Gender/Carbrands/Degree, and this is a "combined" dimension; one
dimension that comprises two or more individual dimensions. The toolbar buttons are:

o Delete — deletes selected Dimensions.

¢ Move Up/Down — moves selected Dimensions up or down in the list.
e Combine Dimensions - click to combine the selected dimensions.

¢ New Dimension- creates a new dimension for the current matrix.

o Refresh-refreshes the display. This may be required in the event changes have been made to the list
that are not displayed immediately.

Click on a Dimension Name link to open the Edit Dimension page for that dimension. The figure below shows
the details of the Degree dimension from the combined dimension shown above.
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Genaral | Dimensions | weights | Report

| Save @ Back to Dimension List ‘L Up to Parent Uncormbine

Dimension name |Degree

Define new Segment:

Operators

Segments in Dimension:
Expand all Collapse all

Add here Title: |Bachelor

C and
OOr
@ None

not

Search:

fan ]
answer_rate - Answer rate True (True)

carbrands - Carbrands False (False)

carowner - Carowner

children - Number of children
country - Country

dateofbirth - Date of birth
datecfmarriage - Married dats
degree - Education/Degree
dogowner - Dog owner
empstatus - Employment stat
gender - Gender
householdsize - Size of house o
housing - Housing -
income_usdollar - Income in |
ipconnection - Internat conne
language - Language <=
marstatus - Maritial status e
PanelistCreatedDate —HEETE
PanelistModifiedDate Left
panelvar

recruited - Recruited - How wa
recruiteddate - Date recruited
terminatedate - Date of termi
title - Title v

Functions

Egqual

Right

@ 1=null

Create new *

Add here Title:

Add here Title:

Add here Title:

Add here Title:

Master

Doctor/Phd

Other degrae

Mo degree

Figure 215 Example of the Edit Dimension page for a dimension

The toolbar buttons and data fields are:

Clear dimension
Remove 4 &
Remove ﬁ G
Remove 4 &
Remove ﬁ O

Remove ﬁ O

e Save - saves changes for the tab. The button flashes while Forsta Plus has unsaved changes.

e Back to Dimension List — takes you back to the list of dimensions registered for this job.

e Up to Parent - for combined dimensions. Moves focus up to the parent dimension.

Uncombine - for combined dimensions. Extracts the selected dimension out of the combined dimension,

allowing separate weighting and processing (see How to Uncombine a Dimension on page 187 for more

information).

e Dimension Name — the name of the selected dimension.

Collapse Type — appears below Dimension Name in the event a panel does not contain enough suitable

panelists to fill 'requested' targets in particular segments. This property controls how shortages in

segments are to be handled. The options are:

o Nominal collapsing — The targets for the segments with shortages are reduced to correspond to the
maximum available in the sample population. The excess (un-allocated) target is distributed
proportionately (according to segment targets) to the other segments within the dimension (see

Nominal Collapsing on page 176 for more information).

o Ordinal collapsing — in shortage scenarios, the total target is kept. The weight targets for the
segments with shortages are reduced to correspond to the maximum available in the sample
population. The excess (un-allocated) target is distributed to the next segment within the dimension

(see Ordinal Collapsing on page 176 for more information).

o Non-collapsing adjust targets — the total target is reduced by the amount the segment is short. To
reach the original target outgo for the other segments, the weight targets for all the segments within
this dimension are recalculated to suit the adjusted total target (see Non-Collapsing Adjust Targets on

page 177 for more information).

o Non-collapsing keep targets — the total target is reduced by the amount needed to accommodate the
original weight target for a segment with shortage. All segment weight targets are kept (see Non-

Collapsing Keep Targets on page 177 for more information).
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Note: The number of dimensions and the number of segments within the dimensions will significantly
affect the time taken to run the sample job. Depending on the composition of the panel, it may also
become impossible to fill all cells in the matrix. For extreme matrix definitions with many dimensions
and/or large lists of segments within the dimensions, the sample extract may become impossible to
perform.

Select two or more dimensions in the list and click the Combine Dimensions button to combine the selected
dimensions (see Combined Dimensions on page 185 for more information).

7.2.2.1. Nominal Collapsing

Nominal data is a form of categorical data where the order of the categories is not significant. Examples include
industry ("Accommodation, Cafes and Restaurants"”, "Agriculture, Forestry and Fishing", "Communication
Services" ,...), gender, ethnicity etc. In shortage scenarios, the target sample outgo is kept. The segment target of
a segment with shortage is reduced to correspond to the maximum available the in sample population. The
excess target is distributed proportionately (according to the segment targets) to the other segments within the
dimension.

For example: Assume we have asked for a sample of 40000 in total, spread out evenly across the age groups
with 10% (4000) taken from each group. In this case, six of the age groups have shortages, but we see that the
total number of panelists requested is kept by filling up from the four segments where we have an excess. Note
that the missing panelists are drawn as evenly as possible between these four segments (1413,1412, 861, 1413).

|2} Summary Repor
Demo Set Row Available Target djusted Target Final Target Actual H/L(+/-)
Total Total 45,742 40,000 40,000 40,001 1

1) AgeGroupNominal
Nominal collapsing 1)-15 7,403 16.2 % 4,000 10.0 % 4,000 10.0 % 13.5 % 5413 13.5% 1,413 35.3 %
2) 15-19 2,897 6.3% 4,000 10.0 % 4,000 10.0 % 7.2% 2,897 7.2% -1,103 -27.6 %
3) 20-24 3,754 8.2 % 4,000 10.0 % 4,000 10.0 % 5.4 % 3,754 9.4 % -246 -6.2 %
4) 25-34 8,867 13.4 % 4,000 10.0 % 4,000 10.0 % 13.5 % 5412 13.5% 1,412 35.3 %
5) 35-44 4,861 10.6 % 4,000 10.0 % 4,000 10.0 % 12.2 % 4,861 12.2% 861
6) 45-54 3,220 7.0 % 4,000 10.0 % 4,000 10.0 % 8.1 % 3,220 8.0 % -780

7) 55-64 3,132 6.8% 4,000 10.0 % 4,000 10.0 % 7.8 % 3,132 7.8% -868
8) 65-74 2,817 6.2 % 4,000 10.0 % 4,000 10.0 % 7.0 % 2,817 7.0 % -1,183
9) 75-84 3,083 6.7 % 4,000 10.0 % 4,000 10.0 % 7.7 % 3,083 7.7 % -917 -22.9 %
10) 85+ 5,708 12.5 % 4,000 10.0 % 4,000 10.0 % 13.5 % 5412 13.5% 1,412 35.3 %

Figure 216 Example of the results when Collapse Type is set to Nominal Collapsing

7.2.2.2. Ordinal Collapsing

For ordinal data, the numbers assigned to the objects represent the rank order (1st, 2nd, 3rd etc.) of the entities
measured. For this type of data, comparisons of ‘greater than' and 'less than' can be made. In shortage scenarios,
target sample outgo is kept. The segment target of a segment with shortage is reduced to correspond to the
maximum available in the sample population. The excess target (the difference between the requested target and
the actual quantity available) is distributed to the next segment within the dimension. If the last segment has a
shortage, the redistribution will be done in reverse order - the next to last segment will be given the excess target.

For example: Assume we asked for a sample of 40000 in total, spread out evenly across the age groups with 10%
(4000) taken from each group. We have a lot of shortages, and if we look at the figures we see that the shortages
for age groups 15-19 and 20-24 are compensated for in the 25-34 segment. The next shortages are in segments
6,7,8 and 9. These shortage are partially compensated for in the following segment (10). However we don't have
enough panelists in segment 10 to fully compensate, so then the order is reversed. This means we try to
compensate in segment 9, then segment 8 etc. but these are already used up. As many as possible are taken
from segment 5 but there are still not enough, so the remainder are taken from segment 4.

-176 -




Forsta Confidential

Forsta Plus 2022 Professional and Standard Panels User Guide

Demo Set Row Available d Target d Target Final Target Actual H/L(+/-)

Total Total 45,742 40,000 40,000 40,001 1

1) AgeGroupOrdinal

Ordinal collapsing 1)-15 7,403 16.2 % 4,000 10.0 % 4,000 10.0 % 10.0 % 4,000 10.0 % 0 0.0 %
2) 15-19 2,897 6.3 % 4,000 10.0 % 4,000 10.0 % 7.2% 2,897 7.2% -1,103| -27.6%
3) 20-24 3,754 8.2 % 4,000 10.0 % 4,000 10.0 % 9.4 % 3,754 9.4 % -246 -6.2 %
4) 25-34 8,867 19.4 % 4,000 10.0 % 4,000 10.0 % 16.3 % 6,529 16.3% 2,529 63.2 %
5)35-44 4,861 10.6 % 4,000 10.0 % 4,000 10.0 % 12.2 % 4,861 12.2% 861 21.5 %
6) 45-54 3,220 7.0 % 4,000 10.0 % 4,000 10.0 % 8.1% 3,220 8.0 % -780 -19.5 %
7) 55-64 3,132 6.8 % 4,000 10.0 % 4,000 10.0 % 7.8 % 3,132 7.8% -s68  -21.7 %
8) 65-74 2,817 6.2 % 4,000 10.0 % 4,000 10.0 % 7.0 % 2,817 7.0 % -1,183 -29.6 %
9) 75-84 3,083 6.7 % 4,000 10.0 % 4,000 10.0 % 7.7 % 3,083 7.7 % -917 -22.9 %
10) 85+ 5,708 12.5 % 4,000 10.0 % 4,000 10.0 % 14.3 % 5708 14.3% 1,708 42.7 %

Figure 217 Example of the results when Collapse Type is set to Ordinal Collapsing

7.2.2.3. Non-Collapsing Adjust Targets

Target sample outgo is reduced by the amount the segment is short. In order to reach the original target outgo for
the other segments, the segment targets for all the segments within this dimension are recalculated to suit the
adjusted sample outgo.

For example: Assume we have asked for 40000 panelists, divided evenly as 50% females and 50% males, which
should give us 20000 of each. We have more than enough male panelists available (27620), however we have
only 18122 females, giving us a shortage of 1878 females. The total target is therefore reduced from 40000 to
38122 (40000-1878=38122). The weight ratio for females is recalculated (18122/38122=0,4754 or 47.5%), and
the weight ratio for males is also adjusted accordingly (20000/38122=0.5246 or 52.5%).

Demo Set Row Available Target djusted Target Final Target Actual H/L(+/-)

Total Total 45,742 40,000 40,000 38,122 -1,878

1) GenderAdjustWeightTargets

Non collapsing adjust targets 1) Male 27,620 60.4 % 20,000 50.0 % 20,000 50.0 % 52.5 % 20,000 52.5% 0 0.0 %
2) Female 18,122 39.6 % 20,000 50.0 % 20,000 50.0 % 47.5% 18,122 47.5% -1,878 -3.4 %

Figure 218 Example of the results when Collapse Type is set to Non-Collapsing Adjust Targets

7.2.2.4. Non-Collapsing Keep Targets

Target sample outgo is reduced by the amount needed to accommodate the original segment target for a
segment with shortage. All segment targets are kept.

For example: Assume we are asking for 40000 panelists, divided evenly as 50% females and 50% males. In this
case we have more than enough (27620) male panelists, but we have only 18122 females. This gives us a
shortage of 1878 females. To keep the 50/50 weight-ratio the male target is also reduced by 1878, so the final
target sample outgo is therefore reduced to 36244.

Demo Set Row Available Target djusted Target Final Target Actual H/L(+/-)

Total Total 45,742 40,000 40,000 36,244 -3,756

1) GenderKeepWeightTargets
1) Male 27,620 60.4 % 20,000 50.0 % 20,000 50.0 % 50.0 % 18,122 50.0 % -1,878 -9.4 %
2) Female 18,122 39.6 % 20,000 50.0 % 20,000 50.0 % 50.0 % 18,122 50.0 % -1,878 -9.4 %

Figure 219 Example of the results when Collapse Type is set to Non-Collapsing Keep Targets

7.2.3. The Weights Tab

The segments within a dimension must be weighted. For example, if you are going to use the Gender dimension
with its Male and Female segments, then you must specify the male-to-female ratio that you want in the result.
You can create several weighting sets for a dimension, though only one weight set can be used on a dimension
per sample.

Use this tab to create a new Weight set for a dimension, and see and/or edit the details of existing weights.
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General || Dimensions | Weights | Report

|>< Celete Weight Mew Weight
[]| weight Name e
I:‘ wl

Figure 220 Example of the Weights tab Weight List

The toolbar buttons are:

e Delete Weight — deletes selected Weights.
¢ New Weight — creates a new Weight for the current Dimension.

o Refresh —refreshes the display. This may be required in the event changes have been made to the list
that are not displayed immediately.

Click on a Weight Name in the list to open the details page for that weight.
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General ” Dirnensicmsl Weights I Report

| n Save Back to Weight List Duplicate
Weight Name: |w1. |
Dimension: | All Dimensions i |
ogets .|
Dimension Name Segment Name Target
Desres Somy
Bachelor %
Master B
Doctor/Phd o
Cther degree S
No degree %%
Total v
Cendar [comy | posee |
Male %%
Female El kL
Total v
Carbrands Copy
saxs
Volvo %%
-
Audi S
Mercedes %%
Opel %%
Ford %%
Chryslar %
Toyota B
Honda %
Mazda I:I %%
Total [IIETT] o6

Figure 221 Example of a Weight Details page

The toolbar buttons and data fields are:

e Save - saves changes for the tab. The button flashes while Forsta Plus has unsaved changes.
e Back to Weight List — closes the details page for the Weight and returns you to the Weight List.

e Duplicate — creates a copy of the current Weight. The new Weight is given the name Copy of (selected
weight).

e Weight Name — the name of the currently selected Weight.

¢ Dimension — if you only wish to view one of the dimensions listed, use this drop-down list to filter out the
other dimensions. Otherwise, select All Dimensions to view all.

Here you can specify the weights to be applied to each individual segment in the weight set (see How to Create a
Weight Set on page 183 for more information).

7.2.4. The Report Tab

This tab shows details of the dimensions and weights used in the current matrix.
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General ” Dimensions " Weights I Report |

‘ =) Printer Friendly Wersion A
Sample Selaction Cell Matrix: CountryGender
Weights: GenderCountry_swvenly
Craated Date: 16/10/2008 10:15:26
Created By: clea
Modified Date: 08/01/2009 13:16:37
Modified By: nigelb
Dimension:
Gender: Country: |A|| b || Search
Number of segments in dimension: 21 b
Number of segments shown: 21
Dimension Details
Demo Sat Cell Count  Cell Alpha Cell Mask
GENDER/COUNTRY (Collapse type: Normal)
i Mzle/US gender = Male AND country = US
2 Male/Metherlands gender = Male AND country = Netherlands
k] Mzle/Belgium gender = Male AND country = Belgium
4 Mzle/France gender = Male AND country = France
5 Mala/Spain gender = Male AND country = Spain
[ Male/UK gender = Mzale AND country = United Kingdom
7 Male/Ireland gender = Mzale AND country = Ireland
=] Male/Iceland gender = Male AND country = Iceland
] Male/Finland gender = Male AND country = Finland
10 Male/Lithuania gender = Male AND country = Lithuania v

Figure 222 Example of the Report tab

The tab has the following button in the toolbar:

e Printer and Save Friendly version — opens a new window containing a printer- and save-friendly version
of the report.

The Weights links in the upper section of the tab allow you to jump down to the corresponding detail lists for the
weight.

When dimensions have been combined (see The Dimensions Tab on page 174 for more information), the
Dimension drop-down field is displayed. Here you can filter the dimension details to show only those for the
dimensions you select.

Click the chevron buttons in the header bar for each section (see the Dimension Details bar in the figure above) to
collapse and expand the section.

7.2.5. Procedures in the Current Matrix Tab

7.2.5.1. How to Duplicate a Matrix

1. Click the Duplicate button in the General tab’s toolbar.

A copy of the current matrix is created and its details are displayed in the General tab.
2. Click in the Matrix Name field and type in a name for the new matrix.
3. Click Save to save the changes.
The new matrix is added to the Matrix List. You can now edit the matrix as required and use it in a job.
7.2.5.2. How to Validate a Matrix

1. Click the Validate Matrix button in the General tab’s toolbar.

Forsta Plus checks the matrix and presents a result message as appropriate.
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Microsoft Internet Explorer,

L] "_u., Mo dimensions are specified in matrix,
-

Figure 223 Example of a matrix validation error message

If the matrix is found to be correctly constructed and is approved, the following message is displayed.

Microsoft Internet Explorer, E|
L "-'.‘ Samplingmatrizx is walid
e

Figure 224 The “matrix is valid” message.

2. Click OK to close the message.

7.2.5.3. How to Create a New Dimension

1. Click the New Dimension button located at the right end of the Dimensions tab toolbar.

The Dimension Name dialog opens.

Dimension Name | |

| (o] 4 || Cancel |

Figure 225 The Dimension name dialog

2. Type a name for the dimension into the Dimension Name field.
3. Click OK.

The Edit Dimension Details window for the new dimension opens.
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General | Dimensions

Weights || Report

|n Save @ Back to Dimension List

Dimension name |Age

Collapse type

| Nominal collapsing

Define new Segment:

Search:

active

=ge - Age

age_groups - Age groups
answer_rate - Answer rate
appliances - Househeold appli:
booked - Booked/Reserved
carowner - Carowner

children - Number of children
country - Country

credits - Incentive points
dateafbirth - Date of birth
dateofmarriage - Married date
degree - Education/Degrees
dogowner - Dog owner
empstatus - Employment stat
=u - EU member

gender - Gender
househaoldsize - Size of house
housing - Housing
income_usdollar - Income in |
ipconnection - Internet conne
language - Language
married - Married

marstatus - Maritial status

activated - Activated - doubl=F"8

W

Show paste area (g

True (True]
False (False)

Operators

@And
ODr
O None

ot

Functions
Equal
In

Between

Contains

Left

Right
@ IsMull

Any

Create new =

Segments in Dimension:
Expand all Collapse all

Figure 226 Example of the Edit Dimension window

4. Inthe variable list (the left column), using the Search function as necessary, find and select the variable
you wish to add to the dimension.

The possible values for the selected variable are presented in the second column. These change as
appropriate to reflect the selected variable. You can add as many variables to a segment as required.

5. Inthe second column, select the required values for the variable.

In the third column select the required operator and function.

Note: The operator for the first variable selected must be None.

7. Click Create New.

The segments are added to the dimension and are listed in the Segments in Dimension column.
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General | Dimensions | weights || Report

|u Save @ Back to Dimension List |
Dimension name [Age
Collapse type | Nominal collapsing ¥ @
Define new Segment: Segments in Dimension: Clear dimension
Expand all Collapse all
Operators v Addhers  Title: Remove ¢ &
® and P T
Gearch: Oor (2ge_groups, "2",
L ] O hione
znswer_rate - Answer rate — |[|-15 (1) D
zppliances - Household appli: 13-13 (2] Mot
booked - Booked/Reserved 20-24 (3]
carovmer - Carowmer 25-24 (4) Functions
children - Number of children 35-a44 (5)
country - Country 43-34 (6] Equal - . .
credits - Incentive points 55-64 (7) Ior (LS = Sre s, S, B Ees Sis]
date=ofbirth - Date of birth £5-74 (8] n
dateofmarriage - Married dats 75-84 (3) Setween
degree - Education/Degree 85+ (10)
dogovmer - Dog owner
empstatus - Employment stat _5_
eu - EU member -
gender - Gender -
householdsize - Size of houst
housing - Housing <=
income_usdallar - Income in | Contains
ipcannection - Internet conne — cnkains
language - Language Left
married - Married
marstatus - Maritial status Right
month
nordic - Sweden. Denmark, Mo O tanui
panelist_status - Panelist Stal ¥ Any
Al

Figure 227 Example of segments in a dimension

8. Save the changes.

Note: If the dimension you are working with is part of a Combined dimension (see Combined Dimensions
on page 185 for more information), the Up to Parent button is included in the toolbar. Click this button to

go to the Edit Dimension page for the combined dimension (see The Dimensions Tab on page 174 for
more information).

7.2.5.4. How to Create a Weight Set

1. Inthe Sample Management > Current Matrix > Weights tab, click the New Weight button located
towards the right side of the tab toolbar.

The Weight Name dialog opens.

Weight Name | |

| (a].4 || Cancel |

Figure 228 The Weight Name dialog

2. Type a name for the new weight into the data field and click OK.

The Details page for the new weight opens.
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Senearal Dirmensions | Weights Report

| Save Back to Weight List Duplicate 2

Weight Name: Test weight

Dimension: All Dimensions %
Dimension Mame Segrnent Mame Target
PMGender Copy Paste
Male 0| %
Fernale 0| 9
Total [ -
HHSize Copy Paste
1 MEM 0| %6
2 MEM 0l %
3-4 MEM 0| =
S5+ MEM 09
Total [ ~+
Mibd Cdeer ~ 8 nn e [P

5.

Figure 229 Example of the Details page for a new weight

The target column fields are blank and must be filled in. Note that the Total fields (currently red) for each
set of rows must sum to 100%. When this is correct, the field will turn green.

Type or copy the appropriate values into the Target fields.

Click the down-arrow beside the Dimension field to open a drop down list of the options available, and
select the required dimension from the list.

Each Dimension row has a Copy and a Paste button. Click Copy to copy the target weights for the
dimension to the clipboard. Click Paste for a different dimension to paste the target weights into that
Dimension’s weight fields.

When all the target weight fields are correctly filled in, click Save to save the details.

The weight is saved and added to the Weights list. In the event some target weights are not filled in correctly, an
error message will be displayed.

7.2.5.5. How to Delete a Weight Set

To delete unnecessary weight sets:

1.
2.
3.

4.

Go to the Sample Management > Current Matrix > Weights tab, Weights list.
Find the weight set you wish to delete, and click in the corresponding box to select it.
Click Delete Weight.

A confirmation message box opens.

Click OK to delete the weight, or Cancel to close the message box without deleting the weight.

7.2.5.6. How to Export a Matrix

You may wish to export a matrix from the current server so it can be used on a different server. A matrix is
exported on an email as an .xml file. To export a matrix:

1.

Click the Export button in the General tab’s toolbar.

The Matrix Export dialog opens.
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Email recipient |dc\cumentatinn@cn nfirmit, corm |

Comment | |

Figure 230 The Matrix Export dialog

2. The default email address is that of the current user. Change as necessary.
Type any comments into the Comment field.
4. Click OK.

The matrix is sent as an .xml file attached to an email. It can now be imported into a different server. To
import a matrix that has been exported from a different server, see section (see How to Import a Matrix on
page 194 for more information).

7.2.5.7. Combined Dimensions

Dimensions can be combined to provide a detailed list of the weights applied to the various combinations of
segments. This then allows you to go in and make fine adjustments to the combined weights to achieve the
sample you require.

The figure below shows a dimensions list with three separate dimensions.

General | Dimensions | weights | Report

}(_ Delete ﬁ Move Up G Mowe Down Combine Dimensions Mew Dimension
I:‘ Dimension Mame 3
|:| Degree
[] sender

[] carbrands

Figure 231 Example of a dimensions list containing three separate dimensions

Each of these dimensions can comprise several segments (click on the blue Dimension Name link to open its
Edit Dimension page).

Segments in Dimension: Clear dimension
Expand all Collapse all
Add here Title: |Ma|e | Remove 1} {}
Add here Title: |Fema|e | Remove 1} {}

Figure 232 The segments in the Gender dimension
And each segment can have a specified weight (see The Weights Tab on page 177 for more information). To
combine dimensions:

1. Select two or more dimensions in the dimension list and click the Combine Dimensions button to
combine the selected dimensions.

The result is as shown in the example below.
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General | Dimensions | Weaights | Report

|>< Delate ﬁ Mave Up {,'r Mowve Down Cormbine Dirmensions Mew Dimmension
D Dimension Name z
|:| Gender/Carbrands/Degree
- Gender
- Carbrands
- Degree
Figure 233 Example of three dimensions combined into one
Click on the "group name" (in this case the Gender/Carbrands/Degree link) to view the full list of all the
combinations of segments in the combined dimension. Click on an individual dimension name (for example
Gender) to open the Edit Dimension page for that dimension.
Generz| | Dimensions | Weights | Report
.3

|n Sauve @ Back to Dimension List

Dimension name |Gender,."Carbrands,."Degree

Collapse type | Neminal collapsing

v @

(1] Segments in this dimension must be changed in the underlying dimensions: Gender, Carbrands, Degree

Segments in Combined Dimension:

Mzlz) AND Any(carbrands, SAAB) AND In{degres, Bachelor)
Male) AND Any(carbrands, SAAB) AND In{degree, Master)

Male) AMD Any(carbrands, SAAB) AND In{degree, Doctor/Phd)
Male) AND Any(carbrands, SAAB) AND In{degree, Othar degrae)
Mzle) AND Any(carbrands, SAAB) AND In{degree, No degree)
Malae) AND Any(carbrands, Volvo) AND In{degree, Bachelar)
Male) AND Any(carbrands, Volvo) AND In{degree, Master)

Mzle) AND Any(carbrands, Volvo) AND In{degree, Doctor/Phd)
Male) AND Any(carbrands, Volvo) AND In{degree, Other degree)
Male) AMD Any(carbrands, Volve) AND In{degree, No degree)
Male) AND Any(carbrands, BMW) AND In{degres, Bachelor)
Male) AND Any(carbrands, BMW) AND In{degres, Master)

Gender: Carbrands: |A|| it | Degree: | All W || Search |
Cell Count Title Expression
i Male/SAAR/Bachelar In{g=nder,
z Male/SAAR/ Master In{gender,
3 Male/SAAB/Doctor/Phd In{gender,
4 Male/SAAB/Other degree In{gender,
5 Male/SAAB/No degree In{gender,
5 Male/Volve/Bachelor In{g=nder,
7 Male/Volva/Mastar In{g=nder,
g Male/Volve/Doctor/Phd In{gender,
E] Male/Volvo/Other degree In{gender,
i0 Male/Volve/Ne degree In{gender,
i1 Male/BMW/Bachealor In{gender,
1z Male/BMW/Master In{gender,
13 Mals/RMW/ Nnctar/ Bhd Tnfnendar.

MaleY 2NN Anwlrarhrand=. RMWY &8N0 Tafdenree. Nnckar/ Phdl

Figure 234 A small part of the segment list for a combined dimension. This list contained 110 cells

Go to the Weights tab and click on a Weight Name link to open the Weight list for the combined dimension.
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Genersl| ” Dimensions I Weights I Report

| n Save Back to Weight List Duplicate 25
Weight Name: |w1. |
Dimension: |.A|| Dimensicns Vl
ergets. |
Dimension Name Segment Name Target
Gender/Carbrands{Degree Copy m
Male/SAAB/Bachelor %%
Male/SAAB/ Master %%
Male/SAL8B/ Dactor/Phd S
Male/SAAB/Other degree S
Male/SAAB/No degree %%
Male/Volva/Bachelor S
Male/Volve/Master S
Male/Volvo/Doctor/Phd %%
Male/Volve/Other degree S
Male/Volve/No degres L
Male/BMW,/Bachelor %%
Male/BMW,/Master .18
Bsla /BRI Pnrkard Bhd [ 4 asle

Figure 235 The weights for the same small part of the combined dimension's segment list

The weights listed here are initially calculated automatically by the system when the dimensions are combined,
and are the results of the combination of the weights specified for each individual segment. For example in the
first row, the individual weights you have specified for the separate Male, SAAB and Bachelor segments, when
combined and calculated against the specified weights for all the other rows in the list, will result in 1.35% of the
total sample being males who both drive a SAAB and have a Bachelor's degree. You can now make fine
adjustments to the targets.

Note that the full list must always total 100%; the Total cell at the bottom of the list will then be green. In the event
the list does not total 100% the cell will be red.

Note: To change the order of the weight list here, you must "uncombine" the dimensions (see How to
Uncombine a Dimension on page 187 for more information), select the appropriate dimension and use the
Move Up and/or Move Down buttons to position the dimension as desired in the dimension list, then
recombine them.

7.2.5.8. How to Uncombine a Dimension

You may wish to remove a dimension from the combined set, for example to adjust its segments' weights
independently of the other dimensions in the combination. To do this:

1. Go to the Dimensions tab.
2. Click on the dimension you wish to remove to open it's Edit Dimension page.
3. Click Uncombine.
A confirmation dialog opens.
4. Click OK to continue.

This will release the dimension from the combination, and the released dimension will then be listed
separately from the remaining combined dimensions in the Weights and Dimensions tabs.
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General ” Dirnensicmsl Weights I Repurtl

| n Save Back to Weight List Duplicate -

Weight Name: |wl |

Dimension: | All Dimensions i |

Dimension Name Segment Name
Gender

Male

Female
Carbrands/Degree

SAAB/Bachelor
SAAB/Master
SAAB/Doctor/Phd
SAAB/Other degres
SAAE/Mo degree
Volvo/Bachelor

Wolve/Master

Valvo/Doctor/Phd

Figure 236 The Weights tab with Gender dimension released from the combination

The weights for the remaining segments in the combination will be recalculated automatically, and the released
dimension will be given the same weights it originally had before it was included in the combination. You can later
recombine the dimensions as necessary.

7.3. Job List

This window lists all the sampling jobs that you currently have “in progress”. Once a job is complete, the sample is
linked to the survey and the panelists are invited to respond, then the job is moved to the Active Job List (see
Active Job List on page Error! Bookmark not defined. for more information).

Use the filters to find the job you are interested in and click on the blue link in the Job Number column to select it.
You will be taken automatically to the Current Job window.

@ Job List Confirmit. ™
everywhere c-
7% Home * Panel Setup ~ Panel Utlities ~ Panel Management ~ [Sample Managemant ~ | user: adrinistrator, Ad... [Log Off 2
Cureent Job Sureent Matrix Job List Ackive Jab List Matrix List Scheduling Coneurrent Sampling Multiple Sample Upload Tester Template List Sampling Setings - @‘
X Delete [ Search| 2 Reset Export Jobs Hew Job Importjob|
[/ 305 Number + Mailing dats last run Crested By Project_Manager | CustomJobStat... Outgo Status Last Exscuted By Project 1d 2
[ ] I[=_= [ [= =~ | [an v | I |
[ test1 30/08/2010 elaa_pros patandosefszss  Open 300 Preduction slaz_pros po266448
[ pemor 01/09/2010 elaa_pros Batandosefszsa  Open so1 Approved elaa_pros p0266448
O ot 25/08/2010 elaa_pros Batandosefszsa  Open 9339 Approved elaa_pros p0266448
0 a7 elas_pros Patendesefszen  Open o Work In Progress p0269005
O »s 07/07/2010 elaa_pros Batandosefszsa  Open 100 Preduction elaa_pros p0266448
'_‘ AS 07/07/2010 slaz oros Fafendosefszea Ooen 500 Production slaz oros 20269073

Figure 237 Example of the Job List window

Note: If you open a job, then return to the Job List and open a different job, an information box appears
warning you that you are about to change jobs. Click OK to continue and change jobs, or Cancel to
cancel the change and remain with the current job.
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7.3.1. The Job List Filters

In an established company the list of registered jobs may run into thousands, and a search through the list for the
one job that you wish to select for exclusion or relaxation could be time-consuming. Forsta Plus therefore
provides you with a set of filters so you can reduce a long list to a manageable size.

0

[ 3eb Humber Mailing date last run Created By Project_Manager CusternlobStat... Outgo Status Last Executed By Project Id
- - B = v All b

Figure 238 The Job List filter bar

e Job Number — type in the number of the job you are looking for, then click Search. You can use the *
character as a wildcard, and type in part of the number. For example, type in 123 to find all jobs where the
job number starts with 123, such as job number 123456. Typing in *123 will find all jobs with the number
123 somewhere in the job number, such as job number 45123678.

e Mailing Date last run — allows you to search for jobs according to the date on which they were mailed.
Click the drop-down arrow beside the operator field and select the required operator, then click on the
calendar icon beside the field and select the date. When you are ready, click Search. For example, select
the <= operator and a date to list all the jobs that were mailed on or before the selected date.

e Created By — allows you to search for jobs created by specific users. Type the user’s identification (as
used by Forsta Plus) into the field, or use standard Windows copy and paste functionality, and click
Search.

e Project Manager - allows you to search for jobs by specific project managers.
e CustomJobStatus - allows you to search for jobs by specific job statuses.

e Outgo - allows you to search for jobs based on the number of emails sent. Select the desired operator
and click Search.

e Status — allows you to search for jobs according to their current status. Click the drop-down arrow beside
the field to open a list of the statuses, select the one required and click Search.

e Last Executed By - allows you to search for jobs based on the user who last executed them Type the
user name of the desired user into the field.

e Project ID - allows you to search for jobs based on the ID of the project to which they apply.

e Alphabetical Filter —the letters of the alphabet are listed along the lower edge of the window. Click a
letter to show only those jobs in which the Description starts with the selected letter. Click All to show all
jobs.

Note: You can use any combination of the above filters to find the required job. For example you can
perform a search to find all the jobs with a particular status that were modified before a given date and
that were created by a particular person. You can set all the filters and then perform the search, or you
can perform separate searches using one filter at a time. Click Reset to remove all search criteria and
display the full list.

7.3.2. The Job List Toolbar

o Delete — delete the selected job(s).

e Search — commence a search based on the selected filter criteria.

¢ Reset - click to remove all search criteria and display the full list.

e Export Jobs - select the jobs you wish to export and click this button to commence the export task.
e New Job —create a new job.

e Import Job — import a job that has previously been exported, for example when you wish to copy a job
from another server into this server.
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7.3.3. Procedures in the Job List Window

7.3.3.1. How to Create a New Job

This function allows you to create a new job from the bottom up. Note that you can also create new jobs by
duplicating existing jobs (see the Current Job > Job Information tab section) and by importing jobs from other
servers (see How to Import a Job on page 190 for more information).

1. Click the New Job button located towards the right end of the Job List toolbar.

The New Job Properties dialog box opens.

Job Number | |

Job Description

| (a]'4 || Cancel

Figure 239 The New Job Properties dialog box

2. Type in a unigue job number.

Note: The Job Number can only include letters, numbers and underscore (_). Do not use space or special
characters (for example &, /, # etc.).

3. Type a description of the job into the Description field.
Note that the first letter used in this description will be used in the alphabetical filter.

4. Click OK.

The job is created and added to the job list. You can now select the new job and go to the Current Job
window to set the details and panelist selection criteria.

7.3.3.2. How to Import a Job

Use this function to import a job that has for example been created on a different server and exported to a file
(see also section (see How to Export a Job on page 127 for more information)).

1. Click the Import Job button located towards the right end of the Job List toolbar.
The Job Import dialog box opens.

File to upload | |[ Browse... |

Job Humber | |

Figure 240 The Job Import dialog box

2. Click Browse to open a standard Windows browse dialog box, and find the file you wish to import.
3. Type a unique job number into the Job Number field.
4. Click OK.

The file is imported and added to the Job List. You can now select it in the Job List and go to Current Job
to edit it.
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7.3.3.3. How to Delete a Job

Jobs that are no longer needed can be deleted from the system. Note that once a job has been deleted it cannot
be undeleted, you will need to rebuild it. You can delete any number of jobs simultaneously.

1. Go tothe Sample Management > Job List menu comment.
The Job List window opens.

2. Find the job or jobs you wish to delete.

3. Click in the check boxes for those jobs to select them.

4. Click Delete.

The selected files are permanently deleted.

7.4. Active Job List

This window lists all the sampling jobs that are currently “in production”. Once a job is complete, the sample is
linked to the survey and the panelists are invited to respond, then the job is moved to this list from the Job List.

) Search 2 Reset Status| All Adive % | Date Filter| Mailing Date % || = % B Days Before Closing| = %

w

Job Number Hame Run Humber Status Praject 1D Mailing Date Days Before Closing Size

s00
500
500

Production po26E448 07/07/2010
Production p0263073 07/07/2010
Production P0262073 07/07/2010
Production p0266448 07/07/2010
Brodictinn n0?RRAAR anina/?o10

AL Dog survey
Az

PRI
EICICICIG)

A8 Demo job

p— 100

Figure 241 Example of the Active Job List

7.4.1. The Search Fields

You may have a large number of jobs that are active simultaneously, and a search through the list for the one job
that you wish to view could be time-consuming. Forsta Plus therefore provides you with a set of filters so you can
reduce a long list to a manageable size.

e Status — allows you to search for jobs according to their current status. Click the drop-down arrow beside
the field to open a list of the statuses, select the one required and click Search.

o Date Filter — use to find active jobs based on their dates. Select the “type” of date you are looking for, for
example the mailing date, select the operator, for example < will give all dates less than (before) the
selected date, and select a date, then click Search.

e Days Before Closing — use to find active jobs based on the number of days remaining before the survey
closes. Select the operator, for example > will give all jobs with more than the specified number of days
remaining, and type in the number of days, then click Search.

7.4.2. The List Columns

e Job Number — the number of the job. Click the link to open the Active Job Details page for the job (see
The Active Job Details Page on page 192 for more information).

e Name — the name of the job.

e Run Number - a sampling job can be run any number of times, allowing you to check the results and
adjust the parameters to achieve the desired sample. This column displays the run number for the
sampling job.

e Status —indicates the current status for the job.

e Project ID — the identification number of the survey project to which the sample is attached.

e Mailing Date — presents the date on which the survey was mailed to the respondents in this sample.

e Days Before Closing — the number of days that this survey and sample will remain active before closing.

e Size —the number of panelists specified for this sampling job.
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7.4.3. The Active Job Details Page

Click on a blue Job Number link in the Active Job List to open the Active Job Details page for that job, as shown
in the example below.

@ Back Save

Mailing Date a7/07,/2010 :ﬁ

Update Complates Rule Mo items available v | Gl
Update Non Responder Date :ﬁ =
Update Non Responder Rule Mo items available | Gl

Update Non Responder Performed

Close Date :ﬁ =]
Survey Closing Rula Mo items available v | Gl
Status Production

Job Humber Al

Name Dog survey

Sample Reserved Date 0707 /2010
Modified By olea_pros

Project Number pl266448

Uploaded Date 0707 /2010
Created By olea

Size 500

Last Completed Run

Figure 242 Example of an Active Job Details page

The properties and data fields are as follows:

Mail Date - the date the survey is to be emailed to the selected respondents.

Update Completes Rule - this field displays the rule that is to be used to define what is to happen when a
respondent completes the survey. If you wish to change the rule that is to be used, click the down-arrow
and select the required rule from the list available.

Update Non-Responder Date - this is the date by which the respondents are to have completed the
survey. If a respondent has not completed the survey by the specified date, then the rule specified below
will be implemented. If you wish to change the date, click the Calendar button and select the required
date.

Update Non-Responder Rule - this field displays the rule that is to be used to define what is to happen
when a respondent has not completed the survey by the specified date. If you wish to change the rule,
click the down-arrow and select the required rule from the list available.

Update Non-Responder Performed - once the Update Non Responder Rule has been performed, this
box is checked by the system to indicate completion.

Close Date - the date the survey is closed for the sample. If you wish to change the date, click the
Calendar button and select the required date

Survey Closing Rule - this field displays the rule that is to be used to define what is to happen
when the survey is closed. If you wish to change the rule that is to be used, click the down-arrow
and select the required rule from the list available.
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e Status - the current status for the job. If you wish to change this status, click the down-arrow and select
the desired status from the drop-down list.

7.5. Matrix List

This window lists all the matrices currently available in your database.

|)( Delete| [ search 2 Reset| panel Fields Hew Matrix Import Matrix

|:| Name Crested Crested By Modified Modified By Last Job Used Last Used Data source Summary E
- = il - = = o =

[ region 18/08/2010 olea_pros 18/08/2010 olea_pros All panelists key

demographics

m)

[0 oemo Age/Gender/Region 18/08/2010 olea_pros 18/08/2010 olea_pros All panelists key
demographics

)

All panelists key
demographics
All panelists key
demographics

[ 2ge/Gender/Ragion 18/08/2010 olea_pros 01/09/2010 olea_pros

[ Age/gender 07/07/2010 olea_pros 07/07/2010 olea_pros AL 07/07/2010

Figure 243 Example of the Matrix List

The list of matrices may be extensive, so Forsta Plus provides you with a set of filters so you can reduce a long
list to a manageable size. The filter fields are:

e Panel Fields — allows you to search for matrices based on specified panel fields, for example all matrices
with Age as or in a dimension.

¢ Name — type in the name of the matrix you are looking for, then click Search. You can use the * character
as a wildcard, and type in part of the name.

e Created — enables you to search for matrices depending on when they were created. Click the drop-down
arrow beside the operator field and select the required operator, then click on the calendar icon beside the
field and select the date. When you are ready, click Search. For example, select the > operator and a date
to list all the matrices that were created after the selected date.

e Created By — allows you to search for matrices created by specific users. Type the user’s identification
(as used by Forsta Plus) into the field, or use standard Windows copy and paste functionality, and click
Search.

¢ Modified — enables you to search for matrices depending on when they were last modified. Click the drop-
down arrow beside the operator field and select the required operator, then click on the calendar icon
beside the field and select the date. When you are ready, click Search. For example, select the >=
operator and a date to list all the matrices that were modified on or after the selected date.

¢ Modified By — allows you to search for matrices modified by specific users. Type the user’s identification
(as used by Forsta Plus) into the field, or use standard Windows copy and paste functionality, and click
Search.

e Last Job Used — allows you to search for matrices according to the job they were last used with. Type or
copy the job ID into the field and click Search.

e Last Used — enables you to search for matrices depending on when they were last used. Click the drop-
down arrow beside the operator field and select the required operator, then click on the calendar icon
beside the field and select the date. When you are ready, click Search. For example, select the <=
operator and a date to list all the matrices that were used on or before the selected date.

e Summary- click on the icon to view a summary of the dimensions included in the matrix.

Note: You can use any combination of the above filters to find the required matrix. For example you can
perform a search to find all the matrices that were created before a given date and that were created by a
particular person. You can set all the required filters and then perform the search, or you can perform
separate searches using one filter at a time.

Across the bottom of the window is an alphabetic filter — click a letter to display only those matrices in which the
Name starts with the selected letter. Click Reset to remove any search criteria and display the full list.

7.5.1. Procedures in the Matrix List Window

7.5.1.1. How to Create a New Matrix

1. Inthe Matrix List window, click the New Matrix button located towards the right end of the toolbar.

The New Matrix dialog box opens.
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Matrix Name | |

| ]9 || Cancel |

Figure 244 The New Matrix dialog

2. Type a name for the new matrix into the Matrix Name field.
3. Click OK.

The Sample Management > Current Matrix window opens at the General tab.

General I Dimensions " Weights " Report |

E Save Duplicate Export Matrix | Walidate Matrix

Matrix Name |Matrix2

Created By usermanual

Created Date 28/08/2008 13:19:12
Modified By usermanual

Modified Date =5/08/2008 13:15:12
Last Accessed

Last Job Used

Last Used

Figure 245 Creating a new matrix

You now need to define the dimensions and segments for the matrix (see Current Matrix on page 173 for more
information)
7.5.1.2. How to Import a Matrix

You may wish to import a matrix from a different server. A matrix is exported from a server as an .xml file
attached to an email. See section (see How to Export a Matrix on page 184 for more information) for further
details on exporting.

1. Open the email and save the attached .xml file to a logical folder on your server.

2. Open Forsta Plus and go to the Sample Management > Matrix List menu command.
The Matrix List window opens.

3. Click the Import Matrix button located in the upper right corner of the Matrix List window.

The Matrix Import dialog opens.

Matix Import

File to upload | |[ Browse.. |

MatHi= name | |

Figure 246 The Matrix Import dialog box
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4. Click Browse to open a standard Windows file selection dialog, browse to the .xml file and select it, then
click Open.

The .xml file name is added to the File to Upload field.

5. Type a logical name for the matrix into the Matrix Name field.

This name will be displayed in the Matrix List window.
6. Click OK.

The matrix file is uploaded and added to the matrix list. You can now edit the matrix as required and add it
to a job (see Current Matrix on page 173 for more information).

7.6. Scheduling

This window lists the jobs that are awaiting execution and those that have been run. To open the Scheduling
window, go to the Sample Management > Scheduling menu command.

) search / Reset Rernows Move Backward Moue Forward  iew [%] Refresh
D Job Number Job Type Status Schedule Mailing Date Progress Log Entry User ID Comment e
[ joffe SamplingExecutelob In Queue 30/08/2008 10:00:00 05/09/2008 0% nigelb_pros

0 of 1 zelected,

p Search i Feset Rermmove Move Backward Mowe Forward  iew zl Refresh
Job Number Job Type Status Schedule Progress Log Entry User [D Comment z

No items available

Figure 247 Example of the Scheduling window

The window contains two lists:

e Sampling Jobs — the queue of sampling jobs that are waiting to be run.
e Other Jobs — support jobs, such as importing files or exporting to a different server.

Both the lists have the following buttons and options:

e Search - type search criteria into the job number field then click Search to reduce the list to only those
jobs answering to the criteria.

¢ Reset - click to remove all search criteria and display the full list.

e Remove — click to delete a selected job from the list.

e Move Backward — moves the selected job to 1 minute after the next job in the list.

e Move Forward — moves the selected job to 1 minute before the previous job in the list.
e View — select Active or Inactive.

o Refresh — click to update the lists.

7.6.1. The Sampling Jobs List
The Sampling Jobs > Active list contains those jobs that are waiting to be run.

1. Click the link in the Schedule column to open the Task Scheduling window for the job.
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L
? Cloze

Definition I Recurrence " Parametears " Instances |
Task Type Sampling - Execute Job
ID 3334
Owner |nige||:|_|:|rc|5 |
Company Confirmit ASA
Project Id pO145462
Comment

Command Line |Firmglobal.Confirmit.Tasks.5ampling

Save || Run task

@ 200% Confirmit

Figure 248 Example of the Task Scheduling window

This window contains the Recurrence Pattern dialog. Here you can change the recurrence settings, disable
(delete) the task, or override the recurrence settings and start the task immediately.

In the Recurrence tab, click Change to open the dialog for access to the recurrence settings (see The Task
Definition Properties Dialog on page 164 for more information).

7.6.2. The Inactive List

1. To view the Inactive job-list, go to the Sampling Management > Scheduling menu command, click the
down-arrow beside the View field and select Inactive.

The Inactive list contains all the jobs that have been run. The job status column indicates whether the job
was completed or aborted by the system.

Note that a job may be aborted by the system for many reasons, for example the system may not be able
to find the required number of panelists, or there may be a problem with the date or exclusion setup.

2. To view the report for a completed job, click the link in the Log Entry column for that job. The Task Log
window opens.
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A Task Log -- Webpage Dialog

Task Log

Sampling - Execute Job

Definition ” Recurrence || Parameters I Instances

05/02/2008 10:11:19 @ Aborted by System

Sampling - Execute Job
I |

0% 25% 50% 75% 100%
Task Id: 109158

Status: Aborted by system

Assigned server: VM110

Schedule: 05/02/2008 10:11:19

Start Time: 05/02/2008 10:11:24

End Time: 05/02/2008 10:11:27

Elzpsed Time: 00:00:13

(10:11:24) Initiating task: Sampling - Execute Job

{10:11:29) Starts building aggregated Sampling Matrix...

(10:11:23) Starts BitStream generation...
[<] (10:11:37) Execute Jobs failad: Firmglobal.Confirmit.TaskManzgement.TaskabortExcaption:
Error in the application. Server stack trace: at
Firmglobal.Confirmit.Core.BusinessManagers.BitStream.BitStreamManager.EndBitStreamSession
8it5tream\'\:‘ritestate writeSta...

(10:11:37]) Task instance aborted by Caonfirmit

@ 2008 Confirmit

Figure 249 Example of the Task Log for an aborted job

e The Definition tab holds the details of the job.

e If the job has been set up to recur then the Recurrence tab provides details of when etc. Click Change to
change the recurrence settings (see How to Set Up Recurring Tasks on page 154 for more information).

e The Parameters tab shows the job's parameters.

e The Instances tab shows the date and time of the task, and how the run progressed (see the figure
above). If this is a recurring job then there may be more than one run listed in this tab. In this case click on
the blue date/time link for a particular run to view the progress list for that run.

Click the Close button located in the upper right corner of the window to close the window and return to the
Scheduling list.

7.6.3. Procedures in the Scheduling Window

7.6.3.1. How to Abort Execution of a Sampling Job

There may be a time when you need to delete a sampling job from the schedule before it has been performed.
Proceed as follows:

1. Go tothe Sample Management > Scheduling menu command.

The Scheduling window opens (see Scheduling on page 195 for more information).
2. Inthe Sampling Jobs list, find the job you wish to delete and click in its checkbox to select it.

3. Click Remove.

The job is deleted from the list and will not be performed.

7.6.3.2. How to Change the Job Schedule Settings
After a job has been scheduled, you may need to change the settings.

1. Go tothe Sample Management > Scheduling menu command.

The Scheduling window opens (see Scheduling on page 195 for more information). The jobs listed in the
Active list are those that are scheduled but that have not yet been executed.

2. Click on the link to the job that you wish to change.
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The Task Scheduling window opens with the Recurrence Pattern dialog (see The Sampling Jobs List on
page 195 for more information).

3. Click Change.
The Recurrence tab opens enabling you to edit the settings.

4. Make the required changes.
Click Save.

The Recurrence Pattern dialog is updated to show the new settings.

7.7. Concurrent Sampling

| Note: The Concurrent Sampling functionality is an add-on and is subject to payment.

7.7.1. Background

In a normal sampling task, each sample is calculated from the available resources (the panelists that have not yet
been selected for other jobs) with no awareness of the requirements of any following samples. This process is
called Sequential Sampling, and the result is that the first samples extracted have first rights to the resources. As
later samples are extracted, the pool of resources in certain categories may be exhausted leaving none available.
The sample selection operator would normally attempt to look ahead at the sample jobs in the queue, and make
manual adjustments to the earlier job specifications so that some scarce respondents will be available for later
jobs. This process is dependent on the skill of the operator, but is also rather crude and imprecise. Furthermore,
comparison of such jobs, presumably of equal priority, is very difficult.

The Concurrent Sampling functionality processes multiple sample selection jobs simultaneously. Each job will

have a different selection criteria and structure, with different target sample counts, based on output or returns,
and will make the trade-offs when allocating scarce panel resources. The result in this case will be that scarce
resources are allocated fairly across multiple sample jobs.

7.7.2. The Concurrent Sampling Window

Go to the Sample Management > Concurrent Sampling menu command. The Concurrent Sampling window
opens.

@ Concurrent Sampling List Confirmit. /™
everywhere e.-'
(uHorme v Panel Setup v Panel Utilities * Panel Management ¥ |Sample Managemant ¥ + |User: Apple, Adam Log OFf 5]
Current Job Current Matrix Job List Active Job List Matrix List Scheduling Concurrent Sampling Multiple Sarmple Upload Tester Template List Sampling Settings < @|
|p Search Mew Concurrent Sarmpling
ji{x] Concurrent Sampling Name Job IDs Job Numbers Created Created By z
el 1l | I | [= =] 2] |

No items available

Page 1

Job ID Job Number Run Number Status !i"“"g Outgo Panel Updated Uploaded Outgo Report HTML | Outgo Report Excel &

No items available

Pags 1

Panel: Confirmit Week Demao (pU162745] Current Rule: (none]  Current Job: Soft drinks tracker (11 Current Matrix: cDuntweendeanguagqEngnsh v Datahase

Figure 250 Example of the Concurrent Sampling window
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The window contains two main areas:
e Concurrent Sampling List — lists the concurrent sampling jobs that are currently available to be run.

e Concurrent Sampling Job List — the jobs that have been selected to be run in the concurrent sampling
task.
7.7.3. How to Run a Concurrent Sampling Job
1. Go tothe Sample Management > Concurrent Sampling menu command.
The Concurrent Sampling window opens.
2. Click the New Concurrent Sampling button towards the right end of the toolbar.

The New Concurrent Sampling window opens.

3. Inthe Available Jobs list, find the jobs you wish to run concurrently and select them by clicking in the
boxes at the beginning of the rows.

If the list is extensive, you can search using the Job Number, the Description or the Mailing Date.
Click Add to move the selected jobs to the Selected Jobs list.
In the Execute Job Properties column, select and/or set the required options.

Click Execute.

N oo o &

In the event you have selected Schedule for later execution in the Execute Job Properties area, a dialog
will open to allow you to set up the recurrence pattern. Make the appropriate settings and save.

The job will run as specified. On completion, the samples can be handled as “normal”.

7.7.3.1. The Execute Job Properties

e Pull to Expected Returns — each panelist can be given a grade for the probability that he/she will reply to
the questionnaire. This variable must be created as a system field in the panel survey, and must be an
open numeric object with a value between 0 and 1. The value of the variable will normally be calculated
for the individual panelists using a rule, and will be based on the responses to previous surveys. The value
is used during the sampling process to calculate how many panelists must be selected for a sample to
ensure that the required number of responses are received. When the Pull to Expected Returns property
is selected, the Expected Return Variable will be used for each panelist when creating the sub samples.

Note: The Expected Return Variable must be included in the Data Source for the selected jobs. To enable
this, you must specify an Expected Return Variable on the Sampling Settings page (see The General Tab
on page 203 for more information).

e Update Panel — ensure this box is checked if you wish to create a sample and update the database. This
action will reserve the selected panelists for the job, ensuring they cannot be used for other jobs during
the exclusion periods.

Click in the box to deselect it if you wish to perform a “dry-run” of the sample selection process. Forsta
Plus will then apply all the expressions and exclusions, will check the system setup, and will present a
report with all the appropriate information, but no changes will be made in the database and the panelists
will not be reserved. Use this to test the job setup to ensure you get the required panel. You can perform
as many dry-runs as you wish.

Note: If you execute the job with the Update Panel option selected, you can remove the panelist
reservations from the database afterwards. To do this, click the Remove Job from Panel button that
appears in the tab’s toolbar.

e Generate Sample File — ensure this box is checked if you require the sample file (the list of panelists
reserved for the job) to be created.

Note: If you select to create the sample file but not to update the panel database, then Forsta Plus will
have no record that the selected panelists have been involved with this job. These same panelists may
then be included in later jobs, and will not be excluded automatically by date and/or category.

e Comments — type any comments into the free-text data field.

e Start Time — click the down arrow to open a drop-down list of the options available:
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0 ASAP - start the job as soon as possible. The job will be queued behind any other jobs awaiting
processing in the database, and will be run as soon as the processor is available.

o Schedule for later execution — select this option if you want to run the job execution procedure at a
later time. If this option is selected, when you click OK, a dialog opens in which you can set the
required time and date for the procedure to be run, and whether you want the job to be repeated (see
How to Set Up Recurring Tasks on page 154 for more information).

7.8. Multiple Sample Upload

This menu command enables you to upload several jobs simultaneously. Note that the jobs must have been
executed.

1. Go to the Sample Management > Multiple Sample Upload menu command.

The Multiple Sample Upload window opens as shown in the example below.

‘ZHome T Admin * End Users ¥ CAPI/Kiosk ¥ Panel Setup ~ Panel Utilities * Panel Management ~ |Sample Management | ~ |User: Bennett, Migel

7]

Current Job  Current Matrix Job List Active Job List Matrix List Scheduling Cencurrent Sampling Multiple Sample Upload Tester Ternplate List Sampling Settings -

| Upload |
) search ok Add Add Al Project ID | |[ select project |
[1 3ob Humber Dascription Mziling Date z Test O
Database
| I | [= ™ =
Comment | ‘
[ jeb7 Test job7 - Date elimination with surveystatus = 0 20.05.2007
[ jeb1 Test jobl - Universal filters 13.05.2007
0 of 2 selected, Page 1
Selected Jobs
X Remove Remove All
Job Number Description Maziling Date 2
No items available
0 of 0 selected, Page 1

Panel: Cornrnunity Panel Test,, (pO220542) Current Job: Multi-Upload jobl (jobi0) Current Matrix: (none) LanguagelEnqlish % | Database  Production V||Samp4

Figure 251 Example of the Multiple Sample Upload window

Here you must specify the project the jobs are to be uploaded to.
2. Inthe Upload Sample Properties column, click Select Project.
The Available Survey Project window opens, listing the projects currently available.
3. Select the project you wish to upload the jobs to, and click OK.
The Available Survey Project window closes and the project number is added to the Project ID field.
4. Inthe Available Jobs list, select the jobs you wish to upload and click Add.
The selected jobs are grayed out in the upper list and are moved to the Selected Jobs list below.
5. Click Upload towards the left end of the Multiple Sample Upload window toolbar.

The task window appears as in the example below. Click the Task ID links to see the details pages for the
tasks.
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The following tasks have been scheduled:

Task 1D Status Job Mumber Diescription
1076 Completaed jobi Test jobli - Universal filters
1077 Completaed job7? Test job7 - Date elimination with surveystatus = 0

Figure 252 Example of the task list

6. On completion, click OK.

The task list closes and you are returned to the Multiple Sample Upload window.

7.9. Tester Template List

Go to the Sample management > Tester Template List menu command. This window enables you to add rows
to the respondent database that you can then populate with “dummy” respondent information such that you can
test the survey and the system setup before you send it out to the actual respondents.

A Template in this instance is a set of dummy respondent information that you can create and store such that it is
available to be added to the respondent database when required.

You can set up any number of such templates for a panel, and add different respondent information to each such
that you can check different parts of the survey logic.

In the event the list is extensive, Forsta Plus provides a search facility to assist you with finding the template you
wish to use. This functions in the same way as the other search facilities in Forsta Plus.

> Delete p Search Mew Tester Template

D Template Name Created Date Creataed By z
| | =™ = |

|:| Doc Test 1 08/01/2009 14:44:14 nigelb

[ pocTestz 08/01/2009 14:44:46 nigelb

Figure 253 Example of the Tester Templates window

7.9.1. How to Create a New Tester Template

1. Click New Tester Template in the upper right corner of the window.

The New tester Template dialog box opens.

Mewr Tester Template

Template Name | |

Cancel || = Back || Mt = || Finizh

Figure 254 The New Tester Template dialog box

2. Type in a name for the template
3. Click Finish.

The template is created and the Tester Template page opens.
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@ Back | Save and Close | [ 5ave

Template Name |Do|: Template 1

Created Date 25/08/2008 09:51:55
Created By nigelb_pros

Updated Date

Updated By
# Remove P ~dd Select Columns
Panelist ID Email Group Code e

No items available

Figure 255 Creating a new tester template

You now need to add the dummy respondents to the template.
4. Inthe lower part of the page, click Add.
A row is added to the table.

5. Type a panelist ID into the first field, a valid email address into the Email field, and type a group code into
the other field.

This Group Code corresponds to the codes specified in the sub-sample.

6. Repeat steps 4 and 5 until you have the required number of “Test respondents” in the template.

@ Back Save and Close [§] save

Template Name |Do|: Template 1

Created Data 25,/08/2008 09:51:55
Created By nigelb_pros

Updated Date 25,/08/2008 09:55:42

Updated By nigelb_pros

¥ Remoue | fb add gelact Columns
[/ Panelist 1D Emnail Group Code “
[ [sooooo01 | [adam.avian@confirmit.com | [os |

[ [soooooo2 | |belinds.brant@confirmit.com | [os |

[ [sooooo03 | [charles.chukar@confirmit.com EE: |

Figure 256 Example of a tester template

7. Click Save and Close or Save to save the changes, then click Back to return to the Tester Templates list.

You can now add the dummy “test respondents” created in the template to the bottom of the respondent
database. The respondent data fields for these new rows in the database are then populated by data copied from
the same number of rows at the top of the database. In this way, the test respondents will automatically fulfill the
category, date and other requirements such that they are accepted as “members” of the sample in the database
(see How to Add Test Panelists to the Database on page 164 for more information).

7.10. Sampling Settings

The Sampling Settings page allows you to set default values and rules for the panel. These settings apply only to
the panel currently in use.

-202 -



Forsta Confidential Forsta Plus 2022 Professional and Standard Panels User Guide

Go to the Sample Management > Sampling Settings menu command.

The Sampling Settings page opens at the General tab.

7.10.1. The General Tab

Use this page to set the default properties for the panel.

Note: A number of the features on this tab can be shown or hidden as required for specific projects. To
enable or disable features, go to the Panel Management > Panel Settings menu item Features tab (see The
Panel Settings Features Tab on page 120 for more information).

- 203 -




Forsta Plus 2022 Professional and Standard Panels User Guide

Forsta Confidential

General Categorization Tree

Property Definitions

Sample File Field Templates

Survey Rule Templates

Save Refresh Survey History Job Information

Panel ID

Date Exclusion Pre Days

Date Exclusion Post Days
Individual Rest Days Variable
Category Exclusion Pre Days
Category Exclusion Post Days
Property Exclusion Pre Days
Property Exclusion Post Days
Survey History Include Months

Set status of job to Production
upon upload

Validate Background Variables
Job Number Pattern

Default Project Filter Length
Default Survey Rule Template

Default Sample File Field
Template

Default Data Source
Default Category

Project Exclusion Default
Enabled

Project Link Required
Category Requirad

Output Rule
Posting Rule
CATI scheduling

Sampling Algorithm
Dimension Collapsing Handling

Support Overlapping Segments

Skip Redistributing Excess
Weights

Expected Return Variable

v g

o =]
Mo items available « (&
Mo items available « &

Mo items available « (&

-

o
o

Edit
Edit

v g

Concurrent sampling ~

Full scheduling

Collapse Similar - gl
O &
O] &

Mo items available « (&

Figure 257 The Sampling Settings page General tab

This page contains the following properties and information:

e Panel ID - the unique identification number for the panel. This is allocated automatically by Forsta Plus
when the panel is first created and cannot be changed.

e Date Exclusion Pre Days - this is the default value for the “humber of days before mailing date” in the
date exclusion function (see How to Set the Date Exclusion Function on page 134 for more information).
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o Date Exclusion Post Days - this is the default value for the “number of days after mailing date” in the
date exclusion function (see How to Set the Date Exclusion Function on page 134 for more information).

e Individual Rest Days Variable - a numeric variable can be included in for example a registration survey,
which specifies a required number of "rest days" for the individual panelists. The panelists will then be
excluded from any samples for the number of days specified. When you wish to make use of this property,
use this field to select the variable that contains the panelists' individual rest days. With this property set,
the Individual Rest Days for a panelist will by default override the global Date Exclusion rule (see The Auto
Job Exclusion Tab on page 129 for more information) and this property can itself be overridden by other
inclusions or exclusions such as category, property and manual. If no value is specified for a particular
panelist, then the global rule will be used for that panelist. The variable must be an open numeric.

e Category Exclusion Pre Days - this is the default value for the “number of days before mailing date” in
the Category Exclusion function (see How to Set the Category Exclusion Function on page 133 for more
information).

e Category Exclusion Post Days - this is the default value for the “number of days after mailing date” in
the Category Exclusion function (see How to Set the Category Exclusion Function on page 133 for more
information).

e Property Exclusion Pre Days - this is the default value for the “number of days before mailing date” for
excluding properties(see The Property Definitions Tab on page Error! Bookmark not defined. for more
information).

e Property Exclusion Post Days - this is the default value for the “number of days after mailing date” for
excluding properties (see The Property Definitions Tab on page Error! Bookmark not defined. for more
information).

e Survey History Include Months — the number of months that items in the survey history will be included
in the BitStream files used by the sampling process. Type in the desired value.

e Logging Enabled — enables or disables extra logging of the sampling balancing algorithm’s behavior.
Note that this property is only available if the System Configuration setting SamplingLoggingEnabled is
enabled on site.

o Set Status of Job to Production... - a job will not normally be given the Production status before first
real panelist has been invited by email. Check this box to set a job status to Production once the sample
has been uploaded.

e Validate Background Variables — check to enable validation that the fields in the sampling file exist in
the survey to which the sample file is to be uploaded.

¢ Job Number Pattern — a regular expression used to determine the legal syntax of a job number.

o Default Project Filter Length — specifies the length of search-criteria when finding a survey to which a
sample is about to be uploaded. This property should be used if the survey names correspond to Job
Numbers.

e Default Survey Rule Template — the Survey Rule Template that is to be used if no other Survey Rule
Template is specified based on custom properties (see The Survey Rule Templates Tab on page 210 for
more information).

e Default Sample File Field Template — the Sample File Field Template to be used if no other Sample File
Field Template is specified based on custom properties (see The Sample File Field Templates Tab on
page 209 for more information).

o Default Data Source - for each sampling job that is created, the user must specify a data source (a
BitStream variant created via a rule) that is used as the source for sampling. If you have multiple data
sources, it is possible to specify which data source is to be set as the default when creating a new job.

e Project Exclusion Default Enabled — this also applies to new jobs. When enabled, the new exclusion
“Project Exclusion” is by default checked for new jobs. When enabled, the job must be linked to a project.
This property is related to the Project Link Required property below.

e Project Link Required — when checked, all new (and old) jobs must be linked to projects before they can
be executed.

e Category Required —when enabled, the user must select one or more categories on the Job Information
page before the job can be executed.

e Output Rule — use this to set the formatting rules for a sample file. Here you can specify the format for
date fields, numeric and Boolean values, and create aliases for the sample file headers. Click Edit to open
the Rule Editor page (see Current Rule on page 73 for more information).
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e Posting Rule —you can run a panel rule for a specific sample file. For example, if you have a survey that
requires specific header names for the columns in the sample database, then use this rule to change the
headers as required. Click Edit to open the Rule Editor page(see Current Rule on page 73 for more
information).

e CATI Scheduling - when you do a respondent upload from a file to a CATI survey you can set the CATI
scheduling. This will automate the assignment and scheduling of your CATI respondents. Respondent
data being loaded into a CATI-enabled survey can have one of the following scheduling modes applied:

o Simple scheduling — will by default create a call without an assignment with a time to call of now. The
following respondent data can adjust the call created:
CatilnterviewerlID will assign the call to the specified group/interviewer ID, a blank (or invalid) value will
result in no explicit assignment being made.
CatiCallTime will assign the date and time to call based on the respondent timezone or the local
company timezone if no timezone is specified, defaulting to the company local timezone, a blank (or
invalid) value will result in the time to call to be set to now. An example value could be: 2001-03-14
13:30.
CatiExtendedStatus will assign the extended status to that value, a blank (or invalid) value will result in
the extended status being set to be Fresh Sample (16). Values other than 16 will not have a call
created for them.

o Full scheduling — will run all respondent data through the full scheduling engine and adhere to all
calling rules. This mode should be used if advanced scheduling is required at the respondent loading
time.

Note: CATI Scheduling is only available for a CATI-enabled survey. Refer to the Authoring User Guide for
further details.

e Sampling Algorithm - allows you to specify the sampling algorithm to be used for single job execution.
The options are Sequential Sampling and Concurrent Sampling (see Concurrent Sampling on page 198
for more information). When Concurrent Sampling is selected, the Expected Return Variable property
becomes available (see below).

¢ Dimension Collapsing Handling - by default, Forsta Plus will collapse similar dimensions in the new
combined matrix as this will minimize the complexity of the combined matrix. Using this property you can
select to collapse only dimensions that are identical. This will maintain more complexity in the matrix, but
the data in the resulting report will be easier to understand.

e Support Overlapping Segments - when running Concurrent Sampling, a new combined matrix will be
set up to include all the dimensions in the different jobs. Similar dimensions will be collapsed according to
the Dimension Collapsing Handling setting selected (see above). If Dimension Collapsing Handling is set
to "ldentical" and "Support Overlapping Segments" is not enabled, only the overlapping parts of the similar
dimensions will be available for sampling.

e Skip Redistributing Excess Weights - after each sampling balancing iteration, any excess weights on
segments are redistributed to segments with available panelists. This is done to increase the total outgo.
However this can lead to over-sampling of some segments compared to the specified weights. Check this
box to prevent redistribution and avoid the risk of over-sampling.

e Expected Return Variable — this property appears in the tab when Sampling Algorithm (see above) is set
to Concurrent Sampling and saved. This property can only be used if one of the variables in the database
contains the panelists’ probability of answering a survey - in which case you select from the drop-down list
the variable to be used. The variable will be a system field in the panel survey, and must be an open
numeric object with a value between 0 and 1. The value of the variable will normally be calculated for the
individual panelists using a rule, and will be based on the responses to previous surveys. Note that the
variable cannot be zero for any of the panelists. This variable will be used when Pull To Expected Return
is selected when running a concurrent sampling job (see The Execute Job Properties on page 199 for
more information).

7.10.2. Refresh Survey History Job Information

When creating a job, you can set some custom properties in Sample Management > Sampling Settings (see
The General Tab on page 203 for more information) and choose that these properties should be copied to the
Survey History table when the job is executed (by setting the Characteristic property to Loop Support (see
Question Properties on page 22 for more information)). However if the job's properties are later changed, they will
only be changed on the job itself, not in the Survey History table.

The Survey History table is only updated when Refresh Survey History Job Information is clicked; the
values/properties in the Survey History table are then synchronized with the values/properties in the job. Note
however that to be able to refresh the Survey History table, a number of criteria must first be met:
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e Inthe Panel Setup > Designer menu command, the Panel Variables toolbox > Survey History
variables must be added with an ID the same as the ID of the custom property for the job.

e The Characteristic property must be set to LoopSupport for all variables that are to be copied to the
Survey History table.

e The Property Definitions tab for the job must have the Survey History Support property checked (see The
Property Definitions Tab on page Error! Bookmark not defined. for more information).

The Refresh Survey History... button will then be active, and when clicked will synchronize the property values
in the Survey History table with the property values in the job.

7.10.3. The Categorization Tree Tab

Use this tab to create and manage a hierarchy tree for the categories used in the panel. The categories are
defined by the user (company) and used to classify jobs, with each job belonging to one or more categories. You
can then use these classifications when for example setting up exclusion rules for sampling (see The Job
Information Tab on page Error! Bookmark not defined. for more information).

General | Categorization Tree | property Definitions | Sample File Field Templates | Survey Rule Templates

= f_‘,ﬁ Categorization Tree Save
Diey
E m Category Id =]
El [3) SampleType
E BasicSample Category Name |Demo

D ConcurrentSample
D SegSample

Figure 258 Example of the Categorization Tree tab

7.10.3.1. How to Add Groups and Categories to a Panel

To add a categorization or a group to the tree:

1. Go tothe Sampling Management > Sampling Settings menu command and click the Categorization
Tree tab.

2. Right-click on the item after which you wish to create the group or categorization, then select Add
Category or Add Categorization Group from the drop-down menu as appropriate.

The Categorization Group Name or Category Name form opens as appropriate.

Save

Categorization Group Name |(new group ].tl

Save

Category Id 1

Category Name |[new category 1)

Figure 259 The Category Group and Name entry forms

3. Type the name for the new item into the Category Name field, then press Return or click Save to save the
changes.

Note: Only alpha-numeric characters, underscore, parenthesis, apostrophe and space may be used in
these fields.

The Group or Categorization is added to the tree.
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General | Categorization Tree I Broperty Definitions || Sample File Field Templates " Survey Rule Templates |

=l {2 Categorization Tree B save
E
Category Id 9
D Demo
= E}SampleType Category Name “:new category 9]

D BasicSample
D ConcurrentSample
|: SegSample

Figure 260 Example of a Categorization Tree with Groups and Categories

These categorizations will be available to you in the Category fields on the Job Information tab when creating
and/or editing the current job (see The Job Information Tab on page Error! Bookmark not defined. for more
information).

7.10.4. The Property Definitions Tab

This tab lists the existing Property Definitions, as shown in the example below.

| General ” Categorization Tree I Property Definitions | Sample File Field Templates " Survey Rule Templates

|>< Delete Mew Property Definition
I:‘ Name 1d Required Showin Joblist | Use Sample File Field Template Survey Rule Template | Survey History Support z
[] customlobStatus €IS v v -
[ eroject_Manager  projman Vv v v - v

Figure 261 Example of the Property Definitions list

The tab allows you to apply your own properties to jobs. Properties can be used not only to categorize jobs, but

also in for example panel rules. You can specify which of the custom properties, and how many of them, are
used.

To edit an existing Definition, click on the blue Name link. The Properties page opens for the definition.

General | Categorization Tree | Property Definitions | sample File Field Templates | Survey Rule Templates

‘@ Back Save and Close [ Save

Property Name | CustomlobStatus |

Property ID [cas |

[l 1s required [¥]show in Joblist [Juse Survey Rule Template [ Survey History Support & [l use in Exclusion

¥ Ramove gk add

O Name Default Valus | Automaticsll... Szmple File Fisld Template Survey Rule Template =
Ok | [open | ® O
O e | [Closed | (@] O

Figure 262 The Property Definitions page

Here you define new property items and specify their requirements. The selection boxes are:
e Is Required — check this box if a job must include this property to be valid.
e Show in Joblist — check this box to specify that the job is to be included in the job list.

e Use Sample File Field Template — in the Property Item List in the lower part of the page, select the
Template to be used.

e Use Survey Rule Template — in the Property Item List in the lower part of the page, select the Survey
Rule Template to be used.
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e Survey History Support— allows you to add the value of the custom property to the Survey History table
at the time the job is executed. This is so customized properties can be used in expressions in Panel
Rules later. Note that once the job is executed and the values are added to the Survey History table, if the
job's properties are later changed then particular criteria must be satisfied if the Survey History table is to
be updated (see Refresh Survey History Job Information on page 206 for more information).

e Use in Exclusion — click to use the definition for Property Exclusion for the job (see How to Set the
Property Exclusion Function on page 135 for more information).

Note: Only one Property Definition can be used for exclusion in a job. Once the Use In Exclusion box is
checked for a Property Definition, the box cannot be accessed for another definition.

7.10.4.1. How to Create a New Property Definition

1. On the Property Definitions tab, click the New Property Definition button towards the right end of the
toolbar.

The New Property Definition dialog opens.

Property Mame

Property ID
(o] 4 Cancel

Figure 263 The New Property Definition dialog

2. Type a name and an ID for the property into the respective fields, then click OK.

The Property Definitions page opens. Select the options and add Property Items as required.

3. Save the changes.

7.10.4.2. How to Define a Property Item
1. Inthe Property Item List toolbar, click the Add button.
A new line is added to the list.

2. Typein an ID and a name for the new property, then select the remaining options as required (see above
for definitions).

3. Save the changes.

7.10.5. The Sample File Field Templates Tab

When a job is run, the output is a text file (respondent list). The job specifies which panelists are to be used, and
also which columns from the database are to be included. This tab specifies which columns are to be included as
default.

Note: To specify any columns that are to be included in addition to these default columns specified here,
go to the Sample Management > Current Job > Sample File Fields tab (see The Sample File Fields Tab on
page Error! Bookmark not defined. for more information).

General || Categorization Tree || Property Definitions | Sample File Field Templates | Survey Rule Templates

> Delete Mew Ternplate Definition

[ name Panel Fields 2

[ Templatei P31 age, brovser, browserversion, carbrand, carowner, children, country, credits, degree, dogo...

Figure 264 Example of the Sample File Field Templates tab

Click on the blue Name link for a template to open the editing page for that template.
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General | Categorization Tree | Property Definitions | Sample File Field Templates | survey Rule Templates

|@ Back Save and Close Save

address_city - Address city

address_post - Post address

age_groups - Age groups

answer_rate - Answer rate

appliances - Household appliances

booked - Booked/Reserved ==
dateofbirth - Date of birth ==
datecfmarriage - Married date

=u - EU mamber

ferename - Forename

language - Language

month

nordic - Sweden, Denmark, Norway, Iceland, Finland

postcode - Postcode

referer - Referer

remote_host - Remote host if available. otherwise ip ¥

Name Templatel_FJ
Panel Fields Available Selected
Search age - Age A
browser - Browser
activated - Activated - double opted Py browserversion - Browserversion
active carbrand - Car brand

carowner - Carownar

children - Number of children

country - Country

credits - Incentive points

degree - Education/Degrees

dogowner - Dog owner

email - Email address

smpstatus - Employment status
firstname - Firstname

gender - Gender

householdsize - Size of household
housing - Housing

income_usdollar - Income in US dollars
ipaddress - IF address

ipconnection - Internet connection
marriad - Marriad i

Figure 265 Example of the template editing page

The available fields are listed in the left column; any fields that are already selected for the template are listed in
the right column. On completion, save the changes.

7.10.5.1. How to Create a New Template Definition

1. Inthe Sample File Field Templates tab, click the New Template Definition button towards the right end of
the tab toolbar.

The Template Editing page opens.
2. Give the new template a name.
3. Inthe Available column, find and select the sample file fields you wish to include in the template.
4. Click the >> button to move them to the Selected column.
5. Click Save to save the changes.

If this template is later used in a job, then the database columns selected here will automatically be included in
the sample file.

7.10.6. The Survey Rule Templates Tab

Use the properties in this tab to specify how information in a survey is to update the panel, and to specify which
rules are to be used in which event. Three events can be controlled by rules:

¢ When and how the database is updated with respect to panelists who have completed the survey.
e When and how the database is updated with respect to panelists who have not responded to the survey.
e When the survey is to be closed to respondents.

7.10.6.1. How to Create a New Survey Rule Template

1. Click the New Survey Rule Template button located towards the right end of the list toolbar.

The New Survey Rule Template dialog box opens.

Mame

(1.4 Cancel

Figure 266 The New Survey Rule Template dialog box
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2.
3.

Type a name for the new rule into the Name field.
Click OK.

The Rules page opens, enabling you to edit the rules for the template.

@ Back | Save and Close Save

Name test

Update Completes Rule survey - complete | il
Update Non Responder Rule survey - nonstarters | W | gl
Survey Closing Rule survey - closing | il
Update Non Responder Days u] =]
Close Days = =]

Figure 267 The Edit Rules page

The properties are as follows:

Name — the name of the rule. This can be edited as required.

Update Completes Rule - the rule that updates the panel database with information on the panelists who
have completed the survey since the previous time this rule was run. Note that this rule will only be run
when the Survey Synchronization task runs (see Survey Synchronization on page 72 for more
information). The Survey Synchronization task must therefore be set up to run at suitable intervals such
that the panel database is maintained appropriately.

Update Non Responder Rule — not all panelists selected for a survey will always wish or be able to
respond to the survey invitation. This rule is intended to be used to free up panelists who have not
responded to the survey within a set time, so they can be used in new surveys. This rule is usually run
once between the start and closing dates of a survey, on a date specified by the Update Non Responder
Days setting below. Note that this rule will only be run when the Survey Synchronization task runs (see
Survey Synchronization on page 72 for more information). The Survey Synchronization task will therefore
need to be set up such that this rule is run at the required time.

Survey Closing Rule — this rule is run when a survey is to be closed (when the survey is completed).
Note that this rule will only be run when the Survey Synchronization task runs (see Survey
Synchronization on page 72 for more information). The Survey Synchronization task will therefore need to
be set up such that this rule is run at the required time. Note also that this rule has the same effect as
going manually to the survey's Project Management > Overview > Panel Status tab and selecting
Closed.

Update Non Responder Days — the number of days after the start of a survey that the Update Non
Responder rule is to be run (see also Update Non Responder Rule above).

Close Days - the number of days after the survey is first made available to a sample that the survey is
closed - the life of the survey.

Select the rules and type the required values into the fields as appropriate, then click Save or Save and
Close to input the settings.
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8. Reportal Reports

The Reportal Reports menu command allows you to create new reports based on the panel, and view and edit
any reports that have previously been created for this panel.

Note: The Reporting functionality is a Forsta add-on. If you do not have access to this functionality,
contact your Forsta account manager for more information.

8.1. Report List

Go to the Reporting > Reportal Reports menu command to open a list of the reports that have been created for
this panel. From this page you can also create new reports.

|)<_ Delete| /) Search ./ Reset [i&] Mew Reuurt|

[]! Report Humber Report Name Published Date Enduser List Company Created By Created Date 2

= - dac = - £

[ 1170 DocPansll report2 Not published - Confirmit Apple_Pros, Adam 6/29/2012 1:31:49 PM *

[ 1182 DocPanell Reportl Mot published - Confirmit Apple_Pros, Adam 6/27/2012 11:15:31 AM

Figure 268 Example of the Report List page

In the event the list is extensive, use the search functionality to find the report(s) you are looking for.

e Click on a Report Name link to open the report in Reportal, at the Report Summary page. Refer to the
Reportal User Guide for further details.

e Delete - select a report by clicking in the appropriate box at the left side of the list, then click Delete to
delete the report.

e Search - if the report list is extensive, add search criteria to the various fields above the list then click
Search or the green search button to the right end of the header row to reduce the number of items in the
list.

e Reset - clears any search criteria that you may have added, and resets the list such that it contains all the
reports available for this panel.

e New Report - click to create a new report based on the panel (see How to Create a New Report on page
212 for more information).

8.2. How to Create a New Report

The report creation functionality uses a pre-defined wizard to create the reports - refer to the Reportal User Guide
for further details on the wizard.

1. When in the Report List page, click the New Report button, located at the right end of the Report List
page's toolbar.

The Create Report Using Wizard overlay opens.
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Create report using wizard

Report name

Wizard name

Template name (optional)

Select end user list (optional)
| v| @

Publish report now

Cancel

Figure 269 The Create Report Using Wizard overlay

Type a name for your new report into the Report Name field.

3. Click the down-arrow next to the Wizard Name field to open a drop-down list of the wizards available to
you, and select the wizard you wish to use.

4. Select a template and/or an end-user list as required.
Select the Publish Report Now check-box if you wish to publish the new report immediately.
Click Create Report.
A task progress page opens. On completion click Close to close the overlay and return to the Report List.

Full details on creating, editing and publishing reports are given in the Reportal User Guide.
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9. The Panel App

The Forsta Panel App is an application that allows organizations running customer or Market Research panels to
offer surveys to their panelists via mobile devices. Panelists can use this app to register for panels, manage their
profile, pause and resume surveys during completion, and track accrued points for survey completion. The app
can also receive push notifications about new or uncompleted surveys from the Forsta panel software (see Push
Notifications on page 215 for more information).

The Panel App functionality is available for Standard and Professional Panels (not Basic Panel) at no extra
charge. However this version cannot be customized. For an additional charge you can customize and brand your
Panel App to ensure consistency for panelists or customers regardless of how they access your surveys. The
customization includes branding of the app icon, names and labels within the app, customized log-in screens and
customized survey lists. Contact your Forsta representative for details.

Join now!

R

TechShop community

The TechShop community gives our
highly valued techies the opportunity
to tell us how awesome we are, and
how we can take our awesomeness
fo new heights.

And yes, if you sign up, you are
nrettv awesome too

Figure 270 Example of the Panel App in use

To use the Forsta Panel App, the respondent must download the app from the Apple App Store or Google Play.
The app is fully integrated with Forsta Professional and Standard Panels, so you as the designer use your
existing panel designer software to create the survey. You will however need a separate, mobile-optimized portal
layout. Refer to the separate Professional Authoring User Guide for further details on setting up surveys and
portals.
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Important

Use of Forsta Apps may include the use of third party components (“TPC”s), including but not limited to
the GoogleTM Firebase range of products. The continued operation of certain features of Forsta Apps
may depend on the continued proper operation of those TPCs. Forsta explicitly disclaims any warranty
for or on behalf of TPCs. Certain device information, such as but not limited to operating system and
model, may be forwarded to the provider of the TPCs for ensuring proper and efficient wording of the App
and in accordance with the TPC’s terms and conditions. For a full list of TPCs for your specific App,
please contact privacy @forsta.com.

9.1. Push Notifications

Use Push Noatifications to alert your "mobile panelists” that they have new surveys waiting for them. The panelist
then simply taps the message to participate in the survey.

Push notifications are not dependent on respondents checking their email, and they are more reliable than SMS.
Push registration is updated automatically every time the respondent uses the Panel App, so if the respondent
changes their mobile number the information will be updated the next time they log in.

The push notification system uses the same system as for email invitations - when the system is set up correctly
the Push Notification check-box becomes available.

To send a push notification:

1. Inthe survey that you will be sending to your panelists, create an email in the Invitation and reminder
emails folder and set this up as the Push Notification message.

2. Inthe panel, go to the Sample Management > Job List menu item.

The list of available jobs is presented.

Select the sampling job you wish to use.
4. Inthe Sampling Job page, go to the Execution tab and click Execute Job.
In the Execute Job Properties dialog, check the Upload Sample box then click Next.

The Upload Sample Properties page opens. Here you can select to send emails and/or push messages.

Survey ID plO033Z29
Comment
I:‘ Email Sample
S S
S
Push Message (Mobile Panel App)
Push Message |Pu5h notification (survey) vl
Sending Date 09.10.2014
Sending Time 00:00 W
S L'
Cancel < Back Finish

Figure 271 Setting up to send the Push Notification
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6. The Push Message drop-down will list the emails you have available in the survey. Prior to this step in the
process you should have set up one of the emails as the push notification - select that email. Refer to the
separate Professional Authoring User Guide for further details on setting up the email.

If the desired languages are properly configured as part of the panel user database and the email
template selected for the push is correctly set up for multiple languages, then the right language will be
used in the push message.

Note: Remember that the selected email will be presented to the respondent on his/her mobile display, so
space will be restricted. The email subject should not exceed 30 characters and the email body should
not exceed 120 characters, including spaces.

7. Select the time you wish to send the notification, then click Finish.

9.2. For the Respondent

To use the Forsta Panel App, the respondent must first download the app from the Apple App Store or Google
Play. After the respondent has installed the app on their mobile, they must run it. The first time it is run, the
respondent must register and create a password. After that, when the respondent receives a notification that they
have a survey waiting for them they merely have to log in.

Password

B Remember me

-] Sign in

Join now!
L e 4
g

Figure 272 Example of arespondent login page
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Any surveys allocated to the respondent will then be listed on the mobile display and the respondent just touches
a survey in the list to open it.

7.

My Credits O

Survey 2

Survey 4
Survey 5

Survey 6

©TechShop 2014
Evy

About Contact Privacy Terms

Figure 273 Example of a survey list

The layouts of the screen, the login page, the menu and the edit profile page can all be customized.

9.3. Location Trigger History Tracking and Storage

The Forsta Panel App can perform location-based survey triggering. A project manager can associate beacon
identifiers and/or geolocation coordinates to a Forsta Plus survey and sample panelists for this survey. If a
panelist is using the Panel App, the app will request the necessary permission to access Bluetooth and/or
geolocation services on the device to facilitate triggering. One of the advanced features of this product is it is
possible to fully customize what behavior is desired when the panelist enters and exits specific location/beacon
boundaries.

For example, it is possible to perform path-to-purchase studies where the project manager wishes to present a
survey to panelists who visit a particular sales outlet but only if they have visited a competitor within the last x
hours. The app is able to do this as it stores the history information for every trigger event that has occurred on
that device in the last 30 days.

Note: This is not considered “bread-crumbing” as the app does not “track” the user but rather the trigger
events relate to specific locations that the project manager has defined to trigger.
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Important
To avoid misunderstandings and obtain consent, Forsta recommends that you inform your panelists that

the Panel App will collect some location data from his/her mobile device. Forsta further recommends that
you specify which data will be collected, for what it will be used, and with whom it will be shared.
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10. Changes Made to the Survey

When a panel is attached to a survey, several changes are made to that survey so it can function correctly
alongside the panel. This chapter describes those changes, and the additional functionality that becomes
available within surveys run by companies with the Professional Panels functionality.

Important

Surveys using batch statusing must include three “background” variables, named ‘JobNumber'
'RunNumber' and 'Panelistld'. These are open-text variables with a field width of 255 characters. They
must be added as background variables in the survey tree, and they must be included in the fields
uploaded in the sample/job. JobNumber should be an open question node with a suitable field width set,
while RunNumber and Panelistld must be numerical open questions with a suitable number of digits.

Note: The changes and functionality described in this chapter will only occur or be available to
companies with access to the Professional Panels functionality.

10.1. How to Attach a Panel to the Survey

If your company is using the Professional Panels functionality, then before you launch a survey you will need to
tell it which panel you wish it to use.

| Note: This selection must be made before you launch the survey prior to sending it to your respondents.

1. Within the survey, go to the Project Management > Overview menu command.

The Project Overview page opens at the General tab. The Panel selection field is located towards the
bottom of the page.

External Quick Test http://author.testlab.firmglobal.net/ extwix/extquicktest_p2941361.aspx?

URL _ gtkey=19830289460542c038c59983418289a8R/=3
Panelist

registration- D

fupdate profile

project

Panel Allow current survey to access Find Panel... Clear | Go to panel

Email address to
receive emails
trinnarad hw Anrumentatinn@ennfirmit.com

Figure 274 The Panel selection field

2. Type the Panel ID into the field, or
3. Click the Find Panel button.
The Find Professional Panel window opens, with a list of the panels available to you.
4. Click on the appropriate radio button to select the required panel from the list.
5. Click OK.
The window closes and the Panel ID is added to the field.
6. Click Save to save the changes.

Now, when you launch the survey, the selected panel will be attached to the survey.

Important

If a panel is launched when there is high activity on projects related to that panel, those projects may
experience delays and SQL timeouts. This occurs because Forsta Plus will attempt to update the panel
databases with respondent transaction information as that information is input. If a panel must be
relaunched while related surveys are live then you should launch at a time when activity in the surveys is
at a minimum.
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10.2. Registering a New Panelist

A special survey is used to register new panelists. This survey must include two scripting functions, while a third is
optional though strongly recommended:

e One function must check the database before the panelist is registered to ensure the panelist is not
already in the database, and close the survey if he/she is already included.

e The second function must register the new panelist’s information.

e The third function can remove the panelist's details from the survey on completion of the registration to
prevent the database continually growing as panelists register (as this will waste space on the server).

= Lé_él Panelist Registration Survey (pl467491)
@ Ermnail - Email {Opem)
E Gender - Gender (Single)
@ Passward - Passward (Open)
Update Rest of the information ko the panel {Scripk)
@] i4 - NFO: (Infa)
Remove respondent From survey (Scriph)
= Scales and Lists

) Quotas
I Ernails

Figure 275 Example of a simple Panelist Registration survey

Note: Security standards built into Forsta Plus mean that passwords are validated according to the rules
specified for the panel. The validation procedure will be run whenever a password is changed. Refer to
the separate Professional Authoring User Guide for further information.

10.2.1. Checking for Previous Registration

A panelist must only be registered in a panel database once. The script shown in the figure below checks the
email address of a prospective panelist against the database and closes the survey if the email address already
exists. If the email address is unique, then a new row is added to the panelist database. This script is written into
the Email question’s Question Details > Validation tab.

B g

@ mail - Emnail {Open)

L Ly L a1

EGender - Gender (Single) var fieldMames ¢ String[] = ["email"];

—= var fieldvalues @ String[] = [f('Ernail']:

@ Passward - Password (Open) ifiCreatePanelist{fielddarmes, fieldvalues)<0)

Update Rest of the information to the panel {Scripk) o

— , R.aiseError();

@H - INFO: {Info) SetErrarMessagel(LanglDs.en,"Couldn't register new panelist
Remove respondent from survey (Script) with this ermnail address, for example because a panelist

3 Scales and Lists already exists with the zarme email addreszs,");

3 Dunkas

Figure 276 Example of script to check whether the email address already exists

10.2.2. Updating the Information

Once a new panelist has completed the survey, the information he/she has provided must be uploaded to the
database. An “update” script, an example of which is shown in the figure below, performs this function.
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Er LT R T R e R TY]

doie Res ot ionationigiicprabag] @ semptcede

i4 - INFO: {Info

@ { ! . var fieldMarmes @ String[] = ["gender".,"Pazsword"]:
@Remove respondent From survey (Script) var fieldwalues ¢ String[] = [f('Gender' ) f('Password')]:

|5 Seales and Lists UpdatePanelvariables(fielddames, fieldvalues];

Figure 277 Example of the database registration script

10.2.3. Removing the Respondent Data from the Survey

Once the database is updated, the script example in the figure below deletes all the current respondent
information from the survey (not the panelist database) to prevent database overload, and then redirects the
survey. The redirect script is required to prevent the survey returning an error when it notices that it contains no
data for the current respondent.

8 update Rest o the nformation tothe rerel srie) i (S

(@] - INFo: (Info)
ey e g P e | e DeleteCurrentResponse();
lemove respondent from survey (Script) Redirect("http:/isurvey testlab. firmglobal netfcamrmunities/default. aspx?p=p0&35014")

15rales and | sk

Figure 278 Example of script to delete the information from the survey

10.3. Updating Existing Panelist Information

Special surveys are used to update the panelist information. These surveys will need to contain a number of
scripting objects that are used to perform particular functions within the panel database.

Ly Questionnaire Tree y

= @F‘rufile Update Survey 1 (pl1467870) e
@ Get Panelist Data (Script)
E Gender - Gender {Single)
i@ dateafhbirth - Date of birth (Open)
3] Usstate - State (Single)
i@ househaoldsize - Mumber of persons living in householc
4= | carowner - Carownet (Single)
E empstatus - Employrent skatus (Single)
E marskatus - Marital status (Single)
i@' Email - Email {Cpen)
@ Update Panelist Diata {Scripk)
@ Delete Current Database Row (Scripk)

| 5cales and Lists

| Quotas
| Emnails

Figure 279 Example of a simple Panelist Update survey

10.3.1. Fetching the Existing Information

When a panelist wishes to update his/her information, the first operation the survey must perform is to fetch the
existing data from the database. This will then be used to populate the survey so the panelist can see the current
information.

Note: If the password is fetched, it can be updated but for security reasons it will be encrypted such that
it cannot be read.

The first object in the survey will therefore be a script object to fetch the data. This will need a script, for example
that shown in the figure below.
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Name Get Panelist Data

@ ek Panelist Diata (Script)
E Gender - Gender (Single) Deleted [ ]
@ dateofbirth - Date of birth (Of
B2 Usstats - State (Single) (@ serpteode
@householdsme-Number of pet war fialdNames : String[] =

Ecarowner - Carowner (Single) ["gender"."dateafbirth","USstate" ,"householdzize","carownar","ermpstatus"."rmarstatus","arail"];
Eempstatus - Employment skaty var variables = GetPanelVariables(fieldMarmes);

Figure 280 Example of script to fetch the data from the database

10.3.2. Updating the Existing Information

As when registering a new panelist, the database must be updated with the information. This will require an
“Update” script object in the survey, containing a script such as that shown in the figure below.

var fieldMarmes : String[] = ["gender"."dateafbirth","USstate”,"househaldsize","carowner","empstatus","rmarstatus","email"];
var fieldvalues : String[] = [f('Gandar' ) f('dateofbirth' 1L f('USstate' 1L F ' househealdsize ) f('carownar L 'arnpstatus ") f
('rmarstatus')f{'email'l];

UpdatePanelVariables(fieldMarmes, fieldvaluss);

Figure 281 Example of script to update existing panelist information

Note: If the password is one of the fields fetched, a validation check is performed. If the check fails, the
update will not be performed. Note also that for security reasons the password will be encrypted such
that it cannot be read.

10.3.3. Remove the Respondent Data from the Survey

As when registering a new panelist, once the database is updated, the current respondent information must be
removed from the survey to prevent database overload. And again, a redirect script is required to prevent the
survey returning an error when it notices that it contains no data for the current respondent.

DeleteCurrentResponsel);
FRedirect("http: /¥ survey testlab. firrmglobal net communities/ default, aspx?p=p0&32014™)

Figure 282 Example of script to delete the response and redirect

10.4. Updating the Survey History Variables

You can update values in a survey history record. The only requirement here is that the survey includes a variable
field called PanelistID.

var shFieldMames | String[] = ["SurveyStatus","SHAIv"]:
var shFieldvalues : String[] = ["5","&"]:
UpdateSurveyHistoryWariablez(panelistld, jobMurmber,shFieldMarmes, shFieldvaluesz):

Figure 283 Example of script to update the Survey History Record

10.5. Standard Surveys Associated with a Panel

A regular survey is associated with a panel (see How to Attach a Panel to the Survey on page 219 for more
information). An association from a job to a survey is created when the sample is uploaded to the survey using
the job upload functionality within sampling. A survey is not regarded as “Open” for panelists before the invitations
have been emailed, unless the job status has been specifically set to “In production” in the sample system.

There are two ways to status the information from a survey back to the panel:

e Standard real-time update — some fundamental fields in the panel are maintained continually up-to-date.
These fields include the status of the survey, Start Date and Completed Date.
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Note: Forsta Plus On-Premise customers can switch off the real-time status functionality at site level.

e Survey rules — this uses batch processing, usually set up to run as a recurring task. Survey rules provide
much improved flexibility concerning how the panel status is maintained.

Note that both real-time statusing and batch statusing can be used simultaneously. Batch statusing (explained in
previous chapters) can be specified to update the panelist fields and survey history fields based on information in
the survey, panelist level information, survey history level information and limited information from the job.

Important

Surveys using batch statusing must include three “background” variables, named ‘JobNumber'
'RunNumber' and 'Panelistld’'. They must be added as background variables in the survey tree, and they
must be included in the fields uploaded in the sample/job. JobNumber should be an open question node
with a suitable field width set, while RunNumber and Panelistld must be numerical open questions with a
suitable number of digits.
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APPENDIX A: RESERVED KEYWORDS

The following Reserved Keywords must not be used as Question IDs in Professional Panels. In the event a listed
reserved keyword is used as a variable name, the panel launch will fail.

Note: These Keywords are not case-sensitive, so for example neither "ANY" nor "any" can be used as a
Question ID. Question IDs can however start with these character strings (except _), so for example
"Anyone" can be used.

The Underscore () character (a question ID must not start with ).
A

abstract
action
aggregated
all

and

any

avg
between
boolean
break

by

byte

C

callback
case

catch

char

class
comment
con

conn

const
contains
continue
convert
count
createddate
datebetween
debugger
default
delete

do

double
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else

enum

env

€q

extends
false

final

finally

float

floor

for

function

ge

goto

group

gt

if
implements
import

in

instanceof
int

interface
interview_end
interview_start
interviewer
interviewerid
in_use
isfalse

istrue

iterationid

| (except for use under special conditions

L (except for use under special conditions

last_handled
le

long

It

native

ne
never_again
new

none
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noofemailssent
not
not_in_quota
notin

null

or

order

package

page

panelid
panelist_created_date
panelistid
panelist_modified_date
private

projectid
protected

public

PValDate
PVallnHier
PValNum
PValStr
PValStrArr

R

recoding

respid
responseid
return

rid

right

rolling

round

rowguid

S
sample_category
select

short
smtpstatus
source_projectid
source_responseid
state

static

status
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string

super

switch
synchronized
this

throw

throws

to

todate
transient
tries

true

try

typeof
unique_sourceid
var

void

volatile

while

with

The following can only be used in respondent lists:

userid
password

language
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APPENDIX B: SUPPORTED FUNCTIONALITY FOR
PROFESSIONAL AND STANDARD PANELS

The table below shows which functionality is available for Standard and Professional Panels.

Standard Panel | Professional Panel

Set Up

Panel Designer X X
Doc2Panel X X
Support for multiple languages X X
Portal X X
Linked surveys (registration, profile update, sample X X
surveys)

Flex support X X

Panel Management

Panel Rules X X
Single Panelist Editor X X
Data edit access control X
Multiple Panelist Editor X
Data Export/Import X X
Recoded variables X X
Aggregated variables X X
Panelist credits import/export X X

Sample Management

Sample Job X X

External fields X
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Project Exclusion X X
Date Exclusion X X
Manual Job Exclusion X X
Manual Panelist Exclusion X
Category and Property Exclusion X
Sample Job Filter X X
Scheduling X
Sample by Expected Return X
Individual Rest Days X
Sub Samples X
Sample Matrix X X
Original cellweights X
Dynamic Targets X X
Concurrent Sampling X
Multiple Sample Upload X
Set Sample File Fields X X
Tester template list X
Disregards in Future Date Exclusions X X
Incidence and Completion Rate X X
Survey synchronization X
Sample Augments X
Sample Fill-in X
Job Approval X
Output rules and posting rules X
Job Definition Report X
Outgo Report X X
Crosstab Report X
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Reporting
Reportal X X
OLAP Reporting X
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APPENDIX C: PANEL FEATURES

Panel Setup
Legacy Jobs Company administrators can import legacy jobs from other panel systems into Professional
Import Panel. These jobs can then be used for exclusions in sampling, and for aggregated variables.

This would normally be used when migrating from another panel system to a Professional
Panel. After the migration further imports of legacy jobs are normally not needed.

(see Legacy Jobs Import on page 27 for more information)

Panel Utilities

Panel Activity | Gives access to a log of all activities performed on the panel, including job execution, sample
Log uploads and rule executions.

The log helps panel managers and other panel users obtain an overview of the activity in the
panel, which will help when maintaining the panel.

(see The Activity Logs Tab on page 69 for more information)

Database This function completely removes deleted questions/columns, and the associated data, from
Cleanup the panel database. When deleting objects in a panel, the data for the objects will be kept in
the panel database. The data will not be deleted before you run a Database Cleanup.

(see Survey Synchronization on page 72 for more information)

Panel Management

Aggregated Aggregated variables can be used to create aggregations of survey history and credit history
Variables records. These aggregations can then be used in for example sampling or in panel rules.

For example, an aggregated variable could be used to store the total number of surveys each
panelist has completed. That can be used in reporting, sampling, or rules to calculate the
panelist’s historical response rate.

(see Aggregated Variable List on page 98 for more information)

Multiple Panelist| The Multiple Panelist Editor allows users to create functions to update several panelists in one
Editor operation.

This is normally used for batch updates of panelists when you need to change the value of a
variable for a number of panelists. The same goal can be achieved using a panel rule, but the
Multiple Panelist Editor provides a warning to tell you how many panelists will be updated
before actually doing the update.

(see Multiple Panelist Editor on page 106 for more information)

Rules Rules are used to create data processes that manipulate the panel data.

For example, you can use a recurring rule to calculate a panelist's age based on the date of
birth. When the age is calculated you can then write it back to the panel data. Rules can also
be used to among other things import and export panel data.

(see Rule List on page 94 for more information)
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Rule Set

Rule sets can be used to group panel rules so that they run consecutively and as one process.

For example, rule sets can be used to group together data update rules and BitStream
generation rules. If you run an age calculation rule every night and write the age back to the
panel data, you will probably want to run a BitStream generation rule afterward to make sure
the updated ages will be used in sampling. You can then create a rule set of the data
processing rule and the BitStream generation rule, which results in one task to manage rather
than two.

(see Rule Set List on page 97 for more information)

Sample Management

Scheduling

Provides access to a list of the sampling jobs awaiting execution, and provides the ability to
change the processing order of the jobs.

This can be useful to ensure that focused samples are run first if a series of samples are to be
run. For example, if you have one sample targeting female professors in the Boston area and a
second sample targeting all American females, you would want the more focused Boston
female professors sample to run first. This will ensure that the Boston female professors are
not used in the American females sample, leading to shortages in the Boston sample.

(see Scheduling on page 195 for more information)

Concurrent
Sampling

The Concurrent Sampling functionality processes multiple sample selection jobs
simultaneously. Each job will have a different selection criteria and structure, with different
target sample counts, based on output or returns, and will make the trade-offs when allocating
scarce panel resources. The result in this case will be that scarce resources are allocated fairly
across multiple sample jobs.

(see Concurrent Sampling on page 198 for more information)

Multiple Sample
Upload

Upload multiple sample jobs simultaneously to a survey. If you have run a series of
independent samples, you can use this functionality to upload all these samples to one project
in one operation.

(see Multiple Sample Upload on page 200 for more information)

Tester Template
List

Users can add additional rows to the respondent table in a survey on sample upload. The rows
can be populated with dummy respondents that can be used for testing the survey.

(see Tester Template List on page 201 for more information)

Survey
Synchronization

Users can run a panel rule to check all surveys associated with the current panel, and update
the panel iffiwhen there are changes in the survey data. This keeps the panel SurveyHistory
data up-to-date so samples can be selected appropriately, and allows you to apply advanced
business logic on data collection results.

(see Survey Synchronization on page 72 for more information)

Job Approval Set whether jobs will have to be approved by a manager before they can be uploaded to a
survey.
(see How to Execute a Job on page 151 for more information)
Disregard in This is a setting applied on job execution which allows you to specify that sample is not to be
Future Date excluded in future samples based on date exclusions.
Exclusions

(see The Job Execution Area on page 150 for more information)

External Fields

Allows users to upload additional information on the individual panelists in a job. The additional
information is uploaded to the job in a text file.
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This feature is used when there are additional background fields needed in a survey that are
not or should not be uploaded to the panel database directly.

(see The Data Fields and Areas on page 126 for more information)

Manual Panelist
Exclusion

Allows you to exclude selected panelists from the sample. The panelists are specified in a text
file containing a Panelistld column with the panelist ids of the panelists to be excluded.

(see The Manual Panelist Exclusion Tab on page 132 for more information)

Sampling -
Output Rule

A rule used to format the output of a sampling job. The rule allows you to for example specify
the format of output variables, run scripts on the output data, and create aliases for the sample
file headers.

(see The General Tab on page 203 for more information)

Sampling -
Posting Rule

When a sample is posted to a survey you can run a data processing rule. This rule can be
used to update panel data and/or SurveyHistory data for the panelists in the sample.

For example, you might have a custom survey history variable called sh_age. This should be
populated with the age of the panelist at the time he/she was sampled to a survey. You can
then use a posting rule to set the sh_age variable from an age variable in the panel data.

(see The General Tab on page 203 for more information)

Advanced
Sampling
Algorithm
Settings

Advanced Sampling Algorithm contains three functions for sampling; the ability to set Sampling
Algorithm, Dimension Collapsing Handling, and Support Overlapping Segments.

Sampling Algorithm: Allows you to specify the sampling algorithm to be used for single job
execution. The options are Sequential Sampling and Concurrent Sampling. Sequential
Sampling will be default if the feature is disabled.

Dimension Collapsing Handling: By default, Forsta Plus will collapse similar dimensions
(dimensions with similar segment expressions) in the new combined matrix as this will
minimize the complexity of the combined matrix. Using this property you can select to collapse
only dimensions that are identical.

Support Overlapping Segments: When running Concurrent Sampling, a new combined matrix
will be set up to include all the dimensions in the different jobs. Similar dimensions (dimensions
with similar segment expressions) will be collapsed according to the Dimension Collapsing
Handling setting selected. If Dimension Collapsing Handling is set to "Identical" and "Support
Overlapping Segments" is not enabled, only the overlapping parts of the similar dimensions
will be available for sampling.

(see The General Tab on page 203 for more information)

Expected
Return Variable

Each panelist can be given a grade for the probability that he/she will reply to the
questionnaire. This probability can be used in sampling to calculate how many panelists must
be selected to ensure the required number of responses.

(see The Execute Job Properties on page 199 for more information)

Individual Rest
Days

Numeric variable in the panel data which specifies a required number of “rest days” for the
individual panelists. The panelists will then be excluded from any samples for the number of
days specified.

(see The General Tab on page 203 for more information)

Active Job List

A list of all sampling jobs currently in production, i.e. the sample is run but the panelists are not
yet invited to respond.

(see Active Job List on page Error! Bookmark not defined. for more information)
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Sub Sample
Groups

Sub Sample Groups enable users to split a Sub Sample into smaller groups which the
sampling algorithm will attempt to balance as much as possible based on the sampling matrix,
so that each group becomes as representative as possible for the total Sub Sample. Users
could pre-assign panelists into these groups so that if product testing needs to be done and
different groups of respondents need to test different products but also be as representative as
possible of the overall sample, the grouping functionality can be used for pre-assignment
rather than having a random draw which could potentially give some bias.

Advanced
Exclusion

Advanced Exclusion includes three functions for exclusions; the ability to exclude all panelists,
to include a specific sample, and to set which status will be excluded for category, date and
property exclusions.

Exclude All Panelists: Will exclude all panelists from the sample. You will then have to
manually include another sample to get panelists in this sample. Can for instance be used to
send follow-up surveys to people sampled to a previous survey.

Include Job: Can be used in Manual Job Exclusion to include panelists from a previous job in
this one.

Status on exclusions: Can be used to set a status that will be the only one excluded in
Category, Date and Property exclusion. This can for instance be used to only exclude panelists
that have completed a survey in the given date exclusion range.

(see The Exclusions Tab on page 129 for more information)

Category
Exclusion

Samples jobs can be categorized and these categories can then be used in exclusions when
running sampling.

For example you might want to categorize samples on the topic of the survey. This can then be
used to make sure respondents are not sampled to a lot of surveys on the same topic in a
short period of time.

(see The Auto Job Exclusion Tab on page 129 for more information)

Property
Exclusion

Panelists who have been sampled to jobs with particular properties can be excluded. Only one
property can be used to exclude panelists.

For example, you might create a sampling property called Duration. This can be used by the
person doing the sampling to indicate how long a survey takes to complete, and the property
has the values Short, Medium, and Long. You do not want panelists to get long surveys too
often, since that might demotivate them. You can then use property exclusion to make sure
people are excluded from long surveys for a period of time after being sampled to one.

(see How to Set the Property Exclusion Function on page 135 for more information)

Original
Cellweight

You might have specified a particular cell weight that they want for a survey. However, it might
not be possible to meet this requested cell weight because you do not have enough panelists
available to meet the requested selection criteria. In this situation the cell weight might be
changed to enable the job to be completed. The Original Cellweight property allows you to
store the cellweight originally requested for the sample, and include it in the outgo reports for
the sample for comparison.

(see The Sub Sample Editor Page on page 142 for more information)

Sub Sample

Within one sample you might have different groups that should be sampled with different
targets, different matrices etc. This can be done by using sub samples.

For example, let’'s say you are using one sample job to sample to panelists from different
countries. For each of the countries you want to use that country’s nationally representative
matrix. This can be done using sub samples.

(see The Sub Sample Editor Page on page 142 for more information)

Advanced
Sample File
Handling

Advanced Sample File Handling contains two functions; Rebuild Sample File and Export
Sample File.
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Rebuild Sample File: Will regenerate the sample file to include new columns, but without
selecting new panelists. This can be used for example if you have created a sample file but
need to add or change variables.

Export Sample File: Once a sample file is created it can be exported. It will be exported as a
tab delimited text file. This can be used if you want to manually upload the sample file, for
instance if you want to upload it to a project on another server.

(see The Job Runs Area on page 151 for more information)

Sample
Augment

Augments can be used to automate the process of making sure quotas are met in surveys.
This is done by augmenting the sample to a survey after a given number of days.

For example, if you need 1000 completes in a survey you will probably start by creating a
sample of 1000 panelists. However there is a good chance that not all of the panelists will
reply, leaving you with perhaps only 600 completes. You can therefore set up the Augment
functionality such that after a specified period, additional samples are created and invites
emailed so that you will receive the desired total of 1000 completes at the end of the survey
period.

(see The Augment Sample Properties Page on page 158 for more information)

Export Job List

Exports the list of jobs. This will export the list as a tab delimited text file.

(see Job List on page 188 for more information)

Job Definition
Report

The job definition report specifies the job definition at the moment the job run was executed.
This can be used to check the parameters of the job run at the time of execution.

(see The Definition Report on page 170 for more information)

Crosstab Report

The Crosstab Report allows you to create a report on the fields included in the sample file from
a job run. The report will reflect the data as it was when the sample file was created.

(see The Crosstab Report on page 169 for more information)

Sample Fill-in

If a run does not find the required sample using the specified weight set, you can execute a
"topping-up" run for which weights are recalculated automatically to generate the required total
sample. The Sample Fill-in will be run with a later mailing date than the original sample, which
means new panelists can potentially be available for the sample. This can be used to make
sure you reach the desired quotas in your projects.

(see How to Generate Sample Fill-in on page 160 for more information)

Sample File Provides an overview of the first 10 panelists in the sample file so you can check that the file is
Preview correct.

(see The Job Runs Area on page 151 for more information)
Property Properties can be defined in the panel. Properties can be used to categorize jobs. The
Definition properties can then be used in for example sample exclusions.

(see The Property Definitions Tab on page Error! Bookmark not defined. for more
information)

Permissions

Data edit
access control

The panel administrator(s) can give the panel users an individual data edit access. This access
permission has three levels; low, medium and high. In the panel designer the panel
administrators can set access permission levels on each individual variable in the panel. Each
variable can be given a low, medium or high access level.

Once set the panel users can only edit data in variables where the permission is equal or lower
than the permission set on their user.
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(see Access Permission Levels on page 33 for more information)
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INDEX
Available Jobs, 130
A
_ B

Abort a Sampling Job, 197
Aborted tab, 30 Basic Sampling, 141
Accept Leading Zeros, 23 Batch, 153, 163
Access Permission Levels, 33 beacon identifier, 217
Access Professional Panels, 3 BitStream Files, 79, 85
Accessing Community Portals, 35 Bluetooth, 217
Action Tab, 81 Body Style Name, 45
Activate Logging, 19 Boolean, 23
Active Job Details Page, 192 bread-crumbing, 217
Active Job List, 11, 191 Button
Active Languages, 9, 26 Add, 148
Activity Logs Tab, 69 Add All, 148
Add a Community Portal to your Panel, 36 Back to Dimension List, 175
Add a Language to the Portal, 40 Back to Weight List, 179
Add a Rule to the Rule Set, 92 Delete, 174, 189
Add a Visual Component to the Page, 57 Delete Weight, 178
Add an HTML Table to the Page, 55 Dimension, 179
Add an Object to the Tree, 14 Duplicate, 125, 174, 179
Add columns, 66 Execute Job, 150
Add Fields to the Selected Fields Column, 148 Export Job, 125
Add Group Set (After), 141 Export Matrix, 174
Add Group Set (Below), 141 Import Job, 189
Add Groups and Categories to a Panel, 207 Job Definition Report, 166
Add Meta Tags to a Portal, 39 Move Backward, 195
Add rows, 66 Move Forward, 195
Add Sub Sample (After), 141 Move Up/Down, 174
Add Sub Sample (Below), 141 New Dimension, 174
Add Test Panelists to the Database, 164 New Job, 189
Add Users to the Permissions List, 33 New Weight, 178
Adding a Custom Code, 144 Printer and Save Friendly version, 172, 180
Adding a Global Custom Code, 144 Refresh, 174, 178, 195
Adding a Matrix List, 144 Remove, 148, 195
Adding Rows and Columns to the Table, 66 Remove All, 148
Additional Items, 125 Save, 125, 150, 173, 175, 179
Additional Items Tab Search, 148, 189

Menu Bar, 148 Validate Job, 125
Additional survey link parameters, 19 Validate Matrix, 174
Administrator, 27 View, 195
Advanced Filter, 102 Weight Name, 179
After the Job has been Executed, 160
Aggregated Variable List, 98 C
All, 134, 135
All Surveys Tab, 104 Calculate Variables, 113
Allow the portals to be embedded within frames, Categories and Keywords, 29
123 Categorization Tree Tab, 207
Alphabetical Filter, 189 Category, 126, 132
Append data, 86 Exclusion, 130
Append with key, 86 Select, 128
Apply Filters when Calculating..., 142 CATI Support, 8
ASAP, 153, 154, 161, 162, 200 Cell properties’ 67
Attach a Panel to the Survey, 219 Cellweight, 142
Augment Sample Properties, 158 Change
Augmenting limits, 158 Execution Settings, 159
Auto Job Exclusion Tab, 129 Job Schedule Settings, 197
Automap Fields, 91 Panel Mailing Date, 163
Automatic Exclusion Password, 59

Including, 137 Changes Made to the Survey, 219
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Characteristic, 23, 24 Adding, 144
Check the Job, 127 CustomJobStatus, 189
Checking for Previous Registration, 220
Clear Advanced Filter, 102 D
Closing Surveys, 72
Collapse All, 141 Data, 99
Collapse Type, 175 Export, 109
Combine Dimensions, 174 Import, 112
Combined Dimensions, 185 Templates, 113
Comment, 163 Data Fields, 138
Comments, 153, 199 Data Source, 126, 174
Company, 3, 6, 29, 30, 31 Data Write Access, 23
Completed, 15, 134, 135 Database Cleanup, 10, 71
Completed Surveys Tab, 104 Database Generation, 9, 24
Completed tab, 30 Date Exclusion, 130
CompletedDate, 15 Date Exclusion Function
Completion Rate, 151 Set the, 134
Concurrent Sampling, 198 Days Before Closing, 191
Window, 198 Days Between Augments, 158
Concurrent Sampling Job List, 199 Days to First Augment, 158
Concurrent Sampling List, 199 Decimal Places, 23
Core Fields Default
Credit Transaction History, 16 language, 19
Survey History, 15 Default Code, 143
Create Default Value, 23
a Duplicate of a Matrix, 180 Define a Property Item, 209
a New Aggregated Variable, 98 Definition Report, 170
a New Community Portal for a Panel, 36 Definition tab, 197
a New Dimension, 181 Delete, 141, 212
a New Group Set, 145 a Job, 191
a New Job, 190 a Job from the Execute List, 160
a New Matrix, 193 a Weight Set, 184
a New Page, 51 an Object from the Tree, 14
a New Property Definition, 209 cells, 66
a New Rule, 95 columns, 66
a New Rule Set, 97 rows, 66
a New Sub Sample, 144 Delete an Object from the Tree, 14
a New Survey Rule Template, 210 Deleted, 19, 23
a New Template Definition, 210 Deleted (property), 14
a New Tester Template, 201 Delimiter, 110
a Page Master, 45 Deployment, 30
a Weight Set, 183 Description, 29, 131
an Expression, 139 Deselect a Job, 137
Create a New Professional Panel, 3 Designer, 9, 12
Create a New Report, 212 Designer Log, 9, 26
create new reports, 212 Details Tab, 103
Created, 3, 29, 193 dimension, 176
Created By, 3, 6, 189, 193 Dimension
Creation Methods Combined, 185
Drag and Drop, 14 Create New, 181
Duplicate, 14 Uncombine, 187
Insert After, 14 Dimension Name, 175
Insert Inside, 14 Dimensions Tab, 173, 174
Creator, 29 Disable
Credit Balance, 61 update of noOfEmailsSent, 19
Credit Transaction History, 16, 81, 87, 114 Disable Balancing, 143
criteria, 124 Disable task, 154
Crosstab Report, 168, 169 Disabled Features, 6
Current Job, 11, 124 Discard Default Group..., 143
Current Matrix, 11, 173 Display
Current Matrix Tab, 180 Name, 19
Current Rule, 10, 73 Disregard in Future Eliminations, 151
Current Rule Set, 10, 91 Disregard Sampling Matrix, 141
Custom Doc2Panel, 9
headers, 20 Document type, 45
survey link text, 20 Drag and Drop, 14
Custom Code, 142 Duplicate, 14, 141
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Duplicate a Job, 126
Duplicate a Matrix, 180
Duplicate a Rule, 88
Dynamic language, 42

Edit, 141

Edit a Page, 51

Edit a Page Master, 46
Edit Profile, 62

Edit Profile Link, 62

Editing your Page Masters and Portal Pages, 66

editor page, 140
Email, 112, 117

Invitation and Reminder, 16
Email Address, 112
Email address..., 30
Email Details Page, 19
email link, 49
Email reminder, 157
Email Sample, 157
EmailStatus, 15
Enable database encryption, 30
Encrypt

File, 112
Enforce HTTPS, 30
Enforce HTTPS access to portals, 123
Error Handling in a Rule Set List, 93
Excel File, 87
excess target, 176
Exclude

Open Ends, 111
Exclude All

checkbox, 133
Exclude all panelists, 130
Exclude fields, 123
Exclude Open Ends, 85
exclusion, 124
Exclusion

Category, 130

Date, 130
Exclusions, 124
Exclusions Tab, 129, 132
Execute a Job, 151
Execute a Rule, 88
Execute Job Properties, 199
Executing tab, 30
Execution, 125
Execution Settings

Change, 159
Execution Tab, 149, 151
Execution Time/Date for a Job

Set the, 154
Existing Project, 162
Expand All, 141
expiry days, 7
Export

a Job, 127

a Matrix, 184
Export a Panel Definition, 25
Export a Panel Portal, 66
Export a Rule, 89
Export Jobs, 189
Export Panelist Credits, 116
Export the Sample File, 164
Exporting Data, 109
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Expression, 142

Create, 139
External fields, 148
External Fields, 126
External Javascript Url, 45
External link, 62
External Survey Links, 126

F

Fetching the Existing Information, 221
Field Mapping, 90
Field name, 148
Field Names, Search for, 149
Field Type, 148
Field Width, 22
File
Transfer, 112
Upload, 113
File Upload, 127
Filter
Category, 132
Description, 131
Job Number, 131
Mailing Date, 131
Outgo, 131
Filter Tab, 138, 139
Filters, 131
Job list, 189
Flex Extension, 15
Flex Extensions, 10
Folders and Structure, 54
Forgotten Password, 7
Free Text, 68
From, 19
FTP, 112, 117

G

General Information, 3, 167, 171

General Information Area, 167

General Tab, 73, 91, 173, 203

Generate Database, 24

Generate Sample File, 152, 199

Generate Sample Fill-in, 160

geolocation coordinates, 217

Global Custom Code, 142
Adding, 144

Global Script Tab, 83

Global Variables Tab, 82

Group Increment, 146

Group Set Editor, 143

Group Set, Create new, 145

Group Start Code, 146

GroupNumber, 15

groups, 140

H

Hidden Panel Variables, 35
hierarchy column, 140
History Tracking and Storage, 217
How to
Abort a Sampling Job, 197
Access Professional Panels, 3
Add a Language to the Portal, 40
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Add a Portal to your Panel, 36

Add a Rule to the Rule Set, 92

Add a Visual Component to the Page, 57
Add an HTML Table to the Page, 55
Add an Object to the Tree, 14

Add Fields to the Selected Fields Column, 148
Add Groups and Categories to a Panel, 207
Add Meta Tags to a Portal, 39

Add Test Panelists to the Database, 164
Add Test Respondents to the Database, 202
Add Users to the Permissions List, 33
Attach a Panel to the Survey, 219, 222
Change the Execution Settings, 159
Change the Job Schedule Settings, 197
Change the Panel Mailing Date, 163
Check the Job, 127

Create a New Aggregated Variable, 98
Create a New Dimension, 181

Create a New Group Set, 145

Create a New Job, 190

Create a New Matrix, 193

Create a New Page, 51

Create a New Portal for a Panel, 36
Create a New Professional Panel, 3
Create a New Property Definition, 209
Create a New Report, 212

Create a New Rule, 95

Create a New Rule Set, 97

Create a New Sub Sample, 144

Create a New Survey Rule Template, 210
Create a New Template Definition, 210
Create a New Tester Template, 201
Create a Page Master, 45, 52

Create a Weight Set, 183

Create an Expression, 139

Define a Property Iltem, 209

Delete a Job, 191

Delete a Job from the Execute List, 160
Delete a Weight Set, 184

Delete an Object from the Tree, 14
Deselect a Job, 137

Duplicate a Job, 126

Duplicate a Matrix, 180

Duplicate a Rule, 88

Edit a Page, 51

Edit a Page Master, 46

Execute a Job, 151

Execute a Rule, 88

Export a Job, 127

Export a Matrix, 184

Export a Panel Definition, 25

Export a Panel Portal, 66

Export a Rule, 89, 96

Export Panelist Credits, 116

Export the Sample File, 164

Generate Sample Fill-in, 160

Import a Job, 190

Import a Matrix, 194

Import a Panel Definition, 25

Import a Panel from a Remote Site, 4
Import a Panel Portal, 37

Import a Rule, 89, 96

Import Panelist Credits, 118

Include an Automatic Exclusion, 137
Make the Portal Dynamic, 38

Make the Portal Language Dynamic, 42
Manually Exclude a Job, 136
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Publish a Portal, 64
Remove a Job from the Panel, 161
Remove a Run from the Panel, 160
Remove Fields from the Selected Fields
Column, 149
Remove Users from the Permissions List, 33
Run a Concurrent Sampling Job, 199
Save a Portal as a Template, 65
Select a Category, 128
Set a Portal as Default, 38
Set the Category Exclusion Function, 133
Set the Date Exclusion Function, 134
Set the Execution Time/Date for a Job, 154
Set the Mailing Date, 132
Set Up Recurring Tasks, 154
Uncombine a Dimension, 187
Undelete an Object, 14, 71
Upload a File, 127
Upload the Sample File, 162
Validate a Matrix, 180
How to Set the Property Exclusion Function, 135
HTML mode, 68
HTML Table, 55

Id, 19
iFrames, 62
Images, 69
Import

a Job, 190

a Matrix, 194
Import a Panel Definition, 25
Import a Panel from a Remote Site, 4
Import a Panel Portal, 37
Import a Rule, 96
Import Panelist Credits, 118
Importing Data, 112
In progress, 134, 135
In Progress, 15
Inactive List, 196
Incidence Rate, 151
Include

link, 19

Open Ends, 111
Include an Automatic Exclusion, 137
Include Open Ends, 85
Indexed, 22
In-line frame, 62
Insert After, 14
Insert Inside, 14
Instances Tab, 165
Introduction, 1
Invitation and Reminder Emails, 16
Invitation sent, 134
InvitationDate, 15
Invited, 15, 135

Job
Check, 127
Create New, 190
Delete, 191
Description, 126
Deselect, 137
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Details, 167, 171
Duplicate, 126
Execution Area, 150
Export, 127
Filters, 131
Import, 190
Information, 124
Information Tab, 125
List, 11, 124, 188
Manually exclude, 136
Number, 126, 131, 189, 191
Properties, 126
Reporting Area, 166
Status, 126, 166
Job Definition Report, 170
Job Details Area, 167
Job Information Tab, 126
Job List
Filters, 189
Toolbar, 189
Job List Window, 190
Job Runs Area, 151, 168
Job Runs list, 170
Job Schedule Settings, Change, 197
JoblsClosed, 16

K

Key Fields, 91
Keywords, 3
Keywords, reserved, 224

L

Language, 42

Language Selector, 60
Languages, 29

Last Executed By, 189
Last Job Used, 193

Last Modified, 29

Last Used, 193

Legacy Jobs Import, 9, 27
Link Target, 62

Linked Projects, 10
Linked Surveys, 34

List Columns, 191
Locale, 111

Location Trigger History Tracking, 217
Log Entry column, 196
Logging Details Page, 70
Login, 58

login attempts, 7

Login Name, 59

Login Status, 59
Lower/Upper Limit, 23
Lower/Upper Limit Type, 23

M

mailcode, 153, 163

Mailing Date, 126, 131, 189, 191
Set the, 132

Make the Portal Dynamic, 38

Manage Available matrices, 142

Manage Credits, 105

Managing your Panel Portals, 64
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Managing your Portal Templates, 65
Managing your Portal within your Panel, 65
Manual Job Exclusion Tab, 130
Manually Exclude a Job, 136
Manually Excluded and Included Jobs, 130
Mapping Fields, 90
Matrix
Create New, 193
Duplicate, 180
Export, 184
Import, 194
Validate, 180
Matrix List, 11, 141, 193
Adding, 144
Matrix List Window, 11, 193
Matrix Name, 174
Menu
Panel Management, 10, 73
Panel Setup, 9, 12
Panel Utilities, 9, 28
Sample Management, 10, 124
Merge data, 86
Meta Tags, 39
Minimum age, 122
Minimum required length, 122
Minimum required non alpha characters, 122
Minimum required non alphanumeric characters,
122
Minimum required uppercase characters, 122
Modified, 193
Modified By, 193
Multiple Panelist Editor, 10, 106
Multiple Sample Upload, 200

N

Name, 45, 193

Navigator and Navigator Path, 60

New Keyword, 29

New Objects Toolbox, 20

New Project, 162

New Report, 212

New Target Factor, 158

Nominal, 175

Nominal Collapsing, 176
Non-Collapsing Adjust Targets, 175, 177
Non-Collapsing Keep Targets, 175, 177
Number of Augments, 158

Number of Groups, 146

Numeric, 23

Objects, 13
Open Ends

Handling, 111

Only, 111
Open Ends Handling, 84
Open Ends Only, 85
Ordinal, 175
Ordinal Collapsing, 176
Original Cellweight, 142
Outgo, 131, 189
Outgo Report, 169
Outgo Report Excel, 172
Outgo Report HTML, 171
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Output Field Templates Tab, 209
Override
Filename, 111
Overview, 9, 28
Overview Tab, 69
Ownership Tab, 166

P

Page Area, 58
Page Master Properties, 45
Page Masters Folder, 45
Page Properties, 53
Pages Folder, 51
Panel, 124
Panel Activity Log, 10, 69
Panel App, 214, 216
Panel Database, 76
PANEL FEATURES, 231
Panel fields, 148
Panel ID, 3, 29
Panel Management Menu, 10, 73
Panel Name, 3, 29
Panel Portal, 46

Designer, 44

Languages, 40
Panel Portal URL, 30
Panel Portals, 10, 35
Panel Settings, 10, 120
Panel Settings Features Tab, 120
Panel Setup Menu, 9, 12
Panel Updated column, 161, 162
Panel Utilities Menu, 9, 28
Panel variable (hidden), 35
Panel variable (visible), 35
Panel Variables, 35, 111
Panel Variables Toolbox, 13
panelist, 124
Panelist Credits, 10, 114
Panelist Editor Tabs, 102
Panelist Unique Variable, 123
Parameters Tab, 165
Password expiry days, 122
Password history, 122
Password Policy, 6
Password Recovery, 59

Password similar to username, 122

Percent, 146
Period, 31
Permissions Tab, 32

Personally Identifiable Information, 123

PGP encryption, 112
Pll, 123
Poll, 63
Portal, 39, 42
Portal Code property, 39
Portal Code Variable, 38
Post Script Tab, 83
Preapproved, 151
Procedures in the
Current Matrix Tab, 180
Exclusions Tab, 132
Execution Tab, 151
Filter Tab, 139
Job Information Tab, 126
Job List Window, 190
Matrix List Window, 193
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Sample Definition Tab, 144

Sample File Fields Tab, 148

Scheduling Window, 197
Professional Panel

Create New, 3

Definition Export, 9, 25

List, 3
Project Exclusion, 130
Project ID, 31, 131, 163, 189
Project Manager, 189
Project Tasks button, 30
Properties

cell, 67

Page Master, 45

table, 66
Properties on a Community Portal, 63
Properties Tab, 164
Property Definitions Tab, 208
Property exclusion, 130
Property Exclusion Function, 135
Publish a Portal, 64
Push Notifications, 215

Q
Question Category, 23
Question Details Page, 22
Question Properties, 22
Quick Access pane, 3

R

Read only, 19
Rebuild Sample File, 151
Recode, 113
Recurr Tab, 165
Recurrence, 112
Recurrence Pattern Type, 155
Recurrence tab, 197
Recurring, 31
Recurring tab, 30
Recurring task, 154
Recurring Task, 154
Recurring Tasks
Set up, 154
Recurring Tasks button, 30
Refresh, 141
Refresh Survey History Job Information, 206
Registering a New Panelist, 220
reminder email, 157
Remove a Job from the Panel, 161
Remove a Run from the Panel, 160
Remove Fields from Selected Fields Column, 149
Remove Job From Panel, 151
Remove Respondent Data from the Survey, 221
Remove Users from the Permissions List, 33
Removing Respondent Data from Survey, 222
Reply to, 19
Reply to Display Name, 19
Report
Create New, 212
Report List, 212
Report Number, 31
Report page designer
HTML mode, 68
images, 69
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text, 68
Report Tab, 94, 173, 179
Reportal Reports, 212
Reporting, 125
Reporting Tab, 166
Repost Sample, 161, 162
Reserved, 15, 134, 135
Reserved keywords, 224
ReservedDate, 15
Reset, 189, 212
Right-Click Menu, 141
Rule List, 10, 94
Rule Management Tab, 92
Rule Set List, 10, 97
Run a Concurrent Sampling Job, 199
Run Number, 191
RunNumber, 16

S

sample, 177
Sample Definition Tab, 140, 144
Sample file, 164
Sample File Fields

Tab, 147
Sample File Fields Tab, 148
Sample File, Upload, 162
Sample Fill-in, 160
Sample management, 124
Sample Management Menu, 10
Sampling Algorithm, 206
Sampling Job

Abort, 197
Sampling Jobs List, 195
Sampling Settings, 11, 202
Save a Portal as a Template, 65
scarce resources, 198
Schedule, 31, 155
Schedule for later execution, 153, 161, 162, 200
Schedule for Later Execution, 117
Scheduled tab, 30
Scheduling, 11, 195
Scheduling Window, 197
Script Tab, 82
Search, 100, 138, 212
Search Facility, 6
Search tab, 30
Searching for Field Names, 149
Secondary Project Toolbox, 20
Security Tab, 121
segment, 176, 177
Select a Category, 128
Select a View, 106
Select Action on Views, 106
Select Columns, 101
Select Rows, 105
Selected Matrix, 142
Send as HTML, 19
Send as plain text, 19
Send confirmation email, 19
Sequential Sampling, 198
Server, 30, 31
Session timeout..., 123
Set a Portal as Default, 38
Set the Date Exclusion Function, 134
Set the Execution Time/Date for a Job, 154
Set the Mailing Date, 132
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Set the Property Exclusion Function, 135
Set Up Recurring Tasks, 154
shortage, 176
Single Panelist Editor, 10, 100
Source Tab, 74
Source Type, 90
BitStream Files, 79
Credit Transaction History, 81
Database, 76
Delimited Text File, 74
Panel Database, 76
Survey Database, 79
Survey Database Synchronization, 77
Specify Auto Exclusion, 130
Standard real-time update, 222
Standard Surveys Associated with a Panel, 222
Start Time, 112, 153, 161, 162, 199
StartDate, 15
Status, 30, 31, 189, 191
Stopped by system, 134, 135
Stopped By System, 15
Styles, 46, 49
Sub Sample, 172
Create new, 144
Sub Sample Information, 167, 171
Sub Sample Name, 142
Sub Samples, 124
Sub Samples Folder Editor Page, 141
SubSampleNumber, 15
SubSamples Information Area, 168
Summary, 193
SUPPORTED FUNCTIONALITY, 228
Survey Database, 79
Survey Database (Synchronization), 77
Survey History Core Fields, 15
Survey History Variables, 111, 222
Survey Rule Templates Tab, 210
Survey rules, 223
Survey Sync, 10, 72
survey triggering, 217
SurveylD, 15
Surveys List, 61
Surveys Not Started Tab, 105
Surveys Started Not Completed Tab, 104
SurveyStatus, 15
System Variables, 15

T

Tab
Additional Items, 125
Auto Job Exclusion, 129
Exclusions, 124, 129
Execution, 125, 149
Filter, 138
Job Information, 124
Manual Job Exclusion, 130
Reporting, 125
Sample Definition, 140
Sample File Fields, 147
Sub Samples, 124
Universal Criteria, 124
Table, 55
add colums, 66
add rows, 66
background color, 67
cell padding, 67
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cell properties, 67
cell spacing, 67
delete cell, 66
delete column, 66
delete row, 66
height, 67
properties, 66
width, 67
Target, 146
Target for Calculation Diff, 159
target sample, 177
Target Tab, 84
Target Type
BitStream Files, 85
Credit Transaction History, 87
Database, 85
Delimited Text File, 84
Excel File, 87
None, 86
Panel Database, 86
Task Definition Properties Dialog, 164
Task ID, 31
Task Log window, 196
Task Owner, 166
Task type, 31
Task Type, 30
Tasks Page, 30
Templates, 113
Test Database, 157, 163
Tester Template List, 11, 201
Testing your Panel Portal, 65
Text, 63, 68
Text Mode, 19
The Tool bar, 125
Theme Code, 47, 49
Theme Selector, 47, 60
Themes Folder, 46
Time and date fields, 154
Toggle Key Fields, 91
toolbox, 20
Total Digits, 23
Total target, 142
Transaction Editor, 115
Truncate Open Ends, 111

U

Uncombine, 175
Uncombine a Dimension, 187
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Undelete an Object, 14
Unique, 23

Universal Criteria, 124
Unsubscribe, 15
UnsubscribedDate, 15
Up to Parent, 175
Update data, 86
Update Panel, 152, 199

Updating Existing Panelist Information, 221

Updating the Existing Information, 222
Updating the Information, 220

Updating the Survey History Variables, 222

Upload a File, 127
Upload Multiple Samples, 200
Upload Sample Properties, 156, 158
Upload the Sample File, 162
Uploading a File, 113
Use

HTTPS, 19
Use Dynamic Targets, 142
Use newest available..., 45
User ID, 31

Using Visible and Hidden Panel Variables, 35

\%

Validate a Matrix, 180
Validating an Action Script, 89
Variable Type, 22

Variables to Include, 111

View Stylesheet Contents, 50
Virtual Variable List, 10

Visible Panel Variables, 35
Visual Components, 55

Visual Components toolbox, 57
Visual Components Toolbox, 58

w

Weight Parameter, 143
weight ratio, 177
Weight Set, 160
Create, 183
Delete, 184
Weights Tab, 173, 177
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